# Table of Contents

**About This Guide** ................................................. xiii

- Objectives ................................................... xiii
- Audience ..................................................... xiii
- Document Conventions ...................................... xiii
- Related Documentation ..................................... xiii
- Documentation Feedback ................................... xiv
- Requesting Technical Support ............................... xiv
  - Self-Help Online Tools and Resources .................. xv
  - Opening a Case with JTAC ................................. xv

**Part 1**  
**Junos Pulse**  
**Chapter 1**  
**Junos Pulse Overview** ........................................... 3

- Introducing Junos Pulse ........................................ 3
- Junos Pulse Client for Windows ............................... 4
- Pulse Client for Mac OS X ..................................... 4
- User Experience .................................................. 6
- Location Awareness ............................................. 6
- Session Migration .............................................. 6
- Centralized Pulse Configuration Management ............. 6
- Security Certificates .......................................... 7
- Compliance and Remediation ................................ 8
- Two Factor Authentication ................................... 9
- Junos Pulse Collaboration Suite Integration ............. 9
- Sign In Notifications .......................................... 9
- Automatic Software Updates ................................ 9
- Junos Pulse Client Status Icons ............................. 10
- Installation Requirements ................................... 10
- Junos Pulse Client Error Messages Overview ............ 11
- Accessing Junos Pulse Client Error Messages on Mac OS X Endpoints .................. 11
- Junos Pulse Client Log Files ................................ 12
- Deleting the Junos Pulse Client Log Files ................. 12
- Migrating From Odyssey Access Client to Junos Pulse Client .................. 15
- Migrating From Network Connect to Junos Pulse ......... 15
- Predictable Pulse Server Hostname Resolution with IPv6 18

**Chapter 2**  
**Configuring Junos Pulse Access Control Service** ........... 19

- Before You Begin ............................................. 20
- Junos Pulse Access Control Service Overview ........... 20
- Pulse Access Control Service and Pulse Secure Access Service Deployment Options ........................................... 21
Chapter 3 Configuring Junos Pulse Secure Access Service

Before You Begin Configuring Junos Pulse Secure Access Service

Junos Pulse Secure Access Service Overview

Junos Pulse and IVS

About Sign-In Notifications

Configuring and Implementing Sign-in Notifications

Copyright © 2013, Juniper Networks, Inc.
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Junos Pulse Secure Access Service Split Tunneling Overview</td>
<td>75</td>
</tr>
<tr>
<td>Split Tunneling Disabled</td>
<td>76</td>
</tr>
<tr>
<td>Split Tunneling Enabled</td>
<td>76</td>
</tr>
<tr>
<td>Pulse Split Tunneling Summary</td>
<td>77</td>
</tr>
<tr>
<td>Split Tunneling Notes</td>
<td>79</td>
</tr>
<tr>
<td>Configuring a Role for Junos Pulse Secure Access Service</td>
<td>79</td>
</tr>
<tr>
<td>Configuring General Role Options for Pulse Secure Access Service</td>
<td>81</td>
</tr>
<tr>
<td>Configuring Role Options for Pulse Secure Access Service</td>
<td>83</td>
</tr>
<tr>
<td>Configuring Role Options for Host Checker for Pulse Secure Access</td>
<td>85</td>
</tr>
<tr>
<td>Machine Authentication for Pulse Secure Access Service Overview</td>
<td>86</td>
</tr>
<tr>
<td>Credential Provider Authentication for Pulse Secure Access Service</td>
<td>87</td>
</tr>
<tr>
<td>Configuring User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection</td>
<td>88</td>
</tr>
<tr>
<td>Configuring Machine–Then–User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection</td>
<td>90</td>
</tr>
<tr>
<td>Machine and User Authentication Through a Pulse Connection for Pulse Secure Service</td>
<td>92</td>
</tr>
<tr>
<td>Configuring Junos Pulse for Secure Application Manager</td>
<td>93</td>
</tr>
<tr>
<td>Pulse Connection Set Options for Pulse Secure Access Service</td>
<td>99</td>
</tr>
<tr>
<td>Junos Pulse Connection Options</td>
<td>101</td>
</tr>
<tr>
<td>Connection is Established Settings</td>
<td>103</td>
</tr>
<tr>
<td>Location Awareness Rules</td>
<td>104</td>
</tr>
<tr>
<td>Machine Connection Preferences</td>
<td>105</td>
</tr>
<tr>
<td>User Connection Preferences</td>
<td>105</td>
</tr>
<tr>
<td>Pre-login Connection Preferences</td>
<td>106</td>
</tr>
<tr>
<td>Securing the Connection State on the Junos Pulse Client</td>
<td>106</td>
</tr>
<tr>
<td>Creating a Client Connection Set for Junos Pulse Secure Access Service</td>
<td>107</td>
</tr>
<tr>
<td>Junos Pulse FIPS Mode for Pulse Secure Access Service Overview</td>
<td>109</td>
</tr>
<tr>
<td>Endpoint Requirements</td>
<td>109</td>
</tr>
<tr>
<td>Configuration Overview</td>
<td>110</td>
</tr>
<tr>
<td>Configuring Location Awareness Rules for Junos Pulse</td>
<td>111</td>
</tr>
<tr>
<td>Component Set Options for Junos Pulse Secure Access Service</td>
<td>113</td>
</tr>
<tr>
<td>Creating a Client Component Set for Junos Pulse Secure Access Service</td>
<td>114</td>
</tr>
<tr>
<td>Endpoint Security Monitoring and Management for Pulse Secure Access Service</td>
<td>116</td>
</tr>
<tr>
<td>Remediation Options</td>
<td>117</td>
</tr>
<tr>
<td>Issuing a Remediation Message with Junos Pulse Secure Access Service</td>
<td>120</td>
</tr>
<tr>
<td>Using SMS/SCCM Remediation with Junos Pulse Secure Access Service</td>
<td>120</td>
</tr>
<tr>
<td>Configuring Shavlik Remediation with Junos Pulse Secure Access Service</td>
<td>122</td>
</tr>
<tr>
<td>Enabling Enhanced Endpoint Security with Junos Pulse Secure Access Service</td>
<td>123</td>
</tr>
<tr>
<td>Pushing Junos Pulse Configurations Between Junos Pulse Servers of the Same Type</td>
<td>125</td>
</tr>
<tr>
<td>Enabling or Disabling Automatic Updates of the Junos Pulse Client</td>
<td>127</td>
</tr>
<tr>
<td>Upgrading Junos Pulse Client Software</td>
<td>128</td>
</tr>
<tr>
<td>Integrating iPass Open Mobile with Junos Pulse for Windows Client</td>
<td>129</td>
</tr>
</tbody>
</table>
Chapter 8: Customizing the Junos Pulse Client

Customizing Junos Pulse Overview
- BrandPackager Usage Notes
- BrandPackager Workflow
- Setting Up the Junos Pulse Customization Environment
- Initializing the Junos Pulse Customization Environment
- Importing an Existing Customized Junos Pulse Package
- Editing Junos Pulse User Interface Labels
- Editing Junos Pulse Messages
- Adding Custom Graphics to Junos Pulse
- Customizing Junos Pulse for Windows Online Help
- Validating Customizations to the Junos Pulse Client
- Building the New Junos Pulse Package
- Testing the Junos Pulse Package
- Installing or Upgrading Pulse for Windows with a Branding Package
- Installing a Branding Package Only

Part 2: Junos Pulse Compatibility

Chapter 9: Client Software Feature Comparison
- Comparing Odyssey Access Client and Junos Pulse
- Comparing Network Connect and Junos Pulse
- Pulse Split Tunneling

Part 3: Junos Pulse for Mobile Devices

Chapter 10: Junos Pulse for Mobile Devices and Junos Pulse Mobile Security Suite
- Junos Pulse for Mobile Devices Overview
- Junos Pulse Mobile Security Gateway
- Junos Pulse Mobile Clients and User Agent Strings

Chapter 11: Junos Pulse for Apple iOS
- Junos Pulse for Apple iOS Overview
- Before You Begin
- Configuring a Role and Realm for Junos Pulse for Apple iOS
- Allowing Junos Pulse for iOS Users to Save Webmail Password
- Host Checker for Pulse iOS Clients
Configuring Host Checker for Junos Pulse iOS Clients . . . . . . . . . . . . . . . . . . . . . 218
Implementing Host Checker Policies for Junos Pulse for iOS Devices . . . . . . . . . 220
Installing the Junos Pulse for Apple iOS App . . . . . . . . . . . . . . . . . . . . . . . . . . . . 222
Using iPhone Configuration Utility Profiles for Junos Pulse for iOS . . . . . . . . . 223
Collecting Log Files from Junos Pulse for iOS . . . . . . . . . . . . . . . . . . . . . . . . . . . 223
Launching the Junos Pulse for iOS App with a Command . . . . . . . . . . . . . . . . . . 224
Junos Pulse for iOS Error Message Reference . . . . . . . . . . . . . . . . . . . . . . . . . . . . 225
Configuring Secure Mail . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 226
  Enabling Secure Mail at the Role Level . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 227
  Defining the Secure Mail Resource Profile . . . . . . . . . . . . . . . . . . . . . . . . . 228
  Importing an S/MIME Certificate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 229
  Onboarding Devices . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 230
  Configuring an Authorization-Only Policy for ActiveSync . . . . . . . . . . . . . . 231
  Managing Onboarded and ActiveSync-Only Devices . . . . . . . . . . . . . . . . . . . 232

Chapter 12 Junos Pulse for Google Android . . . . . . . . . . . . . . . . . . . . . . . . . . 235
  Junos Pulse for Android Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235
  Configuring a Role and Realm for Pulse for Android . . . . . . . . . . . . . . . . . . . 236
  Application Acceleration on Junos Pulse Mobile VPN Connections . . . . . . . . 238
  Configuring Application Acceleration for Pulse Mobile VPN Connections . . . 239
  Allowing Junos Pulse for Android Users to Save Webmail Password . . . . . . . 240
  Host Checker for Pulse Android Clients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 240
  Configuring Host Checker for Junos Pulse Android Clients . . . . . . . . . . . . . . . 241
  Implementing Host Checker Policies for Junos Pulse for Android Clients . . . . . 243
  Junos Pulse for Android Error Message Reference . . . . . . . . . . . . . . . . . . . . . . 244
  Launching the Junos Pulse for Android App Using a Command . . . . . . . . . . . . 246
  Junos Pulse for Android VPN API Reference . . . . . . . . . . . . . . . . . . . . . . . . . 247
    Explicit Intent Target Component . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
    Explicit Intent API — VPN Connect . . . . . . . . . . . . . . . . . . . . . . . . . . . 247
    Explicit Intent API — VPN Disconnect . . . . . . . . . . . . . . . . . . . . . . . . . 248
    Explicit Intent API — VPN Check Status . . . . . . . . . . . . . . . . . . . . . . . 249
    Explicit Intent API — Example . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 250
  Launching the Junos Pulse for Android App Through a Browser Link . . . . . . 250

Chapter 13 Junos Pulse for Nokia Symbian Devices . . . . . . . . . . . . . . . . . . . . . 253
  Junos Pulse for Symbian Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 253
    Configuring Pulse Secure Access Service for Junos Pulse on Symbian Devices . . . . 253

Chapter 14 Junos Pulse for Windows Mobile Devices . . . . . . . . . . . . . . . . . . . . 257
  Junos Pulse for Windows Mobile Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . 257
    Pulse Release 1.0, 2.0, and 3.0 and Pulse SAM Connectivity . . . . . . . . . . . . 257
  Configuring Junos Pulse Secure Access Service for Windows Mobile Endpoints . . . . 259
  Configuring Host Checker for Junos Pulse for Windows Mobile Clients . . . . . . . 263
  Junos Pulse Mobile Security Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 265
# Table of Contents

## Part 4  Windows In-Box Junos Pulse Client

### Chapter 15  Windows Pro and Windows RT In-Box Junos Pulse Client

- Microsoft Windows In-Box Junos Pulse Client Overview .......................... 269
- Microsoft Windows In-Box Junos Pulse Client Supported Platforms .......... 270
- Microsoft Windows In-Box Junos Pulse Client Supported Features ............ 270
- Microsoft Windows In-Box Junos Pulse Client Limitations ......................... 271
- Microsoft Windows In-Box Junos Pulse Client User Interface .................... 272
- Windows PowerShell Script Examples for Microsoft Windows In-Box Junos Pulse Client ................................................................. 275
- Host Checker Statement of Health for Junos Pulse Secure Access Service
  - Overview .................................................................................. 279
- Configuring a Statement of Health Host Checker Policy for Junos Pulse Secure Access Service ............................................................... 280
- Enabling Statement of Health on the Windows Endpoint for the Windows In-Box Junos Pulse Client ................................................................. 281
- Viewing Windows In-Box Junos Pulse Client Log Messages ...................... 282

## Part 5  Index

- Index .......................................................................................... 285

---

Copyright © 2013, Juniper Networks, Inc.
List of Tables

About This Guide ................................................. xiii
Table 1: Notice Icons .............................................. xiii
Table 2: Junos Pulse Documentation ................................ xiv

Part 1 Junos Pulse
Chapter 1 Junos Pulse Overview ................................... 3
Table 3: Pulse Icon States (Windows Tray and OS X Menu Bar) .... 10
Table 4: Junos Pulse Event Log Messages .......................... 12

Chapter 2 Configuring Junos Pulse Access Control Service .......... 19
Table 5: Configurable Options for Junos Pulse Connection Sets ....... 27

Chapter 3 Configuring Junos Pulse Secure Access Service .......... 69
Table 6: Split Tunneling Options Summary .......................... 77
Table 7: Pulse/SAM Client Version Summary ....................... 93
Table 8: Pulse Connection Options .................................. 102

Chapter 5 Configuring Junos Pulse Application Acceleration Service .... 139
Table 9: Personal Firewall Exceptions for Pulse Acceleration ....... 140

Chapter 7 Deploying Junos Pulse Client Software .................. 157
Table 10: Pulse Launcher Arguments .................................. 171
Table 11: Pulse Launcher Return Codes ................................ 172

Part 2 Junos Pulse Compatibility
Chapter 9 Client Software Feature Comparison ..................... 197
Table 12: Odyssey Access Client and Junos Pulse Feature Comparison .... 197
Table 13: Network Connect and Junos Pulse Feature Comparison .......... 201
Table 14: Pulse Split Tunneling ........................................ 203

Part 3 Junos Pulse for Mobile Devices
Chapter 10 Junos Pulse for Mobile Devices and Junos Pulse Mobile Security Suite .... 207
Table 15: User Agent String Client Type Pairings for Mobile Devices ........ 209

Chapter 11 Junos Pulse for Apple iOS ................................ 211
Table 16: Junos Pulse for iOS Error Messages ....................... 225
Table 17: Device Management Page ................................... 233

Chapter 12 Junos Pulse for Google Android .......................... 235
Table 18: Junos Pulse for Android Error Messages .................... 244
Chapter 14  Junos Pulse for Windows Mobile Devices ......................... 257
            Table 19: Pulse/SAM Client Version Summary ....................... 258
Part 4     Windows In-Box Junos Pulse Client
Chapter 15  Windows Pro and Windows RT In-Box Junos Pulse Client .......... 269
            Table 20: Schema Options ........................................ 278
About This Guide

- Objectives on page xiii
- Audience on page xiii
- Document Conventions on page xiii
- Related Documentation on page xiii
- Documentation Feedback on page xiv
- Requesting Technical Support on page xiv

Objectives

The *Junos Pulse Administration Guide* describes Junos Pulse and includes procedures for network administrators who are responsible for setting up and maintaining network access using Junos Pulse client software.

Audience

The *Junos Pulse Administration Guide* is for network administrators who are responsible for setting up and maintaining network access using Junos Pulse client software. This guide describes the procedures for configuring Junos Pulse as the access client.

Document Conventions

Table 1 on page xiii defines notice icons used in this guide.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="i" /></td>
<td>Informational note</td>
<td>Indicates important features or instructions.</td>
</tr>
<tr>
<td><img src="image" alt="⚠️" /></td>
<td>Caution</td>
<td>Indicates a situation that might result in loss of data or hardware damage.</td>
</tr>
</tbody>
</table>

Related Documentation

Table 2 on page xiv describes related Junos Pulse documentation.
Table 2: Junos Pulse Documentation

<table>
<thead>
<tr>
<th>Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Junos Pulse Security for Mobile Devices</td>
<td>Describes the Pulse Mobile Security Suite and includes procedures for network administrators who are responsible for setting up and managing security on mobile devices.</td>
</tr>
<tr>
<td>Junos Pulse Access Control Service</td>
<td>Describes how to configure and maintain Junos Pulse Access Control Service.</td>
</tr>
<tr>
<td>Junos Pulse Application Acceleration</td>
<td>Describes how to use the JWOS Web interface to configure, monitor, and manage the Junos Pulse Application Acceleration Service.</td>
</tr>
<tr>
<td>SRX Series Services Gateways</td>
<td>Describes how to use and configure SRX Series Gateways running Junos OS.</td>
</tr>
</tbody>
</table>

Documentation Feedback

We encourage you to provide feedback, comments, and suggestions so that we can improve the documentation. You can send your comments to techpubs-comments@juniper.net, or fill out the documentation feedback form at https://www.juniper.net/cgi-bin/docbugreport/. If you are using e-mail, be sure to include the following information with your comments:

- Document or topic name
- URL or page number
- Software release version (if applicable)

Requesting Technical Support

Technical product support is available through the Juniper Networks Technical Assistance Center (JTAC). If you are a customer with an active J-Care or JNASC support contract, or are covered under warranty, and need post-sales technical support, you can access our tools and resources online or open a case with JTAC.

- Product warranties—For product warranty information, visit http://www.juniper.net/support/warranty/.
- JTAC hours of operation—The JTAC centers have resources available 24 hours a day, 7 days a week, 365 days a year.
Self-Help Online Tools and Resources

For quick and easy problem resolution, Juniper Networks has designed an online self-service portal called the Customer Support Center (CSC) that provides you with the following features:

- Find CSC offerings: http://www.juniper.net/customers/support/
- Search for known bugs: http://www2.juniper.net/kb/
- Find product documentation: http://www.juniper.net/techpubs/
- Find solutions and answer questions using our Knowledge Base: http://kb.juniper.net/
- Download the latest versions of software and review release notes: http://www.juniper.net/customers/csc/software/
- Search technical bulletins for relevant hardware and software notifications: https://www.juniper.net/alerts/
- Join and participate in the Juniper Networks Community Forum: http://www.juniper.net/company/communities/
- Open a case online in the CSC Case Management tool: http://www.juniper.net/cm/

To verify service entitlement by product serial number, use our Serial Number Entitlement (SNE) Tool: https://tools.juniper.net/SerialNumberEntitlementSearch/

Opening a Case with JTAC

You can open a case with JTAC on the Web or by telephone.

- Use the Case Management tool in the CSC at http://www.juniper.net/cm/.
- Call 1-888-314-JTAC (1-888-314-5822 toll-free in the USA, Canada, and Mexico).

For international or direct-dial options in countries without toll-free numbers, see http://www.juniper.net/support/requesting-support.html.
PART 1

Junos Pulse

- Junos Pulse Overview on page 3
- Configuring Junos Pulse Access Control Service on page 19
- Configuring Junos Pulse Secure Access Service on page 69
- Configuring Junos Pulse on SRX Series Gateways on page 135
- Configuring Junos Pulse Application Acceleration Service on page 139
- Session Migration on page 149
- Deploying Junos Pulse Client Software on page 157
- Customizing the Junos Pulse Client on page 177
CHAPTER 1

Junos Pulse Overview

• Introducing Junos Pulse on page 3
• Junos Pulse Client Status Icons on page 10
• Installation Requirements on page 10
• Junos Pulse Client Error Messages Overview on page 11
• Accessing Junos Pulse Client Error Messages on Mac OS X Endpoints on page 11
• Junos Pulse Client Log Files on page 12
• Deleting the Junos Pulse Client Log Files on page 15
• Migrating From Odyssey Access Client to Junos Pulse Client on page 15
• Migrating From Network Connect to Junos Pulse on page 18
• Predictable Pulse Server Hostname Resolution with IPv6 on page 18

Introducing Junos Pulse

Junos® Pulse is an extensible multiservice network client that supports integrated connectivity, location-aware network access, application acceleration, security, and selected third-party services. Junos Pulse simplifies the user experience by letting the network administrator configure, deploy, and control the Pulse client software and the Pulse connection configurations that reside on the endpoint.

Junos Pulse comprises client and server software. The client enables secure authenticated network connections to protected resources and services over local and wide area networks. The Junos Pulse client software can connect with the Junos Pulse Secure Access Service to provide remote access to enterprise and service provider networks. Pulse can provide application acceleration features when it is implemented with Junos Pulse Application Acceleration Service. Pulse also delivers secure, identity-enabled network access control (NAC) for LAN-based network and application access when it is deployed with Junos Pulse Access Control Service. Pulse integrates third-party endpoint security applications such as antispyware, anti-malware, and patch management applications. Pulse also integrates with Junos Pulse Collaboration Suite for online meeting services.

Users of mobile devices (smart phones) can install the Pulse mobile device app from the respective app stores for secure connectivity to Junos Pulse Secure Access Service. Mobile device users can also enable an optional security component, the Junos Pulse
Mobile Security Suite. Windows 8.1 (Pro and RT) introduced a Junos Pulse VPN client as part of the operating system.

Junos Pulse Client for Windows

The Junos Pulse client interface (see Figure 1 on page 4) displays the deployed Pulse services in the left pane and details about the selected item in the right pane. The Connections item lists the Pulse connections. Each connection is a set of properties that enables network access through a specific Pulse server. The Security item is visible only when optional security options are deployed, such as the Juniper Networks Enhanced Endpoint Security (EES) application. If a Pulse server is licensed to provide EES, you can enable EES and deploy it as part of the Host Checker configuration. The Acceleration item is active when the Pulse client has an adjacency with Pulse Application Acceleration Service.

The Pulse client interface also supports select third-party applications. Figure 1 on page 4 shows one such application, iPass Networks, integrated into the Pulse client interface.

Figure 1: Junos Pulse Client Interface

Pulse Client for Mac OS X

Pulse 3.0 and higher supports Apple computers running Mac OS X. You deploy Pulse to Mac endpoints the same way you deploy the Windows client. Figure 2 on page 5 shows the Pulse for Mac client interface.
Figure 2: Junos Pulse for Mac Client Interface

Pulse for Mac endpoints supports the following:

- Connections to Junos Pulse Access Control Service
- Connections to Junos Pulse Secure Access Service
  Pulse clients connect to the Pulse Secure Access Service in SSL fallback mode.
- Host Checker
  Host Checker for Mac OS X supports the following rules and remediation actions:
  - Port
  - Process
  - File
  - Custom IMC
  - Enable Custom Instructions
  - Kill Processes
  - Delete Files
  - Send reason strings
User Experience

From the user perspective, Junos Pulse presents a clean, uncomplicated interface. The user can enter credentials, select a realm, save settings, and accept or reject the server certificate. When you configure the client, you can specify whether to permit end users to modify settings, such as by adding connections.

NOTE: If your Pulse environment uses Security Assertion Markup Language (SAML) for a Single Sign-on (SSO) authentication environment, the Pulse user sees a credential dialog box that is served (HTTPS) from the Pulse server instead of the local Pulse client credential dialog box. The sign-in page is defined as part of the sign-in policy on the Pulse server and the Pulse client embeds the sign-in page within a Pulse client dialog box.

The client displays the connection status until the connection is made. If a connection fails as a result of the endpoint failing a Host Checker policy, Host Checker reason strings and remediation options appear.

Location Awareness

The location awareness feature enables you to define connections that are activated automatically based on the location of the endpoint. Pulse determines the location of the endpoint by evaluating rules that you define. For example, you can define rules to enable Junos Pulse to automatically establish a secure tunnel to the corporate network through Junos Pulse Secure Access Service when the user is at home, and to establish a Junos Pulse Access Control Service connection when the user is in the office and connected to the corporate network over the LAN. Location awareness rules are based on the client’s IP address and network interface information. Split tunneling must be enabled for location awareness.

Session Migration

If you configure your access environment to support the Junos Pulse session migration feature, users can log in once through a Pulse server on the network, and then securely access additional Pulse servers without needing reauthentication. For example, a user can connect from home through Junos Pulse Secure Access Service, and then arrive at work and connect through Junos Pulse Access Control Service without having to log in again. Session migration also enables users to access different resources within the network without repeatedly providing credentials. IF-MAP Federation is required to enable session migration for users.

Centralized Pulse Configuration Management

Centralized configuration management is a key feature of Junos Pulse. Pulse connection sets (the configurations that define how and when a Pulse client connects), are bound to a particular Pulse server. The binding server is the one that provides the initial Pulse configuration to the Pulse client. For example, if you create a Pulse connection set on ServerA, and then distribute those connections to endpoints, those clients are bound to ServerA.
A bound client is managed by its particular Pulse server. The Pulse administrator defines the Junos Pulse connections and software components that are installed on the endpoint. When the Pulse client connects to the Pulse server that is managing it, the server automatically provisions configuration and software component updates. The administrator can add, remove, and modify connections. The administrator can also allow dynamic connections (connections that are added by Pulse servers when the user logs into the server using a browser). A dynamic connection enables a bound client to add connections from Pulse servers other than the one the client is bound to. Dynamic connections are created as manual rather than automatic connections, which means that they are run only when the user initiates the connection or the user browses to a Pulse server and launches Pulse from the server's Web interface. Dynamic connections create the connection with the minimum configuration required to make the connection, which means that the URL used to install or launch Pulse from the Pulse server's Web interface is used as the Connection URL and connection name. Binding Junos Pulse clients to a particular server ensures that the client does not receive different configurations when it accesses other Pulse servers. A bound endpoint receives connection set options and connections from its binding server, but it can have its Pulse client software upgraded from any Pulse Secure Access or Pulse Access control server that has the automatic upgrade option enabled. (SRX gateways do not support Pulse software updates.)

NOTE: A Junos Pulse client can be bound to only one Pulse server connection set at a time. The Junos Pulse client can receive updates and changes to that bound connection set from other Pulse servers only if the connection set is exported from the Pulse server and then imported to another Pulse server.

A Pulse client does not need to be bound to a Pulse server. An unbound client is managed by its user. If the Junos Pulse client software is installed without any connections, the user must add connections manually. Dynamic connections can be added by visiting the Web portals of Pulse servers. An unbound client does not accept configuration updates from any Pulse server.

“Adding a Pulse Configuration to a New Pulse Installation” on page 160 explains the binding process in more detail.

Security Certificates

Users cannot add CA servers or manage the server list. Pulse handles certificates in the same way that a browser handles certificates. If the Pulse dynamic certificate trust option is enabled for a connection, the user can accept or reject the certificate that is presented if it is not from a CA that is defined in the endpoint's certificate store.

An 802.1x connection enables an added layer of certificate verification. When you define an 802.1x connection on the Pulse server, you can specify server certificate distinguished names (DN) for each CA.
Compliance and Remediation

Pulse supports the Host Checker application to assess endpoint health and update critical software. Host Checker is a client-side agent that is based on Trusted Network Connect standards. You configure rules in Host Checker policies for Junos Pulse Secure Access Service and Junos Pulse Access Control Service to specify the minimum criteria for the security compliance of endpoints that are allowed to enter the network. Endpoints that fail can be connected through a remediation role that provides limited access. Host Checker can be deployed from a Pulse server to Pulse clients on Windows and Mac OS X endpoints. It will be downloaded and run when a browser is used on a Windows or Mac OS X endpoint to connect to the Pulse server Web portal.

Host Checker for mobile clients (iOS, Android, and Windows Mobile) is included as part of the app and it runs if Host Checker policies are configured and enabled on the server. Host Checker is not supported in the use case where the user employs a browser on the mobile device to connect to the Pulse server Web portal.

For Windows and OS X clients, you can use Host Checker to perform the following:

- **Malware protection through Enhanced Endpoint Security (EES)**
  EES ensures that malware, spyware, viruses, or worms are not present on endpoints, and you can restrict or quarantine these endpoints depending on your Host Checker policy configuration. EES is an optional licensed feature of Pulse Secure Access Service and Junos Pulse Access Control Service.

- **Virus signature monitoring**
  You can configure Host Checker to monitor and verify that the virus signatures, operating systems, software versions, and patches installed on client computers are up to date. You can configure automatic remediation for those endpoints that do not meet the specified criteria.

- **Patch management information monitoring and patch deployment**
  You can configure Host Checker policies that check for Windows endpoints’ operating system service pack, software version, or desktop application patch version compliance.

- **Patch remediation options**
  Pulse and Host Checker support endpoint remediation through Microsoft System Management Server or Microsoft System Center Configuration Manager (SMS/SCCM) or through the Shavlik patch deployment engine. With SMS/SCCM, Pulse triggers a preinstalled SMS/SCCM client to get patches from a pre-configured SMS/SCCM server. Shavlik uses a patch deployment engine that Pulse downloads to any endpoint that needs remediation. Shavlik provides patches directly from Microsoft and other vendors’ Web sites. (Internet connectivity is needed for Shavlik remediation.) Shavlik patch management is an optional feature. A separate license is required for Shavlik patch monitoring and deployment.

- **Endpoint configuration**
  You can configure custom rules to allow Host Checker to check for third-party applications, files, process, ports, registry keys, and custom DLLs.
Pulse mobile clients support a set of Host Checker functions that vary from one OS to the next. For complete information on Host Checker for mobile clients, see “Implementing Host Checker Policies for Junos Pulse for iOS Devices” on page 220, “Implementing Host Checker Policies for Junos Pulse for Android Clients” on page 243, and “Junos Pulse Mobile Security Overview” on page 265.

Two Factor Authentication

Pulse supports RSA SecurID authentication through soft token, hard token, and smart card authenticators. The SecurID software (RSA client 4.1 and later) must already be installed on the client machine.

Junos Pulse Collaboration Suite Integration

Junos Pulse Collaboration Suite is accessible through the Pulse interface on Windows, Mac OS X, Android, and iOS. (Android clients must be R4.0 or later. iOS clients must be R3.2 or later.) Junos Pulse Collaboration Suite enables users to schedule and attend secure online meetings. In meetings, users can share their desktops and applications with one another over a secure connection. Meeting attendees can collaborate by enabling remote control of their desktops and through text chatting.

Sign In Notifications

The notifications feature on Pulse Secure Access Service and Pulse Access Control Service allows the network administrator to display notifications to Pulse client users prior to the user logging in and after the user has already logged in. For example, you could display a legal statement or a message stating who is allowed to connect to the server before you display the Pulse credentials dialog. After the user has connected, you could display a message that notifies the user of scheduled network or server maintenance or of an upcoming company meeting.

Automatic Software Updates

After you deploy Junos Pulse client software to endpoints, software updates occur automatically. If you upgrade the Junos Pulse configuration on the server, updated software components are pushed to a client the next time it connects. You can disable this automatic upgrade feature.

**NOTE:** The automatic update feature is supported on Pulse Secure Access and Pulse Access Control servers only. SRX gateways do not support automatic Pulse software updates.

**NOTE:** When you configure Junos Pulse to make 802.1x-based connections, a reboot might be required on Windows XP endpoints when Pulse is upgraded.

Additional Pulse software components that are needed for new connections are pushed to the client as needed. Network connection properties are passed to the client at connect
time based on the client’s role as defined on the Pulse server, after which those configuration properties reside on the client computer.

Related Documentation
- Junos Pulse Client Status Icons on page 10
- Junos Pulse for Mobile Devices Overview on page 207
- Understanding Session Migration on page 149

Junos Pulse Client Status Icons

The Junos Pulse client interface (Windows and OS X) displays a system tray icon (Windows) or a menu bar icon (OS X) that indicates connection status, provides access to menu items that let the user connect and disconnect from networks and meetings, and enables quick access to the program interface. Only one icon is visible even when there are multiple connections. One icon provides the status for all connections by indicating the most important connection state information.

Table 3: Pulse Icon States (Windows Tray and OS X Menu Bar)

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Connection failed.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Connected with issues. For example, Host Checker found an issue that must be fixed before full access is available.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Connected.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>The user has suspended the connection.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>No active connections.</td>
</tr>
</tbody>
</table>

Related Documentation
- Installation Requirements on page 10
- Introducing Junos Pulse on page 3

Installation Requirements

For detailed information about supported platforms and installation requirements, see the Junos Pulse Supported Platforms Guide, which is available at http://www.juniper.net/support/products/pulse.
Junos Pulse Client Error Messages Overview

Junos Pulse client error and warning messages reside in message catalog files on the endpoint. Each message includes a short description that states the problem and a long description that provides more details and suggests actions the user can take to resolve the issue. Some of the message catalog files are part of a Junos Pulse component and are installed on an endpoint only if that component is installed on the endpoint.

All message catalog files are localized. The filename indicates the language. For example, MessageCatalogConnMgr_EN.txt is the English-language version of the file. The following filename conventions indicate the language:

- DE—German
- EN—English
- ES—Spanish
- FR—French
- IT—Italian
- JA—Japanese
- KO—Korean
- PL—Polish
- ZH—Chinese (Traditional)
- ZH-CN—Chinese (Simplified)

Related Documentation

- Introducing Junos Pulse on page 3

Accessing Junos Pulse Client Error Messages on Mac OS X Endpoints

Junos Pulse client error and warning messages reside in message catalog files on the OS X endpoint. Each message includes a short description that states the problem and a long description that provides more details and suggests actions to resolve the issue. Some of the message catalog files are part of a Junos Pulse component and are installed on an endpoint only if that component is installed on the endpoint.

All message catalog files are localized. The filename indicates the language. For example, MessageCatalogPulseUI_EN.txt is the English-language version of the file. The following filename conventions indicate the language:

- DE—German
- EN—English
- ES—Spanish
- FR—French
- IT—Italian
To view Pulse catalog files on Mac OS X endpoint, use Finder to display the package contents of the Pulse application.

Related Documentation

- Introducing Junos Pulse on page 3
- Junos Pulse Client Log Files on page 12

**Junos Pulse Client Log Files**

The Junos Pulse client writes information to Pulse log files on Windows and Apple OS X endpoints. If you need to investigate a problem with Pulse connectivity on a Pulse client endpoint, you can instruct the user to save the client logs and e-mail them to you.

The user saves logging information by opening Pulse and then clicking File > Logs > Save As. All relevant log files are added to a single file, *LogsAndDiagnostics.zip*. The user saves the .zip file and then makes it available to you.

Pulse maintains its own log files on all supported platforms. On Windows 7 and Windows Vista, the Pulse client also logs its major operational events into Windows Event Log. Network administrators can review the Pulse event log to help troubleshoot problems. Table 4 on page 12 lists the Pulse messages that can appear in the Windows event log.

To view the Pulse messages:

1. Open the Windows Event Viewer.
2. Click **Applications and Services** > **Junos Pulse** > **Operational**.

**Table 4: Junos Pulse Event Log Messages**

<table>
<thead>
<tr>
<th>ID</th>
<th>Level</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>600</td>
<td>error</td>
<td>The connection &lt;ID&gt; failed authentication: Error &lt;ID&gt;.</td>
<td>802.1X EAP authentication failure.</td>
</tr>
<tr>
<td>601</td>
<td>informational</td>
<td>User has canceled authentication of the connection &lt;ID&gt;.</td>
<td>The user canceled 802.1X EAP authentication.</td>
</tr>
<tr>
<td>602</td>
<td>error</td>
<td>Failure writing wireless LAN profile for connection &lt;ID&gt; Error &lt;ID&gt;: Reason &lt;ID&gt;: Profile: &lt;ID&gt;.</td>
<td>A failure occurred while a wireless LAN profile was being created or modified.</td>
</tr>
</tbody>
</table>
### Table 4: Junos Pulse Event Log Messages (continued)

<table>
<thead>
<tr>
<th>ID</th>
<th>Level</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>603</td>
<td>error</td>
<td>Failure writing wireless LAN profile for connection &lt;ID&gt; Error &lt;ID&gt;.</td>
<td>A failure occurred while a wireless LAN profile was being deleted.</td>
</tr>
<tr>
<td>604</td>
<td>error</td>
<td>Failure writing wired LAN profile for connection &lt;ID&gt; Error &lt;ID&gt;: Profile: &lt;ID&gt;.</td>
<td>A failure occurred while a wired LAN profile was being created or modified.</td>
</tr>
<tr>
<td>605</td>
<td>error</td>
<td>Failure writing wired LAN profile for connection &lt;ID&gt; Error &lt;ID&gt;.</td>
<td>A failure while a wired LAN profile was being deleted.</td>
</tr>
<tr>
<td>500</td>
<td>informational</td>
<td>Pulse servicing has completed successfully. All components are up to date.</td>
<td>Pulse servicing was successful.</td>
</tr>
<tr>
<td>501</td>
<td>informational</td>
<td>Pulse servicing has completed successfully. All components are up to date.</td>
<td>Servicing was requested but all components were up to date.</td>
</tr>
<tr>
<td>502</td>
<td>error</td>
<td>Pulse servicing has failed. Failure summary:</td>
<td>Pulse servicing failed.</td>
</tr>
<tr>
<td>100</td>
<td>informational</td>
<td>User requested connection &lt;ID&gt; to start.</td>
<td>The user initiated a connect request.</td>
</tr>
<tr>
<td>101</td>
<td>informational</td>
<td>User requested connection &lt;ID&gt; to stop.</td>
<td>The user initiated a disconnect request.</td>
</tr>
<tr>
<td>102</td>
<td>informational</td>
<td>Connection &lt;ID&gt; is starting because its policy requirements have been met. Connection Policy: &lt;ID&gt;.</td>
<td>A connection was started because of a policy evaluation.</td>
</tr>
<tr>
<td>103</td>
<td>informational</td>
<td>Connection &lt;ID&gt; is stopping because of its policy requirements. Connection Policy: &lt;ID&gt;.</td>
<td>A connection was stopped because of a policy evaluation.</td>
</tr>
<tr>
<td>104</td>
<td>informational</td>
<td>Connection &lt;ID&gt; is stopping because of transition to context &lt;ID&gt;.</td>
<td>The machine-to-user connection was disconnected to transition to another identity.</td>
</tr>
<tr>
<td>105</td>
<td>informational</td>
<td>Connection &lt;ID&gt; is starting because of transition to context &lt;ID&gt;.</td>
<td>The machine-to-user connection was connected as part of the transition to another identity.</td>
</tr>
</tbody>
</table>
| 106 | informational | Connection <ID> is disconnected due to computer suspend.                | The connection to Pulse Secure Access Service was disconnected because the computer is being suspended.
| 107 | informational | Connection <ID> is disconnected due to login error.                     | A credential provider connection was disconnected because of a login error.                            |
| 108 | informational | Connection <ID> is disconnected because it was modified.                | A connection was disconnected because it was modified.                                                 |
### Table 4: Junos Pulse Event Log Messages (continued)

<table>
<thead>
<tr>
<th>ID</th>
<th>Level</th>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>109</td>
<td>informational</td>
<td>User requested connection <code>&lt;ID&gt;</code> to suspend.</td>
<td>The user initiated a suspend request.</td>
</tr>
<tr>
<td>110</td>
<td>informational</td>
<td>User requested connection <code>&lt;ID&gt;</code> to resume.</td>
<td>The user initiated a resume request.</td>
</tr>
<tr>
<td>1</td>
<td>informational</td>
<td>The Junos Pulse service version <code>&lt;ID&gt;</code> has successfully started.</td>
<td>The Pulse service started.</td>
</tr>
<tr>
<td>2</td>
<td>informational</td>
<td>The Junos Pulse service has stopped.</td>
<td>The Pulse service stopped.</td>
</tr>
<tr>
<td>200</td>
<td>error</td>
<td>No connections matching URL <code>&lt;ID&gt;</code> were found in Pulse database. Request to start a connection from the browser has failed.</td>
<td>Pulse failed to resume a connection from the browser.</td>
</tr>
<tr>
<td>400</td>
<td>error</td>
<td>The host check for connection <code>&lt;ID&gt;</code> has failed. Failed policies: <code>&lt;ID&gt;</code>.</td>
<td>Host Checker failed one or more policies.</td>
</tr>
<tr>
<td>300</td>
<td>informational</td>
<td>The connection <code>&lt;ID&gt;</code> was established successfully through web-proxy <code>&lt;ID&gt;</code>.</td>
<td>Pulse established a connection to Pulse Secure Access Service or Pulse Access Control Service through a Web proxy.</td>
</tr>
<tr>
<td>301</td>
<td>informational</td>
<td>The connection <code>&lt;ID&gt;</code> was established successfully to address <code>&lt;ID&gt;</code>.</td>
<td>Pulse established a direct (nonproxy) connection to Pulse Secure Access Service or Pulse Access Control Service.</td>
</tr>
<tr>
<td>302</td>
<td>informational</td>
<td>The connection <code>&lt;ID&gt;</code> was disconnected.</td>
<td>The Pulse connection was disconnected from the Pulse server.</td>
</tr>
<tr>
<td>303</td>
<td>error</td>
<td>The connection <code>&lt;ID&gt;</code> encountered an error: <code>&lt;ID&gt;</code> Peer address: <code>&lt;ID&gt;</code>.</td>
<td>A connection encountered an error.</td>
</tr>
<tr>
<td>304</td>
<td>error</td>
<td>The connection <code>&lt;ID&gt;</code> was disconnected due to change in routing table. Interface address changed from <code>&lt;ID&gt;</code> to <code>&lt;ID&gt;</code>.</td>
<td>Pulse detected a change in the route to the Pulse server.</td>
</tr>
<tr>
<td>305</td>
<td>informational</td>
<td>VPN tunnel transport for connection <code>&lt;ID&gt;</code> switched from ESP to SSL mode due to missing ESP heartbeat.</td>
<td>ESP to SSL fallback occurred because of missing ESP heartbeats.</td>
</tr>
<tr>
<td>306</td>
<td>informational</td>
<td>VPN tunnel for connection <code>&lt;ID&gt;</code> is switched to ESP mode.</td>
<td>Tunnel transport switched to ESP mode.</td>
</tr>
<tr>
<td>307</td>
<td>error</td>
<td>The connection <code>&lt;ID&gt;</code> encountered an error: System error: <code>&lt;ID&gt;</code> Peer address: <code>&lt;ID&gt;</code>.</td>
<td>The Pulse connection failed because of a system error.</td>
</tr>
<tr>
<td>308</td>
<td>error</td>
<td>The server disconnected connection <code>&lt;ID&gt;</code> Reason <code>&lt;ID&gt;</code>: Peer address: <code>&lt;ID&gt;</code>.</td>
<td>The server disconnected a connection.</td>
</tr>
</tbody>
</table>
Related Documentation

• Deleting the Junos Pulse Client Log Files on page 15

Deleting the Junos Pulse Client Log Files

NOTE: Juniper recommends that you do not delete Pulse client log files.

The Pulse client controls log file size automatically. When a current log file reaches 10MB, a new one is created and the oldest log file is deleted. If you need to delete Pulse client log files, do not delete the file without first moving it to the Recycle Bin or renaming it.

To safely delete Pulse client log files on a Windows endpoint:

1. Use a command line or Windows Explorer to locate and delete debuglog.log and, optionally, debuglog.log.old. When prompted if you want to move the file to the Recycle Bin, answer Yes. Do not press Shift+Delete, which permanently deletes a file without moving it to the Recycle bin.

   The file location varies depending on which version of Windows the endpoint is running. For example, the following path is valid for a Windows 7 Enterprise 64-bit endpoint: C:\Users\Public\Juniper Networks\Logging.

2. Empty the Recycle Bin.

   Alternatively, you could first rename debuglog.log and then delete it. After you delete the log file, the Pulse client creates a new one. However, that operation might take some time depending on the activities of the Pulse client.

Related Documentation

• Junos Pulse Client Error Messages Overview on page 11

Migrating From Odyssey Access Client to Junos Pulse Client

Odyssey Access Client® (OAC) is 802.1X network access client software that supports the Extensible Authentication Protocol (EAP) for secure wireless LAN access. Together with an 802.1X-compatible authentication server, OAC secures WLAN communications. OAC also serves as a client for enterprises that are deploying identity-based (wired 802.1X) networking. OAC provides wireless access to enterprise networks, home Wi-Fi networks, and public hotspots.

Junos® Pulse is an extensible multiservice network client that supports integrated connectivity, location-aware network access, application acceleration, security, and selected third-party services. Junos Pulse simplifies the user experience by letting the network administrator configure, deploy, and control the Pulse client software and the Pulse connection configurations that reside on the endpoint. In addition to 802.1X authentication, Pulse can provide Layer 3 access and other services.

Like OAC, Pulse client software is bundled with Junos Pulse Access Control Service software. However, there are significant differences between OAC and Pulse and you
should be aware of these differences when you plan a migration from OAC to Pulse. The following list includes planning considerations and best-practices for a migration project. See the related topics list for details about the Pulse configuration tasks.

- The 802.1X communication protocol that you use with OAC might need to be changed to support Pulse. OAC supports the full range of 802.1X protocols; Pulse supports only EAP-TTLS/EAP-JUAC. See “Comparing Odyssey Access Client and Junos Pulse” on page 197, which lists the 802.1X protocols supported by OAC and Pulse.

- One common migration practice is to create new sign-in policies, user realms, and user roles for Junos Pulse, and then control the cut-over to Pulse by enabling Pulse sign-in policies and disabling OAC sign-in policies. The new policies, realms, and roles can be clones of the existing OAC policies, realms, and roles as a starting point. However, Pulse has more robust connection decision capabilities so you will probably want to edit your Pulse roles to take advantage of the Pulse capabilities. For example, you can replace both OAC and Network Connect with Pulse and use one client for authenticated LAN access and secure SSL VPN access. Location awareness rules allow Pulse to detect the network environment and choose a network connection based on current location.

- How many OAC configuration do you use? You need a pulse configuration for each of the OAC configurations you currently use. A Pulse access configuration is called a connection. It comprises properties that define how, when, and where a connection is established with a Pulse gateway. When you create the Pulse connections that you distribute to Pulse clients, you configure how the connection can be established. Pulse connections support machine authentication and credential provider authentication. Figure 3 on page 16 shows a Pulse Windows client that includes multiple connections.

Figure 3: Junos Pulse Client Interface (Windows Version)
• Odyssey Access Client is a wireless supplicant. Pulse, by design, is not a wireless supplicant. Pulse uses the underlying wireless supplicant on the endpoint, which is typically provided by the endpoint’s OS X or Windows operating system. When you migrate to Pulse and uninstall OAC, you remove the OAC wireless supplicant and the endpoint falls back to using wireless connectivity provided by the OS. You define 802.1X authentication connections for the Pulse client to enable authenticated 802.1X connectivity in the enterprise network. Any custom network configurations that users added to their local OAC configuration are lost when OAC is removed. For example, if a user added connection information to connect to a home wireless network, the user will need to redefine that connection in the endpoint’s wireless supplicant. A best practice is to mention this needed configuration to users as part of the Pulse roll-out. In OAC, network auto-scan lists are defined on the client. With Pulse, you can define an auto-scan list as part of an 802.1X connection that is pushed to the Pulse client.

• Do you use wireless suppression in your OAC environment? Wireless suppression disables wireless connections as long as the client has a wired network connection. You enable wireless suppression as part of a Pulse connection set. Pulse connection set properties define the decision process that Pulse uses to establish network connections.

• If you are using OAC FIPS Edition, you need to deploy Pulse 5.0 or later to support the same level of FIPS compliance that is supported by OAC.

• Do you allow users to modify configuration settings after you deploy them in your OAC environment? When you create a Pulse connection, you can define whether users can override the connection decision that has been defined by the Pulse administrator as part of the Pulse connection. You can also disable the user’s ability to create new connections. Connections created by users are manual connections, that is, the connection is not tried unless the user opens Pulse and selects it.

• Do you allow OAC users to add, remove, or modify trusted servers and certificates? Pulse does not expose this functionality to users. Pulse handles certificates in the same fashion as a browser. When you define a Pulse connection you can allow users to choose to accept an unverified certificate, which allows users to connect to servers that use a self-signed certificate.

Related Documentation

• Comparing Odyssey Access Client and Junos Pulse on page 197
• Client Connection Set Options for Junos Pulse Access Control Service on page 26
• Machine Authentication for Pulse Access Control Service Overview on page 38
• Configuring Location Awareness Rules for Junos Pulse on page 50
• Machine and User Authentication Through a Pulse Connection for Pulse Access Control Service on page 49
• Remote Desktop Protocol Compatibility with Junos Pulse 802.1X Machine Authentication Connection on page 44
• Junos Pulse Client Installation Overview on page 157
Migrating From Network Connect to Junos Pulse

Junos Pulse and Network Connect (NC) can run at the same time on an endpoint.

**NOTE:** The Pulse installation program checks for NC. If the installation program finds NC Release 6.3 or later, the Pulse installation proceeds. If NC is not at least Release 6.3, the program displays a message telling the user to upgrade NC. For detailed information about supported platforms and installation requirements, see the Junos Pulse Supported Platforms Guide, which is available at [http://www.juniper.net/support/products/pulse](http://www.juniper.net/support/products/pulse).

On endpoints that connect to Junos Pulse Secure Access Service, if Junos Pulse is running on the Windows main desktop, you cannot launch Pulse within Secure Virtual Workspace (SVW). SVW is not supported with Pulse.

Related Documentation
- Comparing Odyssey Access Client and Junos Pulse on page 197
- Comparing Network Connect and Junos Pulse on page 201

Predictable Pulse Server Hostname Resolution with IPv6

When connecting to a Junos Pulse server, the Pulse client uses the services of the endpoint operating system to resolve the hostname to an IP address. If a Pulse server hostname resolves to both IPv4 and IPv6 addresses, an IPv4 or an IPv6 address is presented to Pulse as the preferred IP address. The behavior depends on the operating system and how it is configured. For example, Windows 7 adheres to IETF standards that define how to establish the default address selection for IPv6. MAC OS 10.6 does not support that standard. Additionally, Windows 7 default settings can be changed by netsh commands so RFC compliance can be modified on the endpoint. For these and other reasons, it is difficult to predict which Pulse server IP address would get resolved to on a given client machine.

For predictable hostname resolution, we recommend that you use different Pulse server hostnames for IPv6 and IPv4 addresses. For example, configure myserver1.mycompany.com for IPv4 addresses and myserver1-v6.mycompany.com for IPv6 addresses. The Pulse server administrator can publish myserver1-v6.mycompany.com to the Pulse users who are expected to connect over IPv6, and others will continue using myserver1.mycompany.com.

Related Documentation
- Introducing Junos Pulse on page 3
CHAPTER 2

Configuring Junos Pulse Access Control Service

- Before You Begin on page 20
- Junos Pulse Access Control Service Overview on page 20
- Pulse Access Control Service and Pulse Secure Access Service Deployment Options on page 21
- Application Acceleration Deployment Options on page 22
- SRX Series Gateway Deployment Options on page 23
- Configuring a Role for Junos Pulse Access Control Service on page 23
- Client Connection Set Options for Junos Pulse Access Control Service on page 26
- Creating a Client Connection Set for Junos Pulse Access Control Service on page 33
- Junos Pulse FIPS Mode Overview for Pulse Access Control Service on page 36
- Securing the Connection State on the Junos Pulse Client on page 38
- Machine Authentication for Pulse Access Control Service Overview on page 38
- Configuring Machine-Only Machine Authentication for a Junos Pulse Connection on page 39
- Configuring User-After-Desktop Machine Authentication for a Junos Pulse Connection on page 40
- Preferred Realm and Role for Junos Pulse Machine Authentication on page 41
- Remote Desktop Protocol Compatibility with Junos Pulse 802.1X Machine Authentication Connection on page 44
- Credential Provider Authentication for Pulse Access Control Service Overview on page 44
- Configuring User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection on page 46
- Configuring Machine-Then-User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection on page 47
- Machine and User Authentication Through a Pulse Connection for Pulse Access Control Service on page 49
- Configuring Location Awareness Rules for Junos Pulse on page 50

Copyright © 2013, Juniper Networks, Inc.
Before You Begin

Before you begin configuring Junos Pulse, be sure you have already configured your device settings. Also be sure that you have defined the authentication settings, including the authentication servers and sign-in settings. Authentication Host Checker settings can directly affect a Junos Pulse installation because you can define the conditions that an endpoint must meet to be allowed access to protected resources.

Related Documentation

- Introducing Junos Pulse on page 3
- Specifying Host Checker Access Restrictions

Junos Pulse Access Control Service Overview

To enable Pulse clients to connect to Junos Pulse Access Control Service, you configure the service so that when users request authentication, they are assigned a role based on the role mappings and optional security profile that you create. Access to specific resources is permitted only for users and devices that provide the proper credentials for the realm, that are associated with the appropriate roles, and whose endpoints meet security restrictions. If a user attempts to connect to the network from an endpoint that does not comply with the security restrictions you have defined, the user cannot access the realm or role.

As you plan your Pulse configuration, be sure you know how you want to deploy Pulse. You can use one or more of the following Junos Pulse deployment options:

- Use the defaults or make changes to the Junos Pulse default component set and default connection set, and then download and distribute Pulse by having users log in to the Pulse server’s user Web portal. After the installation is complete, users have all the connections they need to access network resources.

- Create the connections that an endpoint needs for connectivity and services, download the settings file (.jnprpreconfig), and download default Pulse installation program. For Windows endpoints you run the Pulse installation program by using an msiexec
command with the settings file as an option. For OS X endpoints, you run the default installer and then import the .jnprpreconfig file using a separate command.

- Distribute Junos Pulse with no preconfiguration. You can download the default Junos Pulse installation file, and then distribute the file to endpoints using your organization's standard software distribution methods. Because the installer does not contain preconfigured connections, users must define network connections manually. Users can also automatically download a Pulse server’s dynamic connection by browsing to and logging into the Pulse Server’s Web portal. Dynamic connections are created as manual rather than automatic connections, which means that they are run only when the user initiates the connection or the user browses to a Pulse Server and launches Pulse from the server’s Web interface.

Related Documentation

- Enabling Pulse Client Downloads on page 142
- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169

Pulse Access Control Service and Pulse Secure Access Service Deployment Options

For Junos Pulse Access Control Service and Pulse Secure Access Service, you can deploy all of the connections required for Windows and Mac OS X clients to connect to any Pulse server.

NOTE: Pulse clients for mobile devices are distributed through the app stores.

Junos Pulse Access Control Service and Pulse Secure Access Service support the following deployment options:

- Web install—Create all of the settings that a Windows or Mac OS X endpoint needs for connectivity and services, and install the software on endpoints that connect to the Pulse server’s Web portal. Pulse servers include a default client connection set and client component set. The default settings enable you to deploy Junos Pulse to users without creating new connection sets or component sets. The default settings for the client permit dynamic connections and install only the components required for the connection.

- Default installer—A default Junos Pulse installer package (in .msi format for Windows and .dmg for Mac OS X) is included in the Pulse server software. You can distribute this default installer to endpoints, run it, and then let users create their own connections or have users browse to the Pulse server and authenticate through the server’s Web portal to receive the initial configuration and bind the client to the server for future configuration updates. Users can automatically install connections to other Pulse servers (if the Pulse client’s configuration allows dynamic connections) by browsing to the user Web portal of a Pulse server where a dynamic connection has been made available. A dynamic connection is a predefined set of connection parameters that
enables a client to connect to the host server. If the user is able to log in to the Pulse server’s user Web portal, the connection parameters are downloaded and installed on the Junos Pulse client. Dynamic connections are created as manual rather than automatic connections, which means that they are run only when the user initiates the connection or the user browses to a Pulse Server and launches Pulse from the server’s Web interface.

- Preconfigured installer—Create the connections that an endpoint needs for connectivity and services, download the settings file (.jnprpreconfig), and download default Pulse installation program. For Windows endpoints you run the Pulse installation program by using an msiexec command with the settings file as an option. For OS X endpoints, you run the default installer and then import the .jnprpreconfig file using a separate command.

**NOTE:** Junos Pulse for mobile devices uses a different deployment model than Pulse for Windows and Pulse for Mac endpoints.

---

**Application Acceleration Deployment Options**

The Junos Pulse client (Windows and Mac) accelerates traffic between the client system and a network’s Junos Pulse Application Acceleration Service. Pulse Application Acceleration Service and Pulse clients discover each other automatically and begin accelerating traffic without user intervention.

**NOTE:** Junos Pulse for Apple iOS and Junos Pulse for Google Android support application acceleration only when configured to operate with Riverbed Steelhead WAN optimization service.

Junos Pulse Application Acceleration Service supports the following deployment options:

- The administrator can enable Pulse downloads and configure Pulse client configuration, and then users can download the Junos Pulse client from JWOS 6.1 or higher. When the license is present, a Junos Pulse selection appears in the task bar of the Web interface for the Pulse server.

- The Junos Pulse client can be downloaded and installed automatically when users access Junos Pulse Secure Access Service. On SA Series SSL VPN systems running software Release 7.0 or later, you can configure an App Acceleration connection for Application Acceleration Service and install it along with the Pulse client software. You can also deploy an App Acceleration connection from Junos Pulse Access Control Service. Although Pulse Access Control Service is for LAN access where WAN
application acceleration is not used, Pulse Access Control Service can deploy any type of Pulse connection, which allows flexibility in how you deploy Pulse to users.

**Related Documentation**
- Junos Pulse for Mobile Devices Overview on page 207
- Understanding Session Migration on page 149

## SRX Series Gateway Deployment Options

Endpoints can use Junos Pulse client software to connect to SRX Series gateways that are running Junos OS Release 10.2, and that have dynamic VPN access enabled and configured. The following describes deployment options for SRX Series gateway connections:

- You can create connections that use the connection type “Firewall” and deploy these connections from Pulse Secure Access Service or Junos Pulse Access Control Service.
- You can download the Junos Pulse installer from a Pulse server or the Juniper Networks Web and install it using local distribution methods such as SMS/SCCM. After installing Pulse, users create a connection to an SRX gateway.

**Related Documentation**
- Understanding Session Migration on page 149

## Configuring a Role for Junos Pulse Access Control Service

A role specifies network session properties for users who are mapped to the role. The following procedure describes configuration options that apply to a role that employs Junos Pulse.

To configure a role for Pulse endpoints:

1. From the admin console, select **Users > User Roles > New User Role**.
2. Enter a name for the role and, optionally, a description.
3. **Click Save Changes**. The role configuration tabs appear.
4. Set the following options:
General > Restrictions

- **Source IP**—Source IP options allow you to make an assignment to this role dependent on the endpoint’s IP address or IP address range. To enable source IP address restrictions, select **Allow or deny users from the following IP addresses**, and then add IP addresses or address ranges. Select **Allow** to allow users to sign in from the specified IP address, or **Deny** to prevent users from signing in from the specified IP address. Then click **Add**. When you are finished making changes, click **Save Changes**.

If you add multiple IP addresses, move the highest priority restrictions to the top of the list by selecting the check box next to the IP address, and then clicking the up arrow button. For example, to deny access to all users on a wireless network (10.64.4.100) and allow access to all other network users (0.0.0.0), move the wireless network address (10.64.4.100) to the top of the list and move the (0.0.0.0) network below the wireless network.

- **Browser**—Browser options allow you to enforce the use of a particular type of browser for Web access to Pulse Access Control Service. Browser options apply only to operations that involve accessing Pulse Access Control Service through its user Web portal, such as acquiring a dynamic connection or installing Pulse through a role. Normal connection operations between the Junos Pulse client and Pulse server are not affected by browser restrictions.

- **Certificate**—Certificate options allow you to require users to sign in from an endpoint that possesses the specified client-side certificate from the proper certificate authority. Before you enable this option, be sure that you have configured the client-side certificate on the Trusted Client CAs page of the admin console.

- **Host Checker**—Host Checker options allow you to enable Host Checker polices, to choose one or more policies for the role, and specify whether the endpoint must meet all or just one of the selected Host Checker policies. The Host Checker policies that appear as Available Policies must be previously defined as part of the Endpoint Security settings in the Authentication section of the admin console.

General > Session Options

- **Session lifetime**—Session lifetime options allow you to set timeout values for user sessions. You can change the defaults for the following:
  - **Max. Session Length**—Specify the number of minutes a user session might remain open before ending. During a user session, prior to the expiration of the maximum session length, Pulse prompts the user to re-enter authentication credentials, which avoids the problem of terminating the user session without warning.
  - **Heartbeat Interval**—Specify the frequency at which the Pulse client should notify Pulse Secure Access Service to keep the session alive. You should ensure that the heartbeat interval of the agent is greater than the Host Checker interval, otherwise performance could be affected. In general, the heartbeat interval should be set to at least 50% more than the Host Checker interval.
  - **Heartbeat Timeout**—Specify the amount of time that Pulse Secure Access Service should wait before terminating a session when the endpoint does not send a heartbeat response.
- **Auth Table Timeout**—Specify a timeout value for the auth table entry to be provisioned as needed. Based on user identity and endpoint status, Pulse Access Control Service assigns the user a set of roles that specify which resources the user can access. The Pulse server pushes the roles associated with each endpoint’s source IP address (called auth table entries) to the Infranet Enforcer. The Infranet Enforcer allows traffic between the endpoint and the protected resources based on resource access policies.

- **Reminder Time**—When the Enable Session Extension feature is enabled, the Reminder Time specifies the number of minutes prior to a session end when the server sends a notice through Pulse and notifies the user that the session will end soon.

- **Enable Session Extension**—You can select the Enable Session Extension check box to allow Pulse users to continue a session beyond the maximum session length. If this feature is enabled, users can extend a session through the Pulse client user interface.

- **Roaming session**—Roaming allows user sessions to work across source IP addresses. Roaming session options include the following:
  - **Enabled**—Select this option to enable roaming for users mapped to this role. A roaming user session works across source IP addresses, which allows mobile users with dynamic IP addresses to sign in to Pulse Secure Access Service from one location and continue working from other locations.
  - **Limit to subnet**—Select this option to limit the roaming session to the local subnet specified in the Netmask box. Users can sign in from one IP address and continue using their sessions with another IP address as long as the new IP address is within the same subnet.
  - **Disabled**—Select this option to disable roaming user sessions for users mapped to this role. Users who sign in from one IP address cannot continue an active Infranet Controller session from another IP address; user sessions are tied to the initial source IP address.

General > UI Options

The UI options allow you to define options that a user sees after a successful login to the Pulse Access Control server by means of a browser or the Pulse client. Be sure that you have already defined the authentication settings for this role.

5. Select the Agent tab. The agent is the client program for a user assigned to this role. When a user connects to the system using a Web browser, the user can click a button to download and install the selected agent if it is not already installed on the user’s endpoint. Configure the following options.

   - **Select Install Agent for this role.**
     
     Agent options appear only after you select this check box.

   - **Select Install Junos Pulse.**

6. In the **Session scripts** area, optionally specify a location for the following:
• **Windows: Session start script**—Specify a script (.bat, .cmd, or .exe) to run for users assigned to the role after Pulse connects with Pulse Access Control Service. For example, you can specify a script that maps network drives on an endpoint to shares on protected resources. The script must be in a location (either local or on the network) that is accessible by the user.

• **Windows: Session end script**—Specify a script (.bat, .cmd, or .exe) to run for users assigned to the role after Junos Pulse disconnects from Pulse Access Control Service. For example, you can specify a script that disconnects mapped network drives. If there is no start script defined, or the start script has not been run, the end script does not run. The script must be in a location (either local or on the network) that is accessible by the user.

7. Click **Save Changes**, and then select Agent > Junos Pulse Settings.

8. Select a component set that you have created, use the Default component set or select **none**. You would select **none** only if you are creating this role to distribute new or updated connections to existing Pulse users.

9. Click **Save Changes**.

10. Select Users > User Realms > Select Realm > Role Mapping > New Rule to configure role mapping rules that map Junos Pulse users to the role you configured.

**Related Documentation**

- Junos Pulse Access Control Service Overview on page 20
- Endpoint Security Monitoring and Management for Pulse Access Control Service on page 55
- Specifying Host Checker Access Restrictions

**Client Connection Set Options for Junos Pulse Access Control Service**

A Junos Pulse client connection set contains network options and allows you to configure specific connection policies for client access to any Pulse server that supports Junos Pulse. Table 5 on page 27 describes connection set options.
Table 5: Configurable Options for Junos Pulse Connection Sets

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow saving logon information</strong></td>
<td>Controls whether the Save Settings check box is available in login dialog boxes in the Pulse client. If you clear this check box, the Pulse client always requires users to provide credentials. If you select this check box, users have the option of saving their credentials.</td>
</tr>
</tbody>
</table>

The Junos Pulse client can retain *learned user settings*. These settings are retained securely on the endpoint, evolving as the user connects through different Pulse servers. The Junos Pulse client can save the following settings:

- Certificate acceptance
- Certificate selection
- Realm
- Username and password
- Proxy username and password
- Secondary username and password
- Role

**NOTE:** If the authentication server is an ACE server or a RADIUS server and authentication is set to Users authenticate using tokens or one-time passwords, Pulse ignores the Allow saving logon information option. If the user sees a username and token prompt and the Save settings check box is disabled. Pulse supports soft token, hard token, and smart card authentication.

When a user opts to save settings, that information is used for each subsequent connection without prompting. If a setting changes (for example, if a user changes a password), the saved setting is invalid and connection attempts fail. In this case, the user must use the client’s Forget Saved Settings feature, which clears all user-saved settings.

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow user connections</strong></td>
<td>Controls whether connections can be added by the user.</td>
</tr>
<tr>
<td><strong>Display splash screen</strong></td>
<td>Clear this check box to hide the Pulse splash screen that normally appears when the Pulse client starts.</td>
</tr>
<tr>
<td><strong>Dynamic certificate trust</strong></td>
<td>Determines whether users can opt to trust unknown certificates. If you select this check box, a user can ignore warnings about invalid certificates and connect to the target Pulse server.</td>
</tr>
<tr>
<td><strong>Dynamic connections</strong></td>
<td>Allows connections within this connection set to be automatically updated or added to a Junos Pulse client when the user connects to the Pulse server through the user Web portal. Dynamic connections are created as manual rather than automatic connections, which means that they are run only when the user initiates the connection or the user browses to a Pulse server and launches Pulse from the server’s Web interface.</td>
</tr>
</tbody>
</table>
Table 5: Configurable Options for Junos Pulse Connection Sets (continued)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FIPS mode enabled</strong></td>
<td>Enable FIPS mode communications for all Pulse connections in the connection set. The Federal Information Processing Standard (FIPS) defines secure communications for the U.S. government. When a Pulse connection is operating in FIPS mode, FIPS On appears in the lower corner of the Pulse client interface.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>Application acceleration is not available for a connection that is operating in FIPS mode.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>Users cannot enable FIPS mode for connections that are created on the client. You must deploy connections with FIPS mode enabled using a pre-configured connection set with FIPS mode enabled or have users establish a browser session to the FIPS enabled Pulse server.</td>
</tr>
<tr>
<td><strong>Wireless suppression</strong></td>
<td>Disables wireless access when a wired connection is available. If the wired connection is removed, Pulse enables the wireless connections with the following properties:</td>
</tr>
<tr>
<td></td>
<td>• Connect even if the network is not broadcasting.</td>
</tr>
<tr>
<td></td>
<td>• Authenticate as computer when computer information is available.</td>
</tr>
<tr>
<td></td>
<td>• Connect when this network is in range.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>Wireless suppression occurs only when the wired connection is connected and authorized. If you enable wireless suppression, be sure to also configure a connection that enables the client to connect through a wired connection.</td>
</tr>
</tbody>
</table>

When you create a connection for a connection set, you choose a connection type. The following options are available for each connection type.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Adapter type</strong></td>
<td>Specifies the type of adapter to use for authentication: wired or wireless.</td>
</tr>
<tr>
<td><strong>Outer username</strong></td>
<td>Enables a user to appear to log in anonymously while passing the actual login name (called the inner identity) through an encrypted tunnel. As a result, the user's credentials are secure from eavesdropping, and the user's inner identity is protected. In general, enter anonymous, which is the default value. In some cases, you might need to add additional text. For example, if the outer identity is used to route the user's authentication to the proper server, you might be required to use a format such as <a href="mailto:anonymous@acme.com">anonymous@acme.com</a>.</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>If you leave the box blank, the client passes the user's or the machine's Windows login name as the outer identity.</td>
</tr>
<tr>
<td><strong>Scan list</strong></td>
<td>Specify the wireless network SSIDs that the user can connect to in priority order.</td>
</tr>
<tr>
<td><strong>Support Non-broadcast SSID</strong></td>
<td>Allow a user to connect to a non-broadcast wireless network from within the Pulse interface.</td>
</tr>
</tbody>
</table>
### Table 5: Configurable Options for Junos Pulse Connection Sets (continued)

<table>
<thead>
<tr>
<th>Trusted Server List (for UAC 802.1x Connection)</th>
<th>Server certificate DN—Specify the server certificate distinguished name (DN) and its signing certificate authority (CA). An empty DN field allows a client to accept any server certificate signed by the selected CA.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSL VPN or UAC (L3) options</td>
<td>Allow user to override connection policy—Allows a user to override the connection policy by manually connecting or disconnecting. Typically, you leave this option selected to make sure that a user can establish a connection under all conditions. If you disable this check box, the user cannot change the endpoint’s connection status, suspend/resume a connection to Pulse Secure Access Service or shut down Junos Pulse.</td>
</tr>
<tr>
<td>Support Remote Access (SSL VPN) or LAN Access (UAC) on this connection—This option must be selected if this connection is for Pulse Access Control Service. If the connection is for Pulse Secure Access Service, you can disable this check box and use the connection for accessing Pulse Collaboration meetings only by also selecting Support Remote Access (SSL VPN) or LAN Access (UAC) on this connection.</td>
<td></td>
</tr>
<tr>
<td>Enable Junos Pulse Collaboration integration on this connection—This option must be disabled if this connection is for Pulse Access Control Service. If the connection is for Pulse Secure Access Service, you can enable this check box and use the connection for accessing Pulse Collaboration meetings.</td>
<td></td>
</tr>
<tr>
<td>This server—Specifies whether the endpoint connects to this Pulse server.</td>
<td></td>
</tr>
<tr>
<td>URL—Allows you to specify a URL for a different Pulse server as the default connection. Specify a different server’s URL to create connections for other Pulse servers in your network.</td>
<td></td>
</tr>
<tr>
<td>SRX options (for Dynamic VPN)</td>
<td>Address—Specifies the IP address of the SRX Series device.</td>
</tr>
<tr>
<td>Allow user to override connection policy—Allows users to override the connection policy by manually connecting or disconnecting. Typically, you leave this option selected to make sure that a user can establish a connection under all conditions. If you disable this check box, the user cannot change the endpoint’s connection status or shut down Junos Pulse.</td>
<td></td>
</tr>
<tr>
<td>App Acceleration options</td>
<td>Allow user to override connection policy—Allows a user to override the connection policy by manually connecting or disconnecting. Typically, you leave this option selected to make sure that a user can establish a connection under all conditions. If you disable this check box, the user cannot change the endpoint’s connection status or shut down Junos Pulse.</td>
</tr>
<tr>
<td>Community string—The Junos Pulse client and the Junos Pulse Application Acceleration Service can form an adjacency only if they belong to the same community as identified by the community string. When you create an App Acceleration connection, be sure the community string for the connection matches the community string defined in the Pulse Application Acceleration Service.</td>
<td></td>
</tr>
</tbody>
</table>

For all connection types, specify how the connection is established. The options vary according to the type of connection. Automatic connections include machine authentication and credential provider connections. Connections can be established using the following options:
<table>
<thead>
<tr>
<th>Table 5: Configurable Options for Junos Pulse Connection Sets (continued)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Manually by the user</strong>—When the endpoint is started, the Junos Pulse client software is started, but no connection is attempted. The user must use the Junos Pulse client interface to select a connection.</td>
</tr>
<tr>
<td><strong>Automatically after user signs into the desktop</strong>—When the endpoint is started and the user has logged in to the endpoint, the Junos Pulse client software connects automatically. For App Acceleration connections, automatic connection is the default because Pulse forms an adjacency with Pulse Application Acceleration Service automatically if the service is available.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> All connections on an endpoint that are configured to start automatically attempt to connect to their target networks at startup time. To avoid multiple connection attempts, be sure that only one connection is configured to start automatically, or configure location awareness rules.</td>
</tr>
<tr>
<td><strong>Automatically when the machine starts. Machine credentials used for authentication</strong>—Enables machine authentication, which requires that Active Directory is used as the authentication server and that machine credentials are configured in Active Directory.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> When you use machine credentials for authentication and no user credentials, Pulse cannot perform user based tasks. The following tasks can be run only when the user is logged in:</td>
</tr>
<tr>
<td>• Run session scripts</td>
</tr>
<tr>
<td>• Detect or modify proxy settings</td>
</tr>
<tr>
<td>• Run automatic Pulse client upgrade</td>
</tr>
<tr>
<td>• Install or upgrade Pulse components</td>
</tr>
<tr>
<td><strong>Automatically when the machine starts. Connection is authenticated again when the user signs in to the desktop</strong>—Enables machine authentication for the initial connection. After the user connects with user credentials, the machine authentication is dropped. When the user logs out, the machine authentication connection is restored. In one typical use case, the machine credentials provide access to one VLAN and the user credentials provide access to a different VLAN.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> If the machine and user have different roles, each role should map to the same connection set. Otherwise, after the user connects, the existing connection set might be replaced.</td>
</tr>
<tr>
<td><strong>Automatically at user login</strong>—Enables Pulse client interaction with the credential provider software on the endpoint. The user credentials are used to establish the authenticated Pulse connection to the network, login to the endpoint, and login to the domain server.</td>
</tr>
<tr>
<td><strong>NOTE:</strong> This label changed at Pulse Access Control Service R4.3. If you had selected the old label for a Pulse connection, <strong>Automatically during desktop authentication. User is presented with the Junos Pulse credential tile at the logon screen</strong>, it is automatically converted to the new label, <strong>Automatically at user login</strong> when you perform the upgrade from R4.2.</td>
</tr>
</tbody>
</table>
Table 5: Configurable Options for Junos Pulse Connection Sets (continued)

Automatically when the machine starts. Connection is authenticated again at user login—Enables Pulse client interaction with the credential provider software on the endpoint. Machine credentials are used to establish the authenticated Pulse connection to the network. When the user provides user credentials, the connection is authenticated again. In one typical use case, the machine credentials provide access to one VLAN, and the user credentials provide access to a different VLAN.

For SSL VPN or UAC (L3) and SRX connections that are set to have the connection established automatically, you can define location awareness rules that enable an endpoint to connect conditionally. For example, the endpoint connects to Pulse Access Control Service if it is connected to the company intranet, or it connects to Junos Pulse Secure Access Service if it is in a remote location.

**NOTE:** Split tunneling must be enabled to allow resolution of location awareness rules.

A Pulse connection uses the IP address of a specified interface on the endpoint to determine its network location. Each location awareness rule includes the following settings:

- **Name**—A descriptive name, for example, “corporate-DNS.” A name can include letters, numbers, hyphens, and underscores.

- **Action**—The method the connection uses to discover the IP address. Choose one of the following values:
  - **DNS Server**—Allows the endpoint to connect if the endpoint’s DNS server on the specified interface is set to one of the specified values. Use the Condition box to specify IP addresses or address ranges.
  - **Resolve Address**—Allows the endpoint to connect if the hostname specified in the DNS Name box can be resolved by the DNS server for the specified interface. If one or more address ranges are specified in the Address Range box, the address must resolve to one of the ranges to satisfy the expression.
  - **Endpoint Address**—Allows the endpoint to connect if the IP address of the specified interface is within a range specified in the IP Address Range box.

**NOTE:** To create a negative location awareness rule, you first create the positive state and then use rule requirement logic to use the rule as a negative condition.
Machine Connection Preferences

The Machine Connection Preferences appear if you have selected one of the machine authentication options for how the connection is established. Normally Pulse presents a selection dialog box if more than one realm or role is available to the user. However, a connection that is established through machine authentication fails if a dialog box is presented during the connection process. To suppress the selection dialogs, either ensure that only one role and realm is available to users, or specify a preferred realm and role for this connection.

- **Preferred Machine Realm**—Specify the realm that this connection uses when establishing the machine connection. The connection ignores any other realm available for the specified login credentials.
- **Preferred Machine Role Set**—Specify the role or the name of rule for the role set that this connection uses when establishing the machine connection. The role or rule name used must be a member of the preferred machine realm.

User Connection Preferences

The User Connection Preferences options enable you to specify a realm and role for automatic connections that would otherwise present a selection dialog box to the user. To suppress the selection dialogs, either ensure that only one role and realm is available to users, or specify a preferred realm and role for this connection.

- **Preferred User Realm**—Specify the realm for this connection that is used when a user logs onto the endpoint. The connection ignores any other realm available for the user's login credentials.
- **Preferred User Role Set**—Specify the preferred role or the name of the rule for the role set to be used for user authentication. The role or rule name used must be a member of the preferred user realm.
- **Select client certificate from machine certificate store**—Enables you to specify the location of the client certificate on a Windows endpoint as part of a Pulse connection that verifies the identity of both the machine and the user before establishing a connection. When this check box is selected, the Pulse connection looks at client certificates located in the Local Computer personal certificate store. When this check box is not selected, the connection accesses the user certificate store on a Windows endpoint. For more information, see "Machine and User Authentication Through a Pulse Connection for Pulse Access Control Service" on page 49.

Related Documentation

- Machine Authentication for Pulse Access Control Service Overview on page 38
- Configuring Location Awareness Rules for Junos Pulse on page 50
- Machine and User Authentication Through a Pulse Connection for Pulse Access Control Service on page 49
- Remote Desktop Protocol Compatibility with Junos Pulse 802.1X Machine Authentication Connection on page 44
Creating a Client Connection Set for Junos Pulse Access Control Service

A Junos Pulse client connection (also called a client configuration) set contains network options and allows you to configure specific connection policies for client access to any Pulse server that supports Junos Pulse.

To create a Junos Pulse client configuration:

1. From the admin console, select Users > Junos Pulse > Connections.
2. Click New.
3. Enter a name and, optionally, a description for this connection set.

   ![NOTE: You must enter a connection set name before you can create connections.]

4. Click Save Changes.
5. From the main Junos Pulse Connections page, select the connection set.
6. Under Options, select or clear the following check boxes:
   - **Allow saving logon information**—Controls whether the Save Settings check box is available in login credential dialog boxes in the Junos Pulse client. If you clear this check box, the Junos Pulse client always requires users to provide credentials. If you select this check box, users have the option of saving their credentials.
   - **Allow user connections**—Controls whether connections can be added by the user through the Pulse client interface.
   - **Display splash screen**—Clear this check box to hide the Pulse splash screen that normally appears when the Pulse client starts.
   - **Dynamic certificate trust**—Determines whether users can opt to trust unknown certificates. If you select this check box, a user can ignore warnings about invalid certificates and connect to the target Pulse server.
   - **Dynamic connections**—Allows new connections to be added automatically to a Junos Pulse client when it encounters new Pulse servers through the Web browser.
   - **FIPS mode enabled**—Enable FIPS mode communications for all Pulse connections in the connection set. The Federal Information Processing Standard (FIPS) defines secure communications for the U.S. government. When a Pulse connection is operating in FIPS mode, **FIPS On** appears in the lower corner of the Pulse client interface.

   ![NOTE: Application acceleration is not available for a connection that is operating in FIPS mode.]

---

Copyright © 2013, Juniper Networks, Inc.
NOTE: Users cannot enable FIPS mode for connections that are created on the client. You must deploy connections with FIPS mode enabled using a pre-configured connection set with FIPS mode enabled or have users establish a browser session to the FIPS enabled Pulse server.

- **Wireless suppression**—Disables wireless access when a wired connection is available. Wireless suppression occurs only when the wired connection is connected and authorized.

7. Under Connections, click **New** to define a new connection.
8. Enter a name and, optionally, a description for this connection.
9. Select a type for the connection. Type can be any of the following:
   - UAC 802.1X
   - SSL VPN or UAC (L3)
   - SRX
   - App Acceleration
10. If you select **UAC 802.1X** from the type list, enter a value or select or clear the following check boxes:
    - **Adapter type**—Select Wired or Wireless.
    - **Outer username**—Enter the outer username.
    - **Scan list**—Enter the SSIDs to connect to in your order of priority.
    - **Support Non-broadcast SSID**—Allow users to connect to a non-broadcast wireless network from within the Pulse interface.
11. Click **Save Changes**.
12. If you selected **SSL VPN or UAC (L3)** for the type, select or clear the following check boxes:
    - **Allow user to override connection policy**

NOTE: If you disable this check box, the user cannot change the endpoint’s connection status or shut down Junos Pulse.

- **Enable Junos Pulse Collaboration integration on this connection**
- **Support Remote Access (SSL VPN) or LAN Access (UAC) on this connection**
- **This Server**—This connection uses the URL of the server where you are creating the connection.
• **URL**—If you did not enable **This Server**, specify the URL of the server for the connection.

• **Client Certificate Location: Client**—Enables you to specify the certificate store that the Pulse client accesses for certificate authentication on Windows endpoints. Typically, you would use the default setting, which retrieves the certificate from the user’s personal certificate store, and then certificate authentication is controlled by the **Connection is established** option. If you disable this option, the Pulse connection uses a machine certificate from the Local Computer Personal certificate store, which enables you to perform machine authentication and user authentication for the Pulse connection. If you disable this option, you must also create a sign-in policy and configure authentications servers to perform the user authentication.

13. If you select **SRX**, enter the IP address of the SRX device in the Address box and specify whether you want the user to be able to override connection policy.

14. If you select **App Acceleration**, select the **Connect Automatically** check box to permit the client to automatically form an adjacency to an Junos Pulse Application Acceleration Service in the network.

   ![NOTE:](note.png) For connections that use application acceleration, if Kaspersky software is installed on the Pulse client endpoint, it must be configured to allow traffic on UDP port 3578.

15. Specify how the connection is established, manually or automatically. These options enable you to configure machine authentication and credential provider authentication.

16. (Optional) You can enable location awareness on automatic connections by creating location awareness rules. Location awareness can force a connection to a particular interface.

   ![NOTE:](note.png) Split tunneling must be enabled to allow resolution of location awareness rules.

17. (Optional) You can set preferred role and realm options for a machine authentication connection.

18. After you have created the client connection set, create a client component set and select this connection set.

---

**Related Documentation**

- Client Connection Set Options for Junos Pulse Access Control Service on page 26
- Endpoint Security Monitoring and Management for Pulse Access Control Service on page 55
- Configuring Location Awareness Rules for Junos Pulse on page 50
- Preferred Realm and Role for Junos Pulse Machine Authentication on page 41
- Remote Desktop Protocol Compatibility with Junos Pulse 802.1X Machine Authentication Connection on page 44
Junos Pulse FIPS Mode Overview for Pulse Access Control Service

The United States Federal Information Processing Standard (FIPS) defines security and interoperability requirements for computer systems that are used by the U.S. government. Junos Pulse for Windows, iOS, and Android support FIPS mode operations when communicating with Junos Pulse Secure Access Service and Junos Pulse for Windows supports FIPS mode operations when communicating with Junos Pulse Access Control Service. When it is operating in FIPS mode, FIPS On appears in the bottom corner of the Pulse for Windows client.

You enable FIPS mode operations for the Pulse Windows client when you configure Pulse connections on the server. You enable FIPS mode operations for a connection set. That connection set can include any or all of the four types of Pulse connections:

- **(UAC (802.1X)**—Pulse client uses FIPS mode cryptography for authentication but it uses default Microsoft cryptography for the WEP/WPA wireless encryption.
- **SSL VPN or UAC (L3)**—FIPS mode cryptography is supported.
- **SRX**—FIPS mode cryptography is not supported.
- **App acceleration**—FIPS mode cryptography is not supported.

NOTE: Application acceleration is not available for a connection that is operating in FIPS mode.

NOTE: Users cannot enable FIPS mode for connections that are created on the client. You must deploy connections with FIPS mode enabled using a pre-configured connection set with FIPS mode enabled or have users establish a browser session to the FIPS enabled Pulse server.

Windows Endpoint Requirements

Pulse supports FIPS mode on Windows Vista and later Windows versions, and on Pulse for iOS and Android for communications with Pulse Secure Access Service. FIPS is not supported by the Pulse client for Apple OS X.

To support client certificate private key operations on Windows, the security policy on the Windows endpoint must have FIPS enabled. To verify that FIPS is enabled, use the Microsoft Management Console (MMC). Make sure that the Group Policy Snap-in is installed, and then open the following item:


Scroll through the Policy list and make sure that the following policy is enabled:

System cryptography: Use FIPS compliant algorithms for encryption, hashing and signing
Configuration Overview

The Pulse client includes all components required for FIPS mode communications. You enable the Pulse server for FIPS mode operations as part of the System SSL Options (System > Configuration > Security > SSL Options). To enable FIPS mode communications for Pulse for Windows clients, deploy one or more Pulse connections to the client that are FIPS enabled. Figure 4 on page 37 shows the check box in the Pulse connection set configuration screen that enables FIPS mode operations for all connections in the connection set.

Figure 4: Enabling FIPS Mode for Pulse Connections

NOTE: If the Pulse server hardware does not support FIPS mode operations, FIPS mode configuration options are not present in the admin console interface.

Related Documentation
- Understanding Juniper Networks FIPS Level 1 Support
- Enabling FIPS Level 1 Support
- Creating a Client Connection Set for Junos Pulse Access Control Service on page 33
- FIPS Supported Platforms
Securing the Connection State on the Junos Pulse Client

To disable user interaction with Pulse connections on the endpoint, you can configure Junos Pulse connections so that when they are deployed to the endpoint, users cannot shut down a connection, suspend or resume a connection to Pulse Secure Access Service, or shut down Pulse. Disabling user interaction with Pulse enables the Pulse administrator to control how endpoints connect to the network without allowing the user to override administrative control. For example, if you use machine authentication, the connection from endpoint to server is established automatically. By locking down the Pulse endpoint, users cannot change their connection.

To secure the Pulse endpoint from the Pulse Access Control server:

1. Click Users > Junos Pulse Connections.
2. Edit or create a new connection.
3. Disable the check box labeled Allow user to override connection policy.

Related Documentation
- Client Connection Set Options for Junos Pulse Access Control Service on page 26
- Endpoint Security Monitoring and Management for Pulse Access Control Service on page 55
- Machine Authentication for Pulse Access Control Service Overview on page 38

Machine Authentication for Pulse Access Control Service Overview

Machine authentication uses machine credentials (machine name and password or machine certificate) to authenticate the endpoint. You can enable machine authentication for Pulse Access Control Service as part of a Junos Pulse connection and distribute the connection to endpoints through the normal Pulse distribution methods. You enable Pulse machine authentication support on a Pulse connection, either Layer 2 or Layer 3.

The following describes the requirements for a machine authentication environment:

- The authentication server used by the Pulse connection must be Active Directory/Windows NT for machine name/password authentication or a certificate server for machine certificate authentication.
- The endpoint must be a member of a Windows domain, and the machine credentials must be defined in Active Directory.
- The Pulse connection must be configured so that no prompts are presented during the login process. For example, prompts for realm or role selection or for a server certificate trust prompt cause the connection to fail. You can specify a preferred role and realm for the connection, which eliminates realm and role selection dialogs.
- For machine certificate authentication, the domain workstation login certificate must be issued by the domain certificate authority. The root certificate must be in the Machine Trusted Certificate store instead of the certificate store for a particular user.
Pulse supports the following machine authentication types:

- **machine-only**—The connection is established using machine credentials when no user is logged in. The connection is maintained after user login.

- **user-after-desktop**—The connection is established using machine credentials when no user is logged in. After user login, the machine connection is disconnected. Once the user logs out, the user connection is disconnected and the machine connection is reestablished.

**Related Documentation**

- Preferred Realm and Role for Junos Pulse Machine Authentication on page 41
- Configuring Machine-Only Machine Authentication for a Junos Pulse Connection on page 39
- Configuring User-After-Desktop Machine Authentication for a Junos Pulse Connection on page 40
- Machine and User Authentication Through a Pulse Connection for Pulse Access Control Service on page 49
- Remote Desktop Protocol Compatibility with Junos Pulse 802.1X Machine Authentication Connection on page 44

### Configuring Machine-Only Machine Authentication for a Junos Pulse Connection

When a Pulse connection is configured for machine-only machine authentication, the Pulse connection is established using machine credentials when no user is logged in. The connection is maintained after user login.

To enable a Pulse connection for machine-only machine authentication:

1. Click **Users > Junos Pulse > Connections** and create or select a connection set.
2. Create or edit a connection. For the connection type, you can select either UAC (802.1X) for a Layer 2 connection or SSL VPN or UAC (L3) for a Layer 3 connection.
3. Under **Connection is established**, select *Automatically when the machine starts. Machine credentials used for authentication*.

   Machine credentials are used to connect to the Pulse Access Control Service when the endpoint is started, before a user logs in. The connection is maintained when a users logs in, logs out, or switches to a different login.
NOTE: When you use machine credentials for authentication and no user credentials, Pulse cannot perform user based tasks. The following tasks can be run only when the user is logged in:

- Run session scripts
- Detect or modify proxy settings
- Run automatic Pulse client upgrade
- Install or upgrade Pulse components

4. For a Layer 2 connection that uses machine certificate authentication, make sure that the connection has an entry in the Trusted Server List. To allow any server certificate, type ANY as the Server certificate DN. To allow only one server certificate, specify the server certificate’s full DN, for example, C=US; ST=NH; L=Kingston; O=My Company; OU=Engineering; CN=c4k1.stnh.mycompany.net; E=ausername@mycompany.com.

5. Specify **Realm and Role Preferences** to suppress realm or role selection dialogs during the login process:

   - **Preferred Machine Realm**—Specify the realm for this connection. The connection ignores any other realm available for the specific login credentials
   - **Preferred Machine Role Set**—Specify the preferred role or the name of the rule for the role set to be used for user authentication. The role or rule name must be a member of the preferred machine realm.

**Related Documentation**

- Machine Authentication for Pulse Access Control Service Overview on page 38
- Credential Provider Authentication for Pulse Access Control Service Overview on page 44
- Remote Desktop Protocol Compatibility with Junos Pulse 802.1X Machine Authentication Connection on page 44

**Configuring User-After-Desktop Machine Authentication for a Junos Pulse Connection**

When a Pulse connection is configured for user-after-desktop machine authentication, the connection is established using machine credentials when no user is logged in. After user login, the machine connection is disconnected. Once the user logs out, user connection is disconnected and machine connection is reestablished.

To enable a Pulse connection for user-after-desktop machine authentication:

1. Click **Users > Junos Pulse > Connections**, and then create or select a connection set.
2. Create or edit a connection. For the connection type, you can select either UAC (802.1X) for a Layer 2 connection or SSL VPN or UAC (L3) for a Layer 3 connection.
3. Under Connection is established, select **Automatically when the machine starts**. Connection is authenticated again when the user signs in to the desktop.
Machine credentials are used to connect to the Pulse Access Control Service when the endpoint is started, before a user logs in. When a user logs in, the machine authentication connection is dropped, and the user login is used instead. When the user logs out, the machine connection is reestablished.

4. For a Layer 2 connection that uses machine certificate authentication, make sure that the connection has an entry in the Trusted Server List. To allow any server certificate, type ANY as the Server certificate DN. To allow only one server certificate, specify the server certificate’s full DN, for example, C=US; ST=NH; L=Kingston; O=My Company; OU=Engineering; CN=c4k1.stnh.mycompany.net; E=ausername@mycompany.com.

5. Specify Realm and Role Preferences to suppress realm or role selection dialogs during the login process for both machine and user logins:

   - **Preferred Machine Realm**—Specify the realm that this connection uses when establishing the machine connection. The connection ignores any other realm available for the specific login credentials.
   - **Preferred Machine Role Set**—Specify the role or the name of a rule for the role set that this connection uses when establishing the machine connection. The role or rule name used must be a member of the preferred machine realm.
   - **Preferred User Realm**—Specify the realm that for this connection that is used when a user logs onto the endpoint. The connection ignores any other realm available for the user’s login credentials.
   - **Preferred User Role Set**—Specify the preferred role or the name of rule for the role set to be used for user authentication. The role or rule name used must be a member of the preferred user realm.

**Preferred Realm and Role for Junos Pulse Machine Authentication**

When a Junos Pulse connection is configured to use machine authentication, any prompts that occur during the login process cause the connection to fail. For example, if the Pulse server authentication policy allows a user to select a realm or a role during the login process, Pulse presents a dialog box to the user and prompts for the realm or role selection. To avoid failed connections caused by prompts during machine authentication, you can specify a preferred role and realm for a Pulse connection.

For a Pulse connection that is used for machine authentication, you do not need to specify the preferred role if either of the following conditions are true:

- Users are mapped to only one role.
• Users are mapped to more than one role, but the realm's role mapping properties are set to merge settings for all assigned roles.

For a Pulse connection that is used for machine authentication, you must specify the preferred realm if the authentication sign-in policy allows the user to select a realm. If that realm maps to only one role, you do not need to specify the role.

For a Pulse connection that is used for machine authentication, you must specify the preferred role if either of the following conditions are true:

• The realm that the user connects to maps to more than one role and the realm's role mapping properties are set to require that the user must select a role. The preferred role set must be the name of a role assigned in that realm.

• The realm that the user connects to maps to more than one role, and the realm's role mapping properties are defined by role mapping rules. You specify the preferred role by specifying the name of a rule that assigns the role set. Figure 5 on page 42 shows a role mapping rule with the rule name highlighted.

Figure 5: Junos Pulse Role Mapping Rule

To identify the connection as a machine authentication connection, you specify how the connection is established using one of the following options:

• **Automatically when the machine starts. Machine credentials used for authentication.**

  This option uses the machine credentials defined in Active Directory for the machine login process and uses the same credentials for user login. When you select this option, the Realm and Role Set Preferences settings enable you to specify the following options:

  • **Preferred Machine Realm**—Type the realm name that maps to the role you want to assign.
• Preferred Machine Role Set—Type the name of the role. The role must be one that is identified in the realm’s role mapping properties. Alternatively, you can specify the name of a role mapping rule that assigns the role set.

NOTE: When you use machine credentials for authentication and no user credentials, Pulse cannot perform user based tasks. The following tasks can be run only when the user is logged in:

- Run session scripts
- Detect or modify proxy settings
- Run automatic Pulse client upgrade
- Install or upgrade Pulse components

• Automatically when the machine starts. Connection is authenticated again when the user signs in to the desktop.

This option uses the Active Directory machine credentials for the machine login process. When machine login is complete, Pulse drops that connection and then uses the user credentials for user login. When you select this option, the Realm and Role Set Preferences enable you to specify the following options:

- Preferred Machine Realm—Type the realm name that maps to the role you want to assign.
- Preferred Machine Role Set—Type the name of the role. The role must be one that is identified in the realm’s role mapping properties. Alternatively, you can specify the name of a role mapping rule that assigns the role set.
- Preferred User Realm—Type the realm name that maps to the role you want to assign.
- Preferred User Role Set—Type the name of the role. The role must be one that is identified in the realm’s role mapping properties. Alternatively, you can specify the name of a role mapping rule that assigns the role set.

NOTE: Realm and role prompts are not the only prompts that are possible during the login process. If the Pulse connection has the Dynamic Certificate Trust option enabled and there is an issue with the server certificate, Pulse asks the user if it is OK to proceed. That certificate prompt causes a machine connection to fail. Note that the Pulse prompt for upgrading Pulse software is presented after the user connection is established, and it will not affect a machine authentication connection.

Related Documentation
- Machine Authentication for Pulse Access Control Service Overview on page 38
Remote Desktop Protocol Compatibility with Junos Pulse 802.1X Machine Authentication Connection

If you want to use Remote Desktop Protocol (RDP) to access an endpoint over a Pulse 802.1X connection, machine authentication is required. Because of a Microsoft OS limitation, an RDP connection attempt over a user-only 802.1X authenticated connection will fail. To support RDP connectivity over an authenticated 802.1X connection, you must have a machine-only connection or a machine-then-user connection. In the case of a machine-then-user connection, when you use RDP to connect to a machine over an 802.1X connection that is connected as user, the connection transitions the 802.1X connection to a machine connection. If you subsequently login to the machine directly, it transitions back to a user connection.

To access the endpoint using RDP, you must define that the connection is established using one of the following Pulse connection options:

• Automatically when the machine starts. Machine credentials used for authentication.
• Automatically when the machine starts. Connection is authenticated again when the user signs in to the desktop.

Related Documentation

• Machine Authentication for Pulse Access Control Service Overview on page 38

Credential Provider Authentication for Pulse Access Control Service Overview

When Microsoft introduced Windows Vista, it moved away from a login integration interface based on GINA (Graphical Identification and Authentication) in favor of credential provider authentication. The Junos Pulse credential provider integration enables connectivity to a network that is required for the user to login to the Windows domain. For example, the domain controller might reside behind a firewall and the endpoint uses credential provider login to connect to Pulse Access Control Service prior to domain login. Junos Pulse integrates with Microsoft credential providers to enable password-based login and smart card login. Credential provider login is supported on Windows Vista and later Windows platforms.

You can use the Pulse support for credential provider authentication to provide single sign-on capabilities. Pulse establishes a connection to the network and then uses the same credentials to login the Windows domain.

You enable Pulse credential provider support on a Pulse connection, (connection type 802.1X (UAC) or SSL VPN (L3)). After the connection has been downloaded to the endpoint through the normal Pulse distribution methods, Pulse annotates the credential provider tile that appears on the user login screen by adding a Pulse icon in the lower right corner of the tile. When the user initiates the login process, Pulse establishes the connection.
Pulse supports the following credential provider types:

- **user-at-credprov**—The connection is established before the user login using credentials collected at the selected credential tile, which provides single-sign-on functionality. The connection is maintained as an active connection on the user’s desktop.

- **machine-then-user-at-credprov**—The connection is established using machine credentials when no user is logged in. When a user clicks a login tile and provides user credentials, the machine connection is disconnected and a new connection is established. When the user logs out, the user connection is disconnected and the machine connection is reestablished. In one typical machine-then-user-at-credprov implementation, the machine connection and the user connection are mapped to different VLANs.

Pulse credential provider support usage notes:

- If the endpoint includes more than one Pulse Layer 2 connection, Windows determines which connection to use:
  1. If a network cable is attached to the endpoint, Layer 2 wired connections are attempted, and then wireless connections. If more than one wireless network is available, the order is determined by the scan list specified as a Pulse connection option.
  2. After all Layer 2 options are attempted, Pulse runs location awareness rules to find one or more eligible Layer 3 connections that are configured for credential provider login. If more than one Layer 3 connection is found, Pulse prompts the user to select a connection. A user can cancel the network connection attempt by clicking the cancel button.
  3. After Pulse evaluates all configured connection options, Pulse returns control to Windows, which enables the user login operation.

- For connections that use user credentials, you can configure the Pulse connection so that prompts are presented during the login process, for example, prompts for realm or role selection or a server certificate trust prompt. For connections that use machine credentials, Pulse prompts cause the connection to fail because there is no interface to allow a response to the prompts. You can suppress any potential realm and role choice by specifying a preferred realm and role for the connection.

- Pulse upgrade notifications and actions are disabled during credential provider login and postponed until the user connection is established. Host Checker remediation notifications are displayed.

Related Documentation

- Configuring Location Awareness Rules for Junos Pulse on page 50
Configuring User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection

With a user-at-credprov connection, the Pulse connection establishes the connection before user login using credentials collected at the selected credential tile, which provides single sign-on functionality. The connection is maintained as an active connection on the user’s desktop.

To enable user-at-credprov credential provider support for a Pulse connection:

1. Create a Pulse connection set for the role (Users > Junos Pulse > Connections), and then create a new Pulse connection. You can select either a Layer 3 connection type, SSL VPN or UAC (L3), or a Layer 3 connection type, UAC (802.1X).
2. In the Connection is established section, select one of the following options:
   - **Automatically at user login**—The user credentials are used to establish the authenticated Pulse connection to the network, login to the endpoint, and login to the domain server. The Pulse connection can be configured so that prompts are presented during the login process, for example, prompts for realm or role selection or a server certificate trust prompt.
   
   **NOTE:** This label changed at Pulse Secure Access Service R7.3. If you had selected the old label for a Pulse connection, “Automatically during desktop authentication. User is presented with the Junos Pulse credential tile at the login screen,” it is automatically converted to the new label, “Automatically at user login,” when you perform the upgrade from R7.2.

   - **Automatically when the machine starts. Connection is authenticated again at user login**—Machine credentials are used to establish the authenticated Pulse connection to the network when the endpoint is started. When a user clicks the login tile and provides user credentials, the connection is authenticated again, and the original connection is dropped. When the user logs out, the user connection is ended, and the machine connection is established again. In one typical use case, the machine credentials provide access to one VLAN, and the user credentials provide access to a different VLAN. Be sure that the Pulse connection does not result in Pulse prompts, for example, prompts for realm or role selection or a server certificate trust prompt, because the machine credential login does not present an interface to respond to the prompts.

3. For a Layer 2 connection that uses machine certificate authentication, make sure that the connection has an entry in the Trusted Server List. To allow any server certificate, type **ANY** as the Server certificate DN. To allow only one server certificate, specify the server certificate's full DN for example, C=US; ST=NH; L=Kingston; O=My Company; OU=Engineering; CN=c4k1.stnh.mycompany.net; E=ausername@mycompany.com.
4. Specify **Realm and Role Preferences** to suppress realm or role selection dialogs during the login process:
• **Preferred User Realm**—Specify the realm for this connection. The connection ignores any other realm available for the specific login credentials.

• **Preferred User Role Set**—Specify the preferred role or the name of the rule for the role set to be used for user authentication. The role or rule name must be a member of the preferred user realm.

**Related Documentation**
- Credential Provider Authentication for Pulse Access Control Service Overview on page 44

---

**Configuring Machine-Then-User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection**

With a machine-then-user-at-credprov connection, Pulse establishes the connection using machine credentials when no user is logged in. When a user clicks a login tile and provides user credentials, the machine connection is disconnected, and a new connection is established. When the user logs out, the user connection is disconnected, and the machine connection is reestablished. In one typical machine-then-user-at-credprov implementation, the machine connection and the user connection are mapped to different VLANs.

To enable machine-then-user-at-credprov credential provider support for a Pulse connection:

1. Create a Pulse connection set for the role (Users > Junos Pulse > Connections), and then create a new Pulse connection. You can select either a Layer 3 connection type, SSL VPN or UAC (L3), or a Layer 3 connection type, UAC (802.1X).

2. In the Connection is established section, select one of the following options:

   • **Automatically at user login**—The user credentials are used to establish the authenticated Pulse connection to the network, login to the endpoint, and login to the domain server. The Pulse connection can be configured so that prompts are presented during the login process, for example, prompts for realm or role selection or a server certificate trust prompt.

   

   **NOTE:** This label changed at Pulse Secure Access Service R7.3. If you had selected the old label for a Pulse connection, “Automatically during desktop authentication. User is presented with the Junos Pulse credential tile at the login screen,” it is automatically converted to the new label, “Automatically at user login,” when you perform the upgrade from R7.2.

   • **Automatically when the machine starts. Connection is authenticated again at user login**—Machine credentials are used to establish the authenticated Pulse connection to the network when the endpoint is started. When a user clicks the login tile and provides user credentials, the connection is authenticated again and the original connection is dropped. When the user logs out, the user connection is ended, and the machine connection is established again. In one typical use case, the machine credentials provide access to one VLAN, and the user credentials provide access
to a different VLAN. Be sure that the Pulse connection does not result in Pulse prompts, for example, prompts for realm or role selection or a server certificate trust prompt, because the machine credential login does not present an interface to respond to the prompts.

3. For a Layer 2 connection that uses machine certificate authentication, make sure that the connection has an entry in the Trusted Server List. To allow any server certificate, type ANY as the Server certificate DN. To allow only one server certificate, specify the server certificate’s full DN, for example, C=US; ST=NH; L=Kingston; O=My Company; OU=Engineering; CN=c4k1.stnh.mycompany.net; E=ausername@mycompany.com.

4. Specify Realm and Role Preferences to suppress realm or role selection dialogs during the login process for both machine and user logins:
   - **Preferred Machine Realm**—Specify the realm that this connection uses when establishing the machine connection. The connection ignores any other realm available for the specific login credentials.
   - **Preferred Machine Role Set**—Specify the role or the name of the role set that this connection uses when establishing the machine connection. The role or rule name used must be a member of the preferred machine realm.
   - **Preferred User Realm**—Specify the realm that for this connection that is used when a user logs in to the endpoint. The connection ignores any other realm available for the user’s login credentials.
   - **Preferred User Role Set**—Specify the preferred role or the name of rule for the role set to be used for user authentication. The role or rule name used must be a member of the preferred user realm.

5. Optionally, specify pre-login preferences:
   - **Pre-login maximum delay**—The time period (seconds) that a Windows client waits for an 802.1x connection to succeed during the login attempt. The range is 1 to 120 seconds.
   - **Pre-login user based virtual LAN**—If you are using VLANs for the machine login user logins, you can enable this check box to allow the system to make the VLAN change.

6. Click **Save Changes**, and then distribute the Pulse connection to Pulse client endpoints.

**Related Documentation**
- Credential Provider Authentication for Pulse Access Control Service Overview on page 44
- Machine and User Authentication Through a Pulse Connection for Pulse Access Control Service on page 49
Machine and User Authentication Through a Pulse Connection for Pulse Access Control Service

Junos Pulse supports certificate authentication for establishing Layer 2 and Layer 3 connections. On Windows endpoints, a Pulse client connection accesses client certificates located in the Local Computer personal certificate store to provide machine authentication, or user certificates located in a user's personal certificate store or on a smart card for user authentication. A Pulse connection can access certificates from only one location. For information on machine authentication, see “Machine Authentication for Pulse Access Control Service Overview” on page 38.

You can create a Pulse connection that uses System Local, Active Directory, or RSA ACE server authentication to verify the user and a certificate to verify machine identity before establishing a connection. To do so, you must first enable an option for the Pulse connection that allows the connection to check the client certificates located in the Local Computer personal certificate store. The option, Select client certificate from machine certificate store, is part of the User Connection Preferences of a Pulse connection. User authentication is accomplished through realm authentication. Machine authentication is accomplished as part of a realm certificate restriction, because the Pulse connection uses the machine certificate. If the certificate store holds more than one valid certificate for the connection, Pulse opens a dialog box that prompts the user to select a certificate.

The following list summarizes the steps to configure a Pulse connection on a Windows endpoint that authenticates both the user and the machine. For detailed procedures on how to perform each configuration task, see the related documentation links.

- Install a machine authentication certificate in the Local Computer personal certificate store of the Windows endpoint and configure the Pulse server certificate server.
- Create a Pulse connection for the target Pulse server. The connection type can be UAC (802.1X) or SSL VPN or UAC (L3). The Connection is established option is typically set to Manually by the user or Automatically at user login.
- In the User Connection Preferences section of the connection properties, click the check box labeled Select client certificate from machine certificate store. This option enables the Pulse connection to perform the machine authentication as part of the Pulse connection attempt.
- Create a sign-in policy on the Pulse server that specifies a user realm. The realm authentication server can be a System Local, Active Directory, or RSA ACE server.
- Configure a certificate restriction on the realm to enable the Pulse server to request a client certificate. Be sure to enable the option labeled Only allow users with a client-side certificate signed by Trusted Client CAs to sign in. Because the Pulse connection is configured to use the machine certificate, the user authentication takes place by means of the realm certificate restriction.

Related Documentation
- Using the Certificate Server
- About Sign-in Policies

Copyright © 2013, Juniper Networks, Inc.
Configuring Location Awareness Rules for Junos Pulse

The location awareness feature enables a Junos Pulse client to recognize its location and then make the correct connection when the connection is set to connect automatically. For example, a Pulse client that is started in a remote location automatically connects to Junos Pulse Secure Access Service. But that same client automatically connects to Pulse Access Control Service when it is started in the corporate office.

**NOTE:** Split tunneling must be enabled to allow resolution of location awareness rules.

**NOTE:** Location awareness and session migration are similar because they both simplify connectivity for the user, but they do so under different conditions. With location awareness, the Pulse client makes a decision on where to connect when a user logs in to the computer. Session migration occurs when the user puts the computer into a stand by or hibernate mode without first logging out, and then opens the computer in a different network environment. Location awareness enables the Pulse client to intelligently start a new session. Session migration enables Pulse servers to intelligently migrate an existing session.

Location awareness relies on rules you define for each connection. If the conditions specified in the rules are true, Pulse attempts to make the connection. To set up the location awareness rules that select among many connections, you must define location awareness rules for each connection. Each location awareness rule is based on the endpoint's ability to reach an IP address or resolve a DNS name over a specified network interface.

The following location awareness example includes two connections. The first connection is a Pulse Access Control Service connection that resolves to TRUE when the endpoint is connected to the corporate LAN. The second connection is Junos Pulse Secure Access Service connection that resolves to TRUE when the endpoint is located in a remote location.

**Pulse Access Control Service connection**

If the DNS server that is reachable on the endpoint's physical network interface is one of your organization's internal DNS servers, then establish the connection.

**Pulse Secure Access Service connection**

If the DNS server that is reachable on the endpoint's physical network interface is not one of your organization's internal DNS servers, and the DNS name of your Pulse Secure Access Service device resolves to the external facing IP address of the Pulse Secure Access Service device, then establish the connection.
NOTE: Connections can be set to manual, automatic, or controlled by location awareness rules. When the user logs in, the Pulse client attempts every connection in its connections list that is set to automatic or controlled by location awareness rules.

NOTE: To create a negative location awareness rule, you first create the positive state and then use rule requirement logic to use the rule as a negative condition.

To configure location awareness rules:

1. If you have not already done so, create a connection or open an existing connection.
   You can configure location awareness rules for Firewall connections and IC or SA connections. Location awareness rules do not apply to 802.1X or App Acceleration connections.

2. In the Connection is established area, select According to location awareness rules, and then click New.

3. Specify a name for the rule.

4. In the Action list, select one of the following:

   • DNS server—Connect if the DNS server associated with the endpoint’s network properties is (or is not) set to a certain value or set of values. Specify the DNS server IP address in the IP address box. Also specify a network interface on which the condition must be satisfied:
     - Physical—The condition must be satisfied on the physical interfaces on the endpoint.
     - Junos Pulse—The condition must be satisfied on the virtual interface that Junos Pulse creates when it establishes a connection.
     - Any—Use any interface.

   • Resolve address—Connect if the configured hostname or set of hostnames is (or is not) resolvable by the endpoint to a particular IP address. Specify the hostname in the DNS name box and the IP address or addresses in the IP address box. Also specify a network interface on which the condition must be satisfied.
NOTE: The Pulse client software evaluates IP and DNS policies on network interface changes. DNS lookups occur on DNS configuration changes or when the time-to-live setting (10 minutes) expires for a particular host record. If Pulse cannot resolve the host for any reason, it polls the configured DNS server list every 30 seconds. If the host had been resolved successfully previously and the time-to-live timer has not expired, the polling continues until the timer expires. If the host had not been resolved successfully previously, the resolution attempt fails immediately.

- **Endpoint Address**—Connect if a network adapter on the endpoint has an IP address that falls within or outside of a range or a set of ranges. Specify the IP address or addresses in the IP address box. Also specify a network interface on which the condition must be satisfied.

5. Click **Save Changes**.

After you create the rule or rules, you must enable each rule you want to use for the connection. To enable a negative form of a rule, use a custom version of the rule. To enable location awareness rules:

1. In the list of connection awareness rules for a connection, select the check box next to each rule you want to enable.

2. To specify how to enforce the selected location awareness rules, select one of the following options:
   - **All of the above rules**—The condition is TRUE and the connection is attempted only when all selected location awareness rules are satisfied.
   - **Any of the above rules**—The condition is TRUE and the connection is attempted when any select location awareness rule is satisfied.
   - **Custom**—The condition is TRUE and the connection is attempted only when all selected location awareness rules are satisfied according to the Boolean logic you specify in the Custom box. Use the Boolean condition to specify a negative location rule. For example, connect to Pulse Secure access service when Rule–1 is false and Rule–2 is true. The boolean logic in the custom box would be: **NOT Rule-1 AND Rule-2**. The accepted Boolean operators are AND, OR, NOT, and the use of ( ).

3. Click **Save Changes**.

**Related Documentation**
- Understanding Session Migration on page 149

**Junos Pulse Access Control Service Component Set Options**

A Junos Pulse component set includes specific software components that provide Junos Pulse connectivity and services.
NOTE: Client component options affect Web-based installations only. For a preconfigured installer, specify components as part of the MSIEXEC command. The preconfigured installer for OS X installations always installs all components.

Component set options include the following choices:

- **All components**—Supports all Pulse connection types. The Enhanced Endpoint Security (EES) component, which is available only if you have an EES license, is included only if the user’s assigned role requires it. Use the All components option only when you want client endpoints to be able to connect to all supported Pulse servers and to be able to use application acceleration.

- **No components**—Updates existing Pulse client configurations, for example, to add a new connection. Do not use this setting for a new installation.

- **Minimal components**—Includes only the components needed to support the selected connections. For example, if the connection set you create includes an IC or SA connection, the component set includes only the components required to connect to Pulse Secure Access Service or Pulse Access Control Service. The default is Minimal components, which provides all needed components for the selected connections and limits the size of the Junos Pulse installation file. The Host Checker component is included as part of the minimal components configuration.

NOTE: Do not deploy Pulse with Minimal components and no connections. If you do so, the Pulse client is not able to connect to any devices and users are not able to create any connections from within the Pulse client interface.

NOTE: Client component options affect Web-based installations only. For a preconfigured installer, specify components as part of the MSIEXEC command. The preconfigured installer for OS X installations always installs all components.

**Related Documentation**

- Junos Pulse Client Installation Overview on page 157
- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169
- Creating a Client Component Set for Junos Pulse Access Control Service on page 54
Creating a Client Component Set for Junos Pulse Access Control Service

Client component options affect Web-based installations only. For a preconfigured installer, specify components as part of the MSIEXEC command. The preconfigured installer for OS X installations always installs all components. To create a client component set:

1. From the admin console, select Users > Junos Pulse > Components.
2. Click New to create a new component set.
3. If you have not yet created a client connection set, select Users > Junos Pulse > Connections and create a new connection set. Or you can use the default client configuration, which permits dynamic connections, supports the outer username anonymous, and allows the client to automatically connect to Pulse Access Control Service or Pulse Secure Access Service.
4. Specify a name for the client component set.
5. (Optional) Enter a description for this client component set.
6. Select a connection set that you have created, or use the default connection set.
7. For Junos Pulse client components, select one of the following options:
   - All components—Includes all Junos Pulse components and supports all access methods and all features.
   - No components—Updates existing Pulse client configurations, for example, to add new connections. This option works on endpoints if they already have Pulse installed. Do not use this option if you are installing Pulse.
   - Minimal components—Includes only the components needed to support the selected connections. For example, if the connection set you create includes an IC or SA connection, the component set includes only the components required to connect to Pulse Secure Access Service or Junos Pulse Access Control Service. The Host Checker component is included as part of the minimal components configuration. The default is minimal components, which provides all needed components for the selected connections and limits the size of the Junos Pulse installation file.

   **NOTE:** Do not deploy Pulse with minimal components and no connections. If you do so, the Pulse client is not able to connect to any devices and users are not able to create any connections from within the Pulse client interface.

   **NOTE:** Client component options affect Web-based installations only. For a preconfigured installer, specify components as part of the MSIEXEC command. The preconfigured installer for OS X installations always installs all components.
8. Click **Save Changes**.

9. After you create a component set, distribute the client to users through a role. When users access the role, the installer automatically downloads to the endpoint. The installer components and connections are applied to the endpoint client.

   If client connections associated with the component set for a role are changed even though the list of components has not, the existing configuration on the endpoint is replaced immediately if the endpoint is currently connected, or the next time the endpoint connects.

   If a user is assigned to multiple roles and the roles include different component sets, the first role in an endpoint’s list of roles is the one that determines which client (component set) is deployed.

---

**Related Documentation**

- Junos Pulse Client Installation Overview on page 157
- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169
- Endpoint Security Monitoring and Management for Pulse Access Control Service on page 55

---

**Endpoint Security Monitoring and Management for Pulse Access Control Service**

You can configure Host Checker policies that verify the endpoint’s operating system service pack, software version, or desktop application patch version compliance. Host Checker uses a list of the most current patch versions from the vendor for predefined rules in the Host Checker policy. Host Checker does not scan for non-security patches. Host Checker runs on Windows and Windows Mobile endpoints, Apple OS X and iOS endpoints, and on Google Android endpoints. The supported Host Checker features vary on each platform.

---

**NOTE:** If a realm has a Host Checker policy enabled that is for desktop clients, and a mobile device user employs a browser on the mobile device to connect to the Web portal, the login is denied because the desktop Host Checker program is not compatible with the mobile client OS. If Pulse mobile users are mapped to multiple roles, the login operation assigns them to a role where Host Checker is not enabled if possible. If all the roles have Host Checker enabled, the mobile users will not be allowed to login from the browser. You can create and enable Host Checker policies that are specific to each mobile operating system and then Host Checker runs when the Pulse client connects to the server.

---

The Pulse Access Control Service and Host Checker manage the flow of information between the corresponding pairs of TNC-based integrity measurement collectors (IMCs) and integrity measurement verifiers (IMVs). IMCs are software modules that run on the
host and collect information such as antivirus, antispyware, patch management, firewall, and other configuration and security information about the host. IMVs are software modules that run on Pulse Secure Access Service and verify a particular aspect of a host’s integrity. Each IMV works with the corresponding IMC on the client endpoint to verify that the endpoint meets the Host Checker rules. IMCs scan the endpoint frequently for changes in security status. For example, if the user turns off virus checking, the IMC can detect this and then trigger a new check to make sure the modified system complies with the requirements of the Host Checker policy. You can configure Host Checker to monitor third-party IMCs installed on client computers by using third-party IMVs that are installed on a remote IMV server.

You obtain the most current patch version information from a Juniper staging site. You can manually download and import the list into the Pulse server, or you can automatically import the list from the Juniper staging site or your own staging site at a specified interval.

Monitoring is based on one or more specified products or on specific patches, though not in the same policy. For example, you could check for Internet Explorer Version 7 with one policy, and Patch MS00-039: SSL Certificate Validation Vulnerabilities with a second policy. Then, apply both policies to endpoints at the role or realm level to ensure that the user has the latest browser version with a specific patch. In addition, for Microsoft products, you can specify the severity level of patches that you want to ignore. For example, you could ignore low or moderate threats.

When you deploy Junos Pulse, Host Checker is included with the installer. You can invoke Host Checker at the role level or the realm level to specify access requirements for endpoints seeking authentication. Host Checker policies that are implemented at the realm level occur before the user is authenticated. Host Checker policies at the role level are implemented after authentication but before the user is permitted to access protected resources. When an endpoint first connects to Pulse Secure Access Service, the latest version of the IMC downloaded to the host computer. The initial check takes about 10-20 seconds to run. Outdated IMC files are automatically updated at subsequent checks.

**NOTE:** The first time an endpoint connects to a Pulse Secure Access Service that has a patch assessment policy, if the connection is a Layer 2 connection, the IMC cannot download. In this case, you should configure a remediation role that displays instructions to direct the user to retry with a Layer 3 connection or to contact the administrator.

### Remediation Options

Host Checker can identify issues on an endpoint. However, Host Checker and Pulse Secure Access Service cannot resolve issues, that is, perform remediation tasks, on non-compliant endpoints. To repair those issues Pulse Secure Access Service supports the following remediation options:

- Instructions to the user—The Pulse Secure Access Service can send a message to the user describing the non-compliant patches or software and a link to where the user can obtain the required software. [Figure 6 on page 57](#) shows a typical Pulse remediation message.
Initiate SMS/SCCM remediation—For remediation using Microsoft System Center Configuration Manager (ConfigMgr or SCCM), formerly Systems Management Server (SMS), a preinstalled SMS/SCCM client on the endpoint is triggered by Host Checker to get patches from a preconfigured SMS/SCCM server. This mechanism installs only those patches that are published on the SMS/SCCM server.

Initiate Shavlik remediation—Pulse Access Control Service and UAC Release 4.1 and later supports Shavlik remediation. Shavlik remediation is an optional licensed feature. After running Host Checker, if the endpoint requires remediation, the user can be prompted to install the required patches. You can configure remediation options to be launched automatically. The Shavlik patch deployment engine is downloaded to the endpoint. The engine links to the vendors’ patch repositories and installs the patches. Figure 7 on page 58 shows the Pulse client screens that a user sees when the Pulse server is configured with Host Checker and Shavlik remediation. The prompt that allows the user to decide whether to install the patches is a configuration option.
Figure 7: Pulse Client Screens for Shavlik Patch Remediation

Connect to: PNG-R
Checking compliance...  Cancel

User Name:  loweb
Please enter your passcode:  

Connect to: PNG-R
Limited network access due to compliance issue.
Pulse needs to install some patches to complete the connection.
Note: Choosing Don't Install may result in limited or no connectivity.

Connect to: PNG-R
Limited network access
Update is in progress. You may close this dialog. Once updating is complete you will be logged in to the network.

Patch Installation:
Starting to install 24 patches...

Close
Issuing a Remediation Message with Junos Pulse Access Control Service

If a Host Checker policy finds that an endpoint is not in compliance, Host Checker can display a message through the Pulse interface that includes custom instructions and reason strings on how to bring the endpoint into conformance. The user must perform the steps described in the message before the endpoint is allowed to access protected resources.

To enable a remediation message for a Host Checker policy:

1. In the admin console, select Authentication > Endpoint Security > Host Checker.
2. In the Policies section, click New to create a new Host Checker policy.
   
   For detailed information about Host Checker Rule Settings, see the Junos Pulse Access Control Service Administration Guide.
3. As part of the Host Checker Policy, select Enable Custom Instructions.
   
   When you select this option, a text box appears. Enter the instructions to display to the user on the Host Checker remediation page. You can use the following HTML tags to format text and to add links to resources such as policy servers or web sites: <i>, <b>, <br>, <font>, and <a href>. For example:

   You do not have the latest signature files.

   <a href="www.company.com">Click here to download the latest signature files.</a>

4. Optionally, select Send reason strings. Select this option to display a message to users (called a reason string) that is returned by Host Checker or IMV and that explains why the client machine does not meet the Host Checker policy requirements. Reason strings describe to users what the IMV is checking on the client machine. This option applies to predefined rules, to custom rules, and to third-party IMVs that use extensions in the Juniper Networks TNC SDK.
5. Click Save Changes.

Be sure to include the Host Checker policy in the realm or role you configure for Pulse users.

Related Documentation

- Issuing a Remediation Message with Junos Pulse Access Control Service on page 59
- Using SMS/SCCM Remediation with Junos Pulse Access Control Service on page 60
- Configuring Shavlik Remediation with Pulse Access Control Service on page 61
- Creating Global Host Checker Policies
Using SMS/SCCM Remediation with Junos Pulse Access Control Service

Junos Pulse supports the SMS/SCCM download method for patch deployment. If the Pulse Access Control Service is configured for the SMS/SCCM method for patch deployment, the Pulse client endpoint must have the SMS/SCCM client already installed on the endpoint, otherwise remediation fails.

Endpoints configured with SMS/SCCM for software management typically poll the server for updates every fifteen minutes or longer. In a worst-case scenario, clients that are not in compliance with existing Host Checker software requirements might have to wait until the next update interval to login. Using the SMS/SCCM download method, you can force the client to initiate the software update immediately after the patch assessment check. If a user attempts to log in, and the endpoint does not have a required software version for compliance with a Host Checker patch assessment policy, Host Checker immediately notifies the client to poll the server for an immediate update. The client receives notification that an SMS/SCCM update has started.

To configure SMS/SCCM to update the client when notified, set the advertisement time on the SMS/SCCM to As soon as possible.

You assign clients to a particular group or collection on the SMS/SCCM server and then server can advertise patches for that collection. You can configure roles on the Pulse Access Control Service that correspond to collections and SMS/SCCM can send the appropriate patches for a particular role.

You must have the SMS/SCCM client installed and configured correctly on endpoints, and the SMS/SCCM server must be reachable. In a Layer 2 network, Host Checker is performed before the endpoint is connected to the network. Host Checker can obtain the IP address of the SMS/SCCM server configured for the client. If the endpoint is out of compliance and remediation is necessary, Host Checker pings the server IP address every 15 seconds until the server can be notified to update the client.

You should inform users of the expected behavior if this feature is enabled, as there is no notification to the user until the SMS/SCCM sends back the advertisement.

NOTE: Juniper Networks recommends only one patch deployment on an endpoint at any point in time. However, there is no way to determine if an SMS/SCCM update is in progress, and so it might be possible that the patch deployment engine is started while an SMS/SCCM Update is also occurring. (This scenario is possible if Pulse is connected to two devices with one using SMS/SCCM remediation and the other using the Shavlik patch deployment engine.) Most patches do not allow two instances to be running, so one of the remediation operations will fail.

The admin console allows you to select only one Host Checker patch remediation option (either SMS/SCCM or Shavlik) for all Host Checker policies.
If Pulse is connected to both Pulse Access Control Service and Pulse Secure Access Service, and one uses SMS/SCCM remediation and the other uses Shavlik remediation, both requests are met. If both servers are configured to use Shavlik remediation, the requests are queued.

To enable SMS/SCCM assessment and remediation:

1. In the admin console, select Authentication > Endpoint Security > Host Checker.
2. In the Policies section, click New to create a new Host Checker policy.
4. Click Save Changes.

Be sure to include the Host Checker policy in the realm or role you configure for Pulse users.

### Related Documentation
- Endpoint Security Monitoring and Management for Pulse Access Control Service on page 55
- Issuing a Remediation Message with Junos Pulse Access Control Service on page 59
- Configuring Shavlik Remediation with Pulse Access Control Service on page 61
- Creating Global Host Checker Policies

## Configuring Shavlik Remediation with Pulse Access Control Service

Endpoints with Junos Pulse Release 2.0 or higher that are not in compliance with specified Host Checker patch policies can be updated with the required patches and brought into compliance automatically by the Shavlik patch deployment engine. The Host Checker IMC on the endpoint interfaces with the patch deployment engine to download and install missing patches reported by the IMV. Shavlik software runs on endpoints, downloads specified patches from vendors’ Web sites, and installs patches that are required through the Host Checker policy.

### NOTE: A license is required for Shavlik patch monitoring and deployment.

The Shavlik patch deployment engine is an executable file that is hosted on the Pulse server and then downloaded to endpoints as part of the Pulse deployment. During a remediation operation, the deployment engine downloads patches directly vendor Web sites so Internet connectivity is needed for Shavlik remediation. The Shavlik patch deployment engine does not work with Layer 2 without Layer 3 connectivity.

All of the files required for patch assessment are a part of a Endpoint Security Assessment Plug-in (ESAP) from the Juniper Networks Customer Support Center ESAP packages beginning with UAC R4.1. The default ESAP package shipped with UAC R4.1 contains the required patch deployment files. Any older ESAP packages fail to update on these devices.
The IMC and IMV software for patch monitoring is backward compatible. Since this feature is available from Pulse Release 2.0 onward, a new Pulse communicating with an older IMV (with Pulse support), or a new IMV communicating to an older IMC exhibit the same behavior as today. There should be no change in the patch assessment, and the Shavlik deployment engine is not invoked for remediation.

NOTE: Juniper Networks recommends only one patch deployment operation on an endpoint at any point in time. However, there is no way to determine if an SMS/SCCM update is in progress, and so it might be possible that the patch deployment engine is started while an SMS/SCCM Update is also occurring. (This scenario is possible if Pulse is connected to two devices with one using SMS/SCCM remediation and the other using the Shavlik patch deployment engine.) Most patches do not allow two instances to be running, so one of the remediation operations will fail.

The admin console allows you to select only one Host Checker patch remediation option (either SMS/SCCM or Shavlik) for all Host Checker policies.

If Pulse is connected to Junos Pulse Secure Access Service and Pulse Access Control Service, and one uses SMS/SCCM remediation and the other uses Shavlik remediation, both requests are met. If both servers are configured to use Shavlik remediation, the requests are queued.

To enable SMS/SCCM assessment and remediation:

1. In the admin console, select **Authentication > Endpoint Security > Host Checker**.
2. In the **Policies** section, click **New** to create a new Host Checker policy.
3. Under Patch Remediation Options, select **Shavlik Patch Deployment**.
4. To allow users to decide whether to install patch updates, select **Prompt the user for consent before automatic patch deployment**.

   Deploying patches can take some time to complete. Some patches require a system reboot.

5. If you enable the user prompt for installing patches, select a default action. The default action runs automatically if the user does not respond to the prompt within 1 minute. Select one of the following default actions:

   - Deploy patches
   - Do not deploy patches
6. Click **Save Changes**.

- **Related Documentation**
  - Endpoint Security Monitoring and Management for Pulse Access Control Service on page 55
  - Issuing a Remediation Message with Junos Pulse Access Control Service on page 59
  - Using SMS/SCCM Remediation with Junos Pulse Access Control Service on page 60
Enabling Enhanced Endpoint Security for Junos Pulse Access Control Service

Host Checker includes integrated antispyware functionality that can detect and update Windows endpoints. Enhanced Endpoint Security (EES) ensures that malware, spyware, viruses, or worms are not present on endpoints that attempt to connect to Pulse Access Control Service, and that you can restrict or quarantine these endpoints according to your Host Checker policy configuration. When EES is running on an endpoint, the Pulse interface displays a security pane that shows EES status.

NOTE: By default, the base license allows two simultaneous endpoints to use this feature. You can purchase a separate license to enable additional users.

EES scans processes on endpoints, monitors file system write and execution operations, and can automatically update machines that are not in compliance. EES reports threats that are detected but not remediated. In some cases the user might be directed to reboot the machine to achieve compliance.

EES uses a signature database that is automatically downloaded to endpoints from Web Root Spy Sweeper servers on the Internet. The signature database is not hosted on Pulse Access Control Service. Endpoints must have access to the Internet for EES to run successfully. Additionally, if you configure default remediation roles, ensure that endpoints that are directed to remediation roles that can access *.webroot.com.

You can configure Pulse Access Control Service to determine the acceptable age of the signature database. The age of the database is the threshold used to determine whether a user can access resources by passing a Host Checker policy. For example, if signatures are 5 days old, and you configure the age as 3 days, the endpoint is allowed to access resources. If you configure the age as 4 days, the endpoint fails the Host Checker policy. Signature updates are performed regularly so endpoints should generally have the most current updates.

If Internet connectivity is not available to an endpoint before it connects to Pulse Access Control Service, and you have chosen to implement the option to check for signature age, the policy does not pass if the signatures are too old. For example, if a user has not accessed the endpoint for several days and the signatures are not up to date, the endpoint cannot access Pulse Access Control Service. To avoid this issue, you should create a default remediation role that allows limited access to the Internet for signature updates at *.webroot.com.

Any endpoint that is configured for an EES scan at Layer 2 always fails the check. To permit a network connection, you should configure the realm to reassign users to a remediation VLAN. This allows endpoint users to connect and download the required signature updates, or if connecting for the first time, the EES installer package.
You configure EES on the Endpoint Security > Host Checker main page to ensure that multiple policies are not created, and that the same policy is used across all realms and roles for which you have enabled it. When you create a realm or a role, you can enable EES restrictions in addition to any other Host Checker policies.

**NOTE:** If you configure an EES policy for endpoints, a separate EES installer (about 5 MB) is downloaded to endpoints on their first attempt to access resources protected by a Host Checker EES policy. User endpoints are scanned for offending software, and signatures are automatically installed.

A significant amount of data is downloaded (approximately 5 MB for the installer and approximately 12 MB for the signatures), followed by the memory scan. After installation, signatures are updated and the memory scan is performed to verify that no spyware is loaded in memory. The download, update, and scan can take significant time to complete.

Any threat detected is automatically remediated by Host Checker and is not reported. If threats cannot be remediated, the endpoint reports back to the server. Roles and user sessions can be adjusted based on endpoint compliance. A number of user strings automatically notify the user of the compliance status.

To enable and use EES antispyware:

1. In the admin console, click **Authentication > Endpoint Security > Host Checker**.
2. Under Options, select the **Advanced Endpoint Protection: Malware Protection** tab.
3. Select the **Enable Advanced Endpoint Protection: Malware Protection** check box.
4. To set the age of the signature definitions database, select the **Signature definitions should not be older than** check box. Enter the frequency in days (3 - 30). This number determines the maximum permissible age of signatures. It does not change the frequency of updates.
5. To enable an immediate EES scan in the background after allowing the network connection, select the **Install EES and scan endpoints after network connection is established** check box.

Choose this option to allow an immediate connection before the scan takes place. This option allows users to connect and to begin work more quickly. However, this option is less secure because it allows network access before the endpoint has been scanned for malware.

6. Click **Save Changes**.

When you create or configure realm or role Host Checker restrictions, you can select **Enhanced Endpoint Security: Malware Protection** to apply to that role or realm.

**Related Documentation**
- Endpoint Security Monitoring and Management for Pulse Access Control Service on page 55
- Issuing a Remediation Message with Junos Pulse Access Control Service on page 59
- Using SMS/SCCM Remediation with Junos Pulse Access Control Service on page 60
Pushing Junos Pulse Configurations Between Junos Pulse Servers of the Same Type

You can use the Push Configuration feature to centrally manage Junos Pulse connections, components, and uploaded Pulse packages. The Push Configuration feature enables you to copy all configuration settings or selected configuration settings from one Pulse server to another Pulse server of the same type, for example, from one SA Series SSL VPN Appliance to another SA Series SSL VPN Appliance to another.

The following notes apply to pushing configurations:

• You can push to a single Pulse server or to multiple Pulse servers in one operation. You can push up to 8 targets per push operation. You can run up to 25 push operations simultaneously. The maximum number of targets is 200. If a push to a target Pulse server fails, the operation proceeds to the next target until all identified targets are updated. The results page displays the status and any problems encountered during the process.

• You can push to a Pulse server that is a member of a cluster as long as the target Pulse server is not a member of the same cluster as the source.

• Target Pulse servers can refuse pushed configuration settings. The default is to accept.

• After an update, the target Pulse server restarts its services. Brief interruptions might occur while the service restarts. We recommend that you push to targets when they are idle or when you can accommodate brief interruptions.

• Target Pulse servers do not display a warning message when they receive a pushed configuration.

• The target Pulse server automatically logs out administrators during the push process.

• The source and target Pulse servers must have the same build version and number.

• The administrator account on the source Pulse server must sign in to the target Pulse server without any human intervention. For example, you cannot have dynamic credentials or multiple roles that are not merged as these both require manual interaction.

Before you use Push Configuration, you must configure your system according to the following conditions:

• You must map to the .Administrators role, thereby creating a “super administrator” with full administration privileges. Modify Authentication > Auth Servers > Administrator Server > Users settings to add yourself to the .Administrators role.

• The target Pulse server administrator account must use static password authentication or two-factor tokens that do not use challenge/response type authentication. For example, certificates, Soft ID, and Defender Authentication are not supported. Modify Administrators > Admin Realms > [Administrator Realm] > General settings to select the proper authentication server for the administrator realm.
Do not configure the administrator account in a way that requires the administrator to select a role to sign in to the target Pulse server. For example, do not map a single user to multiple roles, including the Push Configuration administrator role, and then fail to merge those roles. We recommend creating an account exclusively for Push Configuration administrators to guarantee that the administrator does not need to choose a role during the sign-in process and to clearly distinguish the actions of Push Configuration administrators in your log files. Use the Administrators > Admin Realms > [Administrator Realm] > Role Mapping settings to set the appropriate role-mapping rules.

To push Junos Pulse configurations from one Pulse server to other Pulse servers of the same type:

1. If you have not already done so, define the targets by selecting Maintenance > Push Config > Targets.
2. From the admin console, select Maintenance > Push Config > Push Configuration.
3. In the What to push box, select Selected configuration to display the configuration categories.
4. Scroll down the list and expand the item labeled Junos Pulse.
5. Select the Select All Configurations check box to push all Junos Pulse configurations on this Pulse server. Or chose none, all, or selected items from the following categories:
   - Junos Pulse Connections—Connection sets and connections.
   - Junos Pulse Components—Component sets.
   - Junos Pulse Versions—Pulse packages that were uploaded to the Pulse server.
6. Add the targets to the Selected Targets box.
7. Click Push Configuration.

Related Documentation

Enabling or Disabling Automatic Upgrades of the Junos Pulse Client

After you deploy Junos Pulse client software to endpoints, software updates occur automatically. If you upgrade the Pulse client configuration on your Pulse server, updated software components are pushed to a client the next time it connects.

NOTE: When you configure Junos Pulse to make 802.1x based connections, a reboot might be required on Windows XP endpoints when Pulse is upgraded.
NOTE: A bound endpoint receives connection set options and connections from its binding server, but it can have its Pulse client software updated from any Pulse server that has the automatic upgrade option enabled. During a client software upgrade the client loses connectivity temporarily.

Pulse client software upgrades are enabled by default. To change the behavior of Pulse client upgrades:

1. From the admin console, select Maintenance > System > Options.
2. Set or clear the Enable automatic upgrade of Junos Pulse Clients check box.
3. Click Save Changes.

Related Documentation
- Upgrading Junos Pulse Client Software on page 67

Upgrading Junos Pulse Client Software

The software image for each supported Pulse server includes a Junos Pulse client software package. When a newer version of Pulse is available, you can upload the new software to the Pulse server. You can have more than one version of Pulse on a Pulse server but only one Pulse client package can be active. If you activate a new version of Pulse, and if the Pulse server’s automatic upgrade option is enabled, connected Pulse clients display an upgrade prompt to the user. The user can choose to install the upgrade or cancel the operation. If a user cancels, the upgrade prompt appears each time the client connects to the server. During a client software upgrade the Pulse client loses connectivity temporarily.

NOTE: The automatic update feature is supported on Pulse Secure Access and Pulse Access Control servers only. SRX gateways do not support automatic Pulse software updates.

NOTE: When you configure Junos Pulse to make 802.1x based connections, a reboot might be required on Windows XP endpoints when Pulse is upgraded.
After you have staged the new Pulse software package in a location accessible to the Pulse server, use the following procedure to upload the software to the Pulse server:

1. In the device admin console, select Users > Junos Pulse > Components.
2. In the section labeled Manage Junos Pulse Client Versions, click Browse, and then select the software package.
3. Click Upload.

Only one Junos Pulse software package can be active at a time. After you upload a new package, you need to enable it.

To enable a Pulse package as the default:

1. In the admin console, select Users > Junos Pulse > Components.
2. In the section labeled Manage Junos Pulse Client Versions, select the radio button next to a version, and then click Activate.

Related Documentation

• Enabling or Disabling Automatic Upgrades of the Junos Pulse Client on page 66
CHAPTER 3

Configuring Junos Pulse Secure Access Service

• Before You Begin Configuring Junos Pulse Secure Access Service on page 70
• Junos Pulse Secure Access Service Overview on page 70
• About Sign-in Notifications on page 72
• Configuring and Implementing Sign-in Notifications on page 73
• Junos Pulse Secure Access Service Split Tunneling Overview on page 75
• Configuring a Role for Junos Pulse Secure Access Service on page 79
• Machine Authentication for Pulse Secure Access Service Overview on page 86
• Credential Provider Authentication for Pulse Secure Access Service Overview on page 87
• Configuring User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection on page 88
• Configuring Machine-Then-User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection on page 90
• Machine and User Authentication Through a Pulse Connection for Pulse Secure Access Service on page 92
• Configuring Junos Pulse for Secure Application Manager on page 93
• Pulse Connection Set Options for Pulse Secure Access Service on page 99
• Junos Pulse Connection Options on page 101
• Securing the Connection State on the Junos Pulse Client on page 106
• Creating a Client Connection Set for Junos Pulse Secure Access Service on page 107
• Junos Pulse FIPS Mode for Pulse Secure Access Service Overview on page 109
• Configuring Location Awareness Rules for Junos Pulse on page 111
• Component Set Options for Junos Pulse Secure Access Service on page 113
• Creating a Client Component Set for Junos Pulse Secure Access Service on page 114
• Endpoint Security Monitoring and Management for Pulse Secure Access Service on page 116
• Issuing a Remediation Message with Junos Pulse Secure Access Service on page 120
• Using SMS/SCCM Remediation with Junos Pulse Secure Access Service on page 120
Before You Begin Configuring Junos Pulse Secure Access Service

Before you begin configuring Junos Pulse, be sure that you have already configured SA Series SSL VPN network settings. Also be sure that you have defined the Authentication settings, including the authentication servers and sign-in settings. The Authentication and Host Checker settings can directly affect a Pulse installation because you can define the conditions that an endpoint must meet to be allowed access to protected resources.

Junos Pulse Secure Access Service Overview

To enable Junos Pulse Secure Access Service, you configure the service so that when users request authentication, they are assigned a role based on the role mappings and optional security profile that you create. Access to specific resources is permitted only for users and devices that provide the proper credentials for the realm, that are associated with the appropriate roles, and whose endpoints meet security restrictions. If a user attempts to connect to the network from an endpoint that does not comply with the security restrictions you have defined, the user cannot access the realm or role.

As you plan your Pulse configuration, be sure you know how you want to deploy the Pulse client software. You can use one or more of the following Pulse deployment options:

- Use the defaults or make changes to the Junos Pulse default component set and default connection set, and then download and distribute Pulse by having users log in to the Pulse server’s user Web portal and be assigned to a role. After the installation is complete, users have all the connections they need to access network resources.
- Create the connections that an endpoint needs for connectivity and services, download the settings file (.jnppreconfig), and download default Pulse installation program. For Windows endpoints you run the Pulse installation program by using an msiexec
command with the settings file as an option. For OS X endpoints, you run the default installer and then import the .jnprpreconfig file using a separate command.

- Distribute Junos Pulse with no preconfiguration. You can download the default Junos Pulse installation file (.msi format for Windows; .dmg format for Mac) from a Pulse server, and then distribute the file to endpoints using your organization's standard software distribution methods. Because the installer does not contain preconfigured connections, users must define network connections manually. Or you can create dynamic connections on each Pulse server. These connections are automatically downloaded to the installed Pulse client when users provide their login credentials to the Pulse server's user Web portal. Dynamic connections are created as manual rather than automatic connections, which means that they are run only when the user initiates the connection or the user browses to a Pulse Server and launches Pulse from the server's Web interface.

**NOTE:** For a Windows installation (.msi) that uses an automated distribution mechanism and where the users do not have administrator privileges, you should ensure that the installation is run in the proper context, typically the USER context. To install in USER context, first advertise the .msi while in the SYSTEM context. For example, to advertise the 64-bit Windows installation to all users, use the following msiexec command:

```
msiexec /jm JunosPulse.x64.msi
```

The advertisement allows the installation to be run in USER context even if the user is a restricted (non-admin) user. The location where the advertisement is run and where the actual installation is run must be the same. If the installation is an upgrade, you must advertise the upgrade version before running it. (Note that it is much easier to upgrade the Pulse client by not disabling the automatic upgrade feature on the Pulse server.) After the installation is run by the user, the Pulse client will use the correct user certificate and context.

The following tasks summarize how to configure Junos Secure Access Service:

- Create and assign user roles to control who can access different resources and applications on the network. If you are converting your access environment from agentless or a Network Connect environment, you should create new roles that are specific for Junos Pulse.
- Define security restrictions for endpoints with Host Checker policies.
- Define user realms to establish authentication domains. If you are converting your access environment from agentless or a NC environment, typically you can use your existing realms.
- Associate the roles with appropriate realms to define your access control hierarchy using role mapping.
- Define Junos Pulse component sets, connection sets, and connections.
- Deploy Junos Pulse to endpoints.
Junos Pulse and IVS

The Junos Pulse for Windows client is not compatible with the Instant Virtual System (IVS) feature of SA Series Appliances. In an IVS system, a Pulse client always takes its IP address from the root IVE address pool instead of using the pool defined for the virtualized IVE.

Related Documentation
- Creating a Client Connection Set for Junos Pulse Secure Access Service on page 107
- Configuring a Role for Junos Pulse Secure Access Service on page 79

About Sign-In Notifications

With sign-in notifications, you can create and configure detailed notification messages that appear for Pulse clients and for agentless access endpoints when the user attempts to sign in. For example, you could configure a notification message that explains terms of use, company-specific policies, a welcome page, an end user license agreement (EULA), or a message of the day (MOTD).

For a browser-based (agentless) login, the notification message appears in a separate page either before (pre-auth) or after (post-auth) user authentication during the sign-in process. For a Pulse client login, the notification messages appear in a Pulse message box. The user is expected to read the content of the sign-in notification message and acknowledge by clicking a Proceed button. The user may indicate disagreement by clicking a Decline button, which ends the login attempt.

You can configure a sign-in policy to use a sign-in notification either as pre-auth or post-auth (or both). In the case of post-auth configuration, you can either use a common message for all roles or use separate messages for each role.

You can create a multi-language sign-in notification package that relies on the language setting of the endpoint. You can customize the sign-in notification page appearance for browser-based logins by modifying the related fields in a sign-in page in the Admin UI or by using a custom sign-in page.

Notes:
- Sign-in notifications are supported on Windows, Mac, and for browser-based access on mobile devices. However, sign-in notifications might not work well with all mobile devices due to device limitations.
- Sign-in notifications (including uploaded packages) are included in XML exports.
- If a Pulse session is resumed or extended, the pre-auth notification message is not shown again. However, if the user switches roles when resuming a session, and that role change results in a new notification, Pulse displays the message. You can configure the post-auth message to be skipped if it has already been seen. If the post-auth message is not marked to be skipped, then it always appears.

Related Documentation
- Configuring and Implementing Sign-in Notifications on page 73
Configuring and Implementing Sign-in Notifications

Sign-in notifications appear for Pulse client and for browser-based logins when the user attempts to sign in.

To configure and implement sign-in notifications:

1. In the admin console, select Authentication > Signing In > Sign-in Notifications.
2. Click New Notification.
3. Specify a Name for the notification. This name appears in the sign-in policies page, and in the UI Options page for a selected role.
4. Select Text or Package in the Type box.
   - If you select Text, type the desired sign-in notification message, or copy and paste the relevant text into the Text field.
   - If you select Package, click the Browse button and navigate to a previously prepared .zip file. A package is typically used to provide different language versions of the notification message.
     - The zip file should include a default.txt file and one or more <language>.txt files (Example: en.txt).
     - Language-abbreviations should be strings that can appear in Accept-Language header of an HTTP request.
     - The character encoding supported is UTF-8.

   **NOTE:** When you create a zip file, do not add the folder containing the files, but add the files directly.

5. Click Save Changes.

To enable sign-in notifications:

1. In the admin console, click Authentication > Signing In > Sign-in Policies.
2. Select an existing URL or create a new URL.
3. Under Configure Sign-in Notifications, select the check box for Pre-Auth Sign-in Notification, Post-Auth Sign-in Notification, or both.
   - After Pre-Auth Sign-in Notification, select a previously configured sign-in notification from the drop-down menu.
   - After Post-Auth Sign-in Notification, select the option for Use a common Sign-in Notification for all roles or Use the Sign-in Notification associated to the assigned role.
   - If you select Use a common Sign-in Notification for all roles, select a previously configured sign-in notification from the drop-down menu.
• If you select **Use the Sign-in Notification associated to the assigned role**, the sign-in notification configured for the assigned role will be used.

• Prevent the Post-Auth sign-in notification from being displayed to users who have seen it before, by selecting the **Skip if already shown** check box. (This is only a hint to the system and might not be honored in all environments.)

4. Click **Save Changes**.

5. You can customize the appearance of the sign-in notification message by selecting **Authentication > Signing In > Sign-in Pages** and creating a sign-in page or using an existing page.

6. Under Sign-in Notification appearance, customize UI options for Pre-Auth Notifications and Post-Auth Notifications by changing the following items:

   • For **Notification Title** enter the text that appears at the top of the sign-in notification page.

   • In the **Proceed Button** box, enter the text for the button that the user clicks to proceed with the sign-in.

     This text applies to browser-based logins only. A Pulse client login always displays Proceed.

   • Optionally, clear the check box for **Display “Decline” Button**. If this box is not checked, the user does not have the option to decline.

   • In the **Decline Button** box, enter the text for the button that the user clicks to decline.

     This text applies to browser-based logins only. A Pulse client login always displays Decline.

   • In the **Message on Decline** box, enter the text that you would like to appear when a user clicks the Decline button.

7. Click **Save Changes**.

   ![NOTE:]

   If you enabled **Use the Sign-in Notification associated to the assigned role**, you must complete the implementation by selecting the sign-in notification on the **Users > User Roles > Role Name > General > UI Options page** or **Administrators > Admin Roles > Role Name > General > UI Options page**, as applicable.

   If more than one role is available to a user, the sign-in notification associated with the first role assigned is displayed.

8. Add the sign-in page in which you have customized the sign-in notification appearance to the sign-in policy.

   ![Related Documentation]

   • About Sign-In Notifications on page 72
Junos Pulse Secure Access Service Split Tunneling Overview

The Junos Pulse clients for Windows, Apple OS X, Google Android, and Apple iOS and the Juniper Network Connect client all support split tunneling. Split tunneling is configured as part of the role that is assigned to a user after authentication. When the client and Pulse Secure Access Service establish a VPN tunnel, the Pulse server takes control of the routing environment on the endpoint to ensure that only permitted network traffic is allowed access through the VPN tunnel. Split tunneling settings enable you to further define the VPN tunnel environment by permitting some traffic from the endpoint to reach the local network or another connected subnet. When split tunneling is enabled, split tunneling resource policies enable you to define the specific IP network resources that are excluded from access or accessible through the VPN tunnel.

Figure 9 on page 75 shows a simple network configuration with three possible routes: through the default router, to the local subnet, or to a router connection to an indirectly connected subnet.

Figure 9: Pulse Split Tunneling

The network configuration in Figure 9 on page 75 shows that the local network and the protected network at the other end of the VPN tunnel both have a subnet with the same private IP address, 10.10.0.0/24. In this case, the endpoint needs more information to determine where to send traffic addressed to that IP address range. You use the route precedence setting in the split tunneling settings to define which routing table takes precedence, either the tunnel routes (the routing table associated with the VPN tunnel) or the endpoint route (the routing table associated with the physical interface). If you select tunnel routes for route precedence, traffic addressed to network 10.10.0.0/24 in Figure 9 on page 75 goes through the VPN tunnel and the 10.10.0.0/24 network available on the local indirect network is not reachable. If you select endpoint routes for route precedence, traffic addressed to network 10.10.0.0/24 goes through the physical adapter and the 10.10.0.0/24 network available through the VPN tunnel is not reachable. Pulse restores the original routes when the VPN tunnel is disconnected. However, no matter which way you define route precedence, the endpoint loses connectivity to one of the other of the networks if there are duplicate IP address networks.
### Split Tunneling Disabled

When the endpoint has an active VPN tunnel connection, and split tunneling is disabled, the default route is modified to send all network traffic from the endpoint through the VPN tunnel where it is bound by the VPN access control and resource policies. If you set route precedence to endpoint routes, all network traffic goes through the VPN tunnel except traffic that is destined for directly-connected (local) subnets and indirectly connected (routed) subnets. The Junos Pulse clients for Windows and OS X also support the following option to permit limited access to the local network:

- If the Pulse connection set is configured to allow the user to override the connection policy, the user can manually suspend the active Pulse connection to enable access to the local network. In the network in Figure 9 on page 75, the user could suspend the Pulse connection to access the local printer, which resides on the same subnet as the Pulse endpoint. Suspending the Pulse connection is a manual method. The user must suspend the connection to access to local subnet and then resume the connection to restore connectivity through the tunnel. While the connection is suspended, no traffic goes through the tunnel.

- You can configure the split tunneling properties to allow access to the local subnet. With split tunneling disabled and local subnet access allowed, network traffic goes through the tunnel except for addresses that are on the local subnet. In the network in Figure 9 on page 75, the user could print to the local printer but other traffic would go through the default route to the tunnel. No traffic would go through the subnet router 192.168.0.2.

### Split Tunneling Enabled

When the endpoint has an active VPN connection, and split tunneling is enabled for the role, the Pulse server adds or modifies routes on the endpoint so that traffic meant for specific subnets uses the VPN tunnel, and all other traffic goes through the local physical adapter. You specify the subnets that are excluded from access or accessible or through the VPN tunnel by defining split tunneling resource policies. In a case where you have identically numbered subnets on both the local network and the tunnel network, (that is, the specified split-tunnel subnet conflicts with an existing endpoint route), the route precedence setting determines the traffic path. The route monitoring option, when enabled, enhances network security by terminating the VPN tunnel if another process on the endpoint makes a change to the routing table.

The traffic enforcement option enables you to decide whether the split tunneling configuration can be bypassed. When traffic enforcement is enabled, Pulse creates rules on the endpoint’s firewall (Mac and Win) that ensure that all traffic conforms to the split tunneling configuration. For example, a local program might bypass the routing tables and bind traffic to the physical interface instead of allowing it to go through the Pulse virtual interface. If you enable traffic enforcement, you ensure that all traffic is bound by the split tunneling configuration.
Pulse Split Tunneling Summary

Table 6 on page 77 summarizes the traffic flows that are possible with each split tunnel configuration. Split tunneling options enable you to control the network traffic on the endpoint so that you can allow the needed connectivity to users while maintaining network security.

Table 6: Split Tunneling Options Summary

<table>
<thead>
<tr>
<th>Split Tunnel Settings</th>
<th>Network Traffic Path</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All network traffic from the endpoint goes through the VPN tunnel. Local networks are not available.</strong> Pulse client users may choose to suspend the Pulse connection to allow local access if the Pulse connection set has the property <strong>Allow users to override connection policy</strong> enabled. VPN tunneling access control resource policies in effect for the user’s role determine which IP resources the user can access. Split tunneling resource policies are not in effect with split tunneling disabled.</td>
<td></td>
</tr>
<tr>
<td><strong>All network traffic goes through the VPN tunnel except traffic that is destined for directly-connected (local) subnets.</strong> VPN tunneling access control resource policies in effect for the user’s role determine which IP resources the user can access. Split tunneling resource policies are not in effect with split tunneling disabled.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 6: Split Tunneling Options Summary (continued)

<table>
<thead>
<tr>
<th>Split Tunnel Settings</th>
<th>Network Traffic Path</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Web</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Files</strong></td>
<td></td>
</tr>
<tr>
<td><strong>SSM</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Terminal/SSH</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Terminal Services</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Virtual Desktops</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Meetings</strong></td>
<td></td>
</tr>
<tr>
<td><strong>VPN Tunneling</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Enable</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Disable</strong></td>
<td></td>
</tr>
<tr>
<td><strong>General VPR Options</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Split Tunneling</strong></td>
<td>Choose the split-tunneling mode</td>
</tr>
<tr>
<td><strong>Enable</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Disable</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Juniper client options</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Route Precedence</strong></td>
<td>Should the precedence be given to existing endpoint routes or tunnel routes in case of an overlap?</td>
</tr>
<tr>
<td><strong>Tunnel routes</strong> (Applicable on Windows, MAC OSX, Linux)</td>
<td></td>
</tr>
<tr>
<td><strong>Tunnel routes with local subnet access</strong> (Pulse on Windows, MAC OSX only)</td>
<td></td>
</tr>
<tr>
<td><strong>Endpoint routes</strong></td>
<td></td>
</tr>
</tbody>
</table>

All network traffic goes through the VPN tunnel except traffic that is destined for directly-connected (local) subnets and indirectly connected (routed) subnets. If there are networks with the same IP address on both the local network and specified in the split tunneling resource policies, the route precedence option directs the network traffic through the VPN tunnel.

**NOTE:** Make sure that there is no conflict between your access control resource policies and your split tunneling resource policies.

The default route is set to the local subnet so all other network traffic is subject to the original endpoint routing table.
Table 6: Split Tunneling Options Summary (continued)

<table>
<thead>
<tr>
<th>Split Tunnel Settings</th>
<th>Network Traffic Path</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Network Traffic Path Split Tunnel Settings</strong></td>
<td>Network traffic addressed to the networks defined in the split tunnel resource policies goes through the VPN tunnel. Network traffic that is addressed to the directly-connected (local) subnet goes to the local subnet. The default route is set to the local subnet so all other network traffic is subject to the original endpoint routing table.</td>
</tr>
<tr>
<td><strong>Split Tunneling Notes</strong></td>
<td>Network traffic addressed to the networks defined in the split tunnel resource policies goes through the VPN tunnel. The default route is set to the local subnet so all other network traffic is subject to the original endpoint routing table.</td>
</tr>
<tr>
<td><strong>Configuring a Role for Junos Pulse Secure Access Service</strong></td>
<td>Network traffic addressed to the networks defined in the split tunnel resource policies goes through the VPN tunnel. The default route is set to the local subnet so all other network traffic is subject to the original endpoint routing table.</td>
</tr>
<tr>
<td><strong>Related Documentation</strong></td>
<td>Network traffic addressed to the networks defined in the split tunnel resource policies goes through the VPN tunnel. The default route is set to the local subnet so all other network traffic is subject to the original endpoint routing table.</td>
</tr>
<tr>
<td><strong>Defining Split Tunneling Network Policies</strong></td>
<td>Network traffic addressed to the networks defined in the split tunnel resource policies goes through the VPN tunnel. The default route is set to the local subnet so all other network traffic is subject to the original endpoint routing table.</td>
</tr>
</tbody>
</table>

**Split Tunneling Notes**

- The Pulse server tries to resolve all DNS requests through the endpoint’s physical adapter first, and then routes those that fail to the VPN tunneling adapter.

**Related Documentation**

- About VPN Tunneling
- About VPN Tunneling Resource Policies
- Defining Split Tunneling Network Policies

**Configuring a Role for Junos Pulse Secure Access Service**

A user role defines session settings and options, personalization settings (user interface customization and bookmarks), and access features (Web, file, application, Telnet/SSH, Terminal Services, network, meeting, and e-mail access). A user role does not specify resource access control or other resource-based options for an individual request. For example, a user role can define whether a user can perform Web browsing when the user
is connected through the Pulse Secure Access server Web portal. However, the individual Web resources that a user can access are defined by the Web resource policies that you configure separately.

The following procedure describes the role configuration options.

To create a role for Junos Pulse endpoints:

1. Select Users > User Roles > New User Role in the admin console.
2. Enter a name for the role and, optionally, a description. This name appears in the list of roles on the Roles page.
3. Under Client Options, select Junos Pulse.

When this option is enabled, the Junos Pulse button appears on the Secure Access Service Web portal. When a user clicks it, Pulse is downloaded and installed on the user’s endpoint.

Enabling this option alone does not enable Pulse as the client for the role. This option works in conjunction with the settings you enable in the Access Features section and then configure on the respective role tabs. The combination of settings determines whether you enable Junos Pulse, Junos Pulse for Secure Application Manager (SAM), or Network Connect. The following procedures describe how to enable each client option.

To enable Junos Pulse:

a. In the role’s General > Overview > Options section select Junos Pulse.

   This setting applies to both Windows and Apple OS X versions of Junos Pulse.

b. In the Access Features section select VPN Tunneling.

   The VPN Tunneling tab enables you to specify split tunnel behavior, specify the Pulse component set, and enable 3rd-party software integrations.

To enable Junos Pulse for SAM:

a. In the Options section select Junos Pulse.

b. In the Access Features section select Secure Application Manager and then select Windows version.

   The SAM tab enables you to specify applications and servers secured by SAM.

To enable Network Connect:

a. In the Options section make sure Junos Pulse is disabled.

b. In the Access Features section select VPN Tunneling.

4. Click Save Changes. Role configuration tabs appear.
NOTE: When the Junos Pulse option is enabled and no other access method (VPN Tunneling, WSAM) is enabled, then no client will be delivered.

Configuring General Role Options for Pulse Secure Access Service

The General tab includes options for detailed control of how the client interacts with the server and the network. The following describes the options that apply to Junos Pulse.

**General > Restrictions**

Source IP—Control from which IP addresses users can access the Web portal sign-in page, be mapped to a role, or access a resource.

Browser—Allow or deny access to the role based on the browser’s user agent string.

Certificate—Allow all users or only users with a signed client-side certificate.

Hot Checker—Select configured Host Checker policies to enforce with this role.

**General > VLAN/SourceIP**

VLAN and Select Source IP—To direct traffic to specific sites based on the role, you can define a source IP alias for each role and then use the alias to configure virtual ports you define for the internal interface source IP address. A back-end device can then direct end user traffic based on the alias. This capability enables you to direct various end users to defined sites based on their roles, even though all of the end user traffic has the same internal interface source IP address.

**General > Session Options**

Idle Timeout—the maximum time a session can remain idle (no traffic) before the server ends the session.

Max. Session Length—the maximum time for a session before the server ends the session.

Reminder Time—When the Enable Session Extension feature is enabled, the Reminder Time specifies the number of minutes prior to a session end when the server sends a notice through Pulse and notifies the user that the session will end soon.

Enable Session Extension—Allows the user to extend the session. The user can choose to extend the session at any time by selecting a menu option in the Pulse client interface. If the Session Timeout Warning is selected, a notice message appears when the Reminder Time is reached and the user can choose to extend the session from within that notice message.

Enable Session Timeout Warning—Enables or disables the session timeout warning, which notifies the user when their Pulse VPN session is close to expiring. The Reminder Time value specifies the point at which the reminder appears.

Roaming Session—Select one of the following options to specify the client’s roaming behavior:
- **Enabled**—A roaming session allows a user to retain connectivity when moving a device, such as a laptop with a dynamic IP address, from one subnet to another. Disable this feature to prevent users from accessing a previously established session from a new source IP address. Disabling roaming can help protect against an attack that spoofs a user’s session.

- **Limit to Subnet**—Limit the roaming session to the local subnet specified in the endpoint’s IP configuration. Users can sign in from one IP address and continue using their sessions with another IP address as long as the new IP address is within the same subnet.

- **Disabled**—Disable roaming user sessions for users mapped to this role.

Browser Session Cookie—Select **Enabled** to remove the Secure Access Service session cookie and log users out of their Secure Access Service web session after the Pulse client is launched. Removing the browser session cookie enhances Pulse session security.

**General** > **UI Options**

**UI Options**—The settings on this page define the Pulse Secure Access Service Web portal page.

**SAM** > **Applications**

**Add Application**—We recommend that you use resource profiles to specify the applications available to Pulse for Windows Mobile users, but you can use role and resource policy settings instead.

**SAM** > **Options**

**Auto-uninstall Secure Application Manager**—This feature is not applicable to the Windows Mobile client. Users must download and install Pulse for Windows Mobile before the Windows Mobile device can connect to the Pulse Secure Access Service.

**Prompt for username and password for intranet sites**—If you enable this option, the Pulse Secure Access Service requires users to enter sign-in credentials before connecting to sites on your internal network. This option changes Internet Explorer’s intranet zone setting so that Internet Explorer always prompts the user for network sign-in credentials for an intranet site.

**Auto-upgrade Secure Application Manager**—This feature is not applicable to the Pulse for Windows Mobile app.

**Resolve only hostnames with domain suffixes in the device DNS domains**—If you enable this option, users can only browse to Web sites that are part of their login domain.

**Session start script and Session end script**—This feature is not applicable to the Pulse for Windows Mobile app.
Configuring Role Options for Pulse Secure Access Service

All of the options for role configuration tabs are described in *User Access Management Framework Feature Guide*.

To configure role options for Junos Pulse endpoints:

1. From the admin console, select **Users > User Roles**.
2. Click the role you want to configure and then click the VPN Tunneling tab.
3. Under Split Tunneling Options, select your options:
   - **General VPN Options** apply to all Layer 3 VPN clients, Junos Pulse (Windows, OS X, iOS, and Android), Network Connect, and third-party IKEv2 clients:
     - **Split Tunneling**—Split tunneling options let you define how network traffic flows on the client.
       - **Enable**—Pulse modifies routes on the client so that traffic meant for the corporate intranet uses the virtual adapter created by Pulse (the Pulse tunnel) and all other traffic goes through the local physical adapter.
       - **Disable**—When the Pulse session is established, predefined local subnet and host-to-host routes that might cause split-tunneling behavior are removed, and all network traffic from the client goes through the Pulse tunnel. With split tunneling disabled, users cannot access local LAN resources during an active VPN session. However, when you create a Pulse connection for users, if you allow users to override you can enable an option that allows the user to suspend their VPN connection. While a Pulse connection is in the suspended state, all traffic goes through the local physical adapter.

   - **Juniper Client Options** apply only to Junos Pulse and Network Connect:
     - **Route Precedence**—You can define which routing table takes precedence:
       - **Tunnel Routes**—The route table associated with the Pulse virtual adapter take precedence. Pulse overwrites the physical interface routes if there is conflict between the Pulse virtual adapter and the physical adapters. Pulse restores the original routes when the connection is ended.
       - **Tunnel Routes with local subnet access (Pulse on Windows and Mac OS X only)**—Network traffic addressed to the networks defined in the split tunnel resource policies goes through the VPN tunnel. Network traffic that is addressed to the directly-connected (local) subnet goes to the local subnet. The default route is set to the local subnet so all other network traffic is subject to the original endpoint routing table.
       - **Endpoint Routes**—The route table associated with the endpoint’s physical adapter take precedence.
     - **Route Monitor**—Pulse can monitor the route tables and take appropriate action.
Yes – VPN tunneling ends the connection only if the route change affects the VPN tunnel traffic. For example, if the route metric is changed higher, it should not disconnect VPN tunneling.

No – Route tables are allowed to change on the client endpoint.

- **Traffic Enforcement**—When Traffic Enforcement is enabled, Pulse creates rules on the endpoint’s firewall (Mac and Win) that ensure that all traffic conforms to the split tunneling configuration. For example, a local program might bypass the routing tables and bind traffic to the physical interface instead of allowing it to go through the Pulse virtual interface. If you enable traffic enforcement, you ensure that all traffic is bound by the split tunneling configuration.

Yes – All traffic is bound by the split tunneling configuration.

No – Network traffic that bypasses the local routing tables is not bound the split tunneling configuration.

- **Enable TOS Bits Copy**—Enables you to control the client behavior in networks that employ Quality of Service (QoS) protocols. When you enable this check box, the Juniper client copies IP Type of Service (TOS) bits from the inner IP header to outer the IP Header. Note that enabling this option might require a reboot of the client endpoint when the client software is installed for the first time on Windows endpoints. Juniper clients support TOS bit copy only for IPSec transport and not for SSL transport.

- **Multicast**—Enables the multicast feature on the client when this option is selected.

- **Auto-launch**—Activates the Juniper client software automatically when the endpoint is started when this option is selected.

Options for Juniper client on Windows apply only to Junos Pulse and Network Connect on Windows endpoints:

- **Launch client during Windows Interactive User Logon**—When this option is enabled, the Juniper client starts when the user logs into Windows. Note that this setting is not the same as the Pulse connection settings that control machine authentication and credential provider authentication. Choose one of the following options:

  Require client to start when logging into Windows

  Allow user to decide whether to start client when logging into Windows

- **Windows: Session start script**—Specify a script (.bat, .cmd, or .exe) to run for users assigned to the role after Junos Pulse connects with Pulse Secure Access Service. For example, you can specify a script that maps network drives on an endpoint to shares on protected resources.

- **Windows: Session end script**—Specify a script (.bat, .cmd, or .exe) to run for users assigned to the role after Junos Pulse disconnects from Pulse Secure Access Service. For example, you can specify a script that disconnects mapped network drives. If there is no start script defined, or the start script has not been run, the end script does not run.

- **Skip if Windows Interactive User Logon Enabled**—Select this option to bypass the specified Windows session start script.
If the client signs in to their Windows Domain via the Credential Provider automatic sign-in function, a script is executed by the Windows client. In this case, the sign-in script might be identical to the specified VPN Tunneling start script. You can use this option, therefore, as a way to avoid executing the same script twice.

**Options for Juniper client on Mac** apply only to Junos Pulse and Network Connect on Apple OS X endpoints:

- **Mac: Session start script**—Specify a script (.bat, .cmd, or .exe) to run for users assigned to the role after Junos Pulse connects with Pulse Secure Access Service. For example, you can specify a script that maps network drives on an endpoint to shares on protected resources.

- **Mac: Session end script**—Specify a script (.bat, .cmd, or .exe) to run for users assigned to the role after Junos Pulse disconnects from Pulse Secure Access Service. For example, you can specify a script that disconnects mapped network drives. If there is no start script defined, or the start script has not been run, the end script does not run.

4. In the **Session scripts** area, optionally specify a location for the following:

- **Windows: Session start script**—Specify a script (.bat, .cmd, or .exe) to run for users assigned to the role after Pulse connects with Pulse Access Control Service. For example, you can specify a script that maps network drives on an endpoint to shares on protected resources. The script must be in a location (either local or on the network) that is accessible by the user.

- **Windows: Session end script**—Specify a script (.bat, .cmd, or .exe) to run for users assigned to the role after Junos Pulse disconnects from Pulse Access Control Service. For example, you can specify a script that disconnects mapped network drives. If there is no start script defined, or the start script has not been run, the end script does not run. The script must be in a location (either local or on the network) that is accessible by the user.

5. Click **Save Changes**.

**Configuring Role Options for Host Checker for Pulse Secure Access Service**

Host Checker options allow you to enable configured Host Checker policies, to choose one or more policies for the role, and to specify whether the endpoint must meet all or just one of the selected Host Checker policies. Before you can assign Host Checker policies for a role, you must have already defined the policies.

To configure Host Checker for a selected role:

1. For a selected role, select **General > Restrictions > Host Checker**.

2. Select the check box **Allow users whose workstations meet the requirements specified by these Host Checker policies**.

3. Click **Add** to move Host Checker policies from the **Available Policies** list to the **Selected Policies** list.
4. Select the check box Allow access to the role... to grant access if the endpoint passes any of the selected Host Checker policies.

5. Click Save Changes.

**Related Documentation**
- Credential Provider Authentication for Pulse Secure Access Service Overview on page 87
- Configuring Junos Pulse for Secure Application Manager on page 93
- Machine Authentication for Pulse Secure Access Service Overview on page 86
- Specifying Role-Based Source IP Aliases

---

**Machine Authentication for Pulse Secure Access Service Overview**

Machine authentication uses machine credentials (machine name and password or machine certificate) to authenticate the endpoint. You can enable machine authentication for Pulse Secure Access Service as part of a Junos Pulse connection and distribute the connection to endpoints through the normal Pulse distribution methods. You enable Pulse machine authentication support on a Pulse connection, either Layer 2 or Layer 3.

The following describes the requirements for a machine authentication environment:

- The authentication server used by the Pulse connection must be Active Directory/Windows NT for machine name/password authentication or a certificate server for machine certificate authentication.
- The endpoint must be a member of a Windows domain, and the machine credentials must be defined in Active Directory.
- The Pulse connection must be configured so that no prompts are presented during the login process. For example, prompts for realm or role selection or for a server certificate trust prompt cause the connection to fail. You can specify a preferred role and realm for the connection, which eliminates realm and role selection dialogs.
- For machine certificate authentication, the domain workstation login certificate must be issued by the domain certificate authority. The root certificate must be in the Machine Trusted Certificate store instead of the certificate store for a particular user.

Pulse supports the following machine authentication types:

- **machine-only**—The connection is established using machine credentials when no user is logged in. The connection is maintained after user login.
- **user-after-desktop**—The connection is established using machine credentials when no user is logged in. After user login, the machine connection is disconnected. Once the user logs out, the user connection is disconnected and the machine connection is reestablished.
Credential Provider Authentication for Pulse Secure Access Service Overview

When Microsoft introduced Windows Vista, it moved away from a login integration interface based on GINA (Graphical Identification and Authentication) in favor of credential provider authentication. The Junos Pulse credential provider integration enables connectivity to a network that is required for the user to login to the Windows domain. For example, the domain controller might reside behind a firewall and the endpoint uses credential provider login to connect to Pulse Access Control Service prior to domain login. Junos Pulse integrates with Microsoft credential providers to enable password-based login and smart card login. Credential provider login is supported on Windows Vista and later Windows platforms.

You can use the Pulse support for credential provider to provide single sign-on capabilities. Pulse establishes a connection to the network and then uses the same credentials to login the Windows domain.

You enable Pulse credential provider support on a Pulse connection, (connection type 802.1X (UAC) or SSL VPN (L3)). After the connection has been downloaded to the endpoint through the normal Pulse distribution methods, Pulse annotates the credential provider tile that appears on the user login screen by adding a Pulse icon in the lower right corner of the tile.

Pulse supports the following credential provider types:

- **user-at-credprov**—The connection is established before the user login using credentials collected at the selected credential tile, which provides single-sign-on functionality. The connection is maintained as an active connection on the user’s desktop.

- **machine-then-user-at-credprov**—The connection is established using machine credentials when no user is logged in. When a user clicks a login tile and provides user credentials, the machine connection is disconnected and a new connection is established. When the user logs out, the user connection is disconnected and the machine connection is reestablished. In one typical machine-then-user-at-credprov implementation, the machine connection and the user connection are mapped to different VLANs.

Pulse credential provider support usage notes:

- If the endpoint includes more than one Pulse Layer 2 connection, Windows determines which connection to use:
1. If a network cable is attached to the endpoint, Layer 2 wired connections are attempted, and then wireless connections. If there are more than one wireless network available, the order is determined by the scan list specified as a Pulse connection option.

2. After all Layer 2 options are attempted, Pulse runs location awareness rules to find one or more eligible Layer 3 connections that are configured for credential provider login. If more than one Layer 3 connection is found, Pulse prompts the user to select a connection. A user can cancel the network connection attempt by clicking the cancel button.

3. After Pulse evaluates all configured connection options, Pulse returns control to Windows, which enables the user login operation.

- For connections that use user credentials, the Pulse connection can be configured so that prompts are presented during the login process, for example, prompts for realm or role selection or a server certificate trust prompt. For connections that use machine credentials, Pulse prompts cause the connection to fail because there is no interface to allow a response to the prompts. You can suppress any potential realm and role choice by specifying a preferred realm and role for the connection.

- Pulse upgrade notifications and actions are disabled during credential provider login and postponed until the user connection is established. Host Checker remediation notifications are displayed.

**Related Documentation**

- Configuring User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection on page 46
- Configuring Machine-Then-User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection on page 47
- Pulse Access Control Service and Pulse Secure Access Service Deployment Options on page 21

### Configuring User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection

With a user-at-credprov connection, the Pulse connection establishes the connection before user login using credentials collected at the selected credential tile, which provides single sign-on functionality. The connection is maintained as an active connection on the user’s desktop.

To enable user-at-credprov credential provider support for a Pulse connection:

1. Create a Pulse connection set for the role (Users > Junos Pulse > Connections), and then create a new Pulse connection. You can select either a Layer 3 connection type, SSL VPN or UAC (L3), or a Layer 3 connection type, UAC (802.1X).

2. In the Connection is established section, select one of the following options:

   - **Automatically at user login**—The user credentials are used to establish the authenticated Pulse connection to the network, login to the endpoint, and login to
the domain server. The Pulse connection can be configured so that prompts are presented during the login process, for example, prompts for realm or role selection or a server certificate trust prompt.

**NOTE:** This label changed at Pulse Secure Access Service R7.3. If you had selected the old label for a Pulse connection, “Automatically during desktop authentication. User is presented with the Junos Pulse credential tile at the login screen,” it is automatically converted to the new label, “Automatically at user login,” when you perform the upgrade from R7.2.

- **Automatically when the machine starts. Connection is authenticated again at user login**—Machine credentials are used to establish the authenticated Pulse connection to the network when the endpoint is started. When a user clicks the login tile and provides user credentials, the connection is authenticated again, and the original connection is dropped. When the user logs out, the user connection is ended, and the machine connection is established again. In one typical use case, the machine credentials provide access to one VLAN, and the user credentials provide access to a different VLAN. Be sure that the Pulse connection does not result in Pulse prompts, for example, prompts for realm or role selection or a server certificate trust prompt, because the machine credential login does not present an interface to respond to the prompts.

3. For a Layer 2 connection that uses machine certificate authentication, make sure that the connection has an entry in the Trusted Server List. To allow any server certificate, type `ANY` as the Server certificate DN. To allow only one server certificate, specify the server certificate’s full DN for example, `C=US; ST=NH; L=Kingston; O=My Company; OU=Engineering; CN=c4k1.stnh.mycompany.net; E=ausername@mycompany.com`.

4. Specify **Realm and Role Preferences** to suppress realm or role selection dialogs during the login process:

- **Preferred User Realm**—Specify the realm for this connection. The connection ignores any other realm available for the specific login credentials
- **Preferred User Role Set**—Specify the preferred role or the name of the rule for the role set to be used for user authentication. The role or rule name must be a member of the preferred user realm.

**Related Documentation**
- Credential Provider Authentication for Pulse Access Control Service Overview on page 44
Configuring Machine-Then-User-at-Credprov Credential Provider Authentication for a Junos Pulse Connection

With a machine-then-user-at-credprov connection, Pulse establishes the connection using machine credentials when no user is logged in. When a user clicks a login tile and provides user credentials, the machine connection is disconnected, and a new connection is established. When the user logs out, the user connection is disconnected, and the machine connection is reestablished. In one typical machine-then-user-at-credprov implementation, the machine connection and the user connection are mapped to different VLANs.

To enable machine-then-user-at-credprov credential provider support for a Pulse connection:

1. Create a Pulse connection set for the role (Users > Junos Pulse > Connections), and then create a new Pulse connection. You can select either a Layer 3 connection type, SSL VPN or UAC (L3), or a Layer 3 connection type, UAC (802.1X).

2. In the Connection is established section, select one of the following options:
   - **Automatically at user login**—The user credentials are used to establish the authenticated Pulse connection to the network, login to the endpoint, and login to the domain server. The Pulse connection can be configured so that prompts are presented during the login process, for example, prompts for realm or role selection or a server certificate trust prompt.
   
   **NOTE:** This label changed at Pulse Secure Access Service R7.3. If you had selected the old label for a Pulse connection, “Automatically during desktop authentication. User is presented with the Junos Pulse credential tile at the login screen,” it is automatically converted to the new label, “Automatically at user login,” when you perform the upgrade from R7.2.
   
   - **Automatically when the machine starts. Connection is authenticated again at user login**—Machine credentials are used to establish the authenticated Pulse connection to the network when the endpoint is started. When a user clicks the login tile and provides user credentials, the connection is authenticated again and the original connection is dropped. When the user logs out, the user connection is ended, and the machine connection is established again. In one typical use case, the machine credentials provide access to one VLAN, and the user credentials provide access to a different VLAN. Be sure that the Pulse connection does not result in Pulse prompts, for example, prompts for realm or role selection or a server certificate trust prompt, because the machine credential login does not present an interface to respond to the prompts.

3. For a Layer 2 connection that uses machine certificate authentication, make sure that the connection has an entry in the Trusted Server List. To allow any server certificate, type **ANY** as the Server certificate DN. To allow only one server certificate, specify the server certificate’s full DN, for example, C=US; ST=NH; L=Kingston; O=My Company; OU=Engineering; CN=c4k1.stnh.mycompany.net; E=ausername@mycompany.com.
4. Specify Realm and Role Preferences to suppress realm or role selection dialogs during the login process for both machine and user logins:

- **Preferred Machine Realm**—Specify the realm that this connection uses when establishing the machine connection. The connection ignores any other realm available for the specific login credentials.

- **Preferred Machine Role Set**—Specify the role or the name of the rule for the role set that this connection uses when establishing the machine connection. The role or rule name used must be a member of the preferred machine realm.

- **Preferred User Realm**—Specify the realm that for this connection that is used when a user logs in to the endpoint. The connection ignores any other realm available for the user’s login credentials.

- **Preferred User Role Set**—Specify the preferred role or the name of rule for the role set to be used for user authentication. The role or rule name used must be a member of the preferred user realm.

5. Optionally, specify pre-login preferences:

- **Pre-login maximum delay**—The time period (seconds) that a Windows client waits for an 802.1x connection to succeed during the login attempt. The range is 1 to 120 seconds.

- **Pre-login user based virtual LAN**—If you are using VLANs for the machine login user logins, you can enable this check box to allow the system to make the VLAN change.

6. Click Save Changes, and then distribute the Pulse connection to Pulse client endpoints.

**Related Documentation**

- Credential Provider Authentication for Pulse Access Control Service Overview on page 44
- Machine and User Authentication Through a Pulse Connection for Pulse Access Control Service on page 49
Machine and User Authentication Through a Pulse Connection for Pulse Secure Access Service

Junos Pulse supports certificate authentication for establishing Layer 2 and Layer 3 connections. On Windows endpoints, the Pulse client connection accesses client certificates located in the Local Computer personal certificate store to provide machine authentication or user certificates located in a user’s personal certificate store or a smart card for user authentication. A Pulse connection can access certificates from only one location. For information on machine authentication, see “Machine Authentication for Pulse Secure Access Service Overview” on page 86.

You can create a Pulse connection that verifies the identity of both the machine and the user before establishing a connection. There are two options for configuring this dual authentication connection. Both options employ user authentication against a Local System, Active Directory, or ACE server for user authentication and certificate authentication to verify the machine. Both options also use a Pulse connection option. The option, Select client certificate from machine certificate store, is part of the User Connection Preferences of a Pulse connection.

Option 1: Use an additional authentication server for a realm:

- Create a Pulse connection for the target Pulse server. The connection type can be UAC (802.1X) or SSL VPN or UAC (L3). The Connection is established option is typically set to Manually by the user or Automatically at user login.
- In the User Connection Preferences section of the connection properties, click the check box labeled Select client certificate from machine certificate store. This option enables the Pulse connection to perform the machine authentication as part of the Pulse connection attempt.
- Create a realm sign in policy that authenticates to a certificate server. When Pulse provides the certificate to the server, it uses the certificate from the Local Computer certificate store, which authenticates the machine. If the certificate store holds more than one valid certificate for the connection, Pulse opens a dialog box that prompts the user to select a certificate.
- Create a secondary authentication server for the realm. The secondary server can be a Local System, Active Directory, or RSA ACE server. When the machine authentication is successful, the user is prompted to provide authentication credentials for the secondary authentication server.

Option 2 — Use realm authentication to authenticate the user and a certificate restriction on the realm to authenticate the machine.

- Create a Pulse connection for the target Pulse server. The connection type can be UAC (802.1X) or SSL VPN or UAC (L3). The Connection is established option is typically set to Manually by the user or Automatically at user login.
- In the User Connection Preferences section of the connection properties, click the check box labeled Select client certificate from machine certificate store.
Create a sign-in policy on the Pulse server that specifies a user realm. The realm authentication server can be a System Local, Active Directory, or RSA ACE server.

Configure a certificate restriction on the realm to enable the Pulse server to request a client certificate. Be sure to enable the option labeled **Only allow users with a client-side certificate signed by Trusted Client CAs to sign in.**

Related Documentation

- Certificate Server
- About Configuring Sign In Policies
- Specifying Client-side Certificate Restrictions
- Junos Pulse Connection Options on page 101

### Configuring Junos Pulse for Secure Application Manager

Junos Pulse supports Secure Application Manager (SAM). SAM provides remote access using application names and destinations. SAM does not require a virtual adapter or virtual IP address on the endpoint. SAM provides secure access to client/server applications and thin client solutions without provisioning a VPN tunnel.

With Pulse R3.0 and later, SAM connectivity is provided through SSL VPN (Pulse connection type SSL VPN or UAC (L3)). Prior to Pulse R3.0, SAM connectivity was provided through a separate client. In addition, the Pulse for Windows Mobile app uses SAM to provide access to Windows Mobile smart phones, and that requires a different role. Table 7 on page 93 describes the progression of Pulse/SAM client software.

### Table 7: Pulse/SAM Client Version Summary

<table>
<thead>
<tr>
<th>Pulse/SAM Version</th>
<th>Supported Platforms</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse R1.0</td>
<td>Windows Mobile</td>
<td>SAM client that is installed from the Pulse Secure Access server.</td>
<td>Supports Host Checker.</td>
</tr>
<tr>
<td></td>
<td>Windows XP</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Included with SSL/VPN software R7.0 and R7.1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 7: Pulse/SAM Client Version Summary (continued)

<table>
<thead>
<tr>
<th>Pulse/SAM Version</th>
<th>Supported Platforms</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse R2.0</td>
<td>Windows Mobile (6.0, 6.1, and 6.5)</td>
<td>Pulse for Windows Mobile smart phone app; available for download from juniper.net.</td>
<td>If you install the Pulse 2.0 mobile client on a Windows Mobile device that already has Pulse R1.0, the installation detects the presence of the old client and removes it prior to installing the new client. It also detects and removes Host Checker. Host Checker is not supported. If Pulse R2.0 for Windows Mobile is installed on a Windows Mobile device, the user should not use a browser to sign into a realm that has Pulse R1.0 enabled. Pulse R1.0 cannot detect if Pulse R2.0 for Windows Mobile is already installed, and so it prompts the user to install Pulse R1.0. <strong>NOTE:</strong> If Pulse R2.0 is installed on a Windows Mobile device, and the user connects to a role that has Host Checker enabled, the user is prompted to install Host Checker. However, if the user allows the installation, nothing happens. To avoid this scenario, you should create a separate role for Pulse R2.0 for Windows Mobile devices. Pulse 2.0 for Windows Mobile supports the optional Pulse Mobile Security Suite.</td>
</tr>
<tr>
<td></td>
<td>Junos Pulse R2.0 is supported on touch-based Windows Mobile devices only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulse R3.0 and later</td>
<td>Windows XP</td>
<td>Pulse R3.0 incorporates SAM functionality as a native Pulse connection method.</td>
<td>Supports Host Checker.</td>
</tr>
<tr>
<td>Included with Pulse Secure Access Service software R7.2 and later.</td>
<td>Windows Vista</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This section describes how to configure Junos Pulse Secure Access Service to support Windows endpoints. Pulse Secure Access Service also supports a Java-based SAM client (JSAM). The JSAM client can be deployed from a Pulse Secure Access server to any endpoint that supports Java.

To enable SAM for Windows endpoints and configure a role:

1. Log in to the Pulse Secure Access Service admin console.
2. Select **User Roles** > **New User Role**.
3. On the New Role page, specify a name for the role and, optionally, a description. Make note of the name because later in this procedure, you create a realm and map realm users to this role.
4. In the Options section, select **Junos Pulse**.
NOTE: If you leave the Junos Pulse check box cleared, and then enable Secure Application Manager, Windows version in the Access Features section, you enable the Pulse/SAM for the Pulse for Windows Mobile smartphone app. The Junos Pulse check box must be selected to enable the role for Pulse for Windows endpoints.

5. In the Access Features section of the New Role page, select the Secure Application Manager check box and then select Windows version.

6. Click Save Changes to create the role and to display the role configuration tabs.

The General tab options (Restrictions (which includes Host Checker), VLAN/Source IP, Session Options, and UI Options) are all valid settings for a SAM role.

We recommend that you use resource profiles to specify the applications available to users, but you can use role settings instead.

To specify applications for SAM to secure as part of a role:

1. Open the role you created for Pulse/SAM.
2. Click the SAM tab.
3. In the Applications section, click Add Application or select an existing application in the list and then click Add Duplicate.
4. In the Details section, select a type from the Type list, and then specify a name and description.
   
   If you select Custom to specify an application that is not included in the list, the Application Parameters section appears. Specify the following:
   
   • Filename—Specify the name of the file’s executable file
   • Path—Specify the file’s path
   • MD5 Hash—Optionally specify the MD5 hash of the executable file. If you enter an MD5 hash value, Pulse verifies that the checksum value of the executable matches this value. If the values do not match, Pulse notifies the user that the identity of the application could not be verified and does not allow access.

   If you select Pick a Resource Profile, and at least one application or destination has been configured as a Resource Profile SAM client application, a selection list appears and you can click a Resource Profile. Then, when you click Save Application or Save + New, the role is added to the profile’s list of roles, and the profile’s resource polices are updated. If there are no Resource Profile SAM client applications or destinations configured, this option is not available.

5. Click Save Application or Save + New.
To specify servers for SAM to secure as part of a role:

1. Open the role you created for Pulse/SAM.
2. Click the SAM tab.
3. In the Applications section, click Add Server or select an existing server in the list and then click Add Duplicate.

   If you select Standard, specify a name and a description, and then identify the server by name or IP address.

   If you select Pick a Resource Profile, a selection list appears and you can click a Resource Profile. Then, when you click Save Application or Save + New, the role is added to the profile’s list of roles, and the profile’s resource polices are updated.

4. Click Save Application or Save + New.

To specify options for the SAM role:

1. Open the role you created for Pulse/SAM.
2. Click the SAM tab.
3. Click Options.
4. Make sure Windows SAM is enabled, and then choose from the following:
   - Secure Application Manager options:
     - Auto-launch Secure Application Manager—If you enable this option, Pulse Secure Access Service automatically launches Secure Application Manager services when a user signs in through the Secure Access Service Web portal. If you do not select this option, users must manually start the Secure Application Manager from the Client Applications Sessions section of the Web portal.
     - Auto-allow application servers—If you enable this option, Pulse Secure Access Service automatically creates a SAM resource policy that allows access to the servers specified for the role in the SAM tab application and server lists.
   - Windows SAM Options:
     - Auto-uninstall Secure Application Manager—This setting is a not applicable to Pulse R3.0 or later. It applies to the previous WSAM client software only. If you enable it, it is ignored for connections that use Pulse R3.0 or later.
     - Prompt for username and password for intranet sites—If you enable this option, the Pulse Secure Access Service requires users to enter sign-in credentials before connecting to sites on your internal network. This option changes Internet Explorer’s intranet zone setting so that Internet Explorer always prompts the user for network sign-in credentials for an intranet site.
     - Auto-upgrade Secure Application Manager—This setting is a not applicable to Pulse R3.0 or later. It applies to the previous WSAM client software only. If you enable it, it is ignored for connections that use Pulse R3.0 or later.
• Resolve only hostnames with domain suffixes in the device DNS domains—If you enable this option, users can only browse to Web sites that are part of their login domain.

• Session start script and Session end scripts—You can specify a script (.bat, .cmd, or .exe) to run on the users endpoint after Pulse connects and disconnects. For example, you can specify a script that maps network drives on an endpoint to shares on protected resources when the user connects. The script must be in a location (either local or on the network) that is accessible by the user.

5. Click **Save Changes**.

To use resource profiles to specify the applications available to Junos Pulse users:

1. Create resource profiles that enable access to client applications and destinations and configure the appropriate settings. Select **Users > Resource Profiles > SAM > Client Applications**.

2. Click **New Profile**.

3. From the Type list, select **WSAM**.

4. From the Application list, select one of the following options:
   - Custom—When you select this option, you must manually enter your custom application’s executable filename (such as telnet.exe). Additionally, you can specify this file’s path and MD5 hash of the executable file (although it is not required that you specify the exact path to the executable). If you enter an MD5 hash value, SAM verifies that the checksum value of the executable matches this value. If the values do not match, SAM notifies the user that the identity of the application could not be verified and does not forward connections from the application to the server.
   - Lotus Notes—Select this option to have SAM intermediate traffic from the Lotus Notes fat client application.
   - Microsoft Outlook—Select this option to have SAM intermediate traffic from the Microsoft Outlook application.
   - NetBIOS file browsing—Select this option to have SAM intercept NetBIOS name lookups in the TDI drivers on ports 137 and 139.
   - Citrix—Select this option to have SAM intermediate traffic from Citrix applications.
   - Domain Authentication—Select this option to allow integrated Windows applications, such as file sharing, Outlook, and so forth to authenticate to the domain controller when the client machine is part of a domain. Before using this option, you must:
     - Specify domain controllers that are reachable through the Pulse Secure Access Service in the WSAM Destination list so that LDAP and Kerberos traffic can be proxied and sent to the Pulse server.
     - Configure a WSAM Access Control Policy to allow access to all domain controllers.
NOTE: You can configure access to a standard application once per user role. For example, you can enable one configuration of Microsoft Outlook and one configuration of Lotus Notes for the “Users” role.

5. Enter a unique name and optionally a description for the resource profile.

6. In the Autopolicy: SAM Access Control section create supporting auto policies and assign the policies to the role:
   a. If it is not already enabled, select the Autopolicy: SAM Access Control check box.
   b. In the Resource field, specify the application server to which this policy applies. You can specify the server as a hostname or an IP/netmask pair. You can also include a port.
      If you select Domain Authentication from the Application list, enter your domain controller server addresses into the Resource field. You can add multiple domain controller servers if more than one is available.
   c. From the Action list, select Allow to enable access to the specified server or Deny to block access to the specified server.
   d. Click Add.

7. Click Save and Continue.

8. In the Roles tab, select the roles to which the resource profile applies and click Add.

   The selected roles inherit the autopolicy created by the resource profile. If it is not already enabled, the server also automatically enables the SAM option in the roles General > Overview page for all of the roles you select.

9. Click Save Changes.

10. Select Users > User Realms > New User Realm.

11. Specify a name and, optionally, a description and then click Save Changes to create the realm and to display the realm option tabs.

12. On the Role Mapping tab for the realm, create a new rule that maps all users to the role you created earlier in this procedure.

You can also use resource profiles to configure destination servers, network subnets and hosts and then add the resource profile to a role.

To use resource profiles to specify the network endpoints available to Junos Pulse users:

1. In the admin console, choose Users > Resource Profiles > SAM > WSAM Destinations.
2. Click New Profile.
3. Enter a unique name and optionally a description for the resource profile.
4. In the WSAM Destinations section, specify which servers you want to secure using WSAM and click **Add**. You can specify the servers as hostname or IP/netmask pairs. You can also include a port.

5. Select the **Create an access control policy allowing SAM access to this server** check box (enabled by default) to enable access to the server specified in the previous step.

6. Click **Save and Continue**.

7. In the Roles tab, select the roles to which the resource profile applies and click **Add**.

   The selected roles inherit the autopolicy created by the resource profile.

---

**Related Documentation**

- Junos Pulse for Windows Mobile Overview on page 257
- Configuring Junos Pulse Secure Access Service for Windows Mobile Endpoints on page 259
- Task Summary: Configuring JSAM
- Specifying Role-Based Source IP Aliases

---

**Pulse Connection Set Options for Pulse Secure Access Service**

A Junos Pulse client connection set allows you to configure specific connection policies for client access to any Pulse server. The following options are applied to each connection added to the connection set.

- **Allow saving logon information**—Controls whether the Save Settings check box is available in login credential dialog boxes in the Junos Pulse client. If you clear this check box, the Junos Pulse client always requires users to provide credentials. If you select this check box, users have the option of saving their credentials.

The Junos Pulse client can retain **learned user settings**. These settings are retained securely on the endpoint, evolving as the user connects through different gateways and methods. The Junos Pulse client can save the following settings:

- Certificate acceptance
- Certificate selection
- Realm
- Username and password
- Proxy username/password
- Secondary username/password
- Role
NOTE: If the authentication server is an ACE server or a Radius server and authentication is set to Users authenticate using tokens or one-time passwords, Pulse ignores the Allow saving logon information option. If the user sees a username and token prompt and the Save Settings check box is disabled. Pulse supports soft token, hard token and smart card authentication.

When a user opts to save settings, that information is used for each subsequent connection without prompting. If a setting changes, (for example, if a user changes a password), the saved setting is invalid and connection attempts fail. In this case, the user must use the client’s Forget Saved Settings feature. The Forget Saved Settings feature clears all user saved settings, and Junos Pulse prompts the user for required information on connection attempts.

- **Allow user connections**—Controls whether connections can be added by the user.
- **Display splash screen**—Clear this check box to hide the Pulse splash screen that normally appears when the Pulse client starts.
- **Dynamic certificate trust**—Determines whether users can opt to trust unknown certificates. If you enable this check box, a user can ignore warnings about invalid certificates and connect to the target Pulse server.
- **Dynamic connections**—Allows connections within this connection set to be automatically updated or added to a Junos Pulse client when the user connects to the Pulse server through the user Web portal. Dynamic connections are created as manual rather than automatic connections, which means that they are run only when the user initiates the connection or the user browses to a Pulse Server and launches Pulse from the server’s Web interface.
- **FIPS mode enabled**—Enable FIPS mode communications for all Pulse connections in the connection set. The Federal Information Processing Standard (FIPS) defines secure communications for the U.S. government. When a Pulse connection is operating in FIPS mode, **FIPS On** appears in the lower corner of the Pulse client interface.

NOTE: This option is available only when the Pulse server hardware supports FIPS mode operations.

NOTE: Application acceleration is not available for a connection that is operating in FIPS mode.
NOTE: Users cannot enable FIPS mode for connections that are created on the client. You must deploy connections with FIPS mode enabled using a pre-configured connection set with FIPS mode enabled or have users establish a browser session to the FIPS enabled Pulse server.

- **Wireless suppression**—Disables the endpoint’s wireless access when a wired connection is available. Wireless suppression occurs only when the wired connection is connected and authorized.

If the wired connection is removed, Pulse enables the wireless connections with the following properties:

- Connect even if the network is not broadcasting.
- Authenticate as computer when computer information is available.
- Connect when this network is in range.

NOTE: If you enable wireless suppression, be sure to also configure a connection that enables the client to connect through a wired connection.

**Related Documentation**
- Junos Pulse Secure Access Service Overview on page 70
- Creating a Client Connection Set for Junos Pulse Secure Access Service on page 107
- Junos Pulse Connection Options on page 101
- FIPS Supported Platforms

**Junos Pulse Connection Options**

When you create a connection for a connection set, you must choose a connection type. Table 8 on page 102 lists the options available for each connection type.
<table>
<thead>
<tr>
<th>Table 8: Pulse Connection Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UAC (802.1X) options</strong></td>
</tr>
<tr>
<td><strong>Adapter type</strong>—Specifies the type of adapter to use for authentication: wired or wireless.</td>
</tr>
<tr>
<td><strong>Outer username</strong>—Enables a user to appear to log in anonymously while passing the actual login name (called the inner identity) through an encrypted tunnel. As a result, the user’s credentials are secure from eavesdropping, and the user’s inner identity is protected. In general, enter <strong>anonymous</strong>, which is the default value. In some cases, you might need to add additional text. For example, if the outer identity is used to route the user’s authentication to the proper server, you might be required to use a format such as <a href="mailto:anonymous@acme.com">anonymous@acme.com</a>. <strong>NOTE:</strong> If you leave the box blank, the client passes the user’s or the machine’s login name (inner identity) as the outer identity.</td>
</tr>
<tr>
<td><strong>Scan list</strong>—If you selected wireless as the adapter type, the scan list box is available to specify the SSIDs to connect to in priority order. If you leave the list empty, the user can connect to any available wireless network.</td>
</tr>
<tr>
<td><strong>Support Non-broadcast SSID</strong>—Allow a user to connect to a non-broadcast wireless network from within the Pulse interface.</td>
</tr>
<tr>
<td><strong>Server certificate DN</strong>—If you are using certificate authentication, specify the server certificate distinguished name (DN) and its signing certificate authority (CA). An empty DN field allows a client to accept any server certificate signed by the selected CA.</td>
</tr>
<tr>
<td><strong>Trusted Server List for 802.1X Connection</strong></td>
</tr>
<tr>
<td><strong>Allow user to override connection policy</strong>—Allows a user to override the connection policy by manually connecting or disconnecting. Typically, you leave this option selected to make sure that a user can establish a connection under all conditions. If you disable this check box, the user cannot change the endpoint’s connection status, suspend or resume a connection to Pulse Secure Access Service, or shut down Junos Pulse.</td>
</tr>
<tr>
<td><strong>Support Remote Access (SSL VPN) or LAN Access (UAC) on this connection</strong>—Specifies that the connection is used for network connectivity. This option must be selected if this connection is for Pulse Access Control Service. If the connection is for Pulse Secure Access Service, you can disable this check box and use the connection for accessing Pulse Collaboration meetings only by also selecting Enable Junos Pulse Collaboration integration on this connection.</td>
</tr>
<tr>
<td><strong>Enable Junos Pulse Collaboration integration on this connection</strong>—Specifies that the connection is used for Pulse Collaboration Suite meetings. This option must be enabled if this connection is for Pulse Access Control Service. If the connection is for Pulse Secure Access Service, you can enable this check box and use the connection for accessing Pulse Collaboration meetings. You can enable a connection for Pulse Secure Access Service to be used for remote access only, for Pulse Collaboration integration only, or for both remote access and Pulse Collaboration integration. If you do not select either option, an error occurs when you save changes to this connection.</td>
</tr>
<tr>
<td><strong>This server</strong>—Specifies that you want the endpoint to connect to this Pulse server. Clear this check box to enable the edit box of the URL field and to specify a different Pulse server.</td>
</tr>
<tr>
<td><strong>URL</strong>—Allows you to specify a URL for a different Pulse server as the default connection. Specify a different server’s URL to create connections for other Pulse servers in your network.</td>
</tr>
</tbody>
</table>
Table 8: Pulse Connection Options (continued)

<table>
<thead>
<tr>
<th>SRX options</th>
<th>Address</th>
<th>Specifies the location (hostname or IP address) of the firewall.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><em>Allow user to override connection policy</em></td>
<td>Allows a user to override the connection policy by manually connecting or disconnecting. Typically, you leave this option selected to make sure that a user can establish a connection under all conditions. If you disable this check box, the user cannot change the endpoint’s connection status or shut down Junos Pulse.</td>
</tr>
<tr>
<td>App Acceleration options</td>
<td><em>Allow user to override connection policy</em></td>
<td>Allows a user to override the connection policy by manually connecting or disconnecting. Typically, you leave this option selected to make sure that a user can establish a connection under all conditions. If you disable this check box, the user cannot change the endpoint’s connection status or shut down Junos Pulse.</td>
</tr>
<tr>
<td></td>
<td><em>NOTE:</em> For connections that use application acceleration, if Kaspersky software is installed on the Pulse client endpoint, it must be configured to allow traffic on UDP port 3578.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Community string</em></td>
<td>The Junos Pulse client and the Pulse Application Acceleration Service can form an adjacency only if they belong to the same community as identified by the community string. When you create an App Acceleration connection, be sure the community string for the connection matches the community string defined in the Pulse Application Acceleration Service.</td>
</tr>
</tbody>
</table>

Connection is Established Settings

For all connection types, you specify how the connection is established, manually or automatically. The options vary according to the type of connection. Automatic connections include machine authentication and credential provider connections.

Connections can be established using the following options:

- **Manually by the user**—When the endpoint is started, the Junos Pulse client software is started, but no connection is attempted. The user must use the Junos Pulse client user interface to select a connection.

- **Automatically after user signs into the desktop**—When the endpoint is started and the user has logged in to the endpoint, the Junos Pulse client software connects automatically. For App Acceleration connections, automatically is the default because Pulse forms an adjacency with Pulse Application Acceleration Service automatically if the service is available.

  *NOTE:* All connections on an endpoint that are configured to start automatically attempt to connect to their target networks at startup time. To avoid multiple connection attempts, be sure that only one connection is configured to start automatically, or configure location awareness rules.

- **Automatically when the machine starts. Machine credentials used for authentication**—Enables machine authentication, which requires that Active Directory is used as the authentication server and that machine credentials are configured in Active Directory.
NOTE: If the machine and user have different roles, each role should map to the same connection set. Otherwise, after the user connects, the existing connection set might be replaced.

NOTE: When you use machine credentials for authentication and no user credentials, Pulse cannot perform user based tasks. The following tasks can be run only when the user is logged in:

- Run session scripts
- Detect or modify proxy settings
- Run automatic Pulse client upgrade
- Install or upgrade Pulse components

- Automatically when the machine starts. Connection is authenticated again when the user signs in to the desktop—Enables machine authentication for the initial connection. After the user connects with user credentials, the machine authentication is dropped. When the user logs out, the machine authentication connection is restored.

- Automatically at user login—Enables Pulse client interaction with the credential provider software on the endpoint. The user credentials are used to establish the authenticated Pulse connection to the network, log in to the endpoint, and log in to the domain server.

NOTE: This label changed at Pulse Secure Access Service R7.3. If you had selected the old label for a Pulse connection, Automatically during desktop authentication. User is presented with the Junos Pulse credential tile at the logon screen, it is automatically converted to the new label, Automatically at user login when you upgrade the system from R7.2.

- Automatically when the machine starts. Connection is authenticated again at user login—Enables Pulse client interaction with the credential provider software on the endpoint. Machine credentials are used to establish the authenticated Pulse connection to the network. When the user provides user credentials, the connection is authenticated again. In one typical use case, the machine credentials provide access to one VLAN, and the user credentials provide access to a different VLAN.

### Location Awareness Rules

For connections that are set to have the connection established automatically, you can define location awareness rules.

**According to location awareness rules**—Location awareness rules enable an endpoint to connect conditionally. For example, the endpoint connects to Pulse Access Control Service if it is connected to the company intranet or it connects to Pulse Secure Access
Service if it is in a remote location. Split tunneling must be enabled to allow resolution of location awareness rules.

A Pulse connection uses the IP address of a specified interface on the endpoint to determine its network location. Each location awareness rule includes the following settings:

- **Name**—A descriptive name, for example, “corporate-DNS.” A name can include letters, numbers, hyphens, and underscores.
- **Action**—The method the connection uses to discover the IP address. Choose one of the following values:
  - **DNSServer**—Allows the endpoint to connect if the endpoint’s DNS server on the specified interface is set to one of the specified values. Use the condition box to specify IP addresses or address ranges.
  - **ResolveAddress**—Allows the endpoint to connect if the hostname specified in the DNS Name box can be resolved by the DNS server for the specified interface. If one or more address ranges are specified in the Address Range box, the address must resolve to one of the ranges to satisfy the expression.
  - **Endpoint Address**—Allows the endpoint to connect if the IP address of the specified interface is within a range specified in the IP Address Range box.

**Machine Connection Preferences**

The Machine Connection Preferences appear if you have selected one of the machine authentication options for how the connection is established. Normally Pulse presents a selection dialog box if more than one realm or role is available to the user. However, a connection that is established through machine authentication fails if a dialog box is presented during the connection process. To suppress the selection dialogs, either ensure that only one role and realm is available to users, or specify a preferred realm and role for this connection.

- **Preferred Machine Realm**—Specify the realm that this connection uses when establishing the machine connection. The connection ignores any other realm available for the specified login credentials
- **Preferred Machine Role Set**—Specify the role or the name of the rule for the role set that this connection uses when establishing the machine connection. The role or rule name used must be a member of the preferred machine realm.

**User Connection Preferences**

The User Connection Preferences options enable you to specify a realm and role for automatic connections that would otherwise present a selection dialog box to the user. To suppress the selection dialogs, either ensure that only one role and realm is available to users or specify a preferred realm and role for this connection.

- **Preferred User Realm**—Specify the realm for this connection that is used when a user logs onto the endpoint. The connection ignores any other realm available for the user’s login credentials
• **Preferred User Role Set**—Specify the preferred role or the name of the rule for the role set to be used for user authentication. The role or rule name must be a member of the preferred user realm.

• The **Select client certificate from machine certificate store** option enables you to specify the location of the client certificate on a Windows endpoint as part of a Pulse connection that verifies the identity of both the machine and the user before establishing a connection. When this check box is selected, the Pulse connection looks at client certificates located in the Local Computer personal certificate store. When this check box is not selected, the connection accesses the user certificate store a Windows endpoint. For more information, see “Machine and User Authentication Through a Pulse Connection for Pulse Secure Access Service” on page 92.

**Pre-login Connection Preferences**

The following Pre-login Connection Preferences appear if you select Automatically at user login or Automatically when machine starts. Connection is authenticated again at user login, as the Connection is established option:

• **Pre-login maximum delay**—The time period (in seconds) that a Windows client waits for an 802.1x connection to succeed during the login attempt. The range 1 to 120 seconds.

• **Pre-login user based virtual LAN**—If you are using VLANs for the machine login and the user login, you can enable this check box to allow the system to make the VLAN change.

**Related Documentation**

• Configuring Location Awareness Rules for Junos Pulse on page 50

• Creating a Client Connection Set for Junos Pulse Secure Access Service on page 107

• Preferred Realm and Role for Junos Pulse Machine Authentication on page 41

• Machine and User Authentication Through a Pulse Connection for Pulse Secure Access Service on page 92

**Securing the Connection State on the Junos Pulse Client**

To disable user interaction with Pulse connections on the endpoint, you can configure Junos Pulse connections so that when they are deployed to the endpoint, users cannot shut down a connection, suspend or resume a connection to Pulse Secure Access Service, or shut down Pulse. Disabling user interaction with Pulse enables the Pulse administrator to control how endpoints connect to the network without allowing the user to override administrative control. For example, if you use machine authentication, the connection from endpoint to server is established automatically. By locking down the Pulse endpoint, users cannot change their connection.

To secure the Pulse endpoint from the Pulse Access Control server:

1. Click **Users > Junos Pulse Connections**.

2. Edit or create a new connection.
3. Disable the check box labeled **Allow user to override connection policy**.

**Related Documentation**
- [Client Connection Set Options for Junos Pulse Access Control Service](#) on page 26
- [Endpoint Security Monitoring and Management for Pulse Access Control Service](#) on page 55
- [Machine Authentication for Pulse Access Control Service](#) Overview on page 38

---

**Creating a Client Connection Set for Junos Pulse Secure Access Service**

To create a Junos Pulse connection:

1. From the admin console, select **Users > Junos Pulse > Connections**.
2. Click **New**.
3. Enter a name and, optionally, a description for this connection set.

   **NOTE:** You must enter a connection set name before you can create connections.

4. Click **Save Changes**.
5. From the main Junos Pulse Connections page, select the connection set.
6. Under Options, select or clear the following check boxes:
   - **Allow saving logon information**—Controls whether the Save Settings check box is available in login credential dialog boxes in the Junos Pulse client. If you clear this check box, the Junos Pulse client always requires users to provide credentials. If you select this check box, users have the option of saving their credentials.
   - **Allow user connections**—Controls whether connections can be added by the user through the Pulse client interface.
   - **Display splash screen**—Clear this check box to hide the Pulse splash screen that normally appears when the Pulse client starts.
   - **Dynamic certificate trust**—Determines whether users can opt to trust unknown certificates. If you select this check box, a user can ignore warnings about invalid certificates and connect to the target Pulse server.
   - **Dynamic connections**—Allows new connections to be added automatically to a Junos Pulse client when it encounters new Pulse servers through the Web browser.
   - **FIPS mode enabled**—Enable FIPS mode communications for all Pulse connections in the connection set. The Federal Information Processing Standard (FIPS) defines secure communications for the U.S. government. When a Pulse connection is operating in FIPS mode, **FIPS On** appears in the lower corner of the Pulse client interface.
NOTE: This option is available only when the Pulse server hardware supports FIPS mode operations.

NOTE: Application acceleration is not available for a connection that is operating in FIPS mode.

NOTE: Users cannot enable FIPS mode for connections that are created on the client. You must deploy connections with FIPS mode enabled using a pre-configured connection set with FIPS mode enabled or have users establish a browser session to the FIPS enabled Pulse server.

- **Wireless suppression**—Disables wireless access when a wired connection is available. Wireless suppression occurs only when the wired connection is connected and authorized.

7. Under Connections, click **New** to define a new connection.

8. Enter a name and, optionally, a description for this connection.

9. Select a type for the connection and then specify the connection. Type can be any of the following:
   - **UAC (802.1X)**—Select this type if the connection establishes connectivity to an 802.1X wired or wireless device.
   - **SSL VPN or UAC (L3)**—Select this type to define a connection for Pulse Secure Access Service or Pulse Access Control Service.
   - **SRX**—Select this type to define a connection to an SRX Series Services Gateway.
   - **App Acceleration**—Select this type to define a connection to the Pulse Application Acceleration Service.

   The connection configuration options that appear depend on the connection type you select.

10. After you have created the client connection set, create a client component set and select this connection set.

### Related Documentation

- Component Set Options for Junos Pulse Secure Access Service on page 113
- Endpoint Security Monitoring and Management for Pulse Secure Access Service on page 116
- Configuring Location Awareness Rules for Junos Pulse on page 50
Junos Pulse FIPS Mode for Pulse Secure Access Service Overview

The United States Federal Information Processing Standard (FIPS) defines security and interoperability requirements for computer systems that are used by the U.S. government. Junos Pulse for Windows, iOS, and Android support FIPS mode operations when communicating with Junos Pulse Secure Access Service and Junos Pulse for Windows supports FIPS mode operations when communicating with Junos Pulse Access Control Service. When it is operating in FIPS mode, FIPS On appears in the bottom corner of the Pulse for Windows client.

You enable FIPS mode operations when you configure Pulse connections on the server. You enable FIPS mode operations for a connection set. That connection set can include any or all of the four types of Pulse connections:

- **(UAC (802.1X)**—Pulse client uses FIPS mode cryptography for authentication but it uses default Microsoft cryptography for the WEP/WPA wireless encryption.
- **SSL VPN or UAC (L3)**—FIPS mode cryptography is supported.
- **SRX**—FIPS mode cryptography is not supported.
- **App acceleration**—FIPS mode cryptography is not supported.

**NOTE:** Application acceleration is not available for a connection that is operating in FIPS mode.

**NOTE:** Users cannot enable FIPS mode for connections that are created on the client. You must deploy connections with FIPS mode enabled using a pre-configured connection set with FIPS mode enabled or have users establish a browser session to the FIPS enabled Pulse server.

Endpoint Requirements

Pulse supports FIPS mode on Windows Vista and later Windows versions. FIPS is not supported by the Pulse OS X client.

To support client certificate private key operations, the security policy on the endpoint must have FIPS enabled. To verify that FIPS is enabled, use the Microsoft Management Console (MMC). Make sure that the Group Policy Snap-in is installed, and then open the following item:


Scroll through the Policy list and make sure that the following policy is enabled:

System cryptography: Use FIPS compliant algorithms for encryption, hashing and signing...
Configuration Overview

The Pulse client includes all components required for FIPS mode communications. To enable FIPS mode communications, deploy one or more Pulse connections to the client that are FIPS enabled. Figure 10 on page 110 shows the check box in the Pulse connection set configuration screen that enables FIPS mode operations for all connections in the connection set.

Figure 10: Enabling FIPS Mode for Pulse Connections

NOTE: If the Pulse server hardware does not support FIPS mode operations, FIPS mode configuration options are not present in the admin console interface.

Related Documentation

- Understanding Juniper Networks FIPS Level 1 Support
- Enabling FIPS Level 1 Support
- Creating a Client Connection Set for Junos Pulse Secure Access Service on page 107
- FIPS Supported Platforms
Configuring Location Awareness Rules for Junos Pulse

The location awareness feature enables a Junos Pulse client to recognize its location and then make the correct connection when the connection is set to connect automatically. For example, a Pulse client that is started in a remote location automatically connects to Junos Pulse Secure Access Service. But that same client automatically connects to Pulse Access Control Service when it is started in the corporate office.

NOTE: Split tunneling must be enabled to allow resolution of location awareness rules.

NOTE: Location awareness and session migration are similar because they both simplify connectivity for the user, but they do so under different conditions. With location awareness, the Pulse client makes a decision on where to connect when a user logs in to the computer. Session migration occurs when the user puts the computer into a stand by or hibernate mode without first logging out, and then opens the computer in a different network environment. Location awareness enables the Pulse client to intelligently start a new session. Session migration enables Pulse servers to intelligently migrate an existing session.

Location awareness relies on rules you define for each connection. If the conditions specified in the rules are true, Pulse attempts to make the connection. To set up the location awareness rules that select among many connections, you must define location awareness rules for each connection. Each location awareness rule is based on the endpoint’s ability to reach an IP address or resolve a DNS name over a specified network interface.

The following location awareness example includes two connections. The first connection is a Pulse Access Control Service connection that resolves to TRUE when the endpoint is connected to the corporate LAN. The second connection is Junos Pulse Secure Access Service connection that resolves to TRUE when the endpoint is located in a remote location.

Pulse Access Control Service connection

If the DNS server that is reachable on the endpoint's physical network interface is one of your organization's internal DNS servers, then establish the connection.

Pulse Secure Access Service connection

If the DNS server that is reachable on the endpoint's physical network interface is not one of your organization's internal DNS servers, and the DNS name of your Pulse Secure Access Service device resolves to the external facing IP address of the Pulse Secure Access Service device, then establish the connection.
NOTE: Connections can be set to manual, automatic, or controlled by location awareness rules. When the user logs in, the Pulse client attempts every connection in its connections list that is set to automatic or controlled by location awareness rules.

NOTE: To create a negative location awareness rule, you first create the positive state and then use rule requirement logic to use the rule as a negative condition.

To configure location awareness rules:

1. If you have not already done so, create a connection or open an existing connection.

   You can configure location awareness rules for Firewall connections and IC or SA connections. Location awareness rules do not apply to 802.1X or App Acceleration connections.

2. In the Connection is established area, select According to location awareness rules, and then click New.

3. Specify a name for the rule.

4. In the Action list, select one of the following:

   - **DNS server**—Connect if the DNS server associated with the endpoint’s network properties is (or is not) set to a certain value or set of values. Specify the DNS server IP address in the IP address box. Also specify a network interface on which the condition must be satisfied:
     - **Physical**—The condition must be satisfied on the physical interfaces on the endpoint.
     - **Junos Pulse**—The condition must be satisfied on the virtual interface that Junos Pulse creates when it establishes a connection.
     - **Any**—Use any interface.

   - **Resolve address**—Connect if the configured hostname or set of hostnames is (or is not) resolvable by the endpoint to a particular IP address. Specify the hostname in the DNS name box and the IP address or addresses in the IP address box. Also specify a network interface on which the condition must be satisfied.
NOTE: The Pulse client software evaluates IP and DNS policies on network interface changes. DNS lookups occur on DNS configuration changes or when the time-to-live setting (10 minutes) expires for a particular host record. If Pulse cannot resolve the host for any reason, it polls the configured DNS server list every 30 seconds. If the host had been resolved successfully previously and the time-to-live timer has not expired, the polling continues until the timer expires. If the host had not been resolved successfully previously, the resolution attempt fails immediately.

- **Endpoint Address**—Connect if a network adapter on the endpoint has an IP address that falls within or outside of a range or a set of ranges. Specify the IP address or addresses in the IP address box. Also specify a network interface on which the condition must be satisfied.

5. Click **Save Changes**.

After you create the rule or rules, you must enable each rule you want to use for the connection. To enable a negative form of a rule, use a custom version of the rule. To enable location awareness rules:

1. In the list of connection awareness rules for a connection, select the check box next to each rule you want to enable.

2. To specify how to enforce the selected location awareness rules, select one of the following options:
   - **All of the above rules**—The condition is TRUE and the connection is attempted only when all selected location awareness rules are satisfied.
   - **Any of the above rules**—The condition is TRUE and the connection is attempted when any selected location awareness rule is satisfied.
   - **Custom**—The condition is TRUE and the connection is attempted only when all selected location awareness rules are satisfied according to the Boolean logic you specify in the Custom box. Use the Boolean condition to specify a negative location rule. For example, connect to Pulse Secure access service when Rule–1 is false and Rule–2 is true. The boolean logic in the custom box would be: **NOT Rule-1 AND Rule-2**. The accepted Boolean operators are AND, OR, NOT, and the use of ( ).

3. Click **Save Changes**.

**Related Documentation**

- [Understanding Session Migration on page 149](#)

**Component Set Options for Junos Pulse Secure Access Service**

A Junos Pulse component includes specific software components that provide Pulse connectivity and services.
A component set options includes the following options:

- **All components**—Includes all components. The Enhanced Endpoint Security (EES) component, which is available only if you have purchased an EES license, is included only if the user’s assigned role requires it. Use the All components option only when you want client endpoints to be able to connect to all supported Pulse servers and to be able to use application acceleration. When you include the App Acceleration component, the disk space requirement for the Junos Pulse client installation increases to 300 MB.

- **No components**—Select this option to create an installer that only updates existing Pulse client installations, for example, to add a new connection. Do not use this option if you are creating an installer to add Pulse to endpoints that do not already have Pulse installed.

- **Minimal components**—Includes only the components needed to support the selected connections. For example, if the connection set you create includes an IC or SA connection, the component set includes only the components required to connect to Pulse Access Control Service or Pulse Secure Access Service. The Host Checker component is included as part of the minimal components configuration. The default is minimal components, which provides all needed components for the selected connections and limits the size of the Junos Pulse installation file.

Related Documentation

- Creating a Client Connection Set for Junos Pulse Secure Access Service on page 107

---

**Creating a Client Component Set for Junos Pulse Secure Access Service**

Client component options affect Web-based installations only. A preconfigured installer for a Windows endpoint always installs all components unless you specify the specific components you want using MSIEXEC command options. A preconfigured installer for an OS X endpoint always installs all components. To create a Pulse client component set:

1. From the admin console, select Users > Junos Pulse > Components.
2. Click New to create a new component set.
3. If you have not yet created a client connection set, select Users > Junos Pulse > Connections and create a new connection set. Or you can use the default client configuration, which permits dynamic connections, supports the outer username anonymous, and allows the client to automatically connect to Pulse Access Control Service or Pulse Secure Access Service.
4. Specify a name for the client component set.
5. (Optional) Enter a description for this client component set.
6. Select a connection set that you have created, or use the default connection set.
7. For Junos Pulse client components, select one of the following options:
   - All components—Includes all Junos Pulse components and supports all access methods and all features.
   - No components—Updates existing Pulse client configurations, for example, to add new connections. This option works on endpoints if they already have Pulse installed. Do not use this option if you are installing Pulse.
   - Minimal components—Includes only the components needed to support the selected connections. For example, if the connection set you create includes an IC or SA connection, the component set includes only the components required to connect to Pulse Access Control Service or Pulse Secure Access Service. The Host Checker component is included as part of the minimal components configuration. The default is minimal components, which provides all needed components for the selected connections and limits the size of the Junos Pulse installation file.

   **NOTE:** Do not deploy Pulse with minimal components and no connections. If you do so, the Pulse client is not able to connect to any devices and users are not able to create any connections from within the Pulse client interface.

   **NOTE:** Selecting Pulse components applies to a Web installation only. A preconfigured installer for a Windows endpoint always installs all components unless you specify the specific components you want using MSIEXEC command options. A preconfigured installer for an OS X endpoint always installs all components.

8. Click **Save Changes**.
9. After you create a component set, distribute the client to users through a role. When users access the role, the installer automatically downloads to the endpoint. The installer components and connections are applied to the endpoint client.

   If client connections associated with the component set for a role are changed even though the list of components has not, the existing configuration on the endpoint is replaced immediately if the endpoint is currently connected, or the next time the endpoint connects.

   If a user is assigned to multiple roles and the roles include different component sets, the first role in an endpoint’s list of roles is the one that determines which client (component set) is deployed.

**Related Documentation**
- Component Set Options for Junos Pulse Secure Access Service on page 113
You can configure and enable Host Checker policies to perform an endpoint security assessment before allowing the endpoint to connect. Host Checker is supported on the following operating systems:

- Windows
- Mac OS X
- Google Android
- Apple iOS
- Windows Mobile

You can invoke Host Checker at the role level or the realm level to specify access requirements for endpoints seeking authentication. Host Checker policies that are implemented at the realm level occur before the user is authenticated. Host Checker policies at the role level are implemented after authentication but before the user is permitted to access protected resources. When an endpoint first connects to Pulse Secure Access Service, the latest version of the IMC is downloaded to the host computer. The initial check can take 10-20 seconds to run. Outdated IMC files are automatically updated at subsequent checks.

**NOTE:** The first time an endpoint connects to Pulse Secure Access Service that has a patch assessment policy, if the connection is a Layer 2 connection, the IMC cannot download. In this case, you should configure a remediation role that displays instructions to direct the user to retry with a Layer 3 connection or to contact the administrator.

**NOTE:** If a realm has a Host Checker policy enabled that is for desktop clients, and a mobile device user employs a browser on the mobile device to connect to the Web portal, the login is denied because the desktop Host Checker program is not compatible with the mobile client OS. If Pulse mobile users are mapped to multiple roles, the login operation assigns them to a role where Host Checker is not enabled if possible. If all the roles have Host Checker enabled, the mobile users will not be allowed to login from the browser. You can create and enable Host Checker policies that are specific to each mobile operating system and then Host Checker runs when the Pulse client connects to the server.

For patch management on Windows systems, Host Checker uses a list of the most current patch versions from the vendor for predefined rules in the Host Checker policy. Host Checker does not scan for non-security patches. server and Host Checker manage the
flow of information between the corresponding pairs of TNC-based integrity measurement collectors (IMCs) and integrity measurement verifiers (IMVs). IMCs are software modules that run on the endpoint and collect information such as antivirus, antispyware, patch management, firewall, and other configuration and security information about the host. IMVs are software modules that run on the server and verify a particular aspect of a host's integrity. Each IMV works with the corresponding IMC on the client endpoint to verify that the endpoint meets the Host Checker rules. IMCs scan the endpoint frequently for changes in security status. For example, if the user turns off virus checking, the IMC can detect this and then trigger a new check to make sure the modified system complies with the requirements of the Host Checker policy. You can configure Host Checker to monitor third-party IMCs installed on client computers by using third-party IMVs that are installed on a remote IMV server.

You obtain the most current patch version information from a Juniper staging site. You can manually download and import the list into the SA Series Appliance, or you can automatically import the list from the Juniper staging site or your own staging site at a specified interval.

Monitoring is based on one or more specified products or on specific patches, though not in the same policy. For example, you could check for Internet Explorer Version 7 with one policy, and Patch MS00-039: SSL Certificate Validation Vulnerabilities with a second policy. Then, apply both policies to endpoints at the role or realm level to ensure that the user has the latest browser version with a specific patch. In addition, for Microsoft products, you can specify the severity level of patches that you want to ignore. For example, you could ignore low or moderate threats.

Remediation Options

Host Checker can identify issues on an endpoint. However, Host Checker and Pulse Secure Access Service cannot resolve issues, that is, perform remediation tasks, on non-compliant endpoints. To repair those issues Pulse Secure Access Service supports the following remediation options:

- Instructions to the user— server can send a message to the user describing the non-compliant patches or software and a link to where the user can obtain the required software. Figure 11 on page 118 shows a typical Pulse remediation message.
• Initiate SMS/SCCM remediation—For remediation using Microsoft System Center Configuration Manager (ConfigMgr or SCCM), formerly Systems Management Server (SMS), a preinstalled SMS/SCCM client on the endpoint is triggered by Host Checker to get patches from a preconfigured SMS/SCCM server. This mechanism installs only those patches that are published on the SMS/SCCM server.

• Initiate Shavlik remediation—SA Series SSL VPN Appliance software version 7.1 and later supports Shavlik remediation. After running Host Checker, if the endpoint requires remediation, the user can be prompted to install the required patches. You can configure remediation options to be launched automatically. The Shavlik patch deployment engine is downloaded to the endpoint. The engine links to the vendors’ patch repositories and installs the patches. Shavlik remediation is an optional licensed feature. Figure 12 on page 119 shows the Pulse client screens that a user sees when the Pulse server is configured with Host Checker and Shavlik remediation.
Figure 12: Pulse Client Screens for Shavlik Patch Remediation

Connect to: PNG-R

Checking compliance...  Cancel

User Name:

Password:

Connect to: PNG-R

Limited network access due to compliance issue.

Pulse needs to install some patches to complete the connection.

Note: Choosing Don’t install may result in limited or no connectivity.

Connect to: PNG-R

Limited network access
Update is in progress. You may close this dialog.
Once updating is complete you will be logged in to the network.

Install  Don’t install

Patch Installation:

Starting to install 24 patches...

Close
Issuing a Remediation Message with Junos Pulse Secure Access Service

If a Host Checker policy finds that an endpoint is not in compliance, Host Checker can display a message through the Pulse client interface that includes custom instructions and reason strings on how to bring the endpoint into conformance. The user must perform the steps described in the message before the endpoint is allowed to access protected resources.

To enable a remediation message for a Host Checker policy:

1. In the admin console, select Authentication > Endpoint Security > Host Checker.
2. In the Policies section, click New to create a new Host Checker policy.
3. As part of the Host Checker Policy, select Enable Custom Instructions.

   When you select this option, a text box appears. Enter the instructions to display to the user on the Host Checker remediation page. You can use the following HTML tags to format text and to add links to resources such as policy servers or web sites: <i>, <b>, <br>, <font>, and <a href>. For example:

   You do not have the latest signature files.

   <a href="www.company.com">Click here to download the latest signature files.</a>

4. Optionally, select Send reason strings. Select this option to display a message to users (called a reason string) that is returned by Host Checker or IMV and that explains why the client machine does not meet the Host Checker policy requirements. Reason strings describe to users what the IMV is checking on the client endpoint. This option applies to predefined rules, to custom rules, and to third-party IMVs that use extensions in the Juniper Networks TNC SDK.

5. Click Save Changes.

Be sure to include the Host Checker policy in the realm or role you configure for Pulse users.

Using SMS/SCCM Remediation with Junos Pulse Secure Access Service

Junos Pulse supports the Microsoft System Center Configuration Manager (ConfigMgr or SCCM), formerly Systems Management Server (SMS) download method for patch deployment. If Pulse Secure Access Service is configured for the SMS/SCCM method for
patch deployment, the Pulse client endpoint must have the SMS/SCCM client already installed on the endpoint, otherwise remediation fails.

Endpoints configured with SMS/SCCM for software management typically poll the server for updates every fifteen minutes or longer. In a worst-case scenario, clients that are not in compliance with existing Host Checker software requirements might have to wait until the next update interval to log in. Using the SMS/SCCM download method, you can force the client to initiate the software update immediately after the patch assessment check. If a user attempts to log in, and the endpoint does not have a required software version for compliance with a Host Checker patch assessment policy, Host Checker immediately notifies the client to poll the server for an immediate update. The client receives notification that an SMS/SCCM update has started.

To configure SMS/SCCM to update the client when notified, set the advertisement time on the SMS/SCCM to As soon as possible.

You assign clients to a particular group or collection on the SMS/SCCM server and then server can advertise patches for that collection. You can configure roles that correspond to collections and SMS/SCCM can send the appropriate patches for a particular role.

You must have the SMS/SCCM client installed and configured correctly on endpoints, and the SMS/SCCM server must be reachable. In a Layer 2 network, Host Checker is performed before the endpoint is connected to the network. Host Checker can obtain the IP address of the SMS/SCCM server configured for the client. If the endpoint is out of compliance and remediation is necessary, Host Checker pings the server IP address every 15 seconds until the server can be notified to update the client.

You should inform users of the expected behavior if this feature is enabled, as there is no notification to the user until the SMS/SCCM sends back the advertisement.

NOTE: Juniper Networks recommends only one patch deployment on an endpoint at any point in time. However, there is no way to determine if an SMS/SCCM update is in progress, and so it might be possible that the patch deployment engine is started while an SMS/SCCM Update is also occurring. (This scenario is possible if Pulse is connected to two devices with one using SMS/SCCM remediation and the other using the Shavlik patch deployment engine.) Most patches do not allow two instances to be running, so one of the remediation operations will fail.

The admin console allows you to select only one Host Checker patch remediation option (either SMS/SCCM or Shavlik) for all Host Checker policies.

If Pulse is connected to more than one Pulse server, and one uses SMS/SCCM remediation and the other uses Shavlik remediation, both requests are met. If both devices are configured to use Shavlik remediation, the requests are queued.
To enable SMS/SCCM assessment and remediation:

1. In the admin console, select Authentication > Endpoint Security > Host Checker.
2. In the Policies section, click New to create a new Host Checker policy.
4. Click Save Changes.

Be sure to include the Host Checker policy in the realm or role you configure for Pulse users.

Related Documentation
- Issuing a Remediation Message with Junos Pulse Secure Access Service on page 120
- Configuring Shavlik Remediation with Junos Pulse Secure Access Service on page 122

Configuring Shavlik Remediation with Junos Pulse Secure Access Service

Endpoints with Junos Pulse 2.0 or higher that are not in compliance with specified Host Checker patch policies can be updated with the required patches and brought into compliance automatically by the Shavlik patch deployment engine. The Host Checker IMC on the endpoint interfaces with the patch deployment engine to download and install missing patches reported by the IMV. Shavlik software runs on endpoints, downloads specified patches from vendors’ Web sites, and installs patches that are required through the Host Checker policy. Shavlik is an optional licensed feature.

**NOTE:** A separate license is required for Shavlik patch monitoring and deployment.

The Shavlik patch deployment engine is an executable file that is hosted on SA Series SSL VPN Appliance and then downloaded to endpoints as part of the Pulse deployment. During a remediation operation, the deployment engine downloads patches directly from vendor Web sites so Internet connectivity is needed for Shavlik remediation. The Shavlik patch deployment engine does not work with Layer 2 without Layer 3 connectivity.

All of the files required for patch assessment are a part of a Endpoint Security Assessment Plug-in (ESAP) from the Juniper Networks Customer Support Center ESAP packages beginning with SA Series SSL VPN Appliance software version 7.1.

The IMC and IMV software for patch monitoring is backward compatible. Since this feature is available from Pulse Release 2.0 onward, a new Pulse communicating with an older IMV (with Pulse support), or a new IMV communicating to an older IMC exhibit the same behavior as today. There should be no change in the patch assessment, and the Shavlik deployment engine is not invoked for remediation.
NOTE: Juniper Networks recommends only one patch deployment operation on an endpoint at any point in time. However, there is no way to determine if an SMS/SCCM update is in progress, and so it might be possible that the patch deployment engine is started while an SMS/SCCM Update is also occurring. (This scenario is possible if Pulse is connected to two devices with one using SMS/SCCM remediation and the other using the Shavlik patch deployment engine.) Most patches do not allow two instances to be running, so one of the remediation operations will fail.

The admin console allows you to select only one Host Checker patch remediation option (either SMS/SCCM or Shavlik) for all Host Checker policies.

If the Pulse client is connected to two Pulse servers, and one uses SMS/SCCM remediation and the other uses Shavlik remediation, both requests are met. If both devices are configured to use Shavlik remediation, the requests are queued.

To enable SMS/SCCM assessment and remediation:

1. In the admin console, select Authentication > Endpoint Security > Host Checker.
2. In the Policies section, click New to create a new Host Checker policy.
4. To allow users to decide whether to install patch updates, select Prompt the user for consent before automatic patch deployment.
   
   Deploying patches can take some time to complete. Some patches require a system reboot.
5. If you enable the user prompt for installing patches, select a default action. The default action runs automatically if the user does not respond to the prompt within 1 minute. Select one of the following default actions:
   
   - Deploy patches
   - Do not deploy patches
6. Click Save Changes.

Related Documentation

- Issuing a Remediation Message with Junos Pulse Secure Access Service on page 120
- Using SMS/SCCM Remediation with Junos Pulse Secure Access Service on page 120
- Importing Endpoint Security Assessment Plug-in (ESAP) Packages with NSM
- Host Checker and Trusted Network Computing

Enabling Enhanced Endpoint Security with Junos Pulse Secure Access Service

Host Checker includes integrated antispyware functionality that can detect and remediate Windows endpoints. Enhanced Endpoint Security (EES) ensures that malware, spyware,
viruses, or worms are not present on endpoints that attempt to connect to Pulse Secure Access Service, and that you can restrict or quarantine these endpoints according to your Host Checker policy configuration. When EES is running on an endpoint, the Pulse interface displays a security pane that shows EES status.

NOTE: By default, the base license allows two simultaneous endpoints to use this feature. You can purchase a separate license to enable additional users.

EES scans processes on endpoints, monitors file system write and execution operations, and can automatically remediate machines that are not in compliance. EES reports threats that are detected but not remediated. In some cases the user might be directed to reboot the machine to achieve compliance.

EES uses a signature database that is automatically downloaded to endpoints from Web Root Spy Sweeper servers on the Internet. The signature database is not hosted on the Pulse server. Endpoints must have access to the Internet for EES to run successfully. Additionally, if you configure default remediation roles, ensure that endpoints that are directed to remediation roles that can access *.webroot.com.

You can configure Pulse Secure Access Service to determine the acceptable age of the signature database. The age of the database is the threshold used to determine whether a user can access resources by passing a Host Checker policy. For example, if signatures are 5 days old, and you configure the age as 3 days, the endpoint is allowed to access resources. If you configure the age as 4 days, the endpoint fails the Host Checker policy. Signature updates are performed regularly so endpoints should generally have the most current updates.

If Internet connectivity is not available to an endpoint before it connects to Pulse Secure Access Service, and you have chosen to implement the option to check for signature age, the policy does not pass if the signatures are too old. For example, if a user has not accessed the endpoint for several days and the signatures are not up to date, the endpoint cannot access Pulse Secure Access Service. To avoid this issue, you should create a default remediation role that allows limited access to the Internet for signature updates at *.webroot.com.

Any endpoint that is configured for an EES scan at Layer 2 always fails the check. To permit a network connection, you should configure the realm to reassign users to a remediation VLAN. This allows endpoint users to connect and download the required signature updates, or if connecting for the first time, the EES installer package.

You configure EES on the Endpoint Security > Host Checker main page to ensure that multiple policies are not created, and that the same policy is used across all realms and roles for which you have enabled it. When you create a realm or a role, you can enable EES restrictions in addition to any other Host Checker policies.
NOTE: If you configure an EES policy for endpoints, a separate EES installer (about 5 MB) is downloaded to endpoints on their first attempt to access resources protected by a Host Checker EES policy. User endpoints are scanned for offending software, and signatures are automatically installed.

A significant amount of data is downloaded (approximately 5 MB for the installer and approximately 12 MB for the signatures), followed by the memory scan. After installation, signatures are updated and the memory scan is performed to verify that no spyware is loaded in memory. The download, update, and scan can take significant time to complete.

Any threat detected is automatically remediated by Host Checker and is not reported. If threats cannot be remediated, the endpoint reports back to the server. Roles and user sessions can be adjusted based on endpoint compliance. A number of user strings automatically notify the user of the compliance status.

To enable and use EES antispyware:

1. In the admin console, click Authentication > Endpoint Security > Host Checker.
2. Under Options, select the Advanced Endpoint Protection: Malware Protection tab.
4. To set the age of the signature definitions database, select the Signature definitions should not be older than check box. Enter the frequency in days (3 - 30). This number determines the maximum permissible age of signatures. It does not change the frequency of updates.
5. To enable an immediate EES scan in the background after allowing the network connection, select the Install EES and scan endpoints after network connection is established check box.

Choose this option to allow an immediate connection before the scan takes place. This option allows users to connect and to begin work more quickly. However, this option is less secure because it allows network access before the endpoint has been scanned for malware.
6. Click Save Changes.

When you create or configure realm or role Host Checker restrictions, you can select Enhanced Endpoint Security: Malware Protection to apply to that role or realm.

Related Documentation

- Issuing a Remediation Message with Junos Pulse Secure Access Service on page 120
- Configuring Shavlik Remediation with Junos Pulse Secure Access Service on page 122
- Using SMS/SCCM Remediation with Junos Pulse Secure Access Service on page 120

Pushing Junos Pulse Configurations Between Junos Pulse Servers of the Same Type

You can use the Push Configuration feature to centrally manage Junos Pulse connections, components, and uploaded Pulse packages. The Push Configuration feature enables
you to copy all configuration settings or selected configuration settings from one Pulse server to another Pulse server of the same type, for example, from one SA Series SSL VPN Appliance to another SA Series SSL VPN Appliance to another.

The following notes apply to pushing configurations:

- You can push to a single Pulse server or to multiple Pulse servers in one operation. You can push up to 8 targets per push operation. You can run up to 25 push operations simultaneously. The maximum number of targets is 200. If a push to a target Pulse server fails, the operation proceeds to the next target until all identified targets are updated. The results page displays the status and any problems encountered during the process.

- You can push to a Pulse server that is a member of a cluster as long as the target Pulse server is not a member of the same cluster as the source.

- Target Pulse servers can refuse pushed configuration settings. The default is to accept.

- After an update, the target Pulse server restarts its services. Brief interruptions might occur while the service restarts. We recommend that you push to targets when they are idle or when you can accommodate brief interruptions.

- Target Pulse servers do not display a warning message when they receive a pushed configuration.

- The target Pulse server automatically logs out administrators during the push process.

- The source and target Pulse servers must have the same build version and number.

- The administrator account on the source Pulse server must sign in to the target Pulse server without any human intervention. For example, you cannot have dynamic credentials or multiple roles that are not merged as these both require manual interaction.

Before you use Push Configuration, you must configure your system according to the following conditions:

- You must map to the .Administrators role, thereby creating a “super administrator” with full administration privileges. Modify Authentication > Auth Servers > Administrator Server > Users settings to add yourself to the .Administrators role.

- The target Pulse server administrator account must use static password authentication or two-factor tokens that do not use challenge/response type authentication. For example, certificates, Soft ID, and Defender Authentication are not supported. Modify administrators > Admin Realms > [Administrator Realm] > General settings to select the proper authentication server for the administrator realm.

- Do not configure the administrator account in a way that requires the administrator to select a role to sign in to the target Pulse server. For example, do not map a single user to multiple roles, including the Push Configuration administrator role, and then fail to merge those roles. We recommend creating an account exclusively for Push Configuration administrators to guarantee that the administrator does not need to choose a role during the sign-in process and to clearly distinguish the actions of Push Configuration administrators in your log files. Use the Administrators > Admin Realms...
[Administrator Realm] > Role Mapping settings to set the appropriate role-mapping rules.

To push Junos Pulse configurations from one Pulse server to other Pulse servers of the same type:

1. If you have not already done so, define the targets by selecting Maintenance > Push Config > Targets.
2. From the admin console, select Maintenance > Push Config > Push Configuration.
3. In the What to push box, select Selected configuration to display the configuration categories.
4. Scroll down the list and expand the item labeled Junos Pulse.
5. Select the Select All Configurations check box to push all Junos Pulse configurations on this Pulse server. Or choose none, all, or selected items from the following categories:
   - Junos Pulse Connections—Connection sets and connections.
   - Junos Pulse Components—Component sets.
   - Junos Pulse Versions—Pulse packages that were uploaded to the Pulse server.
6. Add the targets to the Selected Targets box.
7. Click Push Configuration.

**Related Documentation**
- Importing and Exporting Secure Access Service Configuration Files

**Enabling or Disabling Automatic Upgrades of the Junos Pulse Client**

After you deploy Junos Pulse client software to endpoints, software updates occur automatically. If you upgrade the Pulse client configuration on your Pulse server, updated software components are pushed to a client the next time it connects.

**NOTE:** When you configure Junos Pulse to make 802.1x based connections, a reboot might be required on Windows XP endpoints when Pulse is upgraded.

**NOTE:** A bound endpoint receives connection set options and connections from its binding server, but it can have its Pulse client software upgraded from any Pulse server that has the automatic upgrade option enabled. During a client software upgrade the client loses connectivity temporarily.

Pulse client software upgrades are enabled by default. To change the behavior of Pulse client upgrades:

1. From the admin console, select Maintenance > System > Options.
2. Set or clear the Enable automatic upgrade of Junos Pulse Clients check box.
3. Click **Save Changes**.

Related Documentation
- Upgrading Junos Pulse Client Software on page 67

**Upgrading Junos Pulse Client Software**

The software image for each supported Pulse server includes a Junos Pulse client software package. When a newer version of Pulse is available, you can upload the new software to the Pulse server. You can have more than one version of Pulse on a Pulse server but only one Pulse client package can be active. If you activate a new version of Pulse, and if the Pulse server's automatic upgrade option is enabled, connected Pulse clients display an upgrade prompt to the user. The user can choose to install the upgrade or cancel the operation. If a user cancels, the upgrade prompt appears each time the client connects to the server. During a client software upgrade the Pulse client loses connectivity temporarily.

**NOTE:** The automatic update feature is supported on Pulse Secure Access and Pulse Access Control servers only. SRX gateways do not support automatic Pulse software updates.

**NOTE:** When you configure Junos Pulse to make 802.1x based connections, a reboot might be required on Windows XP endpoints when Pulse is upgraded.

![Figure 13: Pulse Client Upgrade Message](image-url)
After you have staged the new Pulse software package in a location accessible to the Pulse server, use the following procedure to upload the software to the Pulse server:

1. In the device admin console, select Users > Junos Pulse > Components.
2. In the section labeled Manage Junos Pulse Client Versions, click Browse, and then select the software package.
3. Click Upload.

Only one Junos Pulse software package can be active at a time. After you upload a new package, you need to enable it.

To enable a Pulse package as the default:

1. In the admin console, select Users > Junos Pulse > Components.
2. In the section labeled Manage Junos Pulse Client Versions, select the radio button next to a version, and then click Activate.

### Integrating iPass Open Mobile with Junos Pulse for Windows Client

Junos Pulse Release 2.1 and later supports select third-party software integration. iPass Open Mobile Platform provides reliable, secure and high-performance deployment of iPass enterprise mobility services. Together Pulse and iPass expand secure access options for Windows XP, Windows Vista, and Windows 7 endpoints. Third-party application integration is supported by Junos Pulse Secure Access Service.

iPass Enterprise Mobility Services provide authorized connectivity to public networks for Pulse users. The user can connect to Wi-Fi, Mobile Broadband, or dial networks from the iPass Networks list when on the road. Once the Internet connection has been established, Junos Pulse provides a secure connection to the enterprise resources. iPass Enterprise Mobility Services provides authorized secure access to networks in restaurants, airports and in-flight Wi-Fi hot spots.

To enable application integration, you install an Advanced Connectivity license on the Pulse server. On the endpoint, the user must install iPass Open Mobile client software. The first time the user connects to the Pulse server where the advanced connectivity license is installed and enabled for the role, the license information is passed to the Pulse client, and then the iPass software is automatically integrated within the Pulse Connections pane. After integration, when the user is away from the corporate network, iPass automatically locates and enables connectivity to an authorized network. The user can then use Pulse to establish a VPN connection to the corporate network.

Integrating iPass and Pulse includes the following tasks:

- Install the Advanced Connectivity License on the SA Series SSL VPN Appliance.
- Enable third-party software integration for a role on the server where you installed the license.
Each Pulse endpoint must install iPass Open Mobile. See your iPass representative for iPass client software.

Each Pulse endpoint must connect to the role on the Pulse server that is enabled for third-party integration. This initial connection downloads the license information to the Pulse endpoint and enables the Pulse client for integration with iPass. If iPass is already installed on the Pulse endpoint, the iPass interface appears in the Pulse Connections pane a few moments after Pulse establishes the connection with the Pulse server.

To install the Advanced Connectivity license:

1. On the Pulse server, login as an administrator, and then click **System > Configuration > Licensing**.
2. Paste or type your license key into the License keys box and then click **Add**.

To enable third-party software integration for a role:

1. Click **Users > User Roles > Role Name > VPN Tunneling > Junos Pulse Settings**.
2. Click the check box labeled **Enable 3rd party connectivity integration**.

**NOTE:** The check box is present only after the Advanced Connectivity License has been installed on the system.

3. Click **Save Changes**.

**Related Documentation**

- Introducing Junos Pulse on page 3
- Configuring License Options

**Pulse Collaboration Suite Overview**

Junos Pulse Collaboration Suite (formerly Secure Meeting) allows users to schedule and attend secure online meetings. In meetings, users can share their desktops and applications with one another over a secure connection. Meeting attendees can collaborate by enabling remote-control of their desktops and through text chatting. Users can schedule meetings through the Pulse Secure Access Service user Web portal or, if they have the Microsoft Outlook Plug-in installed, through Microsoft Outlook.

In addition to regular meetings, Pulse Collaboration Suite supports Instant Meetings and Support Meetings. Instant meetings allow you to create meetings with static URLs for that particular type of meeting (for example, weekly status meetings). You do not need to schedule these types of meetings. The conductor starts the meeting and the invitees enter the URL to attend the meeting.

You can enable Pulse Collaboration Suite integration as part of a Pulse connection and push the connection to Pulse clients through an installer package or a configuration update. The SSL VPN or UAC (L3) connection type includes a check box that enables
Pulse Collaboration integration on the connection. When the check box is selected, Pulse clients that have installed that connection display new menu items that enable users to access Pulse Collaboration Suite functions. A connection that is enabled for meetings can serve as a normal SSL VPN connection or it can be dedicated to meetings only. When a Pulse user clicks the tray icon menu item for meetings, Pulse launches a browser window and connects to the server’s user Web portal.

**Task Summary: Configuring Pulse Collaboration Suite on the Pulse Secure Access Server**

The following summarizes how to enable a Pulse Secure Access server as a meeting server for Pulse Collaboration Suite meetings.

To configure Pulse Collaboration Suite:

1. In the Pulse Secure Access server admin console, click **System > Network > Overview** and specify a network identity for the server. Pulse Collaboration Suite uses this hostname when constructing meeting URLs for e-mail notifications.

2. Configure role-level settings:
   - To enable Pulse Collaboration Suite at the role level, click **Users > User Roles > Role Name > General**.
   - To configure role-level meeting restrictions, click **Users > User Roles > Role Name > Meetings > Options**.

3. Configure the authentication settings:
   - To specify the authentication servers meeting creators can access and search click **Users > User Roles > Role Name > Meetings > Auth Servers**.
   - To allow meeting creators to invite users from an LDAP server, click **Authentication > Auth. Servers > Select LDAP Server > Meetings**.

4. Configure meeting sign-in policies:
   - To customize the user Web portal pages that meeting attendees see when they sign into a meeting, click **Authentication > Signing In > Sign-in Pages**.
   - To define the URL that meeting participants use to join a meeting, click **Authentication > Signing In > Sign-in Policies > Meeting Policy**. You also use this page to associate a meeting page with the URL.
   - To associate your meeting sign-in policy with a user sign-in policy, click **Authentication > Signing In > Sign-in Policies > User Policy**. The Pulse Secure Access server applies the specified meeting URL to any meeting created by a user who signs into the associated user URL.

5. To configure system-level meeting settings, include session time-outs, SMTP server information, time zone settings, and color-depth settings, click **System > Configuration > Pulse Collaboration Suite** page of the admin console.

6. To enable client-side logging, click **System > Log/Monitoring > Client Logs > Settings**.

7. To view the logs that users push to the Pulse server, click **System > Log/Monitoring > Uploaded Logs**.
Configuring Pulse Connections to Support Meetings

When you configure a Junos Pulse connection to support Pulse Collaboration Suite meetings, Pulse users on Windows endpoints can access meeting functions from the Junos Pulse tray icon. When the user clicks Start Meeting in the tray icon menu, Pulse launches a browser window that provides access to the meeting functions. The browser shows the Meetings page of the server's user Web portal, which a user can also access by using a browser to login to the Pulse Secure Access server.

The tray icon for Pulse Collaboration Suite access is available when a Pulse connection is enabled as a meeting server connection. Pulse users cannot enable the meeting function for a connection. This task must be performed by the Pulse administrator on a connection defined on the server, and then installed on endpoints through normal methods of distributing and updating Pulse client software.

The following steps summarize how to create a Pulse connection that enables Pulse Collaboration Suite functions.

1. In a Pulse connection set, create a new Pulse connection or edit an existing connection set.
   
   Pulse Collaboration Suite is available with SSL VPN connections (connection type SSL VPN or UAC (L3)) only.

2. Select the check box labeled Enable Junos Pulse Collaboration integration on this connection.

3. Distribute the connection to endpoints through normal methods of distributing and updating Pulse client software.

Scheduling Meetings Through the Pulse Secure Access Service User Web Portal

If you enable meeting creation abilities at the role level, users can create meetings through the Meetings page of the Pulse Secure Access Service user Web portal. The user scheduling the meeting must specify all of the standard meeting details such as the meeting name, description, start time, start date, recurrence pattern, duration, password, and a list of invitees. Additionally, the user must categorize all invitees into one of two categories:

- Pulse Secure Access Service invitees—A user who signs into the same Secure Access server or cluster as the meeting creator, also called an in-network invitee. When inviting an in-network user to a meeting, the meeting creator must specify the user’s username and authentication server.

- Non-Pulse Secure Access Service invitees—A user who signs into a different Secure Access server or cluster as the meeting creator, also called an our-of-network invitee. When inviting an out-of-network user to a meeting, the meeting creator must specify the user’s email address.
NOTE: If an in-network invitee uses the meeting URL instead of the Meetings page in the Pulse Secure Access Service user Web portal to join a meeting, Pulse Collaboration Suite classifies the user as an out-of-network invitee.

Scheduling Meetings Through Microsoft Outlook

If you enable meeting creation abilities at the role level, Pulse Secure Access Service users can create meetings through the Microsoft Outlook calendar using the Pulse Collaboration Suite Outlook plug-in.

When installing the Pulse Collaboration Suite plug-in on Microsoft Outlook 2000, the following message appears, “The form you are installing may contain macros.” Since the Pulse Collaboration Suite form does not contain macros it does not matter whether you click Disable Macros or Enable Macros.

NOTE: You must use the same Outlook profile to remove the Pulse Collaboration Suite plug-in for Outlook as the one used to install the plug-in. Switching profiles between the installation and removal of the Plug-In is not supported.

To use this plug-in, the user must:

1. Install the plug-in from the Meetings page in the Pulse Secure Access Service user Web portal.
3. Use the Pulse Collaboration Suite tab to enter details about the Pulse Secure Access server on which the meeting should be scheduled as well as the user’s sign-in credentials, realm, and a meeting password.
4. Use the Scheduling and Appointment tabs to schedule the meeting and add invitees using standard Outlook functionality. Note that Pulse Collaboration Suite supports creating standard or recurring meetings through Outlook.

NOTE: Due to limitations with Microsoft Outlook, not all meeting details cross-populate between Microsoft Outlook and Pulse Secure Access Service. For a complete list of restrictions, see the Pulse Collaboration Suite for Outlook information available from the user help system available on the Pulse Secure Access Service user Web portal as well as the Pulse Collaboration Suite for Outlook plug-in installer.
NOTE: The Appointment tab has a check box labeled This is an online meeting using. This check box is not related to the Meeting Server or the Pulse Collaboration Suite Outlook Plug-in and cannot be used by a third-party plug-in.

5. Save the calendar entry to send the information to the Pulse Collaboration Suite server. Note that when saving a meeting, the user might see a certificate warning because the plug-in is communicating with a secure server.

6. Outlook sends invitation e-mails to the invitees using the text and meeting URL link constructed by the Pulse Collaboration Suite Outlook plug-in. Outlook also adds the meeting to the Outlook calendars of meeting invitees. This calendar item includes all of the standard information recorded by Outlook as well as an additional Pulse Collaboration Suite tab containing the information specified by the meeting creator in the Pulse Collaboration Suite tab. Note that the Pulse Secure Access server does not send an additional e-mail using the SMTP server.

7. To delete a meeting, click Delete Meeting from Server on the Pulse Collaboration Suite tab. Clicking Delete from the Outlook form does not delete the meeting.

Related Documentation

- Task Summary: Configuring Junos Pulse Collaboration
- Scheduling Meetings Through the Secure Access Service End-User Console
CHAPTER 4

Configuring Junos Pulse on SRX Series Gateways

- Junos Pulse and SRX Series Gateways on page 135
- Junos Pulse and Dynamic VPN Configuration Overview on page 136

Junos Pulse and SRX Series Gateways

The dynamic virtual private network (VPN) feature of SRX Series gateways simplifies remote access by enabling users to establish Internet Protocol Security (IPsec) VPN tunnels without having to manually configure VPN settings on their endpoints. Junos Pulse supports dynamic VPN connectivity to SRX Series gateways. The VPN settings are part of a Pulse SRX connection. Depending on the version of Junos OS on the SRX gateway, you might be able to deploy Pulse to endpoints from the SRX Series gateway through a Web portal. A remote client accesses the Web portal and, after being authenticated, downloads and installs Pulse. The installation includes a Pulse connection to the SRX Series gateway. Alternatively, you can create and deploy firewall connections from Pulse Access Control Service and Pulse Secure Access Service. See the Junos Pulse Supported Platform Guide for details on the Junos OS versions that are able to deploy Pulse.

To configure a firewall access environment for Pulse clients, you must configure the VPN settings on the SRX Series gateway and create and deploy an SRX connection on the Junos Pulse client.

NOTE: Junos Pulse for mobile devices can access Pulse Secure Access Service only.

For SRX Series gateways that cannot deploy Junos Pulse client software, you have the following configuration and deployment options:

- In an environment that includes Pulse Secure Access Service and Pulse Access Control Service, create connections of the type SRX with a target address of your SRX Series Services gateway. Users could then install the Junos Pulse client software and the connection configurations by logging in to the Web portal of the Pulse Secure Access Service or Pulse Access Control Service and being assigned to a role that installs Junos
Pulse. After the installation, the endpoint has the Junos Pulse client software and the connection information required to connect to the SRX Series Services gateways.

- Install the default Junos Pulse software package, and then have users create new connections that point to the SRX Series gateway.

SRX Series gateways supported an earlier access client called Juniper Networks Access Manager. You must uninstall Access Manager before you deploy Junos Pulse to endpoints. The Pulse installation program checks for Access Manager. If Access Manager is present, the program displays a message instructing the user to uninstall Access Manager before installing Pulse.

**NOTE:** The automatic update feature is supported on Pulse Secure Access and Pulse Access Control servers only. SRX gateways do not support automatic Pulse software updates.

**Related Documentation**

- Junos Pulse and Dynamic VPN Configuration Overview on page 136

**Junos Pulse and Dynamic VPN Configuration Overview**

A dynamic VPN allows administrators to provide IPsec access for Windows endpoints to a Pulse server on a Juniper Networks device while also providing a way to distribute the Dynamic VPN software to remote clients through the use of a Web portal.

The following procedure lists the tasks for configuring a dynamic VPN. For detailed information on these topics, see the Junos OS documentation.

1. Configure authentication and address assignment for the remote clients:
   a. Configure an XAuth profile to authenticate users and assign addresses. You can use local authentication or an external RADIUS server. Use the `profile` configuration statement at the `[edit access]` hierarchy level to configure the XAuth profile.

   To use the XAuth profile for Web authentication, use the `web-authentication` configuration statement at the `[edit access firewall-authentication]` hierarchy level.

   b. Assign IP addresses from a local address pool if local authentication is used. Use the `address-assignment pool` configuration statement at the `[edit access]` hierarchy level. You can specify a subnet or a range of IP addresses. Or you can specify IP addresses for DNS and WINS servers.
2. Configure the VPN tunnel:
   a. Configure the IKE policy. The mode must be aggressive. You can use basic, compatible, or standard proposal sets. Only preshared keys are supported for phase 1 authentication. Use the `policy` configuration statement at the `[edit security ike]` hierarchy level.
   b. Configure the IKE gateway. Either shared or group IKE IDs can be used. You can configure the maximum number of simultaneous connections to the gateway. Use the `gateway` configuration statement at the `[edit security ike]` hierarchy level.
   c. Configure the IPsec VPN. You can use basic, compatible, or standard proposal sets with the `policy` configuration statement at the `[edit security ipsec]` hierarchy level. Use the `vpn` configuration statement at the `[edit security ipsec]` hierarchy level to configure the IPsec gateway and policy.
   d. Configure a security policy to allow traffic from the remote clients to the IKE gateway. Use the `policy` configuration statement at the `[edit security policies from-zone zone to-zone zone]` hierarchy level.

   **NOTE:** The placement of this security policy is important. You must place it above more specific, non-VPN policies so that traffic that is intended to be sent over the VPN tunnel is processed correctly.
   
   e. Configure host inbound traffic to allow specific traffic to reach the device from systems that are connected to its interfaces. For example, IKE and HTTPS traffic must be allowed.
   f. (Optional) If the client address pool belongs to a subnet that is directly connected to the device, the device would need to respond to ARP requests to addresses in the pool from other devices in the same zone. Use the `proxy-arp` configuration statement at the `[edit security nat]` hierarchy level. Specify the interface that directly connects the subnet to the device and the addresses in the pool.

3. Associate the dynamic VPN with remote clients:
   a. Specify the access profile for use with dynamic VPN. Use the `access-profile` configuration statement at the `[edit security dynamic-vpn]` hierarchy level.
   b. Configure the clients who can use the dynamic VPN. Specify protected resources (traffic to the protected resource travels through the specified dynamic VPN tunnel and is therefore protected by the firewall’s security policies) or exceptions to the protected resources list (traffic that does not travel through the dynamic VPN tunnel and is sent in clear text). These options control the routes that are pushed to the client when the tunnel is up, therefore controlling the traffic that is send through the tunnel. Use the `clients` configuration statement at the `[edit security dynamic-vpn]` hierarchy level.

Related Documentation

- Junos Pulse Client Installation Overview on page 157
CHAPTER 5

Configuring Junos Pulse Application Acceleration Service

This chapter describes how to install and manage the Junos Pulse Application Acceleration Service for Junos Pulse for Windows and Junos Pulse for Apple OSX clients.

- Installing the Junos Pulse Client on page 139
- Managing Software, Configurations, and Policies on page 142

Installing the Junos Pulse Client

Mobile and remote Windows users can obtain the benefits of application acceleration by installing the Junos Pulse client. The Junos Pulse client accelerates traffic between the client system and a remote Junos Pulse Application Acceleration Service gateway, provided the gateway is installed in the network path. The gateways and Pulse clients discover each other automatically and begin accelerating traffic without user intervention.

The Junos Pulse client can be installed from a Pulse Secure Access server or from a Pulse Application Acceleration server. Installing the Pulse client from the Pulse Secure Access server is recommended. The Pulse Secure Access server can be configured to download and install the Pulse client automatically when a user accesses the server.

NOTE: You must install the Junos Pulse client on each Windows client, not on a single Windows system that serves as a gateway for other clients.

The following sections describe how to install the Junos Pulse client:

- Configuring Personal Firewalls for Junos Pulse Acceleration on page 140
- Downloading the Junos Pulse Client from a Pulse Secure Access Server on page 140
- Downloading the Junos Pulse Client from a Pulse Application Acceleration Gateway on page 141
- Uninstalling the Junos Pulse Client on page 142
Configuring Personal Firewalls for Junos Pulse Acceleration

Personal firewalls can block connections (adjacencies) between the Pulse client and the Junos Pulse Application Acceleration Service gateway in the network path. The firewall must allow the connection software on the Pulse client (WxConnectionMethod) to receive inbound UDP packets on port 3578. The firewall policies can be changed in either of two ways:

- Administrators can create and distribute a firewall exception to users through a centrally managed firewall system.
- Users can modify the personal firewall on the client.

Some personal firewalls are updated automatically when the Pulse client is installed. Table 9 on page 140 summarizes the configuration required for several common firewall systems. The version number indicates the version that has been verified by Juniper Networks.

<table>
<thead>
<tr>
<th>Firewall Software Package and Version</th>
<th>Configuration Required to Permit Pulse Acceleration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trend Micro IS Pro 17.50</td>
<td>Add a new network control protocol to allow incoming UDP packets for all IP addresses on port 3578.</td>
</tr>
<tr>
<td>McAfee Personal Firewall 12.0</td>
<td>McAfee displays a message to the user when it detects the WX Connection Method service. Users should respond <strong>Allow always</strong>.</td>
</tr>
<tr>
<td>Norton 4.3.0.5</td>
<td>No action required. Pulse updates the firewall during installation.</td>
</tr>
<tr>
<td>Kaspersky 6.0</td>
<td>Edit the rules for applications to allow inbound UDP packets on port 3578.</td>
</tr>
<tr>
<td>Windows XP, Windows Vista, and Windows 7</td>
<td>No action required. Pulse updates the firewall during installation.</td>
</tr>
</tbody>
</table>

Downloading the Junos Pulse Client from a Pulse Secure Access Server

The Junos Pulse client can be downloaded and installed automatically when users access a Pulse Secure Access server. For version 6.5 or 6.3 SA Series gateways, the Junos Pulse client must first be exported from a Junos Pulse Application Acceleration Service gateway and uploaded to the Pulse Secure Access server (see “Distributing the Pulse Client” on page 145). Note that version 7.0 (or higher) Pulse Secure Access servers include the Junos Pulse client, so exporting the client is not necessary.

To download the Junos Pulse client from a Pulse Secure Access server:

1. On a computer running Windows 7, Windows Vista, or Windows XP, enter the URL of the Pulse Secure Access server in a supported Web browser. For example:

   https://sa.company.net
The Loading Components page is displayed. The Host Checker window opens for downloading the Junos Pulse client installer, followed by the Junos Pulse Client window for downloading and installing the client. Note the following:

- If the Windows Firewall is enabled, click **Unblock** when prompted to allow the Junos Pulse client to accept external connections.
- If you are prompted to stop the Network Connect client, click **OK** and restart the Network Connect client after the Junos Pulse client is installed.
- If you are prompted about improper installation of the Host Checker or Junos Pulse client, click **Try Again** to complete the installation.

When installation is complete, the Junos Pulse client starts automatically. To start the client manually, double-click the Junos Pulse icon in the system tray. Application acceleration starts automatically when a remote Junos Pulse Application Acceleration Service gateway is discovered in the network path. No additional configuration is necessary.

### Downloading the Junos Pulse Client from a Pulse Application Acceleration Gateway

If you do not have a Pulse Secure Access server, you can download the Junos Pulse client from any Junos Pulse Application Acceleration Service gateway running JWOS 6.2. Before users can download the Pulse client software, you must:

- Verify that Pulse client downloads are enabled (see “Enabling Pulse Client Downloads” on page 142).
- Specify the Pulse client configuration (see **Defining the Pulse Client Configuration**).

To download the Pulse client to a computer running Windows 7, Windows Vista, or Windows XP:

1. If the WX Client is installed, uninstall the WX Client by selecting **Start > All Programs > Juniper Networks > WX Client > Uninstall**. The WX Client supports only JWOS 6.0 and is not compatible with the Pulse client.
2. Enter the following URL in a supported Web browser:
   
   `https://Gateway IP address/client`
3. Enter the username and password, if needed, and click **Login**.
4. Select **Install Now**, and, if necessary, click **Install** in the Security Warning dialog box. Note the following:
   - If the Windows Firewall is enabled, click **Unblock** when prompted to allow the client to accept external connections.
   - If you are prompted to stop the Network Connect client, click **OK** and restart the Network Connect client after the Junos Pulse client is installed.

When installation is complete, the Pulse client starts automatically, and the Pulse icon is shown in the system tray in the lower-right corner of the Windows desktop. Application acceleration starts automatically when a remote Junos Pulse Application Acceleration Service gateway is discovered in the network path.
Acceleration Service gateway is discovered in the network path. No additional configuration is necessary.

Uninstalling the Junos Pulse Client

To uninstall the Junos Pulse client software, select **Start > All Programs > Juniper Networks > Junos Pulse > Uninstall**, or run the following program (if necessary, change C: to the drive where Windows is installed):

```
C:\Program Files\Juniper Networks\Junos Pulse\Uninstall.exe
```

Managing Software, Configurations, and Policies

The following topics describe how to manage Pulse clients:

- Enabling Pulse Client Downloads on page 142
- Enabling Pulse Client Adjacencies on page 143
- Configuring Pulse Client Policies on page 143
- Viewing the Status of Pulse Clients on page 144
- Viewing the Pulse Client Configuration on page 144
- Uploading Pulse Client Software on page 144
- Distributing the Pulse Client on page 145

Enabling Pulse Client Downloads

Windows users can download and install the Junos Pulse client software from a Junos Pulse Application Acceleration Service gateway that has client downloads enabled. Optionally, you can require users to log in before they can download the client software.

To enable client software downloads:

1. Select **Junos Pulse > Setup > Pulse Software Download**.
2. Verify that the displayed version of the Pulse software is correct. If a later version is available, you must upload it to the gateway (see “Uploading Pulse Client Software” on page 144).
3. Select **Allow Pulse software download** to allow users to download the client software to a new remote client.
4. Select **Allow Pulse software upgrade/downgrade** to allow users to upgrade or downgrade their current version of the Pulse client. You may want to disable Pulse client upgrades and downgrades when:
   - You upgrade the gateway software and want only new users to install the new version of the Pulse client.
   - You downgrade the gateway and want to prevent users from installing an older version of the Pulse client (downgrading the gateway also downgrades the Pulse client loaded on the gateway).
5. Select **Require user authentication** to require users to log in, and specify the required username and password.

6. Click **Submit** to activate the changes.

7. Click **Save** in the taskbar to retain your changes after the next reboot.

**Enabling Pulse Client Adjacencies**

By default, a Junos Pulse Application Acceleration Service gateway running JWOS 6.1 (or higher) can form an adjacency with any client that is running a supported version of the Junos Pulse client software. Traffic is accelerated after the adjacency is established. You can disable and enable client adjacencies at any time. After an adjacency is manually disabled (or disrupted for any reason), it takes about 30 seconds to reestablish the adjacency.

**NOTE:** The new features in JWOS 6.2, such as NSC and Exchange acceleration, require version 2.1 (or later) of the Junos Pulse client.

To enable or disable adjacencies with Junos Pulse clients:

1. Select **Junos Pulse > Setup > Pulse Adjacency**.

2. Select **Allow adjacency with Pulse clients** to enable the gateway to form adjacencies with Junos Pulse clients. If you clear the check box, all current adjacencies are disabled, and all client traffic flows are reset.

3. Click **Submit** to activate the changes.

4. Click **Save** in the taskbar to retain your changes after the next reboot.

**Configuring Pulse Client Policies**

Compression and acceleration services can be configured on a Junos Pulse Application Acceleration Service gateway for each client that is currently adjacent (connected) or that has been adjacent at any time since the last time the gateway was restarted. When an adjacency is established, the enabled services are applied to the traffic sent to that client.

To define the default configuration for a client, see *Defining the Pulse Client Configuration*.

To configure the Junos Pulse client policies:

1. Select **Junos Pulse > Policies**.

2. Enable a service for one or more clients by selecting the check box for the service next to the appropriate clients. To enable or disable a service for all clients, select or clear the **Select All/Clear** check box below the list.

3. Click **Submit** to activate the changes, or click **Reset** to discard them.

4. Click **Save** in the taskbar to retain your changes after the next reboot.
Viewing the Status of Pulse Clients

The Junos Pulse Application Acceleration Service gateways display the connection status of each Junos Pulse client and the status of each service between the local gateway and each Pulse client. The list of clients includes the adjacent (connected) clients and all clients that are waiting for a connection or have been active at any time since the last time the gateway was restarted. Inactive adjacencies are disconnected after 15 minutes.

To view the status of Junos Pulse clients:

1. **Select** Junos Pulse > Status.
2. **Review the status icons:**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Connected Icon" /></td>
<td>The Junos Pulse client is adjacent (connected).</td>
</tr>
<tr>
<td><img src="image" alt="Disconnected Icon" /></td>
<td>The Junos Pulse client is disconnected, waiting for a connection, or in the process of connecting or disconnecting.</td>
</tr>
<tr>
<td><img src="image" alt="Green Icon" /></td>
<td>The service is operating normally.</td>
</tr>
<tr>
<td><img src="image" alt="Not Enabled Icon" /></td>
<td>The service is not enabled on the local gateway. To enable the service, see “Configuring Pulse Client Policies” on page 143.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Icon" /></td>
<td>A problem exists, or the service is enabled on the local gateway, but disabled on the Pulse client.</td>
</tr>
</tbody>
</table>

Viewing the Pulse Client Configuration

The default configuration that is downloaded to Junos Pulse clients can be viewed on a Junos Pulse Application Acceleration Service gateway. Note that when you generate the Pulse client configuration from the gateway, the client configuration contains a subset of the CLI commands from the gateway configuration.

To view the client configuration:

1. **Click** Junos Pulse > Admin > Display Pulse Configuration.
2. **View the client configuration.** For more information about the CLI commands in the configuration, see the Junos Pulse Application Acceleration Service Command Reference Guide.

Uploading Pulse Client Software

When a new version of the Junos Pulse client software becomes available, you must upload it to the Junos Pulse Application Acceleration Service gateway before it can be downloaded by users or exported for distribution. You can load the Pulse client software from a local disk or from an FTP or TFTP server.
To upload a new version of the Pulse client software:

1. Select Junos Pulse > Admin > Load Pulse Software.
2. Verify that you want to replace the client version displayed at the top of the page.
3. Select one of the following, and specify the location of the new Pulse version:

<table>
<thead>
<tr>
<th>Location</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Local disk</td>
<td>Specify the path and filename on a machine in your network, or click Browse and select the client software file.</td>
</tr>
<tr>
<td>TFTP server</td>
<td>Specify the path and filename on a TFTP server:</td>
</tr>
<tr>
<td></td>
<td>• IP address of a TFTP server.</td>
</tr>
<tr>
<td></td>
<td>• Path and filename of the software package on the server. The first character must be a slash (/).</td>
</tr>
<tr>
<td>FTP server</td>
<td>Specify the path and filename on an FTP server:</td>
</tr>
<tr>
<td></td>
<td>• IP address of an FTP server.</td>
</tr>
<tr>
<td></td>
<td>• Path and filename of the software package on the server. The first character must be a slash (/).</td>
</tr>
<tr>
<td></td>
<td>• If the FTP server does not accept anonymous user access, enter a username and password for an account that has read/write privileges on the server.</td>
</tr>
</tbody>
</table>

4. Click Load to update the Junos Pulse client software.

**Distributing the Pulse Client**

In addition to allowing users to download the Junos Pulse client from a Junos Pulse Application Acceleration Service gateway, you can also distribute the client using either of the following methods:

- Juniper Networks SA Series SSL VPN Appliance—The Junos Pulse client can be downloaded and installed automatically when users access the Pulse Secure Access server. For version 6.5 or 6.3 SA Series gateways, you must export the Pulse client software package from a Junos Pulse Application Acceleration Service gateway, and then upload the package to the Pulse Secure Access server. Version 7.0 or higher Pulse Secure Access servers include the Pulse client, so exporting the client is not necessary. Junos Pulse configuration information for the Pulse Secure Access server is included in both the Junos Pulse Administration Guide and the Junos Pulse Secure Access Service Administration Guide.

- Microsoft System Management Server (SMS)—You can distribute the Junos Pulse client through SMS by exporting the client configuration for inclusion in the Windows installer file.

**Distributing the Pulse Client Through an SA Series Gateway**

Use the following procedure to distribute the Junos Pulse client through a version 6.5 or 6.3 SA Series gateway. To distribute the Pulse client through a version 7.0 or higher server, see the Junos Pulse Administration Guide or the Junos Pulse Secure Access Service Administration Guide.
1. Load or generate a Junos Pulse client configuration (see Defining the Pulse Client Configuration).

2. Select Junos Pulse > Admin > Export Pulse Software.

3. Export the client software package to be installed on an SA Series gateway:
   a. Select Create Host Checker package for use with SA to have the Host Checker install and start the Junos Pulse client. If the client fails or is stopped manually, it is not restarted automatically.
   b. Click Export, click OK, and then save the .zip file to a local or network folder.

4. Upload the exported software package to an SA Series gateway:
   a. Log in as an administrator to the admin console of the SA Series gateway and select Authentication > Endpoint Security > Host Checker.
   b. Verify that the Perform check every X minutes and Client-side process, login inactivity timeout are set to 10 minutes or more, and that the timeout interval is not greater than the check interval.
   c. Select New 3rd Party Policy, specify a policy name, and select the exported Junos Pulse client software package as the Policies File.
   d. Click Save Changes.
   e. Select Users > User Realms > Select Realm > Authentication Policy > Host Checker. Select both the Evaluate Policies and Require and Enforce check boxes for the displayed Junos Pulse client policy.
   f. Click Save Changes to save the Host Checker policy.

Distributing the Pulse Client Through SMS

To use SMS to distribute the Junos Pulse client, you must export the client configuration from a Junos Pulse Application Acceleration Service gateway and use it to replace the default client configuration in the Windows installer file.

To distribute the Junos Pulse client through SMS:

1. Export the client configuration from the gateway:
   a. Select Junos Pulse > Admin > Export Pulse Software.
   b. Select Download Configuration for MSI package.
   c. Click Export, and then save the Config_All.ini file to a local or network folder.

2. Download the Windows installer version of the Junos Pulse client software (a .msi file) to a computer that has InstallShield 2008. You can download the software from www.juniper.net/support/products/pulse/.

3. Open the downloaded file with InstallShield, and select the Installation Designer tab.

4. Select Organization > Components in the left pane, and open the first components folder in the middle pane.
5. Select the Files subfolder in the middle pane, right-click the Config_All.ini file displayed in the right pane, and select Delete.

6. Right-click the Files subfolder, and select Add.

7. Locate the Config_All.ini file that you exported from the gateway, and click Open.

8. Select In a new CAB file, select the Stream the new CAB file into the Windows Installer package check box, and click OK.

9. Click Save to save your changes.
CHAPTER 6

Session Migration

- Understanding Session Migration on page 149
- Task Summary: Configuring Session Migration on page 153
- Configuring Session Migration for the Pulse Client on page 154
- Configuring an IF-MAP Federated Network for Session Migration on page 154

Understanding Session Migration

This topic describes the session migration feature. It includes the following information:

- Session Migration Overview on page 149
- Session Migration and Session Timeout on page 151
- How Session Migration Works on page 151
- Session Migration and Session Lifetime on page 152
- Session Migration and Load Balancers on page 152
- Authentication Server Support on page 152

Session Migration Overview

When you enable session migration on two or more Pulse servers, a Pulse endpoint can migrate from one location to another and connect to a different Pulse server without providing additional authentication. For example, a user can be connected from home through a Pulse Secure Access server, and then arrive at work and connect to a Pulse Access Control server without being reauthenticated. If session migration is not enabled, Pulse users must be reauthenticated each time they attempt to access the network through a different Pulse server.

Sessions can be migrated between Pulse Access Control and Pulse Secure Access servers that are in the same IF-MAP federated network: using either the same IF-MAP server, or using IF-MAP servers that are replicas of one another.

The servers must be in the same authentication group. Authentication groups are configured through authentication realms. An authentication group is a string that you define for common usage. You can use authentication groups to group together realms with similar authentication methods. Such as, one authentication group for SecurID authentication, another authentication group for AD. A single gateway can belong to more than one authentication group, with a different authentication group per realm.
The Pulse server to which a user authenticates publishes session information to the IF-MAP server. Other IF-MAP clients in the federated network can use the information to permit access without additional authentication to users.

When a user session is migrated to another Pulse server, the new session information is pushed to the IF-MAP server. The IF-MAP server notifies the authenticating server, and information about the session that existed on the original server is removed leaving only session information about the current authenticating server on the IF-MAP server. The authenticating server removes information about the session from its local session table and the user license count is decremented.

When a session is migrated, realm role-mapping rules determine user access capabilities. You can import user attributes when a session is migrated, or you can configure a dedicated directory server to look up attributes for migrated user sessions. To ensure that session migration retains user sessions, configure a limited access remediation role that does not require a Host Checker policy. This role is necessary because the Host Checker timeout can be exceeded if an endpoint is in hibernation or asleep. With the new remediation role, the user’s session is maintained.

If additional Host Checker policies are configured on a role or realm to which a migrated session applies, the policies are performed before allowing the user to access the role or realm. Administrators of different Pulse servers should ensure that Host Checker policies are appropriately configured for endpoint compatibility.

Figure 14 on page 151 illustrates the task flow for enabling session migration for Pulse.
Figure 14: Requirements for Pulse Session Migration

Session Migration and Session Timeout

Session timeout on the authenticating server does not apply to a migrated session. Instead, session start time is applicable. The inbound server evaluates session timeout using the start time of the original session on the original server.

When a user reboots an endpoint for which session migration is enabled, the session is retained for a short time on the server. For sessions on the Pulse Access Control server, sessions are retained until the heartbeat timeout expires. For Pulse Secure Access server sessions, the idle timeout determines how long the session is retained.

If an endpoint that is connected to a Pulse Access Control server or Pulse Secure Access server is rebooted and the user does not sign out, when the endpoint is restarted and the user attempts to connect to the same access gateway, Pulse resumes the previous session without requesting user credentials if the previous session is still active.

How Session Migration Works

Session migration uses IF-MAP Federation to coordinate between servers.

When a session is established, the authenticating gateway publishes the session information, including a session identifier, to the IF-MAP server. The session identifier is also communicated to the Pulse client.
When the Pulse client connects to a migrating gateway in the same authentication group, the Pulse client sends the session identifier to the migrating gateway. The migrating gateway uses the session identifier to look up the session information in the IF-MAP server. If the session information is valid, the migrating gateway uses the session identifier to establish a local session for the endpoint that the Pulse client is running on.

The IF-MAP server notifies the authenticating gateway that the user session has migrated, and the authenticating gateway deletes the session information from the IF-MAP server.

**Session Migration and Session Lifetime**

Session migration is designed to give users maximum flexibility and mobility. Users are no longer tied to the office. The workplace can travel with the user, and electronic chores such as online banking can come to work. Because of this flexibility, users might be away from their machines for long periods of time, allowing their active session to expire. Session migration requires users to have an active session on the Pulse Access Control or Pulse Secure Access server.

You can adjust session lifetime to ensure that sessions do not time out while users are away from their machines. You adjust session lifetime on the gateway by selecting Users > User Roles > Role Name > General > Session Options in the admin console.

**Session Migration and Load Balancers**

A Pulse client that connects to a Pulse server that is behind a load balancer will attempt to migrate the network connection if the connected server fails. The Pulse servers must be federated and configured for session migration. For example, a load balancer that balances to 2 Pulse servers (non-clustered) balances to Server1. If Server1 fails, the load balancer then balances to Server2. A Pulse client that is connected to Server1 is migrated to Server2 without re-authentication.

**Authentication Server Support**

The behavior of session migration depends to some extent on the authentication server on the inbound side.

The following list provides a summary of authentication server support:

- Local authentication server—Migration succeeds if the username is valid on the local authentication server.
- LDAP server—Migration succeeds if the LDAP authentication server can resolve the username to a distinguished name (DN).
- NIS server—Migration succeeds if the NIS authentication server can find the username on the NIS server.
- ACE server—Migration always succeeds.
- RADIUS server—Migration always succeeds. If you select Lookup Attributes using Directory Server, no attributes are present in the user context data.
- Active Directory—Migration always succeeds. The Lookup Attributes using Directory Server option might not work, depending on your configuration.
Anonymous—No support for migrating sessions because sessions are not authenticated.

Siteminder—No support for migrating sessions because Siteminder SSO is used instead.

Certificate—No support for migrating sessions because sessions are authenticated using certificates.

SAML—No support for migrating sessions because SAML SSO is used instead.

NOTE: For local, NIS, and LDAP authentication servers, the inbound username must reflect an existing account.

To permit session migration for users with the Pulse client, perform the following tasks:

1. Configure location awareness rules within a client connection set to specify locations included in the scope of session migration for users. For example, configure location awareness rules for a corporate Pulse Access Control server connection and a Pulse Secure Access server connection.

2. Configure an IF-MAP federated network, with the applicable Pulse Access Control servers and SA Series appliances as IF-MAP Federation clients of the same IF-MAP Federation server.

3. Ensure that user entries are configured on the authentication server for each gateway.

4. Ensure that user roles are configured for all users on each gateway.

5. Define a remediation role with no Host Checker policies to allow user sessions to be maintained when an endpoint is sleeping or hibernating.

6. Configure role-mapping rules that permit users to access resources on each gateway.

7. Enable and configure session migration from the User Realms page of the admin console.

8. Distribute the Pulse client to users.

Related Documentation
- Configuring Session Migration for the Pulse Client on page 154
- Task Summary: Configuring Session Migration on page 153

Task Summary: Configuring Session Migration

To permit session migration for users with the Pulse client, perform the following tasks:

1. Configure location awareness rules within a client connection set to specify locations included in the scope of session migration for users. For example, configure location awareness rules for a corporate Pulse Access Control server connection and a Pulse Secure Access server connection.

2. Configure an IF-MAP federated network, with the applicable Pulse Access Control servers and SA Series appliances as IF-MAP Federation clients of the same IF-MAP Federation server.

3. Ensure that user entries are configured on the authentication server for each gateway.

4. Ensure that user roles are configured for all users on each gateway.

5. Define a remediation role with no Host Checker policies to allow user sessions to be maintained when an endpoint is sleeping or hibernating.

6. Configure role-mapping rules that permit users to access resources on each gateway.

7. Enable and configure session migration from the User Realms page of the admin console.

8. Distribute the Pulse client to users.

Related Documentation
- Understanding Session Migration on page 149
- Configuring Session Migration for the Pulse Client on page 154
- Understanding Federated Deployments
Configuring Session Migration for the Pulse Client

**NOTE:** Ensure that all of the Pulse Access Control servers and Pulse Secure Access servers for which you want to enable session migration are IF-MAP Federation clients of the same IF-MAP Federation server. Additionally, make sure that each gateway is configured according to the procedures outlined in this section.

To configure session migration:

1. In the admin console, select Users > User Realms.
2. Select an existing realm, or create a new realm.
4. In the Authentication Group box, enter a string that is common to all of the gateways that provision session migration for users. The authentication group is used as an identifier.
5. Select for either the Use Attributes from IF-MAP option button or the Lookup Attributes using Directory Server option.

**NOTE:** Select Lookup Attributes using Directory Server only if you are using an LDAP server. Attributes are served faster with an LDAP server.

### Related Documentation
- Understanding Session Migration on page 149
- Task Summary: Configuring Session Migration on page 153
- *Understanding Federated Deployments*

Configuring an IF-MAP Federated Network for Session Migration

To successfully deploy session migration, you configure an IC Series device IF-MAP server, and you configure all of the connected IC Series devices and SA Series devices that users access as IF-MAP clients. A SA Series device can not be an IF-MAP server.

To add clients, you must specify the IP address and the security mechanism and credentials for the client.

An IF-MAP server certificate must be installed on the IF-MAP server. The client verifies the server certificate when it connects to the server. The server certificate must be signed by a Certificate Authority (CA), the client must be configured to trust certificates signed by that CA, and the hostname in the server certificate must match the hostname in the IF-MAP URL on the client.
You must identify the IF-MAP server to each IC Series device and SA Series device IF-MAP client. To add the server, you specify the IF-MAP URL of the server and how to authenticate to the server. Match the URL and security settings to equal those on the IF-MAP server to which the IF-MAP clients will connect.

To configure IF-MAP server settings on the IC Series device:

1. From the admin console select **System > IF-MAP Federation > Overview**.
2. On the IC Series device, under Choose whether this IC Series device runs an IF-MAP Server, an IF-MAP client, or no IF-MAP, select the **IF-MAP Server** option button.
3. Click **Save Changes**.
4. From the admin console select **System > IF-MAP Federation > This Server > Clients**.
5. Under IF-MAP Client, enter a **Name** and an optional **Description** for this client. For example, enter the name SA-access1.corporate.com and the description Secure Access 1.
6. Type one or more IP addresses of the client. If the client is multi-homed, for best results list all of its physical network interfaces. If the client is an IC Series device or Secure Access cluster, list the internal and external network interfaces of all nodes. It is necessary to enter all of the IP addresses for all of the interfaces because equipment failures might cause traffic between the IF-MAP client and the IF-MAP server to be re-routed through a different network interface. Listing all of the IP addresses maximizes the probability that IF-MAP Federation still works in the event of a failure. For example, enter 172.16.100.105.
7. Under Authentication, select the Client Authentication Method: **Basic** or **Certificate**.
   a. If you select **Basic**, enter a Username and Password. The same information should be added to the IF-MAP server.
   b. If you select **Certificate**, choose which Certificate Authority (CA) to use to verify the certificate for this client. Optionally, specify certificate attributes or restrictions to require values for certain client certificate attributes.
8. Click **Save Changes** to save the IF-MAP Client instance on the IF-MAP server.

To configure IF-MAP client settings on the IC Series device and SA Series device clients:

1. From the admin console select **System > IF-MAP Federation > Overview**.
2. In the IC Series device, under Choose whether this IC Series device runs an IF-MAP Server, an IF-MAP client, or no IF-MAP, select the **IF-MAP Client** option button. On the SA Series device, select **Enable IF-MAP Client** check box.
3. Type the server URL for IF-MAP Web service on the IF-MAP server. Append the server URL with `/dana-ws/soap/dsifmap` for all Juniper Networks IF-MAP servers.
   For example, https://access2.corporate.com/dana-ws/soap/dsifmap.
4. Select the client authentication method: **Basic** or **Certificate**.
   a. If you select **Basic**, enter a username and password. This is the same as the information that was entered on the IF-MAP server.
   b. If you select **Certificate**, select the device certificate to use.

   Ensure that the certificate of the CA that signed the IF-MAP server certificate is added from the System > Configuration > Certificates > Trusted Server CA page.

   The IF-MAP client validates the IF-MAP server certificate: if validation fails, the connection fails. Ensure that the hostname in the IF-MAP URL on the client machine matches the hostname of the server certificate on the IF-MAP server, and that the CA that signed the server certificate is configured as a trusted server CA on the IF-MAP client.

5. Click **Save Changes**.

**Related Documentation**
- Understanding Session Migration on page 149
- Task Summary: Configuring Session Migration on page 153
CHAPTER 7

Deploying Junos Pulse Client Software

- Junos Pulse Client Installation Overview on page 157
- Adding a Pulse Configuration to a New Pulse Installation on page 160
- Installing Junos Pulse Client from the Web on page 163
- Launching Junos Pulse from the Pulse Server Web Portal on page 164
- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169
- Junos Pulse Command-line Launcher on page 170
- Using jamCommand to Import Junos Pulse Connections on page 173

Junos Pulse Client Installation Overview

This section describes how to deploy Pulse for Windows and Pulse for Mac OS X client software from Pulse Access Control Service and Pulse Secure Access Service platforms. Pulse Application Acceleration Service supports deployment of App Acceleration connections only.

Pulse Access Control Service and Pulse Secure Access Service include a default connection set and a default component set. These defaults enable you to deploy the Pulse client to users without creating new connection sets or component sets. The default settings for the client permit dynamic connections, install only the components required for the connection, and permit an automatic connection to Pulse Secure Access Service or Pulse Access Control Service to which the endpoint connects.

In all deployment scenarios, you must have already configured authentication settings, realms, and roles.

You can deploy the Junos Pulse client to endpoints from Pulse Secure Access Service and Pulse Access Control Service in the following ways:

- **Web install**—With a Web install (also called a server-based installation), users log in to the Pulse server’s Web portal and are assigned to a role that supports a Pulse installation. When a user clicks the link to run Junos Pulse, the default installation program adds Pulse to the endpoint and adds the default component set and the default connection set. If you do not make any changes to the defaults, the endpoint...
receives a Pulse installation in which a connection to the Pulse server is set to connect automatically. You can edit the default connection set to add connections of other Pulse servers and change the default options.

---

**NOTE:** A Web install requires that the user have Java installed and enabled for an installation through the Firefox browser or ActiveX enabled for an installation through Internet Explorer. If the browser does not meet this requirement, the user receives a descriptive message at the beginning of the installation process.

---

**NOTE:** A Web install is not compatible with the Pulse rebranding tool, BrandPackager.

---

- **Preconfigured installer**—Create the connections that an endpoint needs for connectivity and services, download the settings file (.jnprpreconfig), and download default Pulse installation program. For Windows endpoints you run the Pulse installation program by using an msiexec command with the settings file as an option. For OS X endpoints, you run the default installer and then import the .jnprpreconfig file using a separate command.

- **Default installer**—You can download the default Pulse installation program and distribute it to endpoints using your local organization’s standard software distribution method (such as Microsoft SMS/SCCM). The Junos Pulse client software is installed with all components and no connections. After users install a default Pulse installation, they can add new connections manually through the Pulse client user interface or by using a browser to access a Pulse server’s Web portal. For the latter, the Pulse server’s dynamic connection is downloaded automatically and the new connection is added to the Pulse client’s connections list. Dynamic connections are created as manual rather than automatic connections, which means that they are run only when the user initiates the connection or the user browses to a Pulse Server and launches Pulse from the server’s Web interface.

If the Windows endpoints in your environment do not have admin privileges, you can use the Juniper Installer Service program, which is available on the admin console System Maintenance Installers page. The Juniper Installer Service allows users to download, install, upgrade, and run client applications without administrator privileges. In order to perform tasks that require administrator privileges, the Juniper Installer Service runs under the client’s Local System account (a powerful account with full access to the system) and registers itself with Windows’ Service Control Manager (SCM). An Active-X control or a Java applet running inside the user’s Web browser communicates the details of the installation processes to be performed through a secure channel between the Pulse server and the client system.
When installing the Juniper Installer Service on client systems, note the following:

- When installing a Juniper client application on a user’s Windows system, the Juniper Installer Service deploys two files on the client machine:
  - JuniperSetupSP1Control.ocx
  - AccessServiceComponent.exe

  The device auto-starts this service when installing, and, then stops and removes it when uninstalling.

- Installing the Juniper Networks Installer MSI package requires administrator rights to install onto your client systems. If you plan to use the EXE version, administrator rights is not needed as long as a previous version of the access service component (deployed through, for example, JIS, Pulse, and so forth) is already present. If policies are defined for your client with the group policy "Run only Allowed Windows Application", the following files must be allowed to run in the group policy. If not, client applications might not install.
  - dsmmf.exe
  - JuniperCompMgrInstaller.exe
  - JuniperSetupClient.exe
  - JuniperSetupClientOCX.exe
  - JuniperSetupXP.exe
  - uninstall.exe
  - x86_Microsoft.*.exe

- You should ensure that the Microsoft Windows Installer exists on the client system prior to installing the Juniper Installer Service.

- Your end-users’ client systems must contain either a valid and enabled Java Runtime Engine (JRE) or a current SA Series Appliance ActiveX control. If the client systems do not contain either of these software components, the users will be unable to connect to the gateway. If there is no JRE on your end-users’ client systems, you should download an appropriate installer package from Maintenance > System > Installers. The service appears in the Windows Services (Local) list as Neoteris Setup Service. The service starts automatically on install and during client system start up.

**Related Documentation**

- Adding a Pulse Configuration to a New Pulse Installation on page 160
- Installing Junos Pulse Client from the Web on page 163
- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169
Adding a Pulse Configuration to a New Pulse Installation

When you install the Junos Pulse for Windows or Junos Pulse for Mac OS X client on an endpoint using the default Pulse installation program, the endpoint has all the Pulse components it needs to connect to Pulse servers. However, the Pulse client needs a configuration that identifies the Pulse servers it can connect to, that is, the connections. Connection properties also define how the connections are to be started, manually, automatically, or according to location awareness rules, and how Pulse connections receive updates. These connection set properties are also called machine settings.

Figure 15 on page 160 shows the default Pulse connection set properties (machine settings) that are passed to the Pulse client as its configuration. Figure 16 on page 162 shows the connection set properties as they appear in a Pulse preconfiguration file, which you can use to add the Pulse configuration when you install Pulse. The preconfiguration file also includes Pulse connections.

**Figure 15: Junos Pulse Configuration Properties Defined on the Pulse Server**

There are two methods for installing an initial configuration on a new Pulse client:

- Use a Pulse preconfiguration file (.jnprpreconfig) when you install Pulse on endpoints using the default Pulse installer.
- Instruct users to open a browser and login to the Pulse server Web portal where the Pulse configuration has been defined. After successful login, the user should start Junos Pulse from the Web page. Or you can enable Auto-launch as a role option to have the Pulse installation begin automatically after login.
The first time a Pulse client connects to a server that offers a Pulse configuration, the configuration settings are installed on the client, and the client is bound to that server, which means that only that server can update the client’s configuration. Any Pulse server can update the Pulse client software version if that feature is enabled, and any Pulse server can add a connection to an existing Pulse client configuration if Dynamic connections is enabled as part of the connection set on the binding server. Only the binding server can update the Pulse client’s configuration.

If the Pulse configuration has Dynamic connections enabled, then connections from other Pulse servers are automatically added to the Pulse client’s connections list when the user connects to the other Pulse server through that server’s Web portal. For example, a user has a Pulse configuration from PulseServerA (the binding server) and the Pulse configuration allows dynamic connections. If the user browses to PulseServerB and successfully authenticates through that server’s Web portal, the server adds a PulseServerB connection to the Pulse client configuration, and it appears in the Pulse client’s connection list. This new connection is set to start manually so that it does not attempt to connect when the endpoint is restarted or conflict with the connections from the binding server. A dynamic connection is added to the Pulse client’s connections list. However, the connection’s target URL is Pulse Web server URL; it does not use the URL that is defined for the connection in the server’s Pulse connection properties. In most cases, these URLs will be the same.

You can see a Pulse configuration by creating and viewing a .jnprpreconfig file. (To create the file, go to the Pulse Component screen, select a component set, and then click the Download Pulse Configuration button.) The .jnprpreconfig file contains a section that defines the machine settings and separate sections for each Pulse connection deployed to the client, as shown in Figure 16 on page 162.
The machine settings and each centrally configured connection (as opposed to connections created by users or added as dynamic connections) include the server ID (server-id) of the binding server. When a user browses to a Pulse server, and the server offers a new configuration, (that is, updates to the machine settings), the client ignores it unless the server ID in the new configuration matches the server ID of the Pulse client’s configuration.

Configuration files have a version number as well. When a Pulse client connects to its binding server, Pulse compares the version of its existing configuration to the version on the server. If the server version is later than the existing client version, the client
configuration is updated. The update might add, change, or remove connections and change machine settings.

If you have several Pulse servers and you want to provision the same Pulse configuration from all of the servers, the server ID of the Pulse configuration must be the same across all of the servers. To accomplish this, you create the configuration on one server, and then use the "push config" feature of the Pulse server to push the configuration to the other Pulse servers. This method ensures that the server ID of the configuration file is the same across all of the Pulse servers so that clients can receive a configuration update from any of the Pulse servers.

**Related Documentation**
- Junos Pulse Client Installation Overview on page 157
- Introducing Junos Pulse on page 3

**Installing Junos Pulse Client from the Web**

For a Web install, you direct users to the Web interface of the Pulse server. After a successful login, a user is assigned to a role that includes an automatic download and installation of the Pulse client software.

**NOTE:** A Web install requires that the user have Java installed and enabled for an installation through the Firefox browser or ActiveX enabled for an installation through Internet Explorer. If the browser does not meet this requirement, the user receives a descriptive message at the beginning of the installation process.

The default Junos Pulse installation settings include minimal components, which includes the Host Checker component, and a connection to the Pulse server. If you want a Web install that has customized settings, you can do any of the following:

- Edit the default connection set and add new connections. The default installer uses the default component set which includes the default connection set.
- Create a new connection set and edit the default component set to include the new connection set.
- Edit the role to specify a component set that includes the connections you want for the default installation.

**NOTE:** A Pulse installation causes a restart of active network connections on a Windows endpoint. When a user initiates a Pulse installation through a WAN connection to the Web interface of a Pulse server, the user might need to log in to their service provider again to reestablish network connectivity. Users need to be aware of this issue before they begin the installation.
Launching Junos Pulse from the Pulse Server Web Portal

One typical method of establishing a VPN connection is for users to browse to the Pulse server’s Web portal, login, and then launch Pulse from the Web page. (This method is common in environments that used the Network Connect client.)

The following items describe the Pulse connection behaviors:

• The Pulse client has been installed on the endpoint by using the default Pulse installer. The installed Pulse client does not yet have any connections. The user browses to the Pulse server, logs into the server, and then clicks the Pulse button on the Web portal page. The following action occurs:
  1. The default Pulse connection set is automatically deployed to the client.
  2. The connection that has a URL that matches the server URL is launched.

• The Pulse client has been installed on the endpoint and it has a connection from the Pulse server. The user browses to the Pulse server, logs into the server, and then clicks the Pulse button on the Web portal page. The following action occurs:
  1. The connection that has a URL that matches the server URL is launched.

• Pulse has been installed on the endpoint and it has a connection from two different Pulse servers. The user browses to one of these Pulse servers, logs into the server, and then clicks the Pulse button on the Web portal page. The following action occurs:
  1. Only the connection that has a URL that matches the server URL is launched.

• Pulse has been installed on the endpoint. It has a connection for one Pulse server but the user browses to a different Pulse server, logs into the server, and then clicks the Pulse button on the Web portal page. The following action occurs:
  1. A new dynamic connection is created on the Pulse client for this Pulse server. (Note that the default connection on the server must be configured as a dynamic connection.) This new connection is a manual connection, that is, it does not start automatically when Pulse starts.
  2. The new connection for this Pulse server is started based on matching URLs.

Usage Notes

The Web browser method of launching Pulse is affected by the following configuration issues:

• The Pulse connection URL and the server URL must be an exact match. Pulse does not perform reverse DNS lookup to find a match.
Connections that have the connection property **Allow user to override connection policy** disabled cannot be launched from the browser even if URLs match.

**Related Documentation**
- Adding a Pulse Configuration to a New Pulse Installation on page 160
- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169

### Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File

The following procedures apply to Windows installations only.

After you create client connection sets and specify the connections to include within a client component set, you can create a preconfiguration file with all of the connections you want to distribute with the Pulse client. You specify the preconfiguration file as an option when you run the Pulse MSI installer program using an msiexec ([`windows\system32\msiexec.exe`](https://example.com)) command.

To create a preconfigured Pulse installer for distribution to Windows endpoints:

1. Select **Users > Junos Pulse > Connections** and create a connection set with the connections that you want to distribute.
2. Select **Users > Junos Pulse > Components**.
3. If necessary, create a new component set with the connection sets you want to distribute.

   It does not matter which component option you select, All components, No components, or Minimal components. The Pulse installer installs all components unless you specify which components to install using one or more ADDLOCAL options in the command line. If you specify one or more ADDLOCAL options, the installer installs only the components you specify. Be sure that you specify all the components required to support the connections you have selected.
4. Select the check boxes next to the component sets that you want to distribute.
5. Click **Download Installer Configuration**.

   You are prompted to save the preconfiguration. You can also specify the name of the target Pulse server for the connections, which enables you to create configuration files that are the same except for the target server.

   The default filename of the `.jnprpreconfig` file is the name of the selected component set. Make note of the filename and location where you put the file. The preconfiguration file must be available to the clients either through a network share or distributed along with the Junos Pulse installation file.
6. Select **Maintenance > System > Installers**.
If necessary for your environment, download and install the Juniper Installer Service. To install Pulse, users must have appropriate privileges. The Juniper Installer Service allows you to bypass privilege restrictions and allow users with limited privileges to install Pulse. See Downloading Client Installer Files for more information about Juniper Installer Service.

7. Download the appropriate Junos Pulse installer for your Windows environment:
   - Junos Pulse Installer (32-bit)
   - Junos Pulse Installer (64-bit)

   **NOTE:** For a Windows installation (.msi) that uses an automated distribution mechanism and where the users do not have administrator privileges, you should ensure that the installation is run in the proper context, typically the USER context. To install in USER context, first advertise the .msi while in the SYSTEM context. For example, to advertise the 64-bit Windows installation to all users, use the following msiexec command:
   ```
   msiexec /im \JunosPulse.x64.msi
   ```
   The advertisement allows the installation to be run in USER context even if the user is a restricted (non-admin) user. The location where the advertisement is run and where the actual installation is run **must** be the same. If the installation is an upgrade, you must advertise the upgrade version before running it. (Note that it is much easier to upgrade the Pulse client by not disabling the automatic upgrade feature on the Pulse server.) After the installation is run by the user, the Pulse client will use the correct user certificate and context.

**Installing the Pulse Client Using Advanced Command-Line Options**

The Junos Pulse installer includes the Pulse client and all the software components for all the Pulse services. The preconfiguration file contains the definitions of the Pulse connections that provide client access to specific Pulse servers and services.

**Usage Notes:**

- The preconfigured installer installs all Pulse components unless you specify the specific components you want using ADDLOCAL options. If you use one or more ADDLOCAL options, the preconfigured installer installs only the components specified by ADDLOCAL. A preconfigured installer ignores the component set you select when you create the preconfiguration file.

- When you use ADDLOCAL options, be sure that your **msiexec** command specifies **all** the components required for your connections. For example, if the connection requires 802.1X connectivity for a connection to Pulse Access Control Service, be sure to include both the 802.1X component and the Pulse Access Control Service component (ADDLOCAL=PulseUAC,Pulse8021x).

- When you run **msiexec**, you should append **/qn** or **/qb** (**msiexec** options) to the command line to suppress the installation program user interface. For example, the user interface lets the user choose a complete installation or a custom installation,
which can override the components you specify with ADDLOCAL options. If the user selects Complete, the msiexec program ignores the ADDLOCAL options in the command line and installs all components. The /qn option specifies a silent install, so no user interface appears. The /qb option also hides the user interface but it displays a progress bar.

- The procedures in this topic are valid with Windows installations only. For information about installing Pulse on OS X endpoints, see “Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File” on page 169.

You run the Pulse preconfigured installer program with msiexec (the command line for launching .msi programs on Windows platforms) and specify the following options.

**NOTE:** Command line options (CONFIGFILE and ADDLOCAL) are case sensitive and must be all caps.

**NOTE:** If the path to the .jnprpreconfig file includes spaces, be sure to use quotes around the path.

- **CONFIGFILE**—This property specifies a configuration file to be imported into Pulse during installation. The property must include the full path to the configuration file. For example:

  ```
  msiexec -i JunosPulse.msi CONFIGFILE="c:\temp\my configuration.jnprpreconfig"
  ```

- **ADDLOCAL**—This optional property specifies which features and feature options (subfeatures) to install when you want to install only specific Pulse features. If you do not specify ADDLOCAL options, all Pulse components are installed. A feature comprises the components required to support client connections. When you use ADDLOCAL, you should append msiexec options /qn or /qb to the command line to suppress the installation program user interface.

Feature and subfeature names are case sensitive. To specify multiple features in a single command, separate each feature with a comma.

The ADDLOCAL property has the following features:

- **PulseSA**—Pulse components required for Pulse Secure Access Service.
- **PulseUAC**—Pulse components required for Pulse Access Control Service.
- **PulseSRX**—Pulse components required for SRX Series Gateways.
- **PulseAppAccel**—Pulse components required for Pulse Application Acceleration Service.

The ADDLOCAL property has the following optional subfeatures:

- **Pulse8021x**—Available with PulseUAC. Includes 802.1X connectivity components.
- **SAEndpointDefense**—Available with PulseSA. Includes Enhanced Endpoint Security (EES) components for connections to Pulse Secure Access Service.
- **SAHostChecker**—Available with PulseSA. Includes Host Checker components for connections to Pulse Secure Access Service.

- **UACEndpointDefense**—Available with PulseUAC. Includes EES components for connections to Pulse Access Control Service.

- **UACHostChecker**—Available with PulseUAC. Includes Host Checker components for connections to Pulse Access Control Service.

- **UACIPSec**—Available with PulseUAC. Includes components required to connect to Pulse Access Control Service using IPSec from 32-bit Windows endpoints. This feature is available in the 32-bit MSI only.

- **UACIPSec64**—Available with PulseUAC. Includes components required to connect to Pulse Access Control Service using IPSec from 64-bit Windows endpoints. This feature is available in the 64-bit MSI only.

**Examples**

When you use ADDLOCAL, you should append `msiexec` options `/qn` or `/qb` to the command line to suppress the installation program user interface. These examples use `/qb`.

To install PulseUAC with 802.1X and EES support on a Windows 32-bit endpoint using a configuration file:

```
msiexec -i JunosPulse.x86.msi CONFIGFILE=c:\pulse\Pulse-Connection-no.jnprpreconfig ADDLOCAL=PulseUAC,Pulse8021x,UACEndpointDefense /qb
```

To install PulseSA on a 32-bit Windows endpoint using a configuration file:

```
msiexec -i JunosPulse.x86.msi CONFIGFILE="c:\temp\myconfiguration.jnprpreconfig" ADDLOCAL=PulseSA /qb
```

To install PulseSA with EES and Host Checker on a 64-bit Windows endpoint using a configuration file:

```
msiexec -i JunosPulse.x64.msi CONFIGFILE="c:\temp\myconfiguration.jnprpreconfig" ADDLOCAL=PulseSA,SAEndpointDefense,SAHostChecker /qb
```

To install PulseAppAccel on a 64-bit Windows endpoint using a configuration file:

```
msiexec -i JunosPulse.x64.msi CONFIGFILE="c:\temp\myconfiguration.jnprpreconfig" ADDLOCAL=PulseAppAccel /qb
```

To install all Pulse components on a 64-bit Windows endpoint using a configuration file:

```
msiexec -i JunosPulse.x64.msi CONFIGFILE="c:\temp\myconfiguration.jnprpreconfig" /qb
```

**Repairing a Pulse Installation on a Windows Endpoint**

Junos Pulse uses an MSI installer, which supports a repair function. If problems with Pulse on a Windows endpoint indicate missing or damaged files or registry settings, the user can easily run the installation repair program. The repair program performs a reinstall and replaces any missing files. The repair program does not install any files that were not part of the original installation. For example, if the file that holds Pulse connection configurations is damaged, the file installed by the repair program does not replace any
Pulse connections that were created by the user or deployed to the endpoint after the original Pulse installation.

To repair a Pulse installation on a Windows endpoint:

1. On the Windows endpoint where Pulse is installed, click Start > Programs > Juniper Networks > Junos Pulse > Repair Junos Pulse.
2. Follow the prompts for the installation wizard.
   When the program is finished, you might be prompted to reboot the system.

**Related Documentation**
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169

## Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File

The following procedures apply to OS X installations only.

After you create client connection sets and specify the connections to include within a client component set, you can create a preconfiguration file with all the connections you want to distribute with the Pulse client. After you run the Pulse installer on the endpoint, you run a special command that imports the settings from the preconfiguration file into Pulse.

To create a preconfigured Pulse installer for distribution to OS X endpoints:

1. Select Users > Junos Pulse > Connections and create a connection set with the connections that you want to distribute.
2. Select Users > Junos Pulse > Components.
3. If necessary, create a new component set with the connection sets you want to distribute.
   It does not matter which component option you select. All components, No components, or Minimal components. The Pulse installation program for OS X always installs all components.
4. Select the check boxes next to the component sets that you want to distribute.
5. Click Download Installer Configuration.
   You are prompted to save the preconfiguration. You can also specify the name of the target Pulse server for the connections, which enables you to quickly create multiple configuration files that are the same except for the target server.
   The default filename of the .jnppreconfig file is the name of the selected component set. Make note of the filename and location where you put the file. The preconfiguration file must be available to the clients either through a network share or distributed along with the Junos Pulse installer file.
7. Download the Junos Pulse installer, Junos Pulse Installer (Macintosh).
Installing the Pulse Client on OS X Endpoints Using Command-Line Options

The Junos Pulse installer includes the Pulse client and all of the software components for all of the Pulse services. The preconfiguration (.jnprpreconfig) file contains the definitions of the Pulse connections that provide client access to specific Pulse servers and services. After you distribute the Pulse installation package, you must first run the installer, and then run a separate program called jamCommand, which imports the settings from the .jnprpreconfig file. The jamCommand program is part of the Pulse installation.

The Pulse file you download from the Pulse server is in compressed (.dmg) format. You must unpack the file before you run the Pulse installation program.

The following steps include sample commands to install Pulse on an OS X endpoint and then import Pulse connections from a .jnprpreconfig file.

1. Run the Pulse installation program:
   ```bash
   sudo /usr/sbin/installer-pkg <full-path-to-the-pulse-install-package> -target /
   ```

2. Import the settings from the .jnprpreconfig file:
   ```bash
   /Applications/Junos/Pulse.app/Contents/Plugins/JamUI/jamCommand -importFile <full-path-to-the-jnprpreconfig-file>
   ```

Related Documentation

- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- jamCommand Reference on page 175

Junos Pulse Command-line Launcher

The Junos Pulse Launcher (pulselauncher.exe) is a standalone client-side command-line program that allows you to launch Pulse and connect to or disconnect from a Pulse server (Pulse Secure Access Service or Pulse Access Control Service) without displaying the Pulse graphical user interface.

Pulse Launcher Usage Notes:

- Pulse Launcher runs on Windows 32-bit and 64-bit endpoints.
- The Pulse Launcher program, pulselauncher.exe, is installed as part of a Pulse client installation in Program Files\Common Files\Juniper Networks\Integration or Program Files (x86)\Common Files\Juniper Networks\Integration.
- Pulse Launcher works only for the SSL VPN or UAC connection type. Pulse Launcher does not support the SRX or UAC (802.1X) connection types.
- The Pulse Launcher program does not support the role mapping option that prompts a user to select from a list of assigned roles. If you use the Pulse Launcher and more than one role can be assigned to a user, you must configure the role mapping settings
for the realm to merge settings for all assigned roles. If the realm settings require the user to select a role, the Pulse Launcher command fails and exits with return code 2.

- Pulse Launcher does not support secondary authentication.

To use the Pulse Launcher program:

1. Write a script, batch file, or application.
2. Include a call to the Pulse Launcher executable, pulselauncher.exe.
3. Include logic in your script, batch file, or application to handle the possible return codes.

   Table 11 on page 172 lists the Pulse Launcher return codes.

The following command shows the complete pulselauncher.exe command syntax:

```
```

Table 10: Pulse Launcher Arguments

<table>
<thead>
<tr>
<th>Argument</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>-version</td>
<td>Display the Pulse Launcher version information, then exit.</td>
</tr>
<tr>
<td>-help</td>
<td>Display available arguments information.</td>
</tr>
<tr>
<td>-stop</td>
<td>Stop Pulse and disconnect all active connections.</td>
</tr>
<tr>
<td>-url &lt;url&gt;</td>
<td>Specify the Pulse server URL.</td>
</tr>
<tr>
<td>-u &lt;user&gt;</td>
<td>Specify the username.</td>
</tr>
<tr>
<td>-p &lt;password&gt;</td>
<td>Specify the password for authentication.</td>
</tr>
<tr>
<td>-r &lt;realm&gt;</td>
<td>Specify the realm on the Pulse server.</td>
</tr>
<tr>
<td>-d &lt;DSID&gt;</td>
<td>Passes a cookie to Pulse Launcher for a specified Pulse server from another authentication mechanism when Pulse Launcher starts. When you use the -d argument, you must also specify the -url argument to specify the Pulse server.</td>
</tr>
</tbody>
</table>
Table 10: Pulse Launcher Arguments (continued)

<table>
<thead>
<tr>
<th>Argument</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>-cert &lt;client certificate&gt;</td>
<td>Specify the certificate to use for user authentication. For &lt;client certificate&gt; use the string specified in the Issued To field of the certificate. When using the -cert argument, you must also specify the -url and -r &lt;realm&gt; arguments.</td>
</tr>
<tr>
<td></td>
<td>To use certificate authentication with the Pulse Launcher program, you must first configure the Pulse server to allow the user to sign in via user certificate authentication. You must also configure a trusted client CA on the Pulse server and install the corresponding client-side certificate in the Web browsers of end-users before running the Pulse Launcher.</td>
</tr>
<tr>
<td></td>
<td>If the certificate is invalid, the Pulse Launcher displays an error message on the command line and logs a message in the log file.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> If Pulse is launched through a browser, the browser handles certificate verification. If Pulse is launched through an application on Windows, the application handles certificate verification. If Pulse is launched through the Pulse Launcher on Windows, Pulse Launcher handles the expired or revoked client certificates.</td>
</tr>
<tr>
<td>-signout &lt;url&gt;</td>
<td>Signout disconnects and signs out from a specific server. Suspend puts an active connection in the suspend state without removing the session information from the server. Resume restores a suspended connection. Pulse can have multiple simultaneous connections so the -url argument is required when you use -signout, -suspend, or -resume.</td>
</tr>
<tr>
<td>-suspend &lt;url&gt;</td>
<td></td>
</tr>
<tr>
<td>-resume &lt;url&gt;</td>
<td></td>
</tr>
<tr>
<td>-t &lt;timeout in seconds&gt;</td>
<td>The amount of time allowed for the connection to take place before the attempt fails. Min = 45 (default), Max = 600.</td>
</tr>
</tbody>
</table>

The following table lists the possible return codes pulselauncher.exe returns when it exits.

Table 11: Pulse Launcher Return Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-1</td>
<td>Pulse is not running.</td>
</tr>
<tr>
<td>0</td>
<td>Success.</td>
</tr>
<tr>
<td>1</td>
<td>A parameter is invalid.</td>
</tr>
<tr>
<td>2</td>
<td>Connection has failed or Pulse is unable to connect to the specified gateway.</td>
</tr>
<tr>
<td>3</td>
<td>Connection established with error.</td>
</tr>
<tr>
<td>4</td>
<td>Connection does not exist. Example: the command attempts to sign out from a server that has not been added on the Pulse UI.</td>
</tr>
<tr>
<td>5</td>
<td>User cancelled connection.</td>
</tr>
<tr>
<td>6</td>
<td>Client certificate error.</td>
</tr>
</tbody>
</table>
### Table 11: Pulse Launcher Return Codes *(continued)*

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>Timeout error.</td>
</tr>
<tr>
<td>8</td>
<td>No user connection allowed from Pulse UI.</td>
</tr>
<tr>
<td>9</td>
<td>No policy override from Pulse UI.</td>
</tr>
<tr>
<td>25</td>
<td>Invalid action for current connection state. This error code would occur if you tried to suspend or resume a connection that was disconnected.</td>
</tr>
<tr>
<td>100</td>
<td>General error.</td>
</tr>
</tbody>
</table>

### Examples

The following command is a simple login application that captures the credentials the user enters, and passes the credentials as arguments to pulselauncher.exe:

```bash
pulselauncher return code: 0
```

The following Pulse Launcher example shows a certificate authentication:

```bash
pulselauncher return code: 0
```

The following example shows a command to use Pulse Launcher to specify a cookie (-d) for a specific Pulse server (-u rl):

```bash
pulselauncher return code: 0
```

### Related Documentation

- [Using jamCommand to Import Junos Pulse Connections on page 173](#)
- [jamCommand Reference on page 175](#)

### Using jamCommand to Import Junos Pulse Connections

The jamCommand.exe program is a command line program that imports a .jnrpcreconfig file into the Pulse client. The jamCommand program is available for Windows (XP, Vista, Windows 7, and Windows 8) and Mac OSX.

**NOTE:** The working name for Junos Pulse during the early development phase was Juniper Access Manager. Many Pulse filenames, directories, and other Junos Pulse elements include the acronym “jam.”
A .jnprpreconfig file includes Pulse connection parameters. You can create a .jnprpreconfig file on the Pulse server, and then use it as part of a Pulse installation to ensure that Pulse users have one or more Pulse connections when they start Pulse for the first time.

NOTE: One typical use case for jamCommand on a Windows endpoint is to first run jamCommand to import one or more Pulse connections from a .jnprpreconfig file, and then run pulselauncher.exe to start Pulse.

To install Pulse connections using jamCommand:

1. Create a .jnprpreconfig file on the Pulse server.
   
   In the Pulse server admin console, click Users > Junos Pulse > Components.

2. Select the component sets you want, and then click Download Installer Configuration.

3. Distribute the .jnprpreconfig file to the Pulse endpoints.

4. Run jamCommand with the .jnprpreconfig file as an option. For example:
   
   On Windows:
   
   \Program Files\Common Files\Juniper Networks\JamUI\jamCommand -importfile myfile.jnprpreconfig

   On Mac OSX:
   
   /Applications/Junos Pulse/Contents/Plugins/JamUI/jamCommand -importfile myfile.jnprpreconfig

If the Pulse client is running when you run jamCommand, the new Pulse connection or connections appear immediately. The connection name appears as it was defined when you created the connection in the Pulse server admin console.

Related Documentation

- Junos Pulse Command-line Launcher on page 170
- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169
- jamCommand Reference on page 175
jamCommand Reference

**Syntax**

jamCommand [-import [script]] [-tray] [-log[level]]

/import

/importFile <script>

/tray

/log <level>

/stop

/suspend <GUIDS>

/resume <GUIDS>

/resume

/brand <brandfile>

/unbrand

/norestart

**Release Information**

Introduced with Pulse R1.0.
Pulse R3.1 introduced the suspend and resume options.
Pulse R4.0.3 introduced new options to support the Junos Pulse Client Customization tool.

**Description**

The jamCommand.exe program is a command line program that imports a .jnprpreconfig or a Branding.PulseBrandingPackage file into the Pulse client. The jamCommand program is available for Windows and Mac OSX.

**Options**

import—Import script from the default memory-mapped file.

importFile <script>—Import script from the specified file.

tray—Launch the tray notify application.

log—Set the global log level.

stop—Stop the Pulse UI.

suspend <GUIDS>—Suspend the Pulse UI.

resume <GUIDS>—Resume a suspended Pulse UI.
**brand** `<brandfile>`—Install the Pulse user interface changes defined in the Pulse branding file.

**unbrand**—Remove the changes applied by the Pulse branding file.

**norestart**—Do not restart Pulse after applying the Pulse branding file.

**Required Privilege Level**

administrator

**Related Documentation**

- Installing the Junos Pulse Client on Windows Endpoints Using a Preconfiguration File on page 165
- Installing the Junos Pulse Client on OS X Endpoints Using a Preconfiguration File on page 169
- Customizing Junos Pulse Overview on page 177
Customizing the Junos Pulse Client

- Customizing Junos Pulse Overview on page 177
- BrandPackager Workflow on page 179
- Setting Up the Junos Pulse Customization Environment on page 180
- Initializing the Junos Pulse Customization Environment on page 181
- Importing an Existing Customized Junos Pulse Package on page 182
- Editing Junos Pulse User Interface Labels on page 183
- Editing Junos Pulse Messages on page 187
- Adding Custom Graphics to Junos Pulse on page 188
- Customizing Junos Pulse for Windows Online Help on page 189
- Validating Customizations to the Junos Pulse Client on page 191
- Building the New Junos Pulse Package on page 191
- Testing the Junos Pulse Package on page 191
- Installing or Upgrading Pulse for Windows with a Branding Package on page 192
- Installing a Branding Package Only on page 193

Customizing Junos Pulse Overview

The Junos Pulse customization tool (BrandPackager) enables you to customize the appearance of the Junos Pulse Windows and Apple OS X clients. You can add your own identity graphic to the Pulse splash screen, to the program interface, and to Windows credential provider tiles. Figure 17 on page 178 shows graphic customizations applied to the Pulse for Windows client. You can also customize error and informational message text, the text that appears in dialog boxes and on buttons, and make limited changes to Pulse online Help. For example, you might want to add your help desk phone number to Pulse error messages and the Pulse online Help.

BrandPackager is available for download from juniper.net.

BrandPackager runs on Windows only, but you use it to create the package files for Pulse Windows and Pulse OS X clients. A package file contains your edits to Pulse resource files. The edited resource files are installed into a special folder on the client. When the Pulse client needs to access a particular file, it checks this special folder first and uses
the file if it is present. If Pulse does not find the file there, it uses the file that resides in
the normal Pulse resource file location.

For Windows, you deploy the package to endpoints and use an MSIEXEC command-line
installation option to instruct the installation program to apply your package file on the
endpoint. For OS X, you copy the package file, the Pulse installation program, and a script
file from the BrandPackager file set to an OS X computer, and then use them to add the
package file to the Pulse installation file.

You can apply your changes to new or upgrade installations. You can also apply your
customizations to an existing Pulse installation without installing or upgrading Pulse.
Your changes to the Pulse user interface, message text, and online Help persist through
normal client software upgrades.

Figure 17: Junos Pulse Interface and Splash Screen with Branding Graphics

BrandPackager Usage Notes

- BrandPackager supports Pulse for Windows and Pulse for Mac (OS X) clients.
- BrandPackager is compatible with Junos Pulse R5.0 or later.
- Pulse client customizations cannot be installed through Pulse Web portal (server)
  installations.
- When you edit Pulse resource files, you must preserve the UTF-8 encoding. UTF-8 files
  include 3 bytes {0xEF, 0xBB, 0xBF}, the Byte Order Mark (BOM), at the beginning of
  the file.
The Pulse interface and the online Help include separate resource files for each of the supported languages. If you make a change in the English file, you should make the same change in the files for the other languages that you support in your environment. If you do not do so, then the edited English version is always used.

Pulse online Help can include new information with each new release. If you edit a Help topic, your changes are retained during a Pulse client upgrade. However, if Juniper Networks changes that topic in the new release, that new information will not be available, because your edited topic will be used instead. For this reason we recommend that you make only limited changes to the online Help. For example, you can change the topic that describes how to contact customer support to direct users to contact your own help desk.

**Related Documentation**

- BrandPackager Workflow on page 179

**BrandPackager Workflow**

To create a rebranded Pulse client, you use the **BrandPackager** tool. The following procedure summarizes the steps from tool installation to client deployment. See the related documentation list for links to detailed information about the steps that are summarized here.

1. Download **PulseBrandingTools.zip** from juniper.net. Create a folder on a Windows 7 or Windows 8 computer for **PulseBrandingTools.zip**, and then unzip it. Make sure that the host computer has Pulse installed, and that the version of Pulse is the one that you want to customize and distribute to users.

   Set up the customization environment by installing 7Zip, a free open-source archive file program, and by running the **BrandPackager** initialization command to copy Pulse resource files to local work folders. To edit an existing package file, first import the file as part of the initialization process.

2. Edit the Pulse user interface files as needed.

3. Edit the Pulse message text files as needed.

4. Add your customization graphics.

5. Optionally, edit the Pulse online Help. There are separate procedures for the Windows and OS X online Help systems.

6. Run the **BrandPackager** script file to verify the structure of your changes and to create your package files.

7. Test your packages. The **BrandPackager** tool set provides a script to quickly activate your changes on the local machine for testing.

8. Deploying the package file is different depending on the platform:

   - For a Windows deployment, you install the package file by using an MSIEEXEC command option when you run the Pulse installer.

   - For an OS X deployment, you copy the branding package, the default Pulse for OS X installation file (**JunosPulse.dmg**), and **ConfigureInstaller** to the Mac, and then run
ConfigureInstaller. *ConfigureInstaller* is a Python script that adds the package file to the Pulse installation program. You can then run the Pulse OS X installation.

**Related Documentation**

- Setting Up the Junos Pulse Customization Environment on page 180
- Initializing the Junos Pulse Customization Environment on page 181
- Editing Junos Pulse User Interface Labels on page 183
- Editing Junos Pulse Messages on page 187
- Adding Custom Graphics to Junos Pulse on page 188
- Customizing Junos Pulse for Windows Online Help on page 189
- *Customizing Junos Pulse for Apple OS X Online Help*
- Validating Customizations to the Junos Pulse Client on page 191
- Building the New Junos Pulse Package on page 191
- Testing the Junos Pulse Package on page 191
- Installing or Upgrading Pulse for Windows with a Branding Package on page 192
- *Installing or Upgrading Pulse for Apple OS X with a Branding Package*

**Setting Up the Junos Pulse Customization Environment**

The Pulse *BrandPackager* customization tool must be run on a Windows 7 or Windows 8 computer that has Pulse 5.0 or later installed. Make sure that the Pulse installation includes all Pulse components to ensure that you have access to all of the Pulse resource files. *BrandPackager* creates the package files for Pulse Windows and Pulse OS X clients. A package file contains your edits to Pulse resource files.

To create the Pulse client customization environment:

1. If you have not already done so, download *PulseBrandingTools.zip* from juniper.net. Create a folder for *PulseBrandingTools.zip*, and then unzip it. Make sure that the host computer has Pulse installed, and that the version of Pulse is the one that you want to customize and distribute to users.

2. Install 7Zip.

   7Zip is a free open-source archive file program. It is used during the process of creating the Pulse customization package. You can download 7Zip from [http://7-zip.org/](http://7-zip.org/).

3. If you have not already done so, install Junos Pulse 5.0 or later on the endpoint where you will do the Pulse customization work.

**Related Documentation**

- Initializing the Junos Pulse Customization Environment on page 181
Initializing the Junos Pulse Customization Environment

The message text and user interface strings that appear in the Pulse client reside in text files that reside in different Pulse installation directories. After you install the BrandPackager tool, you run an initialization command that copies all the strings from the Pulse installation directories to two language-specific files in a reference directory called StringReference. The Pulse resource files are identical on Windows and OS X installations so the files from your Pulse Windows installation can be used for both Windows and OS X customizations.

During initiation, the Pulse customization tool creates the PulseBranding directory and copies Pulse strings from an active Pulse installation to the StringReference directory area for customization.

BrandPackager copies files from the local Pulse installation, so make sure that you have the Pulse version installed that you want to customize and distribute.

Make sure that the Pulse installation includes all Pulse components. You can download the Pulse installation program from a Pulse Access Control server or from a Pulse Secure Access server. You can configure and include Pulse connections in the installation before you edit the Pulse client files. For more information on Pulse installation options, see the Junos Pulse documentation.

To initialize the Pulse customization environment:

1. Run the following command:

   BrandPackager -init

The -init option does not overwrite files. If there is already a PulseBranding directory, only missing files are written to it.

By default, the Pulse online Help files are not included. To include the Help files, specify the -help option:

BrandPackager -init -help

The online Help files are different between Windows and OS X. BrandPackager uses the Windows files from the local Pulse installation. The OS X files are included as part of the BrandPackager file set. The -help option creates two directories. The help directory holds the Windows files. The JunosHelp.Help directory holds the OS X online Help files.

You can run BrandPackager -init -help if you have already run the -init option and want to just add the Help files.

Localized files in the StringReference directory are identified by a language identifier:

- DE – German
- EN – English
- ES – Spanish
Related Documentation

- Editing Junos Pulse User Interface Labels on page 183
- Editing Junos Pulse Messages on page 187
- Adding Custom Graphics to Junos Pulse on page 188
- Customizing Junos Pulse for Windows Online Help on page 189
- Customizing Junos Pulse for Apple OS X Online Help
- Validating Customizations to the Junos Pulse Client on page 191

Importing an Existing Customized Junos Pulse Package

If you already have a customized BrandPackager package, you can import it and make further changes to it without starting over. Also, changes to Pulse Help are not retained during a Pulse software upgrade operation. You should import the old package that has the Help file changes, create a new package, and then include that with the upgrade.

NOTE: If you are upgrading to a new major release of Pulse, make sure you have the latest version of BrandPackager before you create a new BrandPackager package.

To import an existing customized BrandPackager package into the PulseBranding directory:

1. Open a Command Prompt window and make the PulseBranding directory your working directory.
2. Run the following commands:
   BrandPackager -init
   BrandPackager -import <filename>

   The -import option must include the filename of your existing BrandPackager package file. For example:
   BrandPackager -import C:/Staging/PulseWin.PulseBranding

   If your original BrandPackager package included changes to the online Help, run the optional -help option:
BrandPackager -init -help
BrandPackager -import <filename>

The -import option overwrites any files in the PulseBranding directory. The program prompts you for confirmation before it makes any changes.

Related Documentation
- Editing Junos Pulse User Interface Labels on page 183
- Editing Junos Pulse Messages on page 187
- Adding Custom Graphics to Junos Pulse on page 188
- Customizing Junos Pulse for Windows Online Help on page 189
- Customizing Junos Pulse for Apple OS X Online Help
- Validating Customizations to the Junos Pulse Client on page 191

**Editing Junos Pulse User Interface Labels**

You can modify any text string that appears in the Pulse user interface. Pulse user interface strings reside in the StringReference\PulseResource_XX.txt file. Your modified strings must reside in the PulseBranding\BrandingResourceCatalog_XX.txt file. (XX indicates the language.)

**NOTE:** If your Pulse environment uses Security Assertion Markup Language (SAML) for a Single Sign-on (SSO) authentication environment, the Pulse user sees a credential dialog box that is served from the Pulse server instead of the local Pulse client credential dialog box. The sign-in page is defined as part of the sign-in policy on the Pulse server and the Pulse client embeds the sign-in page within a Pulse client dialog box. To change the appearance of the SAML credential dialog, you must edit or create a new sign-in page on the Pulse server.

The BrandingResourceCatalog files hold only the strings you modify. The default strings in their normal files are used for all strings that you do not modify.
The following procedure describes the workflow for modifying user interface strings using the English language version of the Pulse Edit Connection dialog box as an example:

1. Start Pulse and then display the Pulse string that you want to modify. For example, in the Pulse main window, select a connection and then click **File > Connection > Edit**. Press the Alt key to show shortcut characters.

   Figure 18: Pulse Dialog with Shortcut Keys Underlined

2. Take a screen shot of the screen that you want to modify.

   The screen shot is not required but it can help you maintain or create a new shortcut character when you edit the string in the catalog file. It is good practice to keep track of what you change so you can verify your changes later.

3. Find the string that you want to modify.

   Search **StringReference\PulseResource_EN.txt** for the string. The string might appear more than once. For example, the string **Server URL** appears twice as a value in **PulseResource_EN.txt** because that string appears in two different dialog boxes. In general, the resource ID indicates where the value is used.

   Figure 19: StringReference

```
;IDS_CONNECTION_DLG_ST_NAME
[183]
Value = Name:

;IDS_CONNECTION_DLG_ST_URL
[184]
Value = &Server URL;

;IDS_CONNECTION_DLGBTN_CONNECT
[185]
Value = &Connect
```

Many strings use an ampersand (&) to designate a keyboard shortcut key. The ampersand causes the character that follows it to appear as an underlined character
in the user interface. The presence of the ampersand can affect your results when you use the editor's search function.

4. Open `PulseBranding\BrandingResourceCatalog_EN.txt` with a text editor.

5. Copy the string that you want to edit from `PulseResource_EN.txt` to `BrandingResourceCatalog_EN.txt`. Be sure to copy/paste the entire entry. For example:

```
;IDS_CONNECTION_DLG_ST_URL
[184]
Value = &Server URL:
```

6. Modify the string in `BrandingResourceCatalog_EN.txt`. For example:

```
;IDS_CONNECTION_DLG_ST_URL
[184]
Value = &Server URL:
```

Modify only the value. Do not change the string identifiers, `;IDS_CONNECTION_DLG_ST_URL` and `[184].`

We suggest that you keep the same letter for the shortcut to avoid a conflict with other strings on the screen. If the shortcut key letter does not appear in the new string, you can include it by putting it in parentheses. For example, the following entries show how to change Close to Exit and retain the "C" as a shortcut key:

```
;IDS_MAIN_DLG_BTN_CANCEL
[188]
Value = &Close
```

```
;IDS_MAIN_DLG_BTN_CANCEL
[188]
Value = Exit(&C)
```

You should change the shortcut letter only if you are certain that the new letter is not used elsewhere in that dialog box.

Each shortcut key on a screen must be unique. You can eliminate the shortcut by deleting the ampersand. However, shortcut keys are a part of good user interface design.

7. Edit that same resource ID in each of the language files that your organization supports.

The Pulse interface includes separate files for each of the 10 supported languages. If you make a change in the English file, you should make the same change for the other languages that you support in your environment. If you do not do so, then the edited English version is always used.

After initialization, there are two files for each language in the `StringReference` directory:

- `PulseCombinedMessages_XX.txt`
  Message catalog files hold the text that appears in the Pulse program interface and dialog boxes.

- `PulseResource_XX.txt`
Resource catalog files hold the text that appears in Pulse message boxes.

Figure 20: BrandPackager StringReference Directory

To customize a particular string, you find the string you want to customize in PulseCombinedMessages_XX.txt or PulseResource_XX.txt, and then copy and paste that entire string and its resource ID to a corresponding resource or message file in the PulseBranding directory, where you edit it. This directory holds all of the files that make up your customization package.

NOTE: You must use a text editor, such as Visual Studio IDE or Notepad++, that retains the byte order mark (BOM) in the resource files. (Notepad++ is free open source software available at http://notepad-plus-plus.org/)

NOTE: See the Sample directory for an example of a customized Pulse client file set.

Related Documentation

- Editing Junos Pulse Messages on page 187
- Adding Custom Graphics to Junos Pulse on page 188
- Customizing Junos Pulse for Windows Online Help on page 189
- Customizing Junos Pulse for Apple OS X Online Help
- Validating Customizations to the Junos Pulse Client on page 191
Editing Junos Pulse Messages

Pulse message strings reside in the StringReference\PulseCombinedMessages_XX.txt file. Modified message strings must reside in the PulseBranding\BrandingMessageCatalog_XX.txt file. (XX indicates the language.)

The BrandingMessageCatalog files hold only the strings that you modify. The default strings in the installed resource files are used for all strings that you do not modify.

It is not always possible to set up the conditions that cause a particular message to appear in Pulse. Browsing the contents of BrandingMessageCatalog_XX.txt is the easiest way to identify the strings you might want to change.

You can use HTML tags within the BrandingMessageCatalog entries. For example, you can use <b> and </b> tags to make text appear in bold type. You can use <A href= > tags to include a link to other HTML text you want. Make sure that your link displays the text in a new window. For example:

<A HREF="Http://www.myserver/my-message.html" target="_blank">

Keep in mind that the Pulse client might not be connected to the Internet when the error occurs.

Each message includes a short description and a long description. The short description is shown as a title to the longer description. There are no limits to the number of characters that you can include as the long description. However, the long description must be on one line in the message catalog file. Use HTML <br> and </br> tags to insert line breaks when the message is displayed.

To modify a message:

1. Find the string that you want to modify.
   Search PulseCombinedMessages_XX.txt for the string. In general, the resource ID indicates where the value is used.

2. Open PulseBranding\BrandingMessageCatalog_XX.txt with a text editor.

3. Copy the string that you want to edit from StringReference\PulseCombinedMessages_XX.txt to BrandingMessageCatalog_XX.txt. Be sure to copy/paste the entire entry. For example:

   [1731]
   ;kMsgCommonCertTrustPulseAuthServerIdentityNotFound
   Short-desc = Authentication server not trusted.
   Long-desc = Authentication server identity not found in client's "Trusted Server List".
   Contact your network administrator.

4. Modify the string in BrandingMessageCatalog_XX.txt. For example:

   [1731]
   ;kMsgCommonCertTrustPulseAuthServerIdentityNotFound
   Short-desc = Authentication server not trusted.
Long-desc = Authentication server identity not found in client's "Trusted Server List". Contact the Help Desk at Ext.50123.

5. Edit that same resource ID in each of the language files that your organization supports.

   The Pulse interface includes separate files for each of the 10 supported languages. If you make a change in the English file, you should make the same change for the other languages you support in your environment. If you do not do so, then the edited English version is always used.

Related Documentation

- Editing Junos Pulse User Interface Labels on page 183
- Adding Custom Graphics to Junos Pulse on page 188
- Customizing Junos Pulse for Windows Online Help on page 189
- Customizing Junos Pulse for Apple OS X Online Help
- Validating Customizations to the Junos Pulse Client on page 191

Adding Custom Graphics to Junos Pulse

The PulseBranding directory also includes default graphics. To add your custom graphics to the Pulse interface, simply replace the default graphics with your custom graphics.

You can add a graphic to the following areas:

- Next to the Pulse logo on the main screen
- In dialog boxes
- On the About screen
- On the Pulse splash screen

NOTE: The Pulse connection set properties, which you define on the Pulse server, include an option to suppress the Pulse splash screen.

The PulseBranding directory includes two graphics:

- BrandingLogo.png—Appears on the Pulse splash screen and program interface. The default BrandingLogo.png file is an empty file with a transparent background. For best results, your graphic image should have a transparent background. The file must be a PNG file.

  The default BrandingLogo.png file is 19 by 52 pixels. The maximum height is 37 pixels, which corresponds to the size of the Pulse logo. Maximum width is 100 pixels. A graphic larger than the recommended size might be clipped or it could obscure other graphic elements.
• **BrandingCredProv.png**—Appears as the image on credential provider tiles.

To add a custom graphic:

1. Replace `PulseBranding\BrandingLogo.png` with your graphic.
2. Replace `PulseBranding\BrandingCredProv.png` with your graphic.

If you do not want to include a custom graphic, you should delete default graphics from `PulseBranding`.

### Related Documentation

- Editing Junos Pulse User Interface Labels on page 183
- Editing Junos Pulse Messages on page 187
- Customizing Junos Pulse for Windows Online Help on page 189
- *Customizing Junos Pulse for Apple OS X Online Help*
- Validating Customizations to the Junos Pulse Client on page 191

### Customizing Junos Pulse for Windows Online Help

The Pulse online Help provides reference and procedural information for users. Pulse users can access the Help by clicking the Help button in the Pulse program interface. Pulse online Help is a collection of standard HTML files with CSS formatting and javascript navigation. Updating the Help requires knowledge of basic HTML coding. To edit the online Help, you must include the Help when you initialize the Pulse customization environment.

**NOTE:** If you edit a Help topic, your edited topic is used instead of the original topic. Your edited topic is retained during an upgrade. Pulse online Help can include new information with each new release. If Juniper Networks changes a topic in the new release, that new information will not be available because your edited topic is used instead. To avoid this problem, we recommend that you make only the Help topic changes described in this guide.

One topic (access-control-connect-client-jtac-contacting.html) describes how to contact Juniper Technical Support. You might want to edit that topic and substitute your own help desk contact information. Use an HTML editor to make your changes. Do not change the filename or any of the javascript code within the topic.

Pulse Help includes the following language versions:

- DE – German
- EN – English
- ES – Spanish
FR – French
IT – Italian
JA – Japanese
KO – Korean
PL – Polish
ZH-CN – Chinese (Simplified)
CN – Chinese (Traditional)

Be sure to edit the same topics for all the languages that you support.

The Pulse Help viewer includes a menu item labeled Feedback, which links to a documentation comments page on juniper.net.

To change the Feedback destination URL or to remove the menu item:

1. Open j_header.html with an HTML editor.
2. Search for the following string:
   https://www.juniper.net/cgi-bin/docbugreport/
3. Either edit or remove the link.

Related Documentation
- Editing Junos Pulse User Interface Labels on page 183
- Editing Junos Pulse Messages on page 187
- Adding Custom Graphics to Junos Pulse on page 188
- Validating Customizations to the Junos Pulse Client on page 191
- Customizing Junos Pulse for Apple OS X Online Help
Validating Customizations to the Junos Pulse Client

The validation process examines the files in the PulseBranding directory to ensure that they can be added to the Pulse installation package.

To validate your changes before building the BrandPackager package:

1. Run the following command:
   ```
   BrandPackager-validate
   ```

   Validation is a basic level of checking. After you build the new Pulse installation package, you should test the package before you deploy it.

Building the New Junos Pulse Package

The packaging process creates two package files, one for Windows and one for OS X, that include your changes. It does not include the Pulse installation files. You include a package when you install Pulse. Or you can apply your changes to a Pulse client without installing or upgrading Pulse.

To create a package:

1. Run the following command:
   ```
   BrandPackager-package
   ```

   When the command finishes, it creates two package files, PulseWin.PulseBranding and PulseMac.PulseBranding. To apply your changes on a Pulse endpoint, you include a package file when you install or upgrade Pulse.

Testing the Junos Pulse Package

Before you deploy the new Pulse installation package, you should verify that your changes work correctly. BrandInstaller.bat installs the BrandPackager package on the local machine. BrandInstaller.bat employs jamCommand.exe, which is a program that resides in the Pulse program directory.

NOTE: You must be an administrator to run BrandInstaller.
To install your BrandPackager package on the machine where you created it:

1. Run the following command:

   ```shell
   BrandInstaller -brand
   ```

   You can now view your changes on the local Pulse client to make sure that you have made all the modifications correctly. Verify the Pulse client by checking the following:

   - View the main dialog and the About screen to make sure that the branding logo appears as you want.
   - View the screens that contain any of the user interface strings that you changed.
   - If you have updated the Pulse for Windows Help, invoke the Help to make sure your changes are correct.

   If you are satisfied, you can install the package on endpoints.

   Related Documentation:
   - Installing or Upgrading Pulse for Windows with a Branding Package on page 192
   - Installing or Upgrading Pulse for Apple OS X with a Branding Package
   - Installing a Branding Package Only on page 193

### Installing or Upgrading Pulse for Windows with a Branding Package

You install or upgrade Pulse and apply the changes in `PulseWin.PulseBranding` to a Pulse Windows client by using Microsoft Exec (`msiexec`) and setting the `BRANDINGFILE` attribute to point to the branding file. This installation requires administrative privileges.

The following example shows the `msiexec` command to install or upgrade Junos Pulse and to apply the customizations in `PulseWin.PulseBranding`:

```shell
msiexec -i c:\staging\JunosPulse.x64.msi
BRANDINGFILE=c:\staging\PulseWin.PulseBranding
```

For more information on installing Junos Pulse, see the Junos Pulse documentation.

Related Documentation:
- Installing or Upgrading Pulse for Apple OS X with a Branding Package
- Installing a Branding Package Only on page 193
Installing a Branding Package Only

You can add or remove the contents of a Pulse branding package on a client machine by using jamCommand. The jamCommand program is part of every Junos Pulse installation. On Windows endpoints, jamCommand is located in the 32-bit program files directory:

Program Files (x86)\Common Files\Juniper Networks\JamUI\jamCommand.exe

On OS X endpoints, jamCommand is located in the Applications folder:

Applications/Junos Pulse/Contents/Plugins/JamUI/jamCommand

For more information on installing Junos Pulse, see the Junos Pulse documentation.

NOTE: The jamCommand program must be run with administrator privileges.

To apply the customizations in PulseWin.PulseBranding (Windows) or PulseMac.PulseBranding (OS X):

1. Run the following command:

   jamCommand -brand

   To remove your customized Pulse user interface from the endpoint and allow Pulse to use default strings:

1. Run the following command:

   jamCommand -unbrand

jamCommand Usage Notes:

- Running jamCommand with the -brand or -unbrand option causes Pulse to restart. Connections are maintained and should be active after the restart. A restart is required to allow Pulse to access the customized settings. If you will be rebooting the system manually, or if there is no logged in user, then you can use the -norestart option. To avoid a restart when you run jamCommand, use the following option:

   jamCommand -norestart

- jamCommand reports its results using the following numeric error codes:

  0 - Success.
  1 - General branding error.
  2 - Error deleting branding files. This error can also occur when you install new files because the first action -brand performs is to remove the old files.
  3 - Error branding Pulse. The new branding files cannot be written.
The Pulse client version must be R5.0 or later. To verify your current version of Pulse, run `jamCommand` with no parameters. If the result (displayed in a window) shows the branding options (`-brand`, `-unbrand`, `-norestart`), then branding is supported.

The `jamCommand` errors are not written to the console. To see `jamCommand` errors, include a script that checks error codes. Additional error message information is written to the Pulse log files.

Related Documentation

- Installing or Upgrading Pulse for Windows with a Branding Package on page 192
- *Installing or Upgrading Pulse for Apple OS X with a Branding Package*
PART 2

Junos Pulse Compatibility

This section provides detailed information about the how Junos Pulse features compare to Odyssey Access Client and Network Connect software features.

- Client Software Feature Comparison on page 197
CHAPTER 9

Client Software Feature Comparison

- Comparing Odyssey Access Client and Junos Pulse on page 197
- Comparing Network Connect and Junos Pulse on page 201

Comparing Odyssey Access Client and Junos Pulse

Junos Pulse is a single integrated, multiservice network client that provides the basic services provided by the older Network Connect and Odyssey Access Client software. Pulse also supports dynamic connectivity, access control, security, and application acceleration for Microsoft Windows-based devices, secure connectivity for Mac OSX devices, and connectivity, mobile security, and mobile device management (MDM) for mobile devices, all with a simple, easy to use, elegant user experience.

Table 12 on page 197 compares the features in Odyssey Access Client (OAC) and Junos Pulse to help you transition to Pulse. For detailed information about supported platforms and installation requirements, see the Junos Pulse Supported Platforms Guide, which is available at http://www.juniper.net/support/products/pulse.

Table 12: Odyssey Access Client and Junos Pulse Feature Comparison

<table>
<thead>
<tr>
<th>Feature</th>
<th>Junos Pulse Release 5.0 OSX</th>
<th>Junos Pulse Release 5.0 Win</th>
<th>Odyssey Access Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wired/Wireless 802.1X Features</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wired 802.1X support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>(with Microsoft Windows supplicant)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto scan lists</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>(with Microsoft Windows supplicant)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Wireless suppression</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>(with Microsoft Windows supplicant)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Table 12: Odyssey Access Client and Junos Pulse Feature Comparison (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Junos Pulse Release 5.0 OSX</th>
<th>Junos Pulse Release 5.0 Win</th>
<th>Odyssey Access Client</th>
</tr>
</thead>
<tbody>
<tr>
<td>Support for Network Provider (scraping passwords, listing)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Association Mode and Encryption Methods</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Association mode support (for open, shared, WPA/WPA2)</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>(with Microsoft Windows supplicant)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encryption (for WEP, TKIP, AES, WEP with preconfigured key, WPA/WPA2 with pre-shared key)</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>(with Microsoft Windows supplicant)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAP Methods</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAP-TLS outer authentication</td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>EAP-TTLS outer authentication</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>• With EAP-JUAC inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With EAP-MSCHAPv2 inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With EAP-GTC inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With EAP-MD5 inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With PAP inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With CHAP inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With MSCHAP inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With MSCHAPv2 inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAP-PEAP outer authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With EAP-JUAC inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With EAP-MSCHAPv2 inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>• With EAP-GTC inner authentication</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Authentication Methods</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prompt for user name and password</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Table 12: Odyssey Access Client and Junos Pulse Feature Comparison (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Odyssey Access Client</th>
<th>Junos Pulse Release 5.0 OSX</th>
<th>Junos Pulse Release 5.0 Win</th>
<th>Certifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Certificate support (automatic, specific)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Pulse SSL-VPN mode of SA connection is fully FIPS compliant.</td>
</tr>
<tr>
<td>Certificates from smart card reader</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Pulse server certificate verification and private key signing is FIPS compliant.</td>
</tr>
<tr>
<td>Soft token support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Pulse IPSec is FIPS compatible.</td>
</tr>
<tr>
<td>Machine login support</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td>Pulse wireless is FIPS compatible. (WPA encryption is controlled by Windows.)</td>
</tr>
<tr>
<td>Machine authentication followed by user authentication</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Credential provider on 32- and 64-bit Windows Vista, Windows 7, and Windows 8</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Pre-desktop login</td>
<td>N/A</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Configurable UAC Layer 2 connection</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Configurable connection association modes</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FIPS compliance</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Installation and Upgrade Methods</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-upgrade</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Web-based installation</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Standalone installation</td>
<td>Yes (.dmg)</td>
<td>Yes (.msi)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Upgrade/coordinate with previous versions</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Manual Uninstall</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
Table 12: Odyssey Access Client and Junos Pulse Feature Comparison (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Odyssey Access Client</th>
<th>Junos Pulse Release 5.0 OSX</th>
<th>Junos Pulse Release 5.0 Win</th>
<th>Logging and Diagnostics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser based installation and upgrades</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Diagnostics and Logging</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPsec diagnostics and configuration</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Host Enforcer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log viewer</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logging and Diagnostics</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Set debug level</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>In addition to the Pulse log files, Pulse writes events to the Windows application event log. (Windows Vista and Windows 7 systems only.)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Other Features</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPSWAT IMV support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Shavlik IMV support (patch assessment)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automatic patch remediation</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>via Shavlik or SMS/SCCM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Host Checker support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Enhanced Endpoint Security support (Windows OS only)</td>
<td>N/A</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IPSec tunneling to Policy Enforcement Points with NAT-T</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Access service and plug-ins</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Block 3rd party EAP messages</td>
<td>N/A</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Layer 3 authentication</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Server-based pre-configuration of realm/role</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Extend session duration</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>IC cardinality</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
Table 12: Odyssey Access Client and Junos Pulse Feature Comparison (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Odyssey Access Client</th>
<th>Junos Pulse Release 5.0 OSX</th>
<th>Junos Pulse Release 5.0 Win</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client-site management of clustered Pulse servers</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Kerberos SSO</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Initial configuration (intervention-less client provisioning)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Dynamically configurable</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Related Documentation

- Comparing Network Connect and Junos Pulse on page 201

Comparing Network Connect and Junos Pulse

Junos Pulse is a single integrated, multiservice network client that provides the basic services provided by the older Network Connect and Odyssey Access Client software. Pulse also provides dynamic connectivity, access control, security, and application acceleration for Microsoft Windows-based devices, secure connectivity for Mac OSX devices, and connectivity, mobile security, and mobile device management (MDM) for mobile devices, all with a simple, easy to use, elegant user experience.

Table 13 on page 201 compares the features of NC and Pulse to help you transition from NC to Junos Pulse. For detailed information about supported platforms and installation requirements, see the Junos Pulse Supported Platforms Guide, which is available at http://www.juniper.net/support/products/pulse.

Table 13: Network Connect and Junos Pulse Feature Comparison

<table>
<thead>
<tr>
<th>Feature</th>
<th>Network Connect Release 6.3</th>
<th>Junos Pulse Release 5.0 Mac</th>
<th>Junos Pulse Release 5.0 Win</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proxy Support</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Mozilla Firefox</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Apple Safari</td>
<td></td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Google Chrome</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Split Tunneling Options</td>
<td></td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Disable split tunneling without route monitor</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Disable split tunneling with route monitor</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
### Table 13: Network Connect and Junos Pulse Feature Comparison (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Junos Pulse Release 5.0 Mac</th>
<th>Junos Pulse Release 5.0 Win</th>
<th>Network Connect Release 6.3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable split tunneling but allow directly connected local subnet access</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Enable split tunneling with route monitors</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Enable split tunneling without route monitors</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Enable split tunneling with allowed access to local subnet</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Disable split tunneling with allowed access to local subnet</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Client Launch Options</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Command line launcher</td>
<td>Yes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log out on connect</td>
<td>n/a</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Launch as a standalone client</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Launch from browser</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>GINA and Credential Provider support</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Transport Mode</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SSL fallback mode</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>NOTE: If ESP is not available, the connection uses SSL. Once a connection switches to SSL it does not go back to ESP until the connection is restarted.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ESP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Other Features</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OPSWAT IMV support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Shavlik IMV support (patch assessment)</td>
<td>Yes</td>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td>Patch automatic remediation</td>
<td>Yes</td>
<td></td>
<td>via Shavlik or SMS/SCCM</td>
</tr>
<tr>
<td>Host Checker support</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>
### Table 13: Network Connect and Junos Pulse Feature Comparison (continued)

<table>
<thead>
<tr>
<th>Feature</th>
<th>Network Connect Release 6.3</th>
<th>Junos Pulse Release 5.0 Mac</th>
<th>Junos Pulse Release 5.0 Win</th>
<th>Certifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enhanced Endpoint Security support (Windows OS only)</td>
<td>Yes</td>
<td>Yes</td>
<td>N/A</td>
<td>Pulse SSL-VPN mode of SA connection is fully FIPS compliant.</td>
</tr>
<tr>
<td>Run configured scripts when client connects/disconnects</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Pulse server certificate verification and private key signing is FIPS compliant.</td>
</tr>
<tr>
<td>Modify DNS server search order based on server configuration</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Pulse IPSec is FIPS compatible.</td>
</tr>
<tr>
<td>Reconnect automatically if connection breaks</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Pulse wireless is FIPS compatible. (WPA encryption is controlled by Windows.)</td>
</tr>
<tr>
<td>Dial-up adapter support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>3G wireless adapter support</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Max/Idle Session Time-outs</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Logging</td>
<td>Log to file</td>
<td>Yes</td>
<td>Yes</td>
<td>Log to file</td>
</tr>
<tr>
<td></td>
<td>Upload log</td>
<td>Yes</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

#### Certifications

FIPS

- Pulse SSL-VPN mode of SA connection is fully FIPS compliant.
- Pulse server certificate verification and private key signing is FIPS compliant.
- Pulse IPSec is FIPS compatible.
- Pulse wireless is FIPS compatible. (WPA encryption is controlled by Windows.)

### Pulse Split Tunneling

Table 14 on page 203 lists the Network Connect split tunneling options and shows how they map to Pulse split tunneling options.

### Table 14: Pulse Split Tunneling

<table>
<thead>
<tr>
<th>NC Split Tunnel Option</th>
<th>Pulse Split Tunnel Setting</th>
<th>Route Override State</th>
<th>Route Monitor State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable split tunnel</td>
<td>Disabled</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Table 14: Pulse Split Tunneling (continued)

<table>
<thead>
<tr>
<th>NC Split Tunnel Option</th>
<th>Pulse Split Tunnel Setting</th>
<th>Route Override State</th>
<th>Route Monitor State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable split tunneling but allow local access</td>
<td>Disabled</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Enable split tunnel</td>
<td>Enable</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Enable split tunnel with route monitor</td>
<td>Enable</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Enable split tunnel, allow local access</td>
<td>Enable</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Related Documentation

- Comparing Odyssey Access Client and Junos Pulse on page 197
PART 3

Junos Pulse for Mobile Devices

- Junos Pulse for Mobile Devices and Junos Pulse Mobile Security Suite on page 207
- Junos Pulse for Apple iOS on page 211
- Junos Pulse for Google Android on page 235
- Junos Pulse for Nokia Symbian Devices on page 253
- Junos Pulse for Windows Mobile Devices on page 257
Junos Pulse for Mobile Devices and Junos Pulse Mobile Security Suite

Junos Pulse Secure Access Service supports authenticated access from mobile (handheld) devices to corporate applications such as corporate e-mail and the corporate intranet through Pulse Secure Access Service. The Pulse client software for mobile devices includes remote VPN capabilities as well as device security capabilities activated by the Junos Pulse Mobile Security Suite. The Pulse for Android and Pulse for iOS clients support Junos Pulse Collaboration for online meeting services.

The Junos Pulse Mobile Security Suite (MSS) is an optional component of Junos Pulse for mobile devices. The MSS provides (depending on the device OS) antivirus, antispam, and personal firewall services and enables an administrator to monitor and remove device applications and content, perform backup and restore operations, activate remote lock and remote wipe operations, and track devices using GPS. Each supported mobile device supports a specific list of Pulse Mobile Security Suite features.

Each supported mobile device requires that the user install the Pulse client software for the particular device type. The Pulse app is available as a free download from the app stores of the supported mobile devices, and the Windows Mobile app is available from juniper.net. The Pulse MSS is available as a separate server-based product. Pulse for mobile devices and Pulse Mobile Security Suite software cannot be deployed directly from Pulse Secure Access Service. The type of secure connectivity and the supported security features vary according to what is supported on each mobile operating system.

Updated versions of each Junos Pulse mobile client are released independently of each other. Some client features are not available in earlier client releases. If necessary, the description of a particular feature includes the minimum release required for that feature. For VPN features, the Pulse client communicates with the Junos Pulse Secure Access Service. For Pulse Mobile Security Suite features, the client communicates with the Pulse Mobile Security Gateway. As a general rule, users should upgrade to the most recent Pulse client software version to insure compatibility with all server updates.
Pulse is supported on the following mobile devices:

- Junos Pulse for Apple® iOS (iPhone, iPad, and iPod Touch)
- Junos Pulse for Google Android™
- Junos Pulse for BlackBerry
- Junos Pulse for Windows® Mobile
- Junos Pulse for Nokia® Symbian

**NOTE:** Although BlackBerry devices are supported by the Pulse MSS, Junos Pulse VPN software is not available for BlackBerry. However, some BlackBerry devices include support for IKEv2 and you can configure the BlackBerry IKEv2 to connect to Pulse Secure Access Service. See the Junos Pulse Mobile Supported Platforms Guide, which is available at http://www.juniper.net/support/products/pulse/mobile/, for details about BlackBerry devices that can use IKEv2.

The Junos Pulse Mobile Supported Platforms Guide lists the mobile device OS versions supported by Pulse and the security features supported on each mobile device OS.

### Junos Pulse Mobile Security Gateway

Although you enable network access for Pulse on mobile devices using the Pulse Secure Access Service admin console, you manage the security features of the mobile devices by using the Junos Pulse Mobile Security Gateway. The administration interface of the Pulse Mobile Security Gateway enables you to protect and manage mobile devices. For more information, see the Junos Pulse Mobile Security Gateway documentation.

**Related Documentation**

- Junos Pulse for Apple iOS Overview on page 211
- Junos Pulse for Android Overview on page 235
- Junos Pulse for Symbian Overview on page 253
- Junos Pulse for Windows Mobile Overview on page 257

### Junos Pulse Mobile Clients and User Agent Strings

A user agent string is how a Web server identifies the type of browser that is requesting service. A Web server can use that information to provide content that is tailored for the browser. Portions of the Pulse user interface on a mobile device, such as the login screen and intranet bookmarks, are Web pages served from the Pulse server and displayed by the embedded browser of the Pulse client. The appearance of these Web pages can be affected by how the Pulse server is configured to map user agent strings to specific client types.

SA Series software Release 7.1 introduced new user agent string and client type pairings that are designed for each supported Pulse mobile device. If you change any of the user
agent string and client type pairings for mobile devices prior to upgrading your SA Series software to Release 7.1, your changes might cause Pulse mobile device screens to display content incorrectly. If the Pulse interface on mobile devices is not appearing as expected, you should remove your edited user agent string and client type pairings so that the Pulse clients can access the new configurations. SA Series software Release 7.2 introduced a change in how the Pulse secure access server provides the bookmarks index page so that changes to your configuration of user agent string and client type pairings do not affect how the mobile device displays the Pulse bookmarks.

To view and edit the user agent string and client type pairings on your Pulse server:

1. **Click System > Configuration > Client Types.**
   - To edit an existing item, click an item in the table to select it. The string pattern is available for editing in a text box and you can select the client type from a list box.
   - To add a new user agent string and client type pairing, type a string pattern in the edit box at the top of the list, choose a client type from the list box, and then click Add. You can use the * and ? wildcard characters in your string. Note that user agent strings are not case-sensitive.

2. To reorder the list, click an item to select it and then use the up and down arrow buttons to move the item up or down in the list. When a browser requests access, the user agent string submitted by the browser is compared against the list starting at the top of the list and continuing down the list until the first match is reached.
   - The default pairing (User Agent String = "*", Client Type = "Standard HTML") is listed as the last entry in the table to ensure that it is used only when no other pairing applies. You cannot edit, delete, or reorder the default pairing.

3. When you finish making changes to the table, click **Save Changes.**

Table 15 on page 209 lists the User Agent String and Client Type pairings for supported mobile devices in SA Series software.

### Table 15: User Agent String Client Type Pairings for Mobile Devices

<table>
<thead>
<tr>
<th>SA Series Software</th>
<th>Apple iOS</th>
<th>Google Android</th>
<th>Windows Mobile</th>
<th>Nokia Symbian</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release 7.0 and earlier</td>
<td>User Agent String = &quot;*&quot;, Client Type = &quot;Standard HTML&quot;</td>
<td>User Agent String = &quot;*&quot;, Client Type = &quot;Standard HTML&quot;</td>
<td>User-agent string = &quot;<em>Windows CE</em>&quot;, Client Type = &quot;Mobile HTML (Pocket PC)&quot;.</td>
<td>User Agent String = &quot;<em>Symbian OS</em>&quot;, Client-Type = &quot;Smart Phone HTML Basic&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User Agent String = &quot;*&quot;, Client Type = &quot;Standard HTML&quot;</td>
<td></td>
<td>User Agent String = &quot;*&quot;, Client Type = &quot;Standard HTML&quot;</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>User-Agent String = &quot;*&quot;, Client Type = &quot;Standard HTML&quot;</td>
<td></td>
</tr>
</tbody>
</table>
## Table 15: User Agent String Client Type Pairings for Mobile Devices (continued)

<table>
<thead>
<tr>
<th>SA Series Software</th>
<th>Apple iOS</th>
<th>Google Android</th>
<th>Windows Mobile</th>
<th>Nokia Symbian</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release 7.1 and later</td>
<td>User Agent String = &quot;<em>iPad</em>AppleWebKit&quot;, Client type = &quot;iPad Optimized HTML&quot;</td>
<td>User Agent String = &quot;<em>Android</em>&quot;, Client Type = &quot;Android Optimized HTML Full/Advanced/Basic&quot;</td>
<td>User Agent String = &quot;<em>WindowsCE</em>&quot;, Client Type = &quot;Mobile HTML (Pocket PC)&quot;</td>
<td>User Agent String = &quot;<em>Symbian</em>&quot;, Client Type = &quot;Smart Phone HTML Basic&quot;</td>
</tr>
<tr>
<td></td>
<td>User Agent String = &quot;<em>iPad</em>AppleWebKit&quot;, Client type = &quot;iPad Optimized HTML&quot;</td>
<td>User Agent String = &quot;<em>Android</em>&quot;, Client Type = &quot;Android Optimized HTML Full/Advanced/Basic&quot;</td>
<td>User Agent String = &quot;<em>WindowsCE</em>&quot;, Client Type = &quot;Mobile HTML (Pocket PC)&quot;</td>
<td>User Agent String = &quot;<em>Symbian</em>&quot;, Client Type = &quot;Smart Phone HTML Basic&quot;</td>
</tr>
</tbody>
</table>

**NOTE:** You can also configure user agent strings at the role or the realm level to define policies for a user based on browser type.

**Related Documentation**
- Junos Pulse for Apple iOS Overview on page 211
- Junos Pulse for Android Overview on page 235
- Junos Pulse for Symbian Overview on page 253
- Junos Pulse for Windows Mobile Overview on page 257
Junos Pulse for Apple iOS Overview

Junos Pulse provides Layer 3 VPN connectivity based on SSL encryption and authentication between an Apple iOS device (iPhone, iPad, iPod Touch) and Junos Pulse Secure Access Service. Junos Pulse enables secure connectivity to corporate applications and data based on identity, realm, and role. Pulse is designed to provide battery-friendly connectivity by automatically disconnecting from the VPN when the device is inactive while on Wi-Fi, automatically reestablishing VPN connectivity when the device reactivated, and maintaining connectivity when roaming from network to network. Junos Pulse is available for download from the Apple App Store.

NOTE: Mobile client features are updated frequently and each mobile client has a release number that is independent from the other clients and from the Pulse for Windows and the Pulse for Mac clients. We recommend that users upgrade their mobile client to the latest release to ensure that all features described in this guide are supported on the devices.
The Junos Pulse Mobile Supported Platforms Guide, which is available at http://www.juniper.net/support/products/pulse/mobile/ lists the mobile device OS versions supported by Pulse and the security features supported on each mobile device OS.

The Junos Pulse VPN app supports the following features:

- Full Layer 3 tunneling of packets
- UDP/ESP and NCP/SSL modes
- Authentication by all authentication options available on the Pulse Secure Access server
- Certificate authentication followed by any other form of authentication
- Multi-factor authentication (cascading two different types of authentication)
- Host Checker

**NOTE:** A Host Checker policy that is configured for a VPN tunnel is not triggered if the VPN is launched automatically by VPN on Demand on iOS. If the VPN session is started through the Pulse client, Host Checker policy is correctly applied.

- Split tunneling modes:
  - Split tunneling disabled with access to local subnet
  - Split tunneling enabled

- Apple VPN on Demand

A VPN on Demand configuration enables an iOS device to automatically initiate a VPN connection when any application running on the phone initiates a connection to a host in a predefined set of hosts. A VPN on Demand connection uses client certificate-based authentication so the user does not have to provide credentials every time a VPN connection is initiated.

**NOTE:**

When you configure VPN on Demand, you must create an exception for your Pulse Secure Access server hostname. For example, if the hostname is sslvpn.example.com and you want Pulse clients to automatically establish the VPN whenever requests are made for hosts in the example.com domain, the VPN on Demand configuration should contain the following rules:

- If domain name = sslvpn.example.com, then never initiate VPN connection
- If domain name = example.com, then always initiate VPN connection
There are different methods for creating VPN on Demand connections:

• Use the mobile device management (MDM) features of the Junos Pulse Mobile Security Suite. Pulse Mobile Security Suite provides device management as well as security. For complete information about MDM, see the Junos Pulse Mobile Security Gateway documentation.

• Create and manage VPN On Demand configurations from within the Junos Pulse for iOS client.

• Use the iPhone Configuration Utility. For complete information about how to create a VPN on Demand configuration using the iPhone Configuration utility, see the iPhone OS Enterprise Deployment Guide, which is available at www.apple.com.

• Monitor and Control features of the Junos Pulse Mobile Security Suite.

• Junos Pulse for iOS also supports the Junos Pulse Mobile Security Suite (MSS) R3.0 and later. Using the Pulse Mobile Security Gateway, the security administrator can define Pulse connections and other profile settings, and then those settings are downloaded to the device when it registers with the gateway and updated periodically. For more information, see the Junos Pulse Mobile Security Gateway documentation.

• Secure Mail

An ActiveSync proxy on the Pulse Secure Access server provides secure email services to Pulse iOS clients. The secure mail service encrypts email body content and attachments, supports email forwarding, and allows the SA administrator to quarantine the iOS device. Users view encrypted email body with any native iOS email client. Encrypted attachments are displayed by the secure viewer in the Pulse iOS client.

Before You Begin

Before you configure support for Apple iOS devices with Junos Pulse Secure Access Service, keep in mind the following client software behaviors:

• With Wi-Fi connectivity, Pulse reconnects the VPN tunnel automatically when the user wakes up the device. With 3G connectivity, the VPN reconnects when the user generates network traffic using an application like Safari or Mail.

• Establishing the VPN tunnel through a proxy is supported (regardless of the split tunnel mode), except for proxies that require authentication credentials.

• A Proxy Automatic Configuration (PAC) script takes effect only when split tunneling mode is disabled with access to local subnet. The PAC script does not work when the role's split tunnel mode is Enable split tunneling.

• Static host mapping is not created for the Pulse server/proxy hostname.

• DNS considerations:

  • When split tunneling is set to Split tunneling disabled with access to local subnet, Pulse uses the DNS servers that are configured on the Pulse server.

  • When split tunneling is set to Split tunneling enabled, DNS servers that are configured on the Pulse server are used only for hostnames within the Pulse Secure Access Service domains.
• Session scripts are not supported.
• Web-based installation from a Junos Pulse server is not supported.
• Session timeout reminders are not supported.
• When you use client certificate authentication, and the user is enabled to select from among assigned roles, the user is prompted to enter the role name instead of being presented with a list of roles.
• To ensure that users see consistent bookmarks in the Pulse client UI no matter which server they are connected to, you can configure and enable user record synchronization, a feature of the Pulse Secure Access Service platform.

**Related Documentation**

- Configuring a Role and Realm for Junos Pulse for Apple iOS on page 214
- Host Checker for Pulse iOS Clients on page 217
- Configuring Host Checker for Junos Pulse iOS Clients on page 218
- **VPN Tunneling Proxy Support**
- **About User Record Synchronization**

**Configuring a Role and Realm for Junos Pulse for Apple iOS**

To enable SSL/VPN access from an Apple iOS device to Pulse Secure Access Service, the device user must download, install, and configure the Junos Pulse app, and the Pulse administrator must configure specific realm and role settings on Pulse Secure Access Service.

To configure Pulse Secure Access Service for Apple iOS device access:

1. Log in to the Pulse server admin console.
2. Select **User Roles > New User Role**.
3. On the New Role page, specify a name for the role and, optionally, a description. Make note of the name because later in this procedure, you create a realm and map realm users to this role.
4. In the Access Features section of the New Role page, select the **VPN Tunneling** check box.
5. Click **Save Changes** to create the role and to display the role configuration tabs.
   
   Specifying Host Checker policies is part of the role configuration. However, you must first create the policy you want to assign to the role, so that procedure is covered later.
6. Select **Web > Bookmarks** and then click **New Bookmark**.
7. Specify a name and description for the bookmark.
   
   You must create bookmarks to enable the buttons that appear in the Pulse for iOS user interface. Typically, you create a bookmark for your company intranet and for Web e-mail.
8. In the URL box, specify the Web address for access to your organization’s e-mail.

Figure 21: Creating the E-mail Bookmark for the Pulse Client

9. Set the Auto Allow and Display Options as desired, and then click Save Changes.

10. On the VPN Tunneling tab, set the Split Tunneling options by selecting the following options:

   Split Tunneling

   • **Enable**—Split tunneling resource policies specify the traffic that passes through the VPN tunnel.
   • **Disable**—All network traffic goes through the VPN tunnel.
Route Precedence

- **Tunnel Routes**—The route table associated with the Pulse virtual adapter take precedence. Pulse overwrites the physical interface routes if there is conflict between the Pulse virtual adapter and the physical adapters. Pulse restores the original routes when the connection is ended.

- **Tunnel Routes with local subnet access (Pulse on Windows and Mac OS X only)**

- **Endpoint Routes**—The route table associated with the endpoint’s physical adapter take precedence.

11. To change default session time-outs, select **General > Session Options**.

12. In the Session lifetime section, specify **Max. Session Length** in minutes. The remaining session time appears on the Pulse interface of the mobile device client in the format days hours:minutes:seconds. The other session settings are not applied to mobile clients.

13. Click **Save Changes**.

14. Select **Users > Resource Policies > VPN Tunneling > Connection Profiles**.

    A resource policy is a system rule that specifies resources and actions for a particular access feature.

15. Click **New Profile**.

16. Specify a name and description for the connection profile.

    When you define the connection profile, note the following:

    - **IP Address Assignment options**—When Pulse Secure Access Service receives a client request to start a session, it assigns an IP address to the client based on the IP address policies you define.

    - **Connection Settings**—ESP is the default transport. The Pulse for iOS VPN client supports both ESP and SSL.

    - **DNS Settings**—Searching IVE DNS first with split tunneling enabled is not supported. With split tunneling enabled, Junos Pulse uses the IVE DNS for queries for hosts in the IVE DNS search domains only. All other queries go to the client’s DNS servers.

    - **Proxy Server Settings**—The Pulse for iOS client software supports all of the proxy server settings except **Preserve client-side proxy settings**. That option is specific to the Windows client only. Automatically modifying the client proxy configuration when split tunneling is enabled is not supported.

17. In the Roles area, select **Policy applies to SELECTED roles**. Then add the role you created for iOS devices to the Selected roles list.

18. Click **Save Changes**.

19. Select **Users > User Realms > New User Realm**.

20. Specify a name and description. Then click **Save Changes** to create the realm and to display the realm option tabs.

21. In the Servers section, specify the authentication settings.
Authentication server configuration is described in Authentication Servers.

22. On the General tab for the realm, select the Session Migration and Sharing check box.

23. On the Role Mapping tab for the realm, create a new rule that maps all users to the iOS device role you created earlier in this procedure.

---

**Related Documentation**

- Host Checker for Pulse iOS Clients on page 217
- Configuring Host Checker for Junos Pulse iOS Clients on page 218
- Allowing Junos Pulse for iOS Users to Save Webmail Password on page 217
- Creating VPN Tunneling Connection Profiles
- Junos Pulse Secure Access Service Split Tunneling Overview on page 75
- Resource Policies

---

**Allowing Junos Pulse for iOS Users to Save Webmail Password**

A Web bookmark on the role for iOS users allows users to access e-mail through a Web link. You can allow users of the Pulse for iOS app to save their e-mail password when they login to the e-mail system. After you have created a Mobile Webmail bookmark for the role used by iOS users, enable password the option for user to save their e-mail password by doing the following.

1. Open the role you created for iOS users.
2. Click General > Session Options.
3. In the section labeled Persistent Password Caching, select Enabled.
4. Click Save Changes.

---

**Host Checker for Pulse iOS Clients**

Host Checker is a component of Junos Pulse that reports the integrity of iOS endpoints that are attempting to connect to Pulse Secure Access Service. Host Checker runs as a Trusted Network Connect (TNC) client on the endpoint. The client evaluates the endpoint according to predefined criteria and reports to the Trusted Network Connect server, which is a part of Pulse Secure Access Service. If the endpoint is not in compliance with the Host Checker policies, then the user might not get access to the network or might get limited access to the network depending upon the enforcement policies configured by the administrator.

**NOTE:** A Host Checker policy that is configured for a VPN tunnel is not triggered if the VPN is launched automatically by VPN on Demand.
For iOS clients, Host Checker can evaluate client compliance based on the following predefined criteria:

- **OS Checks**—You can specify the iOS version or minimal version that must be installed on the device.

- **Jail Breaking Detection**—Jail breaking is a process that allows Apple iPhone, iPad and iPod Touch users to gain root access to the iOS operating system and bypass usage and access limitations imposed by Apple. With a jail broken device, an iOS user can install applications that are not available through the Apple App Store. Jail broken devices expose the device to a greater risk of running malicious applications.

- **Mobile Security Suite**—Pulse Mobile Security Suite (MSS) for iOS supports features that help protect the iOS device if it is lost or stolen: remote wipe, remote lock, and locate. Pulse MSS also allows the MSS administrator to provide VPN configurations to the device and enforce other usage practices such as requiring a lock password and specifying the password strength. Host Checker enables you to require that an iOS device have the Pulse Mobile Security Suite installed and enabled.

  **NOTE:** The Pulse MSS check on the client is based on the presence of a valid client certificate issued by the Mobile Security Gateway. Therefore, to configure this Host Checker item, you need to add the CA used by MSS in the Certificates section of the Pulse Secure Access Service admin console.

**Related Documentation**

- Configuring Host Checker for Junos Pulse iOS Clients on page 218
- Implementing Host Checker Policies for Junos Pulse for iOS Devices on page 220
- *Host Checker and Trusted Network Computing*

**Configuring Host Checker for Junos Pulse iOS Clients**

Host Checker policies can be part of a larger Host Checker configuration that applies to many different types of clients or to iOS devices only. However, you might find it easiest to create a separate Host Checker policy specifically for iOS devices.

**NOTE:** One type of iOS Host Checker rule, the Pulse Mobile Security Suite (MSS) check, requires that an iOS device be registered with the MSS. To create this type of rule, you must specify the same trusted client certificate authority (CA) that is configured on the Pulse Mobile Security Gateway (MSG). This means that the CA must already be defined in the Certificates section of the Pulse Secure Access Service admin console before you can create this type of Host Checker rule. *Endpoint Defense Feature Guide* includes complete information on configuring the certificate environment for the Pulse Secure Access Service.
To create a Host Checker policy for iOS devices:

1. From the admin console, select **Authentication > Endpoint Security > Host Checker**.
2. In the Policies section, click **New** to open a New Host Checker Policy page.
3. Specify a name for the new policy and then click **Continue** to open the Host Checker Policy page.
   The name appears in lists when you implement the policy so be sure to use a descriptive name, such as iOS HC Policy.
4. Click the Mobile tab, and then click the iOS tab.
5. In the Rule Settings section, click **Select Rule Type** and select one of the following options and then click **Add**:
   - **OS Checks**—To specify the iOS version that must be installed on the device:
     a. Specify a descriptive name for this rule. For example, Must-Be-iOS-4.1-or-higher. Rule names cannot include spaces.
     b. Specify the criteria. For example, to enforce iOS 4.1 or higher, create two conditions: Equal to 4.1 and Above 4.1.
     c. Click **Save Changes**.
   - **Jail Breaking Detection**—Jail breaking is a process that allows Apple iPhone, iPad, and iPod Touch users to gain root access to the iOS operating system and bypass usage and access limitations imposed by Apple. With a jail broken device, an iOS user can install applications that are not available through the Apple App Store. Jail broken devices possess a greater risk of running malicious applications:
     a. Specify a descriptive name for this rule. For example, No-iOS-Jailbreak.
     b. The **Don’t allow Jail Broken devices** check box is enabled by default.
     c. Click **Save Changes**.
   - **Mobile Security Suite**—Pulse Mobile Security Suite (MSS) for iOS supports features that help protect the iOS device if it is lost or stolen: remote wipe, remote lock, and locate. Pulse MSS also allows the MSS administrator to provide VPN configurations to the device. An MSS rule allows you to require that an iOS device have MSS installed and enabled:
     a. Specify a descriptive name for this rule. For example, iOS-MSS.
     b. In the Criteria section, the **Enable Mobile Security Suite on the device** check box is enabled by default.
     c. Click the **MDM Trusted client CA** box to choose a certificate authority.
MDM (Mobile Device Management) enables remote configuration and management of mobile devices. Secure Access Service verifies registration with Pulse MSS through the presence of a valid client certificate issued by the Mobile Security Gateway. Therefore, to configure this Host Checker item, you need to know the client certificate authority that is used by the Pulse Mobile Security Gateway. The certificate authorities listed in the box are defined in the System > Configuration section of the Pulse Secure Access Service admin console.

d. Optionally, specify additional criteria (the certificate field and expected value), and then click **Add**.

e. Click **Save Changes**.

6. After you have configured all of your rules, specify how you want to enforce them by choosing one of the following options:

   - All of the rules
   - Any of the rules
   - Custom

   For Custom requirements, you can specify a custom expression using Boolean operators AND and OR and also group and nest conditions using parenthesis.

7. Specify remediation options:

   - **Enable custom instructions**—If you enable this check box, a text box appears and allows you to type information that appears on the user’s device if Host Checker discovers an issue. For example, if you enabled the MSS rule that terminates the VPN session of Host Checker discovers a virus, you can instruct the user to run a virus scan to clear the issue before trying to connect.

   - **Send reason strings**—Select this option to display a message to users (called a reason string) that explains why the client machine does not meet the Host Checker policy requirements. For example, if the jailbreak detection policy fails, Pulse displays **A jailbroken device is not allowed to access the network. Please contact your network administrator.**

8. When you are finished, click **Save Changes**.

## Related Documentation

- Host Checker for Pulse iOS Clients on page 217
- Implementing Host Checker Policies for Junos Pulse for iOS Devices on page 220
- Junos Pulse for Mobile Devices Overview on page 207

## Implementing Host Checker Policies for Junos Pulse for iOS Devices

After you create one or more Host Checker policies for iOS devices, you must implement them. Pulse Secure Access Service can use Host Checker policies at the realm or the role level.
**Realm Authentication**—You can configure a realm authentication policy to download and run Host Checker with a particular Host Checker policy. If the iOS device does not meet the Host Checker requirements, then Pulse Secure Access Service can deny access. You can provide remediation information in the Host Checker policy to describe the requirement and help users take steps to solve the issue.

To enable a Host Checker policy for a realm:

1. From the admin console, select Users > User Realms > SelectRealm > Authentication Policy > Host Checker. The Host Checker page displays all of the available Host Checker policies.
2. Select the check box next to each policy you want to include. Select one or both of the following check boxes next to the policy:
   - **Evaluate Policies**—Evaluates without enforcing the policy on the iOS device and allows access.
   - **Require and Enforce**—Requires that the iOS device be in compliance with the Host Checker policy. Pulse Secure Access Service downloads Host Checker to the iOS device after the user is authenticated and before the user is mapped to any roles in the system. Selecting this option automatically enables the Evaluate Policies option.
3. Optionally select **Allow access to realm if any ONE of the selected “Require and Enforce” policies is passed**. This check box is available if you selected more than one Host Checker policy. If you enable this check box, an iOS device is allowed access if it passes any of the Require and Enforce policies. The Cache Cleaner policy does not apply to iOS devices.
4. Click **Save Changes**.

**Role**—You can configure a role to download and run Host Checker with a particular Host Checker policy. If the iOS device does not meet the Host Checker requirements, then Secure Access can deny access or assign the user to a remediation role that has limited access. You can provide remediation information in the Host Checker policy to help users take steps to solve the issue.

To enable a Host Checker policy for a role:

1. From the admin console, select Users > User Roles > SelectRole > General > Restrictions > Host Checker. The Host Checker page displays all of the available Host Checker policies.
2. Select **Allow users whose workstations meet the requirements specified by these Host Checker policies**.
3. In the Available Policies list, select the policies that you want to apply to select them, and then click Add to move them to the Selected Policies list. To select a policy click it. So select more than one policy, use Ctrl+click.
4. Optionally select **Allow access to realm if any ONE of the selected “Require and Enforce” policies is passed**. This check box is available if you selected more than one Host Checker policy. If you enable this check box, an iOS device is allowed access if it passes...
any of the Require and Enforce policies. The Cache Cleaner policy does not apply to iOS devices.

5. Click **Save Changes**.

 Related Documentation

- Host Checker for Pulse iOS Clients on page 217
- Configuring Host Checker for Junos Pulse iOS Clients on page 218
- Host Checker and Trusted Network Computing

## Installing the Junos Pulse for Apple iOS App

Junos Pulse is available in the iTunes App Store. After installing the Pulse app, a user can manually configure it.

1. On the iOS device, launch Junos Pulse.
2. Tap the Configuration item on the main status page to display Pulse configurations.
3. Create a new configuration with the URL. The URL for the connection is the Pulse Secure Access Service sign-in URL that was created and defined for mobile devices. Then configure the certificate settings as required.

### NOTE:

When iPhone users launch Pulse for the first time, they see a security warning and a prompt for enabling Pulse SSL VPN functionality. This security precaution helps deter the silent installation of malicious VPN software. If the user declines the Pulse software, the Pulse splash screen appears until the user presses the Home button on the device. If the user accepts the Pulse software, the security warning no longer appears when Pulse is started.

### NOTE:

For certificate authentication, the Pulse Secure Access Service SSL certificate must be issued by a CA. It cannot be self-signed. If the CA is not one of the built-in trusted CAs on the iOS device, then the CA certificate must be imported into the iOS device. Also, the Pulse Secure Access Service must be accessed using a hostname (not an IP address), and the hostname must match the Common Name of the Pulse Secure Access Service SSL certificate.

### NOTE:

The Pulse iOS app also supports the Junos Pulse Mobile Security Suite (MSS) R3.0 and later. Using the Pulse Mobile Security Gateway, the security administrator can use mobile device management (MDM) features to define Pulse connections and other settings, and then those settings are downloaded to the device when it registers with the gateway. For more information, see the Junos Pulse Mobile Security Gateway documentation.
Using iPhone Configuration Utility Profiles for Junos Pulse for iOS

One method of creating VPN configurations is to use a Configuration Profile to define Pulse configurations for the iOS device, and then distribute the configuration profiles by e-mail or by posting them on a Web page. When users open the e-mail attachment or download the profile using Safari on their iOS device, they are prompted to begin the installation process.

You use the iPhone Configuration Utility to create configuration profiles and specify Juniper SSL as the Connection Type for the VPN Payload. You can download the iPhone Configuration Utility (3.0 or later) from the Apple support Web. For details about the utility and how to create Configuration Profiles, see the iPhone OS Enterprise Deployment Guide, which is available at www.apple.com.

NOTE: The Pulse iOS app also supports the Junos Pulse Mobile Security Suite (MSS) R3.0 and later. Using the Pulse Mobile Security Gateway, the security administrator can use the mobile device management (MDM) features to define Pulse connections and other settings within a profile. Those settings are downloaded to the device when it registers with the gateway and updated when the device periodically checks in with the server after registration. For more information, see the Junos Pulse Mobile Security Gateway documentation.

Collecting Log Files from Junos Pulse for iOS

The iOS device user can use the following procedure to e-mail the Junos Pulse log files:

1. On the iOS device, start the Junos Pulse app.
2. Tap Status.
3. Tap Logs > Send Logs.
4. Enter an e-mail address and tap Send.
Launching the Junos Pulse for iOS App with a Command

The Pulse launcher for iOS is a command that is registered with iOS when the mobile device user installs the Junos Pulse for iOS app. The Pulse launcher starts (or stops) Pulse and can establish a VPN connection using connection parameters specified in the command. The command can specify all login parameters. If the app generates or accesses an appropriate passcode, Pulse starts and establishes a VPN connection with no input from the user. You can use the Pulse launcher command in Web pages and external apps.

When a user taps a button that is tied to a Pulse launcher command, the command launches the Pulse app if it is not already running. If Pulse is not already installed on the iOS device, an error occurs. The next step depends on the current Pulse connection status and configuration. One of the following occurs:

- If Pulse does not already have an active connection to Pulse Secure Access Service, it uses an existing configuration to establish the VPN connection.
- If Pulse does not already have an active connection, and it does not already have a configuration for the target Pulse server, Pulse opens the Add Configuration screen. The target URL is already defined and the user just needs to specify a name for the connection.
- If the Pulse app is already connected to a Pulse server, the Pulse app is brought to the foreground.

To employ the Pulse launcher in your Web pages or external applications, specify the link using the following format:

```
junospulse://<server-host>/<server-path>?method={vpn}&action={start|stop}&DSID=<dsid-cookie>&SMSESSION=<smsession-cookie>&username=<username>&password=<password>&realm=<realm>&role=<role>
```

**NOTE:** The Pulse launcher command also supports a different method that enables you to specify a URL to register the device with the Pulse Mobile Security service. See the [Junos Pulse Mobile Security Suite documentation](#) for more information.

**Usage notes:**

- If the DSID cookie is given in the URL, the app does not use the "username", "password", "realm", or "role" parameters because no login is required.
- The values for username, realm, and role are URI-escaped values. Special characters are replaced with their hexadecimal equivalents preceded by '%'.
- If the user has specified the username, realm, and role when creating the VPN configurations in the Junos Pulse app, those values are used to auto-fill the username, realm, and role for the login pages during a Web-based login. During login, if all fields are successfully auto-filled from fields in the VPN configuration or the junospulse://
launch URL, the login progresses without any user input. The username, realm, and role values need to already exist in the VPN configuration for them to be auto-filled during the login process. If the user manually specifies the username, realm, or role during login, the app will not add or update these values in the VPN configuration. The user needs to explicitly update the VPN configuration with these values.

- The Pulse app does not save the password in the Password field in VPN configurations. The Pulse app does not use values from Password fields in VPN configurations installed by the iPhone Configuration Utility or Junos Pulse Mobile Security Suite. Junos Pulse will only use passwords specified in junospulse:// URLs.

- If the user manually specifies the username, realm, or role during login, the app stores these values in the VPN configuration and they will be auto-filled the next time the user signs in. Passwords entered by the user are not saved in the VPN configuration.

- Realm and role fields in the VPN configuration format are supported in Apple iOS 4.2 and later. If the Pulse app is run on an iOS device running iOS 4.1, the realm and role fields will not be visible in the Junos Pulse Add/Edit configuration view.

Examples:

If the calling application has already obtained a DSID cookie from Pulse Secure Access Service, the app can use the following command to start the VPN:

```
junospulse://<server-host>/<server-path>?method=vpn&action=start &DSID=<dsid-cookie>&SMSESSION=<smsession-cookie>
```

If the calling application does not already have a DSID, it can use the following command to start the VPN:

```
junospulse://<server-host>/<server-path>?method=vpn&action=start &username=<username>&password=<password>&realm=<realm>&role=<role>
```

If the calling application wants to stop the VPN, it can use the following command:

```
junospulse://<server-host>/<server-path>?method=vpn&action=stop
```

### Junos Pulse for iOS Error Message Reference

The following error message summary for Junos Pulse for iOS describes possible issues and suggests resolution actions where possible.

#### Table 16: Junos Pulse for iOS Error Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Possible Causes</th>
<th>Suggested Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please provide values for all the fields</td>
<td>A required field was not provided.</td>
<td>Provide a value for all the required fields and then try the operation again. Contact your mobile security provider.</td>
</tr>
</tbody>
</table>
### Table 16: Junos Pulse for iOS Error Messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Possible Causes</th>
<th>Suggested Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>A configuration with the same name already exists. Please choose a different name.</td>
<td>Configuration names must be unique.</td>
<td>Choose a configuration name that is not in use by another configuration, and then try the operation again.</td>
</tr>
<tr>
<td>An internal error occurred while creating the configuration.</td>
<td>An undefined error occurred.</td>
<td>Verify all of the values you entered, and then try the operation again. If the error occurs again, contact the Pulse administrator.</td>
</tr>
<tr>
<td>Please contact your administrator.</td>
<td>Host Checker policy failed and the reason string is displayed for the failure.</td>
<td>Tap the Cancel button and then try again after performing the remediation actions.</td>
</tr>
<tr>
<td>Your device is running operating system version x.y.z.</td>
<td>The iOS version running on the device is not allowed to connect.</td>
<td>If prompted to continue, tap Continue to connect with limited connectivity or tap Cancel to cancel the connection and try again after upgrading iOS.</td>
</tr>
<tr>
<td>Junos Pulse Mobile Security Suite is not active on your device.</td>
<td>Pulse Mobile Security is not active.</td>
<td>If prompted to continue, tap Continue to connect with limited connectivity or tap Cancel to cancel the connection and try again after registering with Mobile Security Suite.</td>
</tr>
<tr>
<td>Your iOS device is jailbroken.</td>
<td>Jail broken iOS devices are not allowed to connect.</td>
<td>If prompted to continue, tap Continue to connect with limited connectivity or tap Cancel to cancel the connection.</td>
</tr>
<tr>
<td>Host Checker is not supported with this version of Junos Pulse. Please upgrade the Junos Pulse client or contact your administrator.</td>
<td>Unsupported Junos Pulse client - Junos Pulse Host Checker is supported on Pulse 3.2 and later.</td>
<td>Check for the update of Junos Pulse on the App store and upgrade the Junos Pulse client to 3.2 or later, and then try again.</td>
</tr>
<tr>
<td>Session disconnected due to invalid certificate.</td>
<td>The Pulse client downloads session information from the Pulse server and the certificate received from the server does not match the stored session certificate.</td>
<td>Click the Close button on the Alert dialog to return to home screen. User can retry the connection.</td>
</tr>
<tr>
<td>Failed to connect to the server.</td>
<td>Sign-in process failed.</td>
<td>Check the network connection (for example, Wi-Fi, 3G, etc.), and then retry the connection.</td>
</tr>
<tr>
<td>Compliance Check couldn’t be completed.</td>
<td>Host Checker compliance check couldn’t be completed during sign-in process.</td>
<td>Try to connect again.</td>
</tr>
</tbody>
</table>

---

**Related Documentation**
- Junos Pulse for Apple iOS Overview on page 211
- Installing the Junos Pulse for Apple iOS App on page 222

### Configuring Secure Mail

For iOS devices, you can configure Secure Mail to:
• Use ActiveSync to synchronize e-mails with a Microsoft Exchange server
• Encrypt the e-mail body and attachments
• Block access to e-mail for lost or stolen devices (also erases all e-mails on the device)
• Support back-end redirection, where an Exchange ActiveSync server redirects the client to another Exchange server

Secure Mail is enabled in the user role, and requires a resource profile to specify the Exchange server and encryption options. In addition, an S/MIME certificate must be imported to the Secure Access Service. For devices that use Secure Mail, users must onboard (register) the device through the Enterprise tab of the Junos Pulse client, which downloads an ActiveSync profile to the device. The profile is signed by the Secure Access Service device certificate, which must be trusted by the iOS device.

For non-iOS devices, an authorization-only sign-in policy can be defined that supports all of the Secure Mail features, except encryption.

NOTE: In release 8.0, Secure Mail is a preview feature that supports up to 15 mailboxes on iOS devices. This limitation does not apply to non-iOS devices using an authorization-only sign-in policy for ActiveSync.

• Enabling Secure Mail at the Role Level on page 227
• Defining the Secure Mail Resource Profile on page 228
• Importing an S/MIME Certificate on page 229
• Onboarding Devices on page 230
• Configuring an Authorization-Only Policy for ActiveSync on page 231
• Managing Onboarded and ActiveSync-Only Devices on page 232

Enabling Secure Mail at the Role Level

To use Secure Mail for iOS devices, you must enable it at the user role level and then create a resource profile that specifies the mail server and encryption settings.

NOTE: Do not enable both Secure Mail and Email Client options in the same role. To disable Secure Mail for a role, you must first block e-mail access for all devices that are currently registered (onboarded) with this role (see "Managing Onboarded and ActiveSync-Only Devices" on page 232).

To enable Secure Mail for a user role:

1. In the admin console, choose Users > User Roles > RoleName > General > Overview.
2. In the Access features section, select the Secure Mail checkbox.
3. Click **Save Changes**.
4. Click **Options** next to the **Secure Mail** checkbox to view or change the resource profile for Secure Mail (see “Defining the Secure Mail Resource Profile” on page 228).

### Defining the Secure Mail Resource Profile

To use Secure Mail for iOS devices, you must enable it at the role level and then create a resource profile that specifies the Exchange server and encryption settings. You must also obtain and import an S/MIME certificate (see "Importing an S/MIME Certificate" on page 229).

To define the Secure Mail resource profile:

1. In the admin console, choose **Users > Resource Profiles > Mobile**.
2. Specify the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Hostname</td>
<td>Enter a hostname alias for the Exchange server, and update your DNS server to map the alias to the IP address of the Secure Access Service. The name must be unique among all virtual hostnames. For example, if the virtual hostname is <code>email.com</code>, and the backend URL is <code>https://mail.juniper.net:8080</code>, a client request to <code>https://email.com/test1</code> via Secure Access is converted to <code>https://mail.juniper.net:8080/test1</code>. The response to the converted request is sent to the client web browser.</td>
</tr>
<tr>
<td>Exchange Server</td>
<td>Enter the URL and port number of the Microsoft Exchange server, such as <code>https://mail.juniper.net:379</code>. If the port number is omitted, it defaults to 80.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the Exchange server (optional).</td>
</tr>
<tr>
<td>Username</td>
<td>Select one of the following to specify the e-mail account format used by the Exchange server:</td>
</tr>
<tr>
<td></td>
<td>• None – Inserts the <code>&lt;USER&gt;</code> variable for the user's login name for the Secure Access Service (the default).</td>
</tr>
<tr>
<td></td>
<td>• Exchange 2007/2010/2013 – Inserts the <code>&lt;NTDOMAIN&gt;&lt;USER&gt;</code> variables to include the user’s domain before the login name.</td>
</tr>
<tr>
<td></td>
<td>• Office 365 – Inserts <code>&lt;USER&gt;@domain.com</code>, and you can enter the appropriate domain, such as <code>&lt;USER&gt;@juniper.net</code>.</td>
</tr>
</tbody>
</table>
Setting | Description
--- | ---
Secure Mail Options | Select one or more of the following encryption options:

- **Encrypt Body** – Encrypts the body of the e-mail using an S/MIME certificate. The encrypted e-mail body can be viewed by any native e-mail client.

  **NOTE:** Graphics embedded in the encrypted e-mail body are displayed twice on iOS devices.

- **Encrypt Attachments** – Encrypts the e-mail attachments using a key generated by the Secure Access Service. Encrypted attachments, which must be opened with the Junos Pulse client, are identified by a `junospulse` file extension, such as `report.pdf.junospulse`. The encrypted file types are listed in the File Extensions text box, separated by semicolons. You can add or delete file extensions from the list.

  **NOTE:** If you add `.gif`, `.jpeg`, `.jpg`, `.png` or `.htm` to the list of encrypted file types, graphics embedded in the e-mail body are not displayed correctly on iOS devices.

- **Allow Outbound E-Mail Attachments** – Decrypts attachments before forwarding an e-mail to an external account. If this option is not selected, e-mails are forwarded without attachments and include a note indicating that attachments were removed.

If you change the encryption settings, onboarded devices must be re-onboarded to obtain the new settings (see “Managing Onboarded and ActiveSync-Only Devices” on page 232).

3. **Click Save Changes.**

**Importing an S/MIME Certificate**

If you enable Secure Mail, you must request an S/MIME certificate from a Certificate Authority (CA) and import the certificate and private key to the Secure Access Service.

To import an S/MIME certificate and private key:

1. In the admin console, choose Users > Resource Profiles > Mobile > S/MIME Certificate.
2. **Click Import Certificate & Key** to display the configuration page.
3. Use one of the following options to complete the import procedure:

   - **If certificate file includes private key**—When the certificate and key are contained in one file.

   - **If certificate and private key are separate files**—When the certificate and key are in separate files.

   - **Import via System Configuration file**—When the certificate and key are contained in a system configuration file that has been exported from the Secure Access Service.

   In the appropriate form, browse to the certificate and key files. If the file is encrypted, enter the password key.

4. **Click Import.**
Onboarding Devices

To use Secure Mail, the user must onboard (register) the device through the Enterprise tab of the Junos Pulse client. Users must enter the Secure Access Service URL, username, realm, role, and password. If onboarding is successful, the user is prompted to confirm installation of the Secure Mail profile. Note the following:

- If the device has a VPN connection to the Secure Access Service, the user is warned that the connection will be closed and reestablished through the onboarding process.
- If the device has received an ActiveSync profile from a Juniper Networks Mobile Security Gateway, the ActiveSync profile must be deleted before the Secure Mail profile can be installed.
- If the user onboards the device a second time by clicking Get Email Profile, a new profile is downloaded to the device with a new master key for encrypting e-mail attachments. Existing e-mail attachments on the device cannot be decrypted until ActiveSync resynchronizes the device with the Exchange server, which uses the new master key to encrypt attachments.
- The following message IDs in the User Access Log can be used to verify the onboarding process (both include the username and device ID):
  - AUT31041—Indicates the status of an onboarding attempt (failed or successful)
  - AUT31044—Indicates the Secure Mail profile was downloaded successfully to the device

To expedite the onboarding process, administrators can use e-mail or SMS to send a junospulse URL to users that contains the Secure Access Service URL, username, realm, and role. Clicking the junospulse URL starts the Junos Pulse client, and displays the Onboard page with the information from the junospulse URL filled in. Users can then just enter their password to register.

The format of the junospulse URL is:

```
junospulse:///?method=enterprise&action=onboard&url=SecureAccessURL&role=UserRole &realm=UserRole&username=UserRolename
```

The URL, role, realm, and username parameters are optional. After a device is onboarded, a junospulse URL with just the method= and action= parameters can be used to re-onboard a device.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>method=</td>
<td>Must be set to enterprise.</td>
</tr>
</tbody>
</table>
Configuring an Authorization-Only Policy for ActiveSync

An authorization-only policy can be defined to allow almost any device to use ActiveSync to synchronize e-mails with a Microsoft Exchange server. Encryption is not supported, but if the option to allow only ActiveSync traffic is enabled, e-mail access can be blocked for devices that are lost or stolen, and back-end redirection is supported (the Exchange ActiveSync server can redirect the client to another Exchange server).

To configure an authorization-only access policy for ActiveSync:

1. In the admin console, choose Authentication > Signing In > Sign-in Policies.
2. To create a new authorization-only access policy, click New URL and select Authorization Only Access. Or, to edit an existing policy, click a URL in the Virtual Hostname column.

   **NOTE:** If a resource profile for Secure Mail is defined, the virtual hostname is displayed with a link to the resource profile. The virtual hostname for the authorization-only policy must be different from the Secure Mail virtual hostname.

3. Specify the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Hostname</td>
<td>Enter a hostname alias for the Exchange server, such as email.com, and update your DNS server to map the alias to the IP address of the Secure Access Service. The name must be unique among all virtual hostnames. Do not include the http(s) protocol. For example, if the virtual hostname is email.com, and the backend URL is <a href="https://mail.juniper.net:8080">https://mail.juniper.net:8080</a>, a client request to <a href="https://email.com/test1">https://email.com/test1</a> via Secure Access is converted to <a href="https://mail.juniper.net:8080/test1">https://mail.juniper.net:8080/test1</a>. The response to the converted request is sent to the client web browser.</td>
</tr>
<tr>
<td>Backend URL</td>
<td>Enter the URL and port number of the Microsoft Exchange server, such as <a href="https://mail.juniper.net:8080">https://mail.juniper.net:8080</a>. If the port is omitted, it defaults to 80.</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the Exchange server (optional).</td>
</tr>
</tbody>
</table>
Select the authorization server name or No Authorization. If you select a server, ensure that the front-end server provides the SMSESSION cookie otherwise you will receive an error.

Select a user role. The role must have a Web Access policy, and only the following role options apply:

- Allow browsing untrusted SSL websites (Users > User Roles > RoleName > Web > Options > View advanced options)
- HTTP Connection Timeout (Users > User Roles > RoleName > Web > Options > View advanced options)
- Source IP restrictions (Users > User Roles > RoleName > General > Restrictions)
- Browser restrictions (Users > User Roles > RoleName > General > Restrictions)

Select the Allow ActiveSync Traffic only option to verify the request is consistent with the ActiveSync protocol, and to include the device on the Device Management page, which allows e-mail access on the device to be blocked if needed (see “Managing Onboarded and ActiveSync-Only Devices” on page 232). If validation fails, a message is created in the user’s event log. If you do not enable this option, both ActiveSync and non-ActiveSync requests are processed, but the device is not shown on the Device Management page.

Click Save Changes to save your edits.

The System Status Overview page displays the number of current ActiveSync and authorization-only connections, and a histogram of the active concurrent connections (Authorization Only Access Active Connections plot in the Concurrent SSL Connections graph).

Managing Onboarded and ActiveSync-Only Devices

The Device Management page lists the devices that use ActiveSync to synchronize e-mail with a Microsoft Exchange server. If a device is lost or stolen, e-mail access can be blocked, which also erases the e-mails on the device. The following types of devices are listed:

- **Onboarded devices**— iOS devices that have Secure Mail enabled in the user’s role and have been onboarded (registered) through the Enterprise tab in the Junos Pulse client. After a device is onboarded, it is displayed on the the Device Management page until it is deleted.

- **ActiveSync-only devices**—Devices that have used ActiveSync through an authorization-only access policy that has the Allow ActiveSync Traffic Only option enabled. If the ActiveSync-only option is disabled, ActiveSync works correctly, but the device is not listed on the Device Management page.

The device ID, username, user roles, operating system, and registration date is shown for each device, along with the onboarded and access status. Devices that become inactive or invalid must be deleted manually. The number of devices that are currently using ActiveSync is shown on the dashboard as ActiveSync Device Count and on the System...
Status page as ActiveSync Connections (select System > Status > Activity or System > Status > Overview).

**NOTE:** If a device operating system is shown as Other, the ActiveSync message has a user-agent string that is not defined in the list of client types (see Defining Client Types).

To view the Device Management page:

1. Select System > Status > Devices.
2. Use the controls described in Table 17 on page 233 to view and manage the devices.

**Table 17: Device Management Page**

<table>
<thead>
<tr>
<th>Buttons</th>
<th>Administrative Actions</th>
</tr>
</thead>
</table>
| **Update** | • To refresh the page, click Update.  
               • To view a specific user, enter the username in the Show Users Named box and click Update. If you do not know the exact username, use an asterisk (*) as a wildcard character.  
               • To change the number of displayed devices, enter a number in the Show N devices box and click Update.  
               **TIP:** To change the sort, click a column header. |
| **Delete** | To delete the ActiveSync record for one or more devices, select the check box next to the appropriate devices and click Delete. If an onboarded device is deleted in error, the user must reregister (re-onboard) the device. ActiveSync-only devices that are deleted in error are added automatically by the next ActiveSync. |
| **Delete All** | To delete the ActiveSync records for all devices, click Delete All. |
| **Block Access** | To erase the e-mails on a device and block future e-mail access, such as when a device is lost or stolen, select the check box next to one or more devices and click Block Access. |
| **Allow Access** | To re-enable e-mail access for a device, select the check box next to one or more blocked devices and click Allow Access. |
| **Force Re-onboard** | To force onboarded devices to be reregistered, select the check box next to one or more devices and click Force Re-onboard. On the selected devices, the body of new e-mails will be replaced with the message Please re-onboard your device.  
               Use this feature when you replace an expired S/MIME certificate—onboarded devices must be reregistered to obtain the new certificate. |

**Related Documentation**

- Defining Client Types
- Displaying System Status
Junos Pulse for Android Overview

Junos Pulse can create an authenticated SSL session between a device running Google Android and Pulse Secure Access Service. Junos Pulse enables secure connectivity to Web-based applications and data based on identity, realm, and role. Junos Pulse is available for download from the Android Market. The Junos Pulse Mobile Supported Platforms Guide, which is available at http://www.juniper.net/support/products/pulse/mobile/ lists the mobile device OS versions supported by Pulse and the security features supported on each mobile device OS.

NOTE: The Google Android OS has limitations in its support for certificate-based authentication. For successful certificate authentication, the user certificate and the private key must be separate files. If necessary, you can separate the private key from the certificate by using openssl commands before you install the certificate and the key on the Android device. The Juniper Networks Knowledgebase includes an article, KB19692, that describes in detail how to create a certificate and key that enables successful certificate authentication for Junos Pulse on Android.
NOTE: To ensure that users see consistent bookmarks in the Pulse client UI no matter which server they are connected to, you should configure and enable user record synchronization, a feature of the Pulse Secure Access Service platform.

Related Documentation

• About User Record Synchronization

Configuring a Role and Realm for Pulse for Android

To enable access from an Android device to Pulse Secure Access Service the Pulse administrator must configure specific realm and role settings on the Pulse server.

To configure Pulse Secure Access Service for Android device access:

1. Log in to the Pulse server admin console.

2. Select User Roles > New User Role.

3. On the New Role page, specify a name for the role and, optionally, a description. Make note of the name because later in this procedure, you create a realm and map realm users to this role.

4. In the Access Features section, select Web and VPN Tunneling.

5. Click Save Changes to create the role and to display the role configuration tabs.

6. Select Web > Bookmarks and then click New Bookmark.

You must create bookmarks to enable the buttons that appear in the Pulse for Android user interface. Typically, you create a bookmark for your company intranet and for Web e-mail. You must create an e-mail bookmark to enable the e-mail button within the Pulse interface on the Android, and that e-mail bookmark must be named Mobile Webmail.
7. On the VPN Tunneling tab, set the Split Tunneling options by selecting the following options:

Split Tunneling

- **Enable**—Split tunneling resource policies specify the traffic that passes through the VPN tunnel.
- **Disable**—All network traffic goes through the VPN tunnel.

Route Precedence

- **Tunnel Routes**—The route table associated with the Pulse virtual adapter take precedence. Pulse overwrites the physical interface routes if there is conflict between the Pulse virtual adapter and the physical adapters. Pulse restores the original routes when the connection is ended.
- **Tunnel Routes with local subnet access (Pulse on Windows and Mac OS X only)**
- **Endpoint Routes**—The route table associated with the endpoint’s physical adapter take precedence.

**NOTE:** Alternatively, you can use Web resource policies to define the bookmarks.
8. To change default session time-outs, select **General > Session Options**.

9. In the Session lifetime section, specify **Max. Session Length** in minutes. The remaining session time appears on the Pulse interface of the mobile device client in the format days:hours:minutes:seconds. The other session settings are not applied to mobile clients.

10. Select **Users > User Realms > New User Realm**.

11. Specify a name and, optionally, a description and then click **Save Changes** to create the realm and to display the realm option tabs.

12. On the Authentication Policy tab for the realm, click **Host Checker** and enable the optional Pulse Mobile Security check to require that mobile device users have Pulse Mobile Security software installed and enabled. See “Junos Pulse for Mobile Devices Overview” on page 207 for more information.

13. On the Role Mapping tab for the realm, create a new rule that maps all users to the Android role you created earlier in this procedure.

**Related Documentation**
- Host Checker for Pulse Android Clients on page 240
- Allowing Junos Pulse for Android Users to Save Webmail Password on page 240
- Junos Pulse Secure Access Service Split Tunneling Overview on page 75
- Resource Policies

**Application Acceleration on Junos Pulse Mobile VPN Connections**

Junos Pulse for Android and Junos Pulse for Apple iOS support application acceleration through Riverbed® Steelhead® mobile technology. Steelhead mobile technology performs WAN optimization to improve performance of web browsing, email, and other applications. When there is a Steelhead Mobile Controller (SMC) in the network path with the Pulse Secure Access server, Pulse mobile clients can use application acceleration services over VPN connections.

Configuration is simple. If you have the Steelhead Mobile Controller installed and configured in your network, you need only enable Steelhead optimization and specify the SMC IP address as one of the settings for the role you assign to VPN users. When the client communicates with the SMC, the SMC downloads the required configuration.

Pulse mobile client users can also manually enter the SMC IP address for accelerated communications for connections that do not connect to Pulse Secure Access Service. This “tunnel light” configuration is described in the Pulse mobile client user guides.

The Pulse mobile client user can view and change some acceleration settings from the Pulse client interface:
- SMC Controller information
- Heath Status of the connection
- Controller status
Configuring Application Acceleration for Pulse Mobile VPN Connections

Junos Pulse for Android and Junos Pulse for Apple iOS support application acceleration through Riverbed® Steelhead® mobile technology. Steelhead mobile technology performs WAN optimization to improve performance of web browsing, email, and other applications. You enable Steelhead optimization and specify the SMC IP address as one of the settings for the role you assign to VPN users.

Before you begin:
- Create and configure one or more roles for Pulse mobile VPN users. See "Configuring a Role and Realm for Junos Pulse for Apple iOS" on page 214 or "Configuring a Role and Realm for Pulse for Android" on page 236.

To enable application acceleration for mobile device VPN connections:

1. Log in to the Pulse server admin console.
2. Click Users > User Roles and select the role to update.
3. Click VPN Tunneling > Options, and then scroll down to the section titled Options for Steelhead Controller.
4. Select Enable Steelhead Optimization.
5. Specify the Server Location as an IP address or a fully qualified hostname.
6. Click Save Changes.
Allowing Junos Pulse for Android Users to Save Webmail Password

A Web bookmark on the role for Android users allows users to access e-mail through a Web link. You can allow users of the Pulse for Android app to save their e-mail password when they login to the e-mail system. After you have created a Mobile Webmail bookmark for the role used by Android users, enable password the option for user to save their e-mail password by doing the following.

1. Open the role you created for Android users.
2. Click General > Session Options.
3. In the section labeled Persistent Password Caching, select Enabled.
4. Click Save Changes.

Host Checker for Pulse Android Clients

Host Checker is a component of Junos Pulse that reports the integrity of Android endpoints that are attempting to connect to Pulse Secure Access Service. Host Checker runs as a Trusted Network Connect (TNC) client on the endpoint. The client evaluates the endpoint according to predefined criteria and reports to the Trusted Network Connect server, which is a part of Pulse Secure Access Service. If the endpoint is not in compliance with the Host Checker policies, then the user might not get access to the network or might get limited access to the network depending upon the enforcement policies configured by the administrator.

For Android clients, Host Checker can evaluate client compliance based on the following predefined criteria:

- OS Checks—you can specify the iOS version or minimal version that must be installed on the device.
- Root Detection—Rooting is a process that allows Android users to gain root access to the operating system and bypass usage and access limitations imposed by device manufacturers and carriers. With a rooted device, a user can install applications that are not available and have not been certified by the device manufacturer or by the app store process. Rooted devices expose the device to a greater risk of running malicious applications. Host Checker can detect rooted devices and then allows or deny network access based on the Host Checker enforcement policy.
- Mobile Security Suite—Pulse Mobile Security Suite (MSS) for Android supports antivirus, antispam, and features that help protect the device if it is lost or stolen: remote wipe, remote lock, and locate. Host Checker enables you to require that an Android device
have the Pulse Mobile Security Suite installed and enabled. The Pulse MSS is detected by the presence of a valid client certificate issued by the Mobile Security Gateway. Therefore, to configure this Host Checker item, you need to know the client certificate authority that is used by the Pulse Mobile Security Gateway.

**NOTE:** Junos Pulse Secure Access Service software release 7.1 (IVE OS 7.1R1) introduced a different implementation of this feature, and that implementation is still available in subsequent releases of the software. In the earlier implementation, you can enable a Mobile Security Check as part of Host Checker component of a realm authentication policy. Although you can still use this earlier implementation of the Mobile Security Suite check, we recommend that you employ the Host Checker policy rather than the realm authentication method. The two methods are compatible so you can enable both. However, enabling both methods is not recommended because that would cause Pulse Secure Access Service to run two different checks to accomplish one task.

---

**Related Documentation**

- Configuring Host Checker for Junos Pulse Android Clients on page 241
- Implementing Host Checker Policies for Junos Pulse for Android Clients on page 243
- Junos Pulse Mobile Security Overview on page 265
- Host Checker and Trusted Network Computing

---

**Configuring Host Checker for Junos Pulse Android Clients**

Host Checker policies can be part of a larger Host Checker configuration that applies to many different types of clients or to Android devices only.

To create a Host Checker policy for Android devices:

1. From the admin console, select **Authentication > Endpoint Security > Host Checker**.
2. In the Policies section, click **New** to open a New Host Checker Policy page.
3. Specify a name for the new policy and then click **Continue** to open the Host Checker Policy page.
   
   The name appears in lists when you implement the policy so be sure to use a descriptive name, such as Android HC Policy.
4. Click the Mobile tab, and then click the Android tab.
5. In the Rule Settings section, click **Select Rule Type** and select one of the following options and then click **Add**:
   
   - **OS Checks**—To specify the iOS version that must be installed on the device:
     
     a. Specify a descriptive name for this rule. For example, Must-Be-Android-2-2-or-higher. Rule names cannot include spaces.
b. Specify the criteria. For example, to enforce Android 2.2 or higher, create two conditions: Equal to 2.2 and Above 2.2.

Host Checker supports Android versions 1.6 through 3.1.

c. Click **Save Changes**.

- **Rooting Detection**—Rooting is a process that allows Android users to gain root access to the operating system and bypass usage and access limitations imposed by manufacturers and service providers. With a rooted device, an Android user can install applications that have not been certified through the app store process. Rooted devices possess a greater risk of running malicious applications.

  a. Specify a descriptive name for this rule. For example, No-Android-root.

  b. The **Don't allow rooted devices** check box is enabled by default.

  c. Click **Save Changes**.

- **Mobile Security Suite**—Pulse Mobile Security Suite (MSS) for Android supports features that help protect the device from viruses and malware and can help protect the device if it is lost or stolen.

  a. Specify a descriptive name for this rule. For example, Android-MSS.

  b. In the Criteria section, the **Enforce Mobile Security Suite on the device** check box is enabled by default.

  c. Click the **Terminate the user session if a threat/virus is found** box to have the Pulse server end the VPN session if Host Checker finds a virus or malware on the device. The user should be instructed to run the Pulse Mobile Security Suite virus scan on their device and remove the threats to before attempted to establish a VPN connection. The Host Checker policy allows you to enable custom instructions and provide instructions to users that appear if Host Checker finds an issue on the device.

  d. Click **Save Changes** to save the rule and open the Host Checker Policy page.

6. After you have configured all of your rules, specify how you want to enforce them by choosing one of the following options:

- All of the rules
- Any of the rules
- Custom

    For Custom requirements, you can specify a custom expression using Boolean operators AND and OR and group and nest conditions using parenthesis.

7. Specify remediation options:

   - **Enable custom instructions**—If you enable this check box, a text box appears and allows you to type information that appears on the user’s device if Host Checker discovers an issue. For example, if you enabled the MSS rule that terminates the
VPN session of Host Checker discovers a virus, you can instruct the user to run a
virus scan to clear the issue before trying to connect.

- **Send reason strings**—Select this option to display a message to users (called a
reason string) that is returned by Host Checker or integrity measurement verifier
(IMV) and explains why the client machine does not meet the Host Checker policy
requirements. For example, if the rooting detection policy fails, Pulse displays, “A
rooted device is not allowed to access the network. Please contact your network
administrator.

8. When you are finished, click **Save Changes**.

### Implementing Host Checker Policies for Junos Pulse for Android Clients

After you create one or more Host Checker policies for Android devices, you must
implement them. Pulse Secure Access Service can use Host Checker policies at the realm
or the role level.

**Realm Authentication**—You can configure a realm authentication policy to download
and run Host Checker with a particular Host Checker policy. If the Android device does
not meet the Host Checker requirements, then Pulse Secure Access Service can deny
access. You can provide remediation information in the Host Checker policy to describe
the requirement and help users take steps to solve the issue.

To enable a Host Checker policy for a realm:

1. From the admin console, select **Users > User Realms > SelectRealm > Authentication
Policy > Host Checker**. The Host Checker page displays all of the available Host Checker
policies.

2. Select the check box next to each policy you want to include. Select one or both of
the following check boxes next to the policy:

   - **Evaluate Policies**—Evaluates without enforcing the policy on the Android device
     and allows access.

   - **Require and Enforce**—Requires that the Android device be in compliance with the
     Host Checker policy. Pulse Secure Access Service downloads Host Checker to the
     Android device after the user is authenticated and before the user is mapped to any
     roles in the system. Selecting this option automatically enables the Evaluate Policies
     option.

3. Optionally select **Allow access to realm if any ONE of the selected “Require and Enforce”
policies is passed**. This check box is available if you selected more than one Host
Checker policy. If you enable this check box, an Android device is allowed access if it
passes any of the Require and Enforce policies. The Cache Cleaner policy does not apply to Android devices.

4. Click **Save Changes**.

**Role**—You can configure a role to download and run Host Checker with a particular Host Checker policy. If the Android device does not meet the Host Checker requirements, then Secure Access can deny access or assign the user to a remediation role that has limited access. You can provide remediation information in the Host Checker policy to help users take steps to solve the issue.

To enable a Host Checker policy for a role:

1. From the admin console, select Users > User Roles > SelectRole > General > Restrictions > Host Checker. The Host Checker page displays all of the available Host Checker policies.

2. Select **Allow users whose workstations meet the requirements specified by these Host Checker policies**.

3. In the Available Policies list, select the policies that you want to apply to select them, and then click Add to move them to the Selected Policies list. To select a policy click it. So select more than one policy, use Ctrl+click.

4. Optionally select **Allow access to realm if any ONE of these selected “Require and Enforce” policies is passed**. This check box is available if you selected more than one Host Checker policy. If you enable this check box, an Android device is allowed access if it passes any of the Require and Enforce policies. The Cache Cleaner policy does not apply to Android devices.

5. Click **Save Changes**.

**Related Documentation**

- Host Checker for Pulse Android Clients on page 240
- Configuring Host Checker for Junos Pulse Android Clients on page 241
- Host Checker and Trusted Network Computing

**Junos Pulse for Android Error Message Reference**

The following error message summary for Junos Pulse for Android describes possible issues and suggests resolution actions where possible.

**Table 18: Junos Pulse for Android Error Messages**

<table>
<thead>
<tr>
<th>Message</th>
<th>Possible Causes</th>
<th>Suggested Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>The certificate for this server is invalid. Tap Accept to connect to this server anyway.</td>
<td>The server certificate for the page received from the Pulse server is not valid.</td>
<td>Tap View Certificate to examine the certificate. Tap Accept and open the URL. Tap Decline. The connection attempt is ended. Contact the Pulse administrator.</td>
</tr>
</tbody>
</table>
Table 18: Junos Pulse for Android Error Messages (continued)

<table>
<thead>
<tr>
<th>Message</th>
<th>Possible Causes</th>
<th>Suggested Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Session disconnected due to invalid certificate.</td>
<td>The Pulse client downloads session information from the Pulse server and the certificate received from the server does not match the stored session certificate. While accessing e-mail or intranet, the certificate received from Pulse server does not match the previously stored session certificate.</td>
<td>Click the Close button on the Alert dialog to return to home screen. Try the operation again. If the error occurs again, contact the Pulse administrator.</td>
</tr>
<tr>
<td>On the Pulse client status screen, the VPN status appears as Not Supported.</td>
<td>The device does not support VPN.</td>
<td>Click the Close button on the Alert dialog to return to home screen. Try the operation again.</td>
</tr>
<tr>
<td>Failed to connect to the server.</td>
<td>Sign-in Process failed.</td>
<td>Check the network connection (for example, Wi-Fi, 3G, etc.), and then try the operation again.</td>
</tr>
<tr>
<td>Failed to process the HTML information from the server.</td>
<td>Sign-in Process failed.</td>
<td>Try the operation again. If the error occurs again, contact the Pulse administrator.</td>
</tr>
<tr>
<td>Your session was terminated. Please connect again.</td>
<td>An invalid URL was used while accessing intranet and e-mail pages.</td>
<td>Reconnect to the Pulse server. If the error occurs again, contact the Pulse administrator.</td>
</tr>
<tr>
<td>Compliance Check couldn’t be completed.</td>
<td>Host Checker compliance check could not be completed during sign-in process.</td>
<td>Try the operation again. If the error occurs again, contact the Pulse administrator.</td>
</tr>
</tbody>
</table>

Related Documentation
- Junos Pulse for Android Overview on page 235
- Configuring a Role and Realm for Pulse for Android on page 236
Launching the Junos Pulse for Android App Using a Command

The Junos Pulse for Android VPN API enables you to start (or stop) a Junos Pulse VPN connection from an external Android app. The information in this topic describes the Junos Pulse API statements for integrating a VPN connection in Junos Pulse for Android from Google Play. To integrate a VPN connection in Junos Pulse for Android for Samsung devices, see Launching the Junos Pulse for Android App (Samsung) Using a Command.

This feature requires Junos Pulse for Android R4.0 or higher. If you implement the API call so that it provides all necessary information, Pulse starts and establishes a VPN connection with no input from the user, and then passes a result code and corresponding data back to the external app. If the API call does not include all of the necessary information, for example, no password is specified, the Pulse login page appears and the user must provide the required information.

When Pulse is launched programmatically to initiate a VPN connection, the following connection behaviors occur.

- If Pulse is not already installed on the device, an error occurs. If Pulse is not already running, Pulse is launched. The next step depends on the current Pulse connection status and configuration. One of the following occurs:
  - If Pulse does not already have an active connection to a Pulse Secure Access server, it uses an existing configuration to establish a VPN connection to the Pulse server.
  - If Pulse does not already have an active connection, and it does not already have a configuration for the target Pulse server, Pulse opens the Add Configuration screen and populates the login fields that are included in the call. The user must specify any missing information.
  - If the Pulse app is already connected to the Pulse server specified in the connection request, the API returns status that Pulse is already connected. It is the calling application's responsibility to maintain state of which Pulse server it is connected to in order to make the correct API call.

Usage notes:

- If the user has specified the username, realm, and role when creating the VPN configuration in the Junos Pulse app, those values are used to auto-fill the username, realm, and role for the login pages during login.
- Error messages related to authentication or Host Checker failure are not supported. In case of incorrect user credentials, the Pulse login screen appears and the user must manually provide credentials.
- The VPN notification icon appears on the Android device after the VPN connection is established and it is cleared when the VPN session is disconnected.

To launch Pulse and connect to the Pulse server from an external Android app, you use an explicit intent. The explicit intent names the component to be called by the Android system by using the Java class as the identifier. Pulse authenticates using the Android
Webkit framework. It passes the result code and corresponding data back to the external app.

You use the VPN status command to determine run time status of the VPN connection. The status command allows you to handle the use case where the VPN connect command results in a successful session connect with the Pulse server, but the VPN tunnel was not established.

To stop the VPN connection, the external app sends an explicit intent to Pulse to disconnect, and then Pulse disconnects the VPN connection and passes a result code back to the app.

Junos Pulse for Android VPN API Reference

Junos Pulse for Android VPN API enables the VPN connection as follows.

1. The external app sends an Android explicit intent to the Junos Pulse app to authenticate the user and start a VPN connection. The intent contains VPN commands and parameters.
2. Pulse checks if the device supports VPN. If not then it returns that information to the calling app.
3. For a VPN connect command, Pulse checks the user credentials passed through the intent. For a URL that is not already defined on the device, a new Pulse connection profile is created and shown to the user to save or update. The intent then authenticates using the Webkit framework and starts the VPN connection.
4. For a VPN status command, the status of a the VPN connection is returned. Status includes the Pulse server IP address, data sent, data received, and the connection start time.
5. For a VPN disconnect command, Pulse disconnects the user session and stops the VPN connection.
6. Pulse passes the result code and corresponding data in a call back to the external app. The external app must implement the callback function.

The VPN API will internally use the Android Intent API calls to add extended data to the intent. The name must include a package prefix.

public Intent putExtra(String name, int value)

public Intent putExtra(String name, String value)

Explicit Intent Target Component

Package name/Class name—net.juniper.junos.pulse.android/net.juniper.junos.pulse.android.ui.ExplicitIntentActivity

Explicit Intent API — VPN Connect

Command Extra
Extra Name: “Junos Pulse Vpn Command”
Extra Value and Type: 1 [integer]
Required: Yes

Command Parameters Extra:

1. Extra Name: “Url”
   Extra Value and Type: Valid SA Url [String]
   Required: Yes

2. Extra Name: “Username”
   Extra Value and Type: Valid Username [String]
   Required: No

3. Extra Name: “Password”
   Extra Value and Type: Valid Password [String]
   Required: No

4. Extra Name: “Realm”
   Extra Value and Type: Valid Realm [String]
   Required: No

5. Extra Name: “Role”
   Extra Value and Type: Valid Role [String]
   Required: No

6. Extra Name: “Certpath”
   Extra Value and Type: Valid certificate file path on device [String]
   Required: No

7. Extra Name: “Keypath”
   Extra Value and Type: Valid certificate key file path on device [String]
   Required: No

Callback Return Code and Intent Parameters

1. JUNOS_PULSE_RETURN_CODE_SESSION_CONNECTED [Value = 6]
2. JUNOS_PULSE_RETURN_CODE_SESSION_DISCONNECTED [Value = 7]
   Intent Params: None
   Return code 7 indicates that VPN disconnect succeeded.
3. JUNOS_PULSE_RETURN_CODE_VPN_NOT_SUPPORTED [Value = 3]
   Intent Params: None
   Return code 3 indicates that VPN is not supported on this device. VPN using Junos
   Pulse is not supported on all devices. All pre-Android ICS, non-Samsung, non-Lenovo,
   non-plugin devices should return this status code. Junos Pulse for Android is supported
   on Android 2.1 and higher (API Level 7) devices. Devices that are running an earlier
   version of Android do not see Pulse on Google Play.

Explicit Intent API — VPN Disconnect

Command Extra
Extra Name: “Junos Pulse Vpn Command”
Extra Value and Type: 2 [integer]
Required: Yes

Command Parameters Extra: None

Callback Return Code and Intent Parameters

1. JUNOS_PULSE_RETURN_CODE_SESSION_DISCONNECTED [Value = 7]
   Intent Params: None
   Return code 7 indicates that VPN disconnect succeeded.

2. JUNOS_PULSE_RETURN_CODE_VPN_NOT_SUPPORTED [Value = 3]
   Intent Params: None
   Return code 3 indicates that VPN is not supported on this device. VPN using Junos Pulse is not supported on all devices. All pre-Android ICS, non-Samsung, non-Lenovo, non-plugin devices should return this status code. Junos Pulse for Android is supported on Android 2.1 and higher (API Level 7) devices. Devices that are running an earlier version of Android do not see Pulse on Google Play.

Explicit Intent API — VPN Check Status

Command Extra
Extra Name: “Junos Pulse Vpn Command”
Extra Value and Type: 3 [integer]
Required: Yes

Command Parameters Extra: None

Callback Return Code and Intent Parameters

1. JUNOS_PULSE_RETURN_CODE_VPN_CONNECTED [Value = 1]
   Intent Params:
   a. Extra Name: “Ipaddr”
      Extra Value and Type: Valid Gateway Url [String]
      Required: Yes
   b. Extra Name: “Starttime”
      Extra Value and Type: VPN Start Time [String]
      Required: Yes
   c. Extra Name: “Tx”
      Extra Value and Type: Bytes Sent [integer]
      Required: Yes
   d. Extra Name: “Rx”
      Extra Value and Type: Bytes Received [integer]
      Required: Yes

2. JUNOS_PULSE_RETURN_CODE_VPN_DISCONNECTED [Value = 2]
   Intent Params: None

3. JUNOS_PULSE_RETURN_CODE_VPN_NOT_SUPPORTED [Value = 3]
Intent Params: None
Return code 3 indicates that VPN is not supported on this device. VPN using Junos Pulse is not supported on all devices. All pre-Android ICS, non-Samsung, non-Lenovo, non-plugin devices should return this status code. Junos Pulse for Android is supported on Android 2.1 and higher (API Level 7) devices. Devices that are running an earlier version of Android do not see Pulse on Google Play.

Pulse returns the following result code if any unsupported command is issued:
JUNOS_PULSE_RETURN_CODE_VPN_INVALID_COMMAND [Value = 5]
Intent Params: None
Return Code 5 indicates that the third-party app has called a VPN command value that is not supported.

Explicit Intent API — Example

```java
Intent intent = new Intent();
intent.setComponent(ComponentName.unflattenFromString("net.juniper.junos.pulse.android/net.juniper.junos.pulse.android.ui.ExplicitIntentActivity");
//Set the intent with authentication parameters like username, password.
JunosPulseActivityIntent.putExtra("JunosPulseVpnCommand", 1);
JunosPulseActivityIntent.putExtra("Url", "connect4.juniper.net");
JunosPulseActivityIntent.putExtra("Username", "test");
JunosPulseActivityIntent.putExtra("Password", "password");
JunosPulseActivityIntent.putExtra("Realm", "Users");
startActivity(JunosPulseActivityIntent);
```

Related Documentation
- Junos Pulse for Android Overview on page 235
- Launching the Junos Pulse for Android App (Samsung) Using a Command

Launching the Junos Pulse for Android App Through a Browser Link

Android device users can launch Pulse from the browser on their device by logging into the Pulse Secure Access Service Web portal, and then clicking the VPN link. The default page that appears when an Android device user logs into the Web portal already includes a VPN link to launch Pulse.

Tapping the VPN link on the Web page launches the Pulse app if it is not already running. If Pulse is not already installed on the Android device, an error occurs. You cannot deploy the Pulse for Android app from the Pulse server.

When a user taps a button that is tied to a Pulse launcher command, the command launches the Pulse app if it is not already running. If Pulse is not already installed on the iOS device, an error occurs. The next step depends on the current Pulse connection status and configuration. One of the following occurs:

- If Pulse does not already have an active connection to Pulse Secure Access Service, it uses an existing configuration to establish the VPN connection.
- If Pulse does not already have an active connection, and it does not already have a configuration for the target Pulse server, Pulse opens the Add Configuration screen.
The target URL is already defined and the user just needs to specify a name for the connection.

- If the Pulse app is already connected to a Pulse server, the Pulse app is brought to the foreground.

To employ the Pulse launcher in your Web pages or external applications, specify the link using the following format:

```
junospulse://<server-host>/<server-path>?method={vpn}&action={start|stop}
&DSID=<dsid-cookie> &SMSESSION=<smsession-cookie> &username=<username>
&password=<password> &realm=<realm> &role=<role>
```

**NOTE:** The Pulse launcher command also supports a different method that enables you to specify a URL to register the device with the Pulse Mobile Security service. See the Junos Pulse Mobile Security Suite documentation for more information.

Usage notes:

- If the DSID cookie is given in the URL, the app does not use the "username", "password", "realm", or "role" parameters because no login is required.

- The values for username, realm, and role are URI-escaped values. Special characters are replaced with their hexadecimal equivalents preceded by '%'.

- If the user has specified the username, realm, and role when creating the VPN configurations in the Junos Pulse app, those values are used to auto-fill the username, realm, and role for the login pages during a Web-based login. During login, if all fields are successfully auto-filled from fields in the VPN configuration or the junospulse:// launch URL, the login progresses without any user input. The username, realm, and role values need to already exist in the VPN configuration for them to be auto-filled during the login process. If the user manually specifies the username, realm, or role during login, the app will not add or update these values in the VPN configuration. The user needs to explicitly update the VPN configuration with these values.

- If the user manually specifies the username, realm, or role during login, the app stores these values in the VPN configuration and they will be auto-filled the next time the user signs in. Passwords entered by the user are not saved in the VPN configuration.

Examples:

If the calling application has already obtained a DSID cookie from Pulse Secure Access Service, the app can use the following command to start the VPN:

```
junospulse://<server-host>/<server-path>?method=vpn &action=start
&DSID=<dsid-cookie> &SMSESSION=<smsession-cookie>
```

If the calling application does not already have a DSID, it can use the following command to start the VPN:
If the calling application wants to stop the VPN, it can use the following command:

```
junospulse://<server-host>/<server-path>?method=vpn&action=stop
```

Related Documentation
CHAPTER 13

Junos Pulse for Nokia Symbian Devices

- Junos Pulse for Symbian Overview on page 253

Junos Pulse for Symbian Overview

Junos Pulse can create an authenticated session between a device running Nokia Symbian and Pulse secure access service. Junos Pulse for Symbian devices uses IKEv2 (Internet Key Exchange) to set up a security association in the IPsec protocol suite. Junos Pulse enables secure connectivity to Web-based applications and data based on identity, realm, and role. Junos Pulse is available for download from the Nokia Ovi store.

The Junos Pulse Mobile Supported Platforms Guide, which is available at http://www.juniper.net/support/products/pulse/mobile/ lists the mobile device OS versions supported by Pulse and the security features supported on each mobile device OS.

The Nokia Symbian relies on IKEv2 authentication and that requires a certificate. Before you begin, be sure you have completed the following certificate configuration steps:

- Import the valid Device Certificate to the Secure Access Server.
  Configuration > Certificates > Device Certificate
- Import the Trusted Client CA certificate.
  Configuration > Certificates > Trusted Client CAs
- Import the Trusted Server Certificates.
  Configuration > Certificates > Trusted Server CAs
- Configure a valid NC profile to work with IKEv2.

Configuring Pulse Secure Access Service for Junos Pulse on Symbian Devices

To enable access from a Symbian device to Pulse Secure Access Service, the device user must download and install the Junos Pulse app, and the Pulse administrator must configure specific realm and role settings on the Pulse server.

To configure Pulse Secure Access Service for Symbian device access:

1. Log in to the Pulse server admin console.
2. Select User Roles > New User Role.
3. On the New Role page, specify a name for the role and, optionally, a description. Make note of the name because later in this procedure, you create a realm and map realm users to this role.

4. In the Access Features section of the New Role page, select the IKEv2 check box.

5. Click **Save Changes** to create the role and to display the role configuration tabs.

6. Select **Web > Bookmarks** and then click **New Bookmark**.

   You must create bookmarks to enable the buttons that appear in the Pulse for Android user interface. Typically, you create a bookmark for your company intranet and for Web e-mail. You must create an e-mail bookmark to enable the e-mail button within the Pulse interface on the Android, and that e-mail bookmark must be named **Mobile Webmail**.

   **Figure 23: Creating the E-mail Bookmark for the Pulse Client**

   ![Creating the E-mail Bookmark for the Pulse Client](image)

   **NOTE:** Alternatively, you can use Web resource policies to define the bookmarks.
NOTE: To ensure that users see consistent bookmarks in the Pulse client UI no matter which server they are connected to, you should configure and enable user record synchronization, a feature of the Pulse Secure Access Service platform.

7. To change default session time-outs, select General > Session Options.

8. In the Session lifetime section, specify Max. Session Length in minutes. The remaining session time appears on the Pulse interface of the mobile device client in the format days hours:minutes:seconds. The other session settings are not applied to mobile clients.


10. Specify a name and, optionally, a description. Then click Save Changes to create the realm and to display the realm option tabs.

11. On the Authentication Policy tab for the realm, click Host Checker and make sure that all Host Checker policies are disabled except for the optional Pulse Mobile Security check.

   You can require that mobile device users have Pulse Mobile Security software installed and enabled.

12. On the Role Mapping tab for the realm, create a new rule that maps all users to the Symbian device role you created earlier in this procedure.

Related Documentation

- Junos Pulse Mobile Security Overview on page 265
- Resource Policies
- About User Record Synchronization
- About Using Certificates on Secure Access Service
Junos Pulse for Windows Mobile Overview

Junos Pulse supports Secure Application Manager (SAM). SAM provides remote access using application names and destinations instead of network subnets. SAM does not require a virtual adapter or virtual IP address on the endpoint so SAM connectivity is secure. SAM provides access to client/server applications and thin client solutions without provisioning a VPN tunnel.

Junos Pulse can provide secure, application-level, remote access to enterprise servers from client applications on mobile endpoints that are running the Windows Mobile operating system. You can provide secure access to individual client/server applications, such as Lotus Notes, Microsoft Outlook, Citrix, and ActiveSync, as well as to application servers.

NOTE: Junos Pulse for Windows Mobile is available for download from the Juniper Web.

Pulse Release 1.0, 2.0, and 3.0 and Pulse SAM Connectivity

The SAM client software has evolved to meet the needs of different environments. Table 19 on page 258 describes the progression of Pulse/SAM client software.
Table 19: Pulse/SAM Client Version Summary

<table>
<thead>
<tr>
<th>Pulse/SAM Version</th>
<th>Supported Platforms</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pulse R1.0</td>
<td>Windows Mobile</td>
<td>WSAM client that is installed from the Pulse Secure Access server.</td>
<td>Supports Host Checker.</td>
</tr>
<tr>
<td></td>
<td>Windows XP</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulse R2.0</td>
<td>Windows Mobile (6.0, 6.1, and 6.5)</td>
<td>Pulse for Windows Mobile; available for download from juniper.net.</td>
<td>If you install the Pulse 2.0 mobile client on a Windows Mobile device that already has Pulse R1.0, the installation detects the presence of the old client and removes it prior to installing the new client. It also detects and removes Host Checker. Host Checker is not supported.</td>
</tr>
<tr>
<td></td>
<td>NOTE: Junos Pulse R2.0 is supported on touch-based Windows Mobile devices only.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pulse R3.0</td>
<td>Windows XP</td>
<td>Pulse R3.0 incorporates SAM functionality as a native Pulse connection method.</td>
<td>Supports Host Checker.</td>
</tr>
<tr>
<td></td>
<td>Windows Vista</td>
<td></td>
<td>NOTE: Host Checker is not supported in the use case where the user employs a browser on the mobile device to connect to the Pulse server Web portal.</td>
</tr>
<tr>
<td></td>
<td>Windows 7</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Junos Pulse Mobile Supported Platforms Guide, which is available at http://www.juniper.net/support/products/pulse/mobile/ lists the mobile device OS versions supported by Pulse and the Pulse Mobile Security Suite features supported on each mobile device OS.

NOTE: Pulse Secure Access Service also supports a Java-based SAM client (JSAM). The JSAM client can be deployed from Pulse Secure Access Service to any endpoint that supports Java.
This section describes how to configure Junos Pulse Secure Access Service to support Pulse for Windows Mobile endpoints.

To enable SAM and configure a role for Windows Mobile endpoints:

1. Log in to the Pulse Secure Access Service admin console.
2. Select **User Roles > New User Role**.
3. On the New Role page, specify a name for the role and, optionally, a description. Make note of the name because later in this procedure, you create a realm and map realm users to this role.
4. In the Access Features section of the New Role page, select the **Secure Application Manager** check box and then select **Windows version**.

   **NOTE:** In the Options section, do not enable Junos Pulse. If you select Junos Pulse and Secure Application Manager, Windows version, you enable the Pulse/SAM access method, which is used for Windows XP, Vista, and Windows 7. The Junos Pulse check box must be left cleared to enable the role for Pulse for Windows Mobile clients.

5. Click **Save Changes** to create the role and to display the role configuration tabs.
6. Select **Web > Bookmarks** and then click **New Bookmark**.

   You must create bookmarks to enable the buttons that appear in the Pulse for Windows Mobile user interface. Typically, you create a bookmark for your company intranet and for Web e-mail. You must create an e-mail bookmark to enable the e-mail button within the Pulse for Windows Mobile app, and that e-mail bookmark must be named **Mobile Webmail**.
Figure 24: Creating the E-mail Bookmark for the Pulse Client

NOTE: Alternatively, you can use Web resource policies to define the bookmarks.

NOTE: To ensure that users see consistent bookmarks in the Pulse app no matter which server they are connected to, you should configure and enable user record synchronization, a feature of the Pulse Secure Access Service platform.

Most of the General and SAM tab options apply to Pulse for Windows Mobile clients. The following describes the role options that you can employ to manage Windows Mobile sessions.

**General > Restrictions**

Source IP—Control from which IP addresses users can access the Web portal sign-in page, be mapped to a role, or access a resource.

Browser—Allow or deny access to the role based on the browser’s user agent string.

Certificate—Allow all users or only users with a signed client-side certificate.
Host Checker—Check compliance with defined policies. You must first define appropriate Host Checker policies before you can assign them to the role.

**General > VLAN/Source IP**

VLAN and Select Source IP—To direct traffic to specific sites based on the role, you can define a source IP alias for each role, and then use the alias to configure virtual ports you define for the internal interface source IP address. A back-end device can then direct end user traffic based on the alias. This capability enables you to direct various end users to defined sites based on their roles, even though all of the end user traffic has the same internal interface source IP address.

Max. Session Length—A session can remain active for the number of minutes set in this option. The session ends when it reaches this limit. Idle Timeout, Reminder Time, and Enable Session Extension features are not applicable to Windows Mobile clients.

**General > Session Options**

Idle Timeout—The maximum time a session can remain idle (no traffic) before the server ends the session.

Max. Session Length—The maximum time for a session before the server ends the session.

Reminder Time—The number of minutes prior to a session end when the server notifies the user that the session will end soon.

Enable Session Extention—Not supported by the Pulse for Windows Mobile app.

**General > UI Options**

UI Options—The settings on this page define the Pulse Secure Access Service Web portal page.

**SAM > Applications**

Add Application—We recommend that you use resource profiles to specify the applications available to Pulse for Windows Mobile users, but you can use role and resource policy settings instead.

**SAM > Options**

Auto-uninstall Secure Application Manager—This feature is not applicable to the Windows Mobile client. Users must download and install Pulse for Windows Mobile before the Windows Mobile device can connect to the Pulse Secure Access Service.

Prompt for username and password for intranet sites—If you enable this option, the Pulse Secure Access Service requires users to enter sign-in credentials before connecting to sites on your internal network. This option changes Internet Explorer's intranet zone setting so that Internet Explorer always prompts the user for network sign-in credentials for an intranet site.

Auto-upgrade Secure Application Manager—This feature is not applicable to the Pulse for Windows Mobile app.
Resolve only hostnames with domain suffixes in the device DNS domains—if you enable this option, users can only browse to Web sites that are part of their login domain.

Session start script and Session end script—This feature is not applicable to the Pulse for Windows Mobile app.

To use resource profiles to specify the applications available to Junos Pulse for Windows Mobile users:

1. Create resource profiles that enable access to client applications and destinations and configure the appropriate settings. Select Users > Resource Profiles > SAM > Client Applications.
2. Click New Profile.
3. From the Type list, select WSAM.
4. From the Application list, select one of the following options:
   - **Custom**—When you select this option, you must manually enter your custom application’s executable filename (such as telnet.exe). Additionally, you can specify this file’s path and MD5 hash of the executable file (although it is not required that you specify the exact path to the executable). If you enter an MD5 hash value, SAM verifies that the checksum value of the executable matches this value. If the values do not match, SAM notifies the user that the identity of the application could not be verified and does not forward connections from the application to the server.
   - **Lotus Notes**—Select this option to have SAM intermediate traffic from the Lotus Notes fat client application.
   - **Microsoft Outlook**—Select this option to have SAM intermediate traffic from the Microsoft Outlook application.
   - **NetBIOS file browsing**—Select this option to have SAM intercept NetBIOS name lookups in the TDI drivers on port 137.
   - **Citrix**—Select this option to have SAM intermediate traffic from Citrix applications.
   - **Domain Authentication**—Select this option to allow integrated Windows applications, such as file sharing, Outlook, and so forth to authenticate to the domain controller when the client machine is part of a domain. Before using this option, you must:
     - Specify domain controllers that are reachable through the Pulse Secure Access Service in the WSAM Destination list so that LDAP and Kerberos traffic can be proxied and sent to the Pulse server.
     - Configure a WSAM Access Control Policy to allow access to all domain controllers.

   NOTE: You can configure access to a standard application once per user role. For example, you can enable one configuration of Microsoft Outlook and one configuration of Lotus Notes for the “Users” role.

5. Enter a unique name and optionally a description for the resource profile.
6. In the Autopolicy: SAM Access Control section create supporting auto policies and assign the policies to the role:
   a. If it is not already enabled, select the Autopolicy: SAM Access Control check box.
   b. In the Resource field, specify the application server to which this policy applies. You can specify the server as a hostname or an IP/netmask pair. You can also include a port. If you select Domain Authentication from the Application list, enter your domain controller server addresses into the Resource field. You can add multiple domain controller servers if more than one is available.
   c. From the Action list, select Allow to enable access to the specified server or Deny to block access to the specified server.
   d. Click Add.
7. Click Save and Continue.
8. In the Roles tab, select the roles to which the resource profile applies and click Add. The selected roles inherit the autopolicy created by the resource profile. If it is not already enabled, the server also automatically enables the SAM option in the roles General > Overview page for all of the roles you select.
9. Click Save Changes.
10. Select Users > User Realms > New User Realm.
11. Specify a name and, optionally, a description and then click Save Changes to create the realm and to display the realm option tabs.
12. On the Authentication Policy tab for the realm, click Host Checker and enable the optional Pulse Mobile Security check to require that mobile device users have Pulse Mobile Security software installed and enabled.
13. On the Role Mapping tab for the realm, create a new rule that maps all users to the Windows Mobile role you created earlier in this procedure.

Related Documentation
- Configuring Host Checker for Junos Pulse for Windows Mobile Clients on page 263
- About User Record Synchronization
- Resource Policies
- Junos Pulse Mobile Security Overview on page 265

Configuring Host Checker for Junos Pulse for Windows Mobile Clients

You can configure Host Checker to enforce policies for handheld devices, such as PDAs and smart phones, that run the Windows Mobile operating system. Host Checker rules include checks for ports, processes, files, registry key settings, operating system version, and certificates on the handheld device. You can also load and use installed third-party IMCs to perform vendor-specific checks. Once the policy is created, Host Checker deploys...
automatically when the user connects to the Pulse server Web portal. Host Checker does not require any configuration on the handheld device itself. When the server determines the device is out of compliance, Host Checker displays a notification icon in the system tray. Clicking this icon opens a browser page that contains reasons for the compliance failure and remediation instructions. Host Checker remains on the handheld device and does not need to be downloaded each time the user connects to the server. When the server upgrades to a newer version of Host Checker, the Windows Mobile device automatically updates the next time the user connects to the server. To remove Host Checker from the device, use the Remove Programs applet in the Settings panel of the device.

To create a Host Checker policy for Windows Mobile devices:

1. From the admin console, select **Authentication > Endpoint Security > Host Checker**.

2. In the Policies section, click **New** to open a New Host Checker Policy page.

3. Specify a name for the new policy and then click **Continue** to open the Host Checker Policy page.

   The name appears in lists when you implement the policy so be sure to use a descriptive name, such as WinMobile HC Policy.

4. Click the Mobile tab, and then click the Windows Mobile tab.

5. In the Rule Settings section, click **Select Rule Type**, select one of the following options, and then click **Add**:

   - **OS Checks**—To specify the Windows Mobile version that must be installed on the device.
   - **Ports**—Allows you to specify the ports numbers that can be used to access the server.
   - **Process**—Allows you to specify a specific process that must be running on the endpoint.
   - **File**—Allows you to verify the existence of a particular file on the endpoint.
   - **Registry Setting**—Check for a specific value in a registry setting.
   - **Machine Certificate**—Allows you to verify that the endpoint has a specific machine certificate installed. When validating a client-side CA certificate, the Pulse server checks that the certificate is not expired or corrupt and that the certificate is signed by a CA that the Pulse server recognizes.

6. After you have configured all of your rules, specify how you want to enforce them by choosing one of the following options:

   - All of the rules
   - Any of the rules
   - Custom

   For Custom requirements, you can specify a custom expression using Boolean operators AND and OR and group and nest conditions using parenthesis.
7. Specify remediation options:
   - **Enable custom instructions**—If you enable this check box, a text box appears and allows you to type information that appears on the user’s device if Host Checker discovers an issue. For example, if you enabled the MSS rule that terminates the VPN session of Host Checker discovers a virus, you can instruct the user to run a virus scan to clear the issue before trying to connect.
   - **Kill processes**—Terminate specific processes on the endpoint.
   - **Delete files**—Delete specific files on the endpoint.
   - **Send reason strings**—Select this option to display a message to users (called a reason string) that is returned by Host Checker or integrity measurement verifier (IMV) and explains why the client machine does not meet the Host Checker policy requirements.

8. When you are finished, click **Save Changes**.

**Related Documentation**
- Host Checker for Pulse iOS Clients on page 217
- Host Checker for Pulse Android Clients on page 240

**Junos Pulse Mobile Security Overview**

The Junos Pulse Mobile Security Suite is an optional feature of the Pulse application for mobile devices. It provides mobile security and device management. It protects mobile devices against viruses, spyware, Trojans and worms, and includes tools to mitigate the risks of lost and stolen devices.

The Junos Pulse Mobile Security Suite provides the following features:

- **Antivirus**—Protects mobile devices against viruses and malware delivered via e-mail, Short Message Service (SMS), Multimedia Messaging Service (MMS), direct download, Bluetooth, or infrared transmission.
- **Firewall**—Protects users from threats by filtering and blocking TCP/IP traffic. A bidirectional, port-based and IP-based packet filtering option protects the mobile device from harmful or questionable content and prevents malicious content from being transferred to the device. The firewall monitors cellular data and Wi-Fi traffic.
- **Antispam**—Provides call and message filtering. Users can prevent interruptions and disturbances by blocking voice and SMS spam by customizing contacts into groups of blacklisted (blocked) numbers.
- **Device monitoring and control**—Provides real time content monitoring of SMS, MMS, and e-mail messages. The administrator can access call logs, address books, and even photos stored on the device.
- **Loss and theft protection**—Loss and theft protection features include remote lock, remote wipe, GPS tracking, backup and restore, remote alarms, and SIM change.
notification by means of commands run from the Pulse Mobile Security Gateway by the administrator.

- **Backup and restore**—Allows a user to back up the contacts and calendar PIM data stored on the device.

**Device Management**—The Pulse Mobile Security Gateway provides a management interface for managing and controlling mobile devices. The Pulse Mobile Security Gateway enables you to create user accounts and profiles, create rules and policies for devices, remotely execute features on the client, remove undesirable applications from devices, and generate reports related to malware detection and security levels. For more information, see the Junos Pulse Mobile Security Gateway documentation.

**Related Documentation**
- Junos Pulse for Apple iOS Overview on page 211
- Junos Pulse for Android Overview on page 235
- Junos Pulse for Symbian Overview on page 253
- Junos Pulse for Windows Mobile Overview on page 257
PART 4

Windows In-Box Junos Pulse Client

- Windows Pro and Windows RT In-Box Junos Pulse Client on page 269
Windows Pro and Windows RT In-Box Junos Pulse Client

Microsoft Windows 8.1 introduced Junos Pulse client as part of the Windows operating system. (Microsoft calls this an “in-box” application.) The Windows in-box Pulse client appears as a VPN Provider network option within Windows 8.1 and later endpoints, including Windows RT endpoints. The user can establish a Layer 3 VPN connection to Junos Pulse Secure Access Service. You can create, manage, and remove Pulse VPN connections on the Windows endpoint through Windows PowerShell scripts. The user can also create connections manually on the endpoint. The Windows in-box Pulse client provides a subset of the features that are available through the Junos Pulse for Windows client.

Windows PowerShell is a command-line shell and scripting language for Windows system administration. For more information about PowerShell, see the PowerShell documentation on Microsoft Tech Net. PowerShell commands are called cmdlets. For information about the VPN Client cmdlets, see the Microsoft Tech Net topic on VPN Client cmdlets.

Configuration on the Pulse server to support the Windows in-box Pulse client is the same as for the Pulse for Windows client. You create sign-in, realm, role, VPN tunnel, and Host Checker policies. You can use the same roles and connection profiles for the Windows in-box Pulse client as you use for the Pulse for Windows client. However, the Windows
in-box Pulse client supports only one type of Host Checker rule, Statement of Health (SoH). Statement of Health is a component of Network Access Protection (NAP), a Microsoft policy enforcement platform built into Windows 8, Windows 7, Windows Vista, and Windows Server 2008 operating systems. NAP SoH lets you enforce system health compliance. Before you can use the Statement of Health Host Checker rule with the Windows in-box Pulse client, you must enable NAP SoH functionality on the endpoint.

Microsoft Windows In-Box Junos Pulse Client Supported Platforms

The Windows in-box Pulse client is supported on Pulse Secure Access Service R7.4 and later. Client upgrades are distributed through Windows Update and Windows HotFix distributions.

NOTE: The Statement of Health rule is the only Host Checker rule supported by the Windows in-box Pulse client, and the Statement of Health rule is available only with Pulse Secure Access Service R8.0 and later. If you are using Pulse Secure Access Service R7.4, then only basic Host Checker functions are available.

Microsoft Windows In-Box Junos Pulse Client Supported Features

The following list describes the supported features for the Windows in-box Pulse client.

• The Windows in-box Pulse client supports connections to Junos Pulse Secure Access Service. Only one connection at a time can be active.

NOTE: Users must have their server’s root certificate installed on the endpoint before attempting to connect to the Pulse server to avoid the error, Server certificate is untrusted.

• The user can manually connect and disconnect. The Pulse administrator can also configure a Windows in-box Pulse VPN connection to connect automatically when the user starts a particular app.

• The Windows in-box Pulse client supports the following authentication functions:
  • Username and password or token code.
  • Authentication server prompts for changing the password, creating a PIN, changing a PIN, and specifying the next token code.
  • Realm and role selection and preferred realm and role.
  • Sign-in notification messages.
  • Secondary authentication.
  • Cached credentials.
  • SSL-VPN connections.
  • Split tunneling enabled or disabled.
NOTE: Windows in-box Pulse client connections always have local subnet access enabled.

• Primary and secondary DNS and domain suffix list:
  • DNS search order as defined on Pulse server (redirects all DNS traffic to specified primary or secondary servers).
  • DNS suffixes added to endpoint DNS lookup.
• Proxy server and Proxy Automatic Configuration (PAC).
• Host Checker (Statement of Health rule only).
• Automatic tunnel connection application launch.

Microsoft Windows In-Box Junos Pulse Client Limitations

The Windows in-box Pulse client supports connections to Pulse Secure Access Service only.

The following Pulse features are not available with the Windows in-box Pulse client:

• Save realm or role preference
• Machine authentication
• Location awareness rules
• Logon and logoff scripts. (As defined in the role. As an alternative, you can use the Microsoft Task Scheduler (schtasks.exe) to run scripts on the endpoint.
• WINS server tunnel parameter
• UDP-ESP tunnel (SSL mode only)
• Certificate trust override prompt
• Proxied HTTPS connections
• Generalized URI connection addresses. (You can use port and uri options in the network connection schema instead).
• Preconfigured Pulse settings (.jnprpreconfig).
• RSA soft-token integration
• Session extension
• Suspend/resume tunnel
• Host Checker automatic remediation actions
• Pre logon VPN plugins

Related Documentation
• Microsoft Windows In-Box Junos Pulse Client User Interface on page 272
Microsoft Windows In-Box Junos Pulse Client User Interface

Microsoft Windows 8.1 introduced Junos Pulse client as part of the Windows operating system. (Microsoft calls this an “in-box” application.) The Windows in-box Pulse client uses Windows operating system dialogs. In addition, there is no user assistance provided with the Windows in-box Pulse client. Pulse connections appear as Windows network connections.

Users can create, manage, and delete Pulse connections. Pulse connections appear as VPN connections in the Networks list. Figure 25 on page 272 shows a Pulse VPN connection labeled PulseCxn1.

Figure 25: Windows Networks List
To manually create a new connection, the user should do the following:

1. Click **Settings > Change PC Settings > Network > Add a VPN Connection**.

   Figure 26 on page 273 shows the Windows dialog to configure the connection.

**Figure 26: Manually Adding a Pulse Connection**

![Add a VPN connection](image)

Juniper Networks Junos Pulse appears as a selection in the **VPN provider** box. The **Connection name** can be anything the user wants but the user needs to provide either the IP address or the hostname (for example, server1.mycompany.net) of the Pulse server in the **Server name or address** box. Because credential prompts are configured on and served from the Pulse server, the **Type of sign-in info**, **User name**, and **Password** boxes are not available. If **Remember my sign-in info**, is selected, Windows preserves the values the user specifies for username and password during the first logon operation.

**NOTE:** Users must have their server’s root certificate installed on the endpoint before attempting to connect to the Pulse server to avoid the error, **Server certificate is untrusted**.

After the user saves the new connection, it appears in the Networks list as shown in Figure 27 on page 274. The user can click the connection to initiate a VPN connection.
Figure 27: Windows Networks List with New Pulse Connection

Pulse connection prompts (Figure 28 on page 274) and messages (Figure 29 on page 275) appear as Windows user interface elements.

Figure 28: Junos Pulse Credentials Dialog
Figure 29: Junos Pulse Message Box

Related Documentation

- Microsoft Windows In-Box Junos Pulse Client Overview on page 269
- Windows PowerShell Script Examples for Microsoft Windows In-Box Junos Pulse Client on page 275
- Host Checker Statement of Health for Junos Pulse Secure Access Service Overview on page 279
- Configuring a Statement of Health Host Checker Policy for Junos Pulse Secure Access Service on page 280
- Enabling Statement of Health on the Windows Endpoint for the Windows In-Box Junos Pulse Client on page 281
- Viewing Windows In-Box Junos Pulse Client Log Messages on page 282

Windows PowerShell Script Examples for Microsoft Windows In-Box Junos Pulse Client

Microsoft Windows 8.1 introduced support for Junos Pulse client as part of the operating system. You can create, manage, and remove Pulse connections on the Windows endpoint by using Windows PowerShell scripts on the endpoint. PowerShell is a command-line shell and scripting language for system administration. To configure Junos Pulse connections, you should have a working knowledge of PowerShell. For detailed information on PowerShell, see the Microsoft TechNet library.

Windows PowerShell commands are called cmdlets. To manage Pulse connections, you use the VPN Client cmdlets. For detailed information on the VPN Client cmdlets, see the VPN Client section of the Microsoft TechNet library.

NOTE: PowerShell scripts must be signed to run on client computers that have a default PowerShell configuration. For more information, see the Microsoft TechNet library.

The following PowerShell script examples show how to create and manage the most commonly used PowerShell cmdlets to create and manage Pulse connection configurations. Most PowerShell VPN Client cmdlets require that you specify the application ID. For Pulse, the application ID is `JuniperNetworks.JunosPulseVpn_cw5n1h2txyewy`. For a complete list of cmdlet options, see the VPN Client section of the Microsoft TechNet library.

NOTE: All connections are HTTPs and use a server certificate, therefore you must install the server root CA to connect.

Add Pulse connection that uses split tunneling

This script creates a Pulse VPN connection named PulseCxn1 that connects to a Pulse server with an IP address of 10.171.216.

```powershell
$xml = "<pulse-schema></pulse-schema>"
$sourceXml=New-Object System.Xml.XmlDocument
$sourceXml.LoadXml($xml)
Add-VpnConnection -Name "PulseCxn1" -ServerAddress "10.17.1.216" -SplitTunneling -PluginApplicationID "JuniperNetworks.JunosPulseVpn_cw5n1h2txyewy" -CustomConfiguration $sourceXml
```

NOTE: Some VPN Client cmdlet options are not applicable to creating Pulse connections. The following Add-VpnConnection options cause an error if you use them when creating a Pulse connection:

- AuthenticationMethod
- EncryptionLevel
- L2tpPsk
- MachineCertificateEKUFilter
- MachineCertificateIssuerFilter
- UseWinlogonCredential

Add Pulse connection that saves the user credentials after the first login

The -RememberCredentials option applies to smart cards and certificate PINs, and to usernames and passwords.

```powershell
$xml = "<pulse-schema ></pulse-schema>"
$sourceXml=New-Object System.Xml.XmlDocument
$sourceXml.LoadXml($xml)
```

Copyright © 2013, Juniper Networks, Inc.
Add-VpnConnection -Name "PulseCxn2" -ServerAddress "10.17.1.217" -RememberCredential -PluginApplicationID "JuniperNetworks.JunosPulseVpn_cw5n1h2txyewy" -CustomConfiguration $sourceXml

Add Pulse connection that uses a specified role and realm and a non-standard port

This script's pulse-schema statement includes schema options that specify the realm and role that are used for this connection. If there are multiple realms or roles available to the user, and you do not specify the preferred values, then the user is prompted for selections.

$xml = "<pulse-schema><port>4444</port><preferredRealm>Users</preferredRealm><preferredRole>TestRole</preferredRole><uri>/local</uri></pulse-schema>
$sourceXml=New-Object System.Xml.XmlDocument
$sourceXml.LoadXml($xml)
Add-VpnConnection -Name "PulseCxn3" -ServerAddress "10.17.1.216" -SplitTunneling -RememberCredential -PluginApplicationID "JuniperNetworks.JunosPulseVpn_cw5n1h2txyewy" -CustomConfiguration $sourceXml

Delete Pulse connection

To delete a Pulse connection, use the following command:

Remove -VpnConnection -Name <connection_name>

Get Pulse connection information

Figure 30 on page 277 shows the output from the following command to show the properties of a VPN connection:

Get -VpnConnection -Name <connection_name>

Figure 30: Get-VpnConnection Output

Start Pulse connection on application launch

You can associate a Pulse connection with an application. When the user starts that application, the specified Pulse VPN connection is initiated.
Add -VpnConnectionTriggerApplication -ConnectionName "PulseCxn1" [-ApplicationID] <String[]>

Start Pulse connection when an application attempts to access a specified domain name

You can associate a Pulse connection with a specific DNS suffix to provide connectivity based on location awareness. When the user attempts to access a resource within the suffix, the specified Pulse VPN connection is initiated.

Add-VpnConnectionTriggerDnsConfiguration -ConnectionName "PulseCxn1" -DnsSuffix "juniper.net" -DnsIPAddress "172.28.144.15","172.24.245.15" -PassThru

Use Microsoft Task Scheduler and PowerShell to update a Pulse connection

You can combine PowerShell and other Windows tools to provide flexibility for your VPN connections. The following example uses Windows Task Scheduler. The scheduled task behaves like a connection startup script. The command creates a scheduled task that runs the specified PowerShell script when the PulseTest connection has established a VPN connection.

schtasks /create /F /TN "VPN Connection Update" /TR "Powershell.exe -NonInteractive -command \test\create-conn.ps1 \test\scripts\settings.xml" /SC ONEVENT /EC Application /MO "*[System[(Level=4 or Level=0) and (EventID=20225)] and *[EventData[Data='PulseTest']]]"

Table 20 on page 278 lists options that you can use in your Pulse connection PowerShell scripts.

Table 20: Schema Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;port&quot;</td>
<td>Use a connection port other than the standard port, 443.</td>
</tr>
<tr>
<td>&quot;uri&quot;</td>
<td>Specifies a sign on policy path override to use when connecting to the server address.</td>
</tr>
<tr>
<td>&quot;preferredRealm&quot;</td>
<td>Specify the preferred connection realm. The user must be a member of the specified authentication realm.</td>
</tr>
<tr>
<td>&quot;preferredRole&quot;</td>
<td>Specify the preferred role. The user must eligible for the role according to the role mapping rules in effect for the realm.</td>
</tr>
<tr>
<td>&quot;optimizeForLowCostNetwork&quot;</td>
<td>true/false</td>
</tr>
<tr>
<td>&quot;isSingleSignOnCredential&quot;</td>
<td>true/false</td>
</tr>
</tbody>
</table>

Related Documentation

- Microsoft Windows In-Box Junos Pulse Client Overview on page 269
- Microsoft Windows In-Box Junos Pulse Client User Interface on page 272
You can use the open standard Statement of Health (SoH) rule in a Host Checker policy for the Pulse for Windows client and for the Windows in-box Pulse client. SoH components evaluate an endpoint’s state of health and make policy decisions for network access based on the result of the health check. To use SoH with the Windows in-box Pulse client, you must also enable the SoH functionality on the endpoint.

**NOTE:** The Statement of Health rule is the only Host Checker rule supported by the Windows in-box Pulse client, and the Statement of Health rule is available only with Pulse Secure Access Service R8.0 and later. If you are using Pulse Secure Access Service R7.4, then Host Checker rules are not available.

You can use the SoH health state validation to determine which roles or realms can be accessed by endpoints. If an endpoint fails the SoH check, or if the SoH cannot be negotiated successfully, the Host Checker policy fails.

You can check the following system health indicators:

- Antivirus is enabled.
- Antivirus is up to date.
- Antispyware is enabled.
- Antispyware is up to date.
- Firewall is enabled.
- Automatic updating is enabled
Configuring a Statement of Health Host Checker Policy for Junos Pulse Secure Access Service

You can use the open standard Statement of Health rule in a Host Checker policy for both the Pulse for Windows client and the Windows in-box Pulse client.

To configure a Statement of Health rule in a Host Checker policy:

1. In the admin console, select Authentication > Endpoint Security > Host Checker.
2. In the Policies section, click New to create a new policy, or click an existing policy.
3. For a new policy, specify a name for the policy and then click Continue.
4. Click the Windows tab. Statement of Health is available for Windows endpoints only.
5. Under Rule Settings, select Custom: Statement of Health, and then click Add.
6. Type a Rule Name for this rule.

To configure the SoH rule, you must select one or more of the Statement of Health parameters.

1. Under Criteria, enter a Label for the selected SoH parameter, or accept the default.
2. Select an SoH policy option from the Parameter menu, and then click Add for the following types:
   • Antivirus Enabled
   • Antivirus up to date
   • Antispyware enabled
   • Antispyware up to date
   • Firewall Enabled
   • Automatic Updating Enabled
3. Select additional options from the Parameter list to add additional SoH parameters.
4. (Optional) For each rule, select the Enable automatic remediation check box. If you select this option for a rule, the user receives a remediation message from the SoH agent, and appropriate remediation is performed, if possible. If the box is not selected, the user receives a remediation message, but no remediation action is performed.
NOTE: Automatic remediation works for the Pulse for Windows client only. The Windows in-box Pulse client does not support automatic remediation.

5. Click Save Changes.

Related Documentation

- Microsoft Windows In-Box Junos Pulse Client Overview on page 269
- Microsoft Windows In-Box Junos Pulse Client User Interface on page 272
- Windows PowerShell Script Examples for Microsoft Windows In-Box Junos Pulse Client on page 275
- Host Checker Statement of Health for Junos Pulse Secure Access Service Overview on page 279
- Enabling Statement of Health on the Windows Endpoint for the Windows In-Box Junos Pulse Client on page 281
- Viewing Windows In-Box Junos Pulse Client Log Messages on page 282

Enabling Statement of Health on the Windows Endpoint for the Windows In-Box Junos Pulse Client

The Statement of Health (SoH) is a basic health check that can be performed on a Windows endpoint. SoH is a component of Network Access Protection (NAP), a Microsoft policy enforcement platform built into Windows 8, Windows 7, Windows Vista, and Windows Server 2008 operating systems that lets you protect network assets by enforcing compliance with system health requirements. NAP SoH functionality is enabled as part of the Pulse for Windows installation. However, before you can use the Statement of Health Host Checker rule with the Windows in-box Pulse client, you must enable the 3rd party Modern VPN NAP client on the endpoint and start the service.

To enable NAP SoH functionality, set the service to run automatically, and to enable the service using PowerShell:

1. Start Windows PowerShell and run the following commands:

```
netsh nap client set enforcement ID = 79624 admin = "enable"
set-service napagent -startype automatic
start-service -name napagent
```

NOTE: You must run the commands as an administrator.
Viewing Windows In-Box Junos Pulse Client Log Messages

The Windows in-box Pulse client uses the Windows Event Log for logging.

To view Windows in-box Pulse client log messages, perform the following steps:

1. Start the Windows Event Viewer.
2. On the navigation pane, open the following path:
   
   Applications and Service Logs > Microsoft > Windows > VpnPluginPlatform > OperationalVerbose.

Related Documentation

- Microsoft Windows In-Box Junos Pulse Client User Interface on page 272
- Windows PowerShell Script Examples for Microsoft Windows In-Box Junos Pulse Client on page 275
PART 5

Index

- Index on page 285
Index

Symbols
&..................................................................................................184
jnprpreconfig
example...............................................................................160
3G wireless.............................................................................203
7Zip.............................................................................................180
802.1x connections
connection, Pulse Secure Access Service......................102
Pulse - OAC comparison....................................................197
Pulse Access Control Service.............................................28
Remote Desktop Protocol and machine
authentication........................................................................44
802.1x connections
certificate..............................................................................7
reboot on upgrade....................................................................9
A
acceleration
client policies.........................................................................143
client status............................................................................144
troubleshooting.....................................................................140
Access Manager.........................................................................136
ACE server.............................................................................27, 100
ActiveSync
using authorization-only policy........................................231
using Secure Mail.................................................................226
ActiveX
Web installation.........................................................................163
adapter type.............................................................................28, 102
address resolution
IPV6..........................................................................................18
admin privileges......................................................................18
Advanced Connectivity license
adding, Pulse Secure Access Service.........................130
advanced endpoint defense
Pulse Access Control Service.............................................63
Pulse Secure Access Service.............................................123
AES.............................................................................................198
agentless
sign-in notifications...............................................................72, 73
allow saving logon information
Pulse Access Control Service.............................................27
Pulse Secure Access Service.............................................99
allow user connections
Pulse Access Control Service.............................................27
Pulse Secure Access Service.............................................100
allow user to override connection policy
App Acceleration connection option.............................29
connection option..............................................................29, 38, 102, 107
connection option, App Acceleration.........................103
connection option, SRX.....................................................29, 103
Android
certificate authentication..................................................235
split tunneling........................................................................75
antispyware
Pulse Access Control Service.............................................63
Pulse Secure Access Service.............................................123
API
Pulse for Android..................................................................246
App Acceleration connection option
community string....................................................................29
Apple iPhone............................................................................214, 222
application acceleration
Android and iOS.....................................................................238
deployment option....................................................................22
FIPS..........................................................................................36, 109
application-level remote access.....................................93, 257
authentication...........................................................................270
SecurID.....................................................................................9
authentication methods.........................................................198
authorization-only policy for ActiveSync....................231
automatic updates.....................................................................9
automatic upgrades............................................................66, 127
autoscan lists.............................................................................197
B
binding server ID.....................................................................163
BlackBerry................................................................................208
blocking access to e-mail.........................................................232
BOM.........................................................................................178
bound and unbound clients
software upgrades...............................................................67, 127
BrandingCredProv.png..............................................................189
BrandingLogo.png.................................................................188
BrandPackager
and SAML..............................................................................183
overview..................................................................................177
supported platforms...........................................................178
BrandPackager.zip.................................................................180

Copyright © 2013, Juniper Networks, Inc.

285
client errors ..........................................................11
client status ....................................................................144
ConfigMgr ..................................................................57, 118, 120
config file ..................................................................................160
connection option
allow user to override connection policy, App Pulse Access Control Service.............................................33
allow user to override connection policy, firewall.........................................................................................103
connection properties.......................................................160
connection rules
configuring ........................................................................50, 111
connection set
Pulse Access Control Service......................................................33
server.............................................................................107
connection set options.......................................................26
adapter type ........................................................................28, 102
allow saving logon information..............................................27, 99
allow user connections.....................................................27, 100
allow user to override connection policy..................................................29, 38, 102, 107
allow user to override connection policy, App Pulse Access Control Service.............................................92
Pulse Secure Access Service............................................99, 100, 102
SRX.................................................................................29
allow user to override connection policy, SRX..........................................................29
community string ..........................................................29, 103
Connection Identity.............................................................28
display splash screen ......................................................27, 100
dynamic certificate trust ......................................................27, 100
dynamic connections.........................................................27, 100
FIPS mode ........................................................................100
FIPS mode enabled.............................................................28
hiding or displaying............................................................27, 100
non-broadcast.................................................................102
outer username...................................................................28, 102
Pulse Secure Access Service............................................99, 100, 102
scan list ..................................................................................102
server certificate DN .......................................................29, 102
wireless suppression..........................................................28, 101
cookie ....................................................................................82
create Pulse connection .....................................................272
credential provider ..............................................................199, 202
Access Control Service.........................................................45
Secure Access Service..........................................................87

Copyright © 2013, Juniper Networks, Inc.
troubleshooting display problems..........................208
Windows Mobile devices...........................................259
rooting detection
  for Android clients..................................................240
route monitor....................................................................201
route monitoring................................................................76
RSA SecuRlD
  client software version..............................................9
RSA soft token..........................................................271
RSA SoftToken................................................................199

S
S/MIME certificate for Secure Mail..........................229
SAML......................................................................................6
  and BrandPackager.....................................................183
Connection Identity
  802.1X connection, Pulse Access Control
    Service...........................................................................28
  802.1X connection, Pulse Secure Access
    Service...........................................................................102
scan lists.................................................................................197
SCCM..............................................................................57, 118, 120
scripts..................................................................................203
Pulse Access Control Service......................................26, 85
Pulse Secure Access Service...........................................84, 85
SAM.....................................................................................97
Windows Mobile app.....................................................82, 262
Secure Mail
  defining the resource profile........................................228
  enabling in user role......................................................227
  importing an S/MIME certificate....................................229
  onboarding devices.......................................................230
  overview.........................................................................226
Secure Meeting..................................................................102, 130
Secure Virtual Workspace................................................18
security
  EES....................................................................................53
Security Assertion Markup Language
  and BrandPackager.....................................................183
security certificates, with Pulse.................................7
Sequence Caching
  client policies............................................................143
  client status....................................................................144
server certificate DN
  802.1X connection, Pulse Access Control
    Service...........................................................................29
  802.1X connection, Pulse Secure Access
    Service...........................................................................102
server certificate is untrusted
  Windows in-box connection......................................270, 273
server ID...............................................................................160
session cookie...............................................................82
session lifetime......................................................................24
session migration..........................................................149
  and authentication server support..............................152
  and IF-MAP.......................................................................154
  and session timeout......................................................151
  configuring......................................................................154
  overview..........................................................................6
  task summary...............................................................153
session scripts......................................................................203
  Pulse Access Control Service......................................26, 85
  Pulse Secure Access Service.......................................84, 85
  SAM.....................................................................................97
  Windows Mobile app.....................................................82, 262
session time-outs..........................................................203
session timeout
  Android..............................................................................238
  iOS.....................................................................................216
  Symbian.........................................................................255
share Pulse configurations.............................................160
Shavlik
  configuring on Pulse Access Control
    Service.............................................................................61
  configuring on Pulse Secure Access
    Service.............................................................................122
  Shavlik IMV.................................................................200, 202
  shortcut key indicator.....................................................184
  shortcut keys.....................................................................184
  sign-in notifications.......................................................25
  agentless.........................................................................72, 73
  Junos Pulse........................................................................72, 73
  localized..........................................................................73
single sign-on........................................................................6, 44, 87
smart card..............................................................................9, 199
smart card authentication..............................................27, 100
SMS........................................................................................57, 118, 120
SMS (System Management Server)..............................60, 120
soft token.............................................................................9, 27, 100, 271
software package............................................................67, 128
software requirements......................................................10, 18
software upgrades
  and bound clients.........................................................7
  for Junos Pulse clients..................................................144
  overview..........................................................................9
SoH (statement of health)....................................................279
SoH, in Host Checker policy............................................279
split tunneling.................................................................276
iOS VPN...........................................................................212, 213
overview...........................................................................75
supported clients.........................................................75
Windows in-box Pulse client......................................270
split tunneling options....................................................83
split tunnelling
  comparison of NC and Pulse........................................201
SRX Series gateways
  deployment option.......................................................23
SSL fallback.....................................................................202
SSL optimization
  client policies............................................................143
  client status..............................................................144
SSO....................................................................................6
  and BrandPackager......................................................183
statement of health, configuring Host Checker policy...........................................................................280
statement of health, Microsoft........................................279
status icons
  Pulse client...................................................................10
Steelhead
  Android and iOS..........................................................238
StringRef...........................................................................185
support, technical See technical support
supported features........................................................270
supported platforms......................................................270
  BrandPackager............................................................178
suspend a connection......................................................29
SVW....................................................................................18
Symbian
  configuring access........................................................253
System Center Configuration Manager............................57, 118, 120
System Center Configuration Manager with Host Checker policy..................................................60, 120
system management server (SMS) with Host Checker policy..................................................60, 120

T
TCP acceleration
  client policies............................................................143
  client status..............................................................144
technical support
  contacting JTAC...........................................................xiv
testing the Pulse package................................................191
text editors........................................................................186
third-party software......................................................129
time-to-live, DNS...........................................................52, 113
TKIP............................................................................................198
token authentication........................................................9, 27, 100
traffic enforcement..........................................................76, 84
Trend Micro firewall..........................................................140
troubleshooting
  application acceleration..............................................35, 103
Type of sign-in info
  Windows in-box connection........................................273

U
UDP port 3578
  and application acceleration.......................................35, 103
unbrand
  using jamCommand......................................................193
uninstall the Junos Pulse client.....................................142
upgrade
  client software...........................................................67, 128, 144
  Windows in-box Pulse client......................................270
upgrading
  Windows........................................................................192
user interface......................................................................178
  customizing the Pulse client interface...........................181
Pulse client.................................................................4
User name
  Windows in-box connection........................................273
user roles
  Pulse Access Control Service.....................................23
  server.............................................................................80
user-after-desktop
  authentication..................................................................40
usernames and passwords
  to download Junos Pulse client software .................142
V
validation...........................................................................191
version monitoring virus signatures and firewall.........8
virtual hostname
  for ActiveSync authorization-only policy......................231
  for Secure Mail.............................................................228
virus signature version monitoring................................8
VPN....................................................................................135
VPN provider
  Windows in-box connection........................................273

W
Web install.................................................................157, 163
Web launch.......................................................................164
Web-mail password
  Android.........................................................................240
iOS....................................................................................217
WEP...........................................................................................198
VPN on Demand
  Android VPN...............................................................236
  bookmarks........................................214, 236, 255, 260
  iOS devices...............................................................213
  iOS VPN................................................................212, 213, 214
  Symbian VPN.........................................................255
  Windows Mobile app...........................................260
Windows 7 wireless issue with FIPS......................36, 109
Windows event log............................................................12
Windows Event Viewer...................................................282
Windows Mobile...........................................................257
  configuring access...........................................97, 262
Windows PowerShell....................................................269
Windows RT
  Host Checker...........................................................279
Windows Update.............................................................270
wireless suppression
  Pulse Access Control Service.........................28, 197
  Pulse Secure Access Service..........................101
WPA/WPA2.............................................................................198
WSAM destinations.........................................................98
App Acceleration connection option
  community string..................................................103